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CHAPTER 1: Introduction to EMS Desktop Client
The purpose of the section is to answer your questions and guide you through the procedures necessary
to install, configure, and administer the EMS Desktop Client efficiently and effectively for Version 44.

Interested in Upgrading?
Contact EMS Sales at (800) 440-3994. For more information, visit www.emssoftware.com.
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CHAPTER 2: Introduction to the EMS Desktop Client Installation
Guide
The EMS Desktop Client is an application that is installed on administrative users' desktops. Administrative
users use this application to configure various workflows, as well as manage day-to-day operations within
the application.

This guide is for system administration and IT users installing the EMS Desktop Client.

This topic provides the following information:

l Understanding User Types 
l EMS System Architecture
l Upgrading? 
l Product Registration 
l Contact Customer Support

Understanding User Types 
There are two different user types in EMS.
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1. Administrators: These users create and maintain the EMS application within your organization, and
manage or approve usage of space. This user type can also include Service Providers (Catering, Audio
Visual, IT Support Staff), Security, and Receptionist Staff. These users will primarily use the EMS
Desktop Client.

2. Web Users: This is a majority of the users in the organization. Web users are typically requesting
rooms and services. These users do not use the EMS Desktop Client, they will primarily use the web-
based application, VEMS in V44 or EMS Web App in V44.1.

EMS System Architecture
The EMS Desktop Client is the foundation for a broad range of components, services, web applications,
APIs, add-ons, and integrations.

Upgrading? 
If you are upgrading to a newer version of EMS, please encourage users at your facility to read the release
notes before they begin working with the new version of the software. Doing so will minimize the amount
of time it takes them to get “up-to-speed” with the new release and help them benefit from new features
and functions that they might not otherwise discover. 

Important!   All the EMS-related components you have licensed must be upgraded with
this release. 
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Product Registration 
Primary Contacts can obtain the license file from the Support Center area on www.emssoftware.com. 
This license file is required to activate your EMS software and is required for new and existing customers.

l Configuration
l System Administration
l EMS Academic Planning specific functionality or the Academic Import Utility

Important! Please note that some discrepancies (e.g. differences in behavior and/or exclu-
sions) will exist.

Contact Customer Support

l Option 1 (Recommended): Search the Knowledge Base available in the EMS Customer Portal.
l Option 2: Submit a Case directly via the EMS Customer Portal.
l Option 3: Email support@emssoftware.com.
l Option 4 (Recommended for critical issues only): Phone (800) 288-4565.

Important! If you do not have a customer login, register here.
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CHAPTER 3: Hardware and Software Requirements

EMS Desktop Client

Supported
Platforms

Windows® 7 (32-bit and 64-bit versions)
Windows® 8 (32-bit and 64-bit versions)
Windows® 8.1 (32-bit and 64-bit versions)
Windows® 10 (32-bit and 64-bit versions)

Minimum
System
Requirements

Processor: 2.0 GHz or faster
Memory: 2 GB or more
Hard-Disk Space: 100 MB
Software: .NET Framework 4.5.2
Video: SVGA 1024 x 768 or higher resolution
Network: Connectivity to Server Resources

Database Server  

Supported
Platforms

Windows 2012 Server
Windows 2012 Server R2
Windows 2008 Server R2

Minimum
System
Requirements

Processor: 2.0 GHz and 4 cores or faster
Memory: 8 GB or more*
Hard-Disk Space: 2 separate physical drives of at least 6 GB; one for data,
and the other for transaction logs (SCSI drives w/9ms access or better and
RAID strategy for fault tolerance recommended)
Software: Microsoft SQL Server 2014, Microsoft SQL Server 2012, Microsoft
SQL Server 2008 R2
Network Card: 100 / 1000 Mbps Ethernet, switched

*Specs apply for up to 100 concurrent users. Increased specs are required
for 100+ concurrent users.
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Web Server 

Supported Platforms Windows 2012 Server,
Windows 2012 Server R2
Windows 2008 Server R2

Minimum System
Requirements

Processor: 2.0 GHz and 4 cores or faster
Memory: 8 GB or more*
Hard-Disk Space: 1 GB or more

*For up to 100 concurrent users. Increased specs required for
100+ concurrent users.

Software Module .NET Version IIS App Pool

Desktop Web Deploy 4.5.2 4.0

Virtual EMS 3.5 2.0

Kiosk 3.5 2.0

Glance 4.6.1 4.0

Glance API 4.6.1 4.0

EMS API 3.5 2.0

Campus Web Service 3.5 2.0

Campus Planning Interface 3.5 2.0

Floor Plan Configuration 3.5 2.0

Room Diagramming
Service

3.5 2.0

PAM Web Service 3.5 2.0
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CHAPTER 4: First Time Installation Instructions
In order to install EMS, you must perform two operations:

1. Run EMS.ServerInstall.exe to create EMS databases on your database server. 

2. Either Install the client using the see EMS Desktop Client Web Deployment, or run the see EMS Client
Install on each individual's machine.

Important! Once you have installed EMS and begun defining your data, it is extremely
important to back up your database every night. If your data is damaged and we determine
the damage to be irreparable, your only alternative will be to restore from the most recent
backup.

Installing EMS Server Components
The server installation process will create two EMS databases on your MS SQL Server:  An EMS_
Master database that contains licensing information and a separate EMS database that will ultimately
contain your reservations data.

Note: A Microsoft SQL Server SA level account will be required to execute the database
installation process.

1. Verify that the prerequisite software has been installed.

2. Secure the EMS.ServerInstall.exe file.

3. Run EMS.ServerInstall.exe (This .exe can be run from any PC that has access to your database server.)
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4. In the Server text box, enter the name of the server running MS SQL Server.

5. In the Database text box, enter the name for your EMS database.  (It is recommended that you
accept the default value of ‘EMS’.)

6. In the Server Authentication area, specify your MS SQL Server authentication credentials.  If SQL
Server Authentication Mode is selected, you will be required to specify a User Name and Password.

7. Click the Execute button.  A Create Database dialogue box will appear.

8. Click Yes to initiate the EMS database installation process

Note:  The time spent on the “Upgrading database…” phase in the installation process is
highly dependent on the size of your database.  Please be patient.

9. Click OK when you receive the “Database Installed Successfully!” message.

You have completed installing the server portion of EMS. Next you will install the software to client
computers.

Note: For information on installing the optional Email Notification Service or the EMS Cam-
pus Auto Sync Service (EMS Academic Planning only), please see Installing or Upgrading the
EMS Email Notification Service and/or Installing or Upgrading the EMS Campus Auto Sync
Service.

Installing to Client Computers
After your EMS databases have been created on your database server, you must install the client software
on each computer that will access your EMS database.

EMS Desktop Web Deployment
Important:  Before beginning the installation process, please install or upgrade your EMS databases.

Important! Existing versions of The EMS Desktop Client Web Deployment must be manu-
ally uninstalled. Please make sure to copy-off and save any files that have been customized.

1. Manually uninstall any previous versions of the EMS Desktop Client Web Deployment on your web
server.  

2. Verify that the prerequisite software has been installed.

3. Download the EMSDesktopWebDeploySetup.msi file onto the web server that will be running the
EMS Desktop Client Web Deployment.

4. Run EMSDesktopWebDeploySetup.msi as an admininstrator.
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5. The first screen welcomes you to the EMS Desktop Client Web Deployment Setup Wizard. 
Click Next to begin the installation process.  The Destination Folder screen will appear.

EMS Desktop Client Web Deployment Setup Screen

6. Select the destination folder.  The installation process will create a new physical directory on your web
server based on the destination folder path entered (“EMS Desktop Web Deploy” in the example
above.).

7. Enter your SQL Instance Name.

8. Enter your Database Name:

l EMS Professional customers – typically named “EMSdata.”
l EMS Workplace, EMS Academic Planning, EMS Enterprise, EMS District and EMS Legal customers -

typically named  “EMS”

9. The Virtual Directory Name will default to the destination folder specified in Step 6.  It is recom-
mended that you keep the default setting.  The installation process will create a virtual directory on
your web server based on the virtual directory entered (“EMS Desktop Web Deploy” in the example
above.)  Click Next.
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Note: The EMS Desktop Client Web Deployment should not be installed in the same virtual
directory as other EMS web-based products OR under a site running another version of the
EMS Desktop Client Web Deployment.

10. The Ready to install the EMS Desktop Client Web Deployment screen will appear.  Click Install to
install the EMS Desktop Client Web Deployment.

11. The Completed EMS Desktop Client Web Deployment Setup Wizard screen will appear. Click Finish.  

12. After following the steps above, verify your EMS Desktop Client Web Deployment installation by
opening a browser and entering the address:

http://[ServerName]/EMSDesktopWebDeploy/  (replace [ServerName] with the name of your web server)

Note: The first time you launch the EMS Desktop Client Web Deployment, it might take a
few extra moments for the website to display.  If you encounter any issues, please contact
Customer Support for assistance.

Use the EMS Desktop Client Web Deployment Option

1. To install the EMS Desktop Client users will need to access the URL from the EMS Desktop Client
Web Deployment.

Note: If your browser has a popup blocker, it should be disabled so that both the EMSAp-
plication.exe and the configuration file can be downloaded.
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2. Click Download and Install the EMS Desktop Client to download the EMSApplication.exe.

3. Run the EMSApplication.exe. This will install the client locally from the service:

Note:  When you launch the EMSApplication.exe if it asks for the EMS Web Deploy con-
figuration URL it will require entering the EMS Desktop Client Web Deployment URL:
http://[ServerName]/EMSDesktopWebDeploy/  (replace [ServerName] with the name of your
web server)

4. The EMS icon will be placed on the users desktop.

Note: When a user launches the EMS Desktop Client, it will check the EMS Desktop Client
Web Deployment for a new version of the Client.

Note: Clients installed through the EMS Desktop Client Web Deployment will not require
administrative permission to install.

5. The system displays a message asking you to import your registration information. Click OK. 

6. The Registration screen appears.  Follow the instructions outlined on the screen to import your EMS
license key.
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Note:  Your license key only needs to be imported once.

7. At the EMS log-in screen, type admin as both the User ID and the Password.

8. Click OK.

Note: When an EMS Client is installed through the EMS Desktop Client Web Deployment it
will only be able to connect to the EMS instance received from the service.

Perform Conventional EMS Desktop Client Installation
Follow these instructions to install the EMS Desktop Client on individual workstations.

1. Verify that the prerequisite software has been installed.

2. Secure the EMSClient.msi.

3. Run EMSClient.msi on the client workstation. Follow the on-screen prompts. It is recommended that
you accept the defaults.

4. Start EMS from the shortcut located on your desktop.

5. In the Provide Server Parameters dialog box, enter the name of your EMS Server and Database.
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6. Click OK.

7. The system displays a message asking you to import your registration information. Click OK. 

8. The Registration screen appears.  Follow the instructions outlined on the screen to import your EMS
license key.

Registration Screen

Note: Your license key only needs to be imported once.

9. At the EMS login screen, type admin as both the User ID and the Password.

10. Click OK.
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11. You are now ready to begin using the system. You can begin defining your data following the instruc-
tions in see Setting Up EMS or you can install to additional client computers by repeating steps 1-
6 above.
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CHAPTER 5: Obtaining the Latest Release of EMS
The latest release of EMS can be downloaded from the online Support Center.

1. Go to www.emssoftware.com and enter your Email Address and Password in the Support Center
area.

2. Click the Software downloads link. 

3. Download the following files.  (Required for both first time installations and upgrades.)

l EMS License (License.lic) – License file required to activate your EMS software.
l EMS Server Install (EMS.ServerInstall.exe) – File used to install or upgrade the EMS databases on your

Microsoft SQL Server.
l EMS Client (EMSClient.msi) – File used to install or upgrade the EMS desktop application.
l EMS Email Notification (EMSEmailNotificationSetup.msi) – File used to install the EMS Email Noti-

fication service (an optional system component.) 
l EMS Campus Auto Sync Service (EMSCampusAutoSyncSetup.msi) – EMS Academic Planning only. 

File used to install the optional EMS Campus Auto Sync Service (an optional system component.) 
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CHAPTER 6: Upgrade Instructions
In order to upgrade EMS, you must perform two operations:

1. Run EMS.ServerInstall.exe to upgrade the EMS databases on your database server. 

2. Either install the client using the EMS Desktop Client Web Deployment, or run the EMS Client
Install. 

Note:  If you are upgrading from a version of EMS released prior to server version 35, please
contact Customer Support.

This topic provides information on the following:

l Prerequisites Before Upgrading 
l Upgrading the EMS Server Components 
l Upgrading Individual Workstations 
l EMS Desktop Client Web Deployment 
l Use the EMS Desktop Client Web Deployment 
l Perform Conventional Desktop Client Installation 
l Install Additional EMS Services 

Prerequisites Before Upgrading 

Important! The following EMS components must be upgraded to the new platform.

l Virtual EMS 
l EMS Web Client – Existing versions of the Web Client are not compatible with this release.
l EMS Campus Planning Interface (EMS Academic Planning only) – Formerly known as the EMS Cam-

pus Web Client. 
l EMS Campus Web Service (EMS Academic Planning only) – If you are upgrading from EMS Campus

2.0, a new version of the EMS Campus Web Service (including the queries.xml and views.sql files)
might be required.  Please contact your Client Services Consultant to evaluate and discuss any poten-
tial impacts to your installation. 

l EMS Email Notification Service 
l EMS Campus Auto Sync Service (EMS Academic Planning only)
l PAM Web Service – Web service used by the optional Plan-a-Meeting and EMS for Outlook modules. 
l EMS for Outlook – Optional module. 
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l Custom Report(s) – If a custom report was developed for you by EMS, please contact Customer Sup-
port to request a new Custom Report DLL that is compatible with this version.  Four to six weeks will
be required to compile a new DLL, so please plan accordingly.

l EMS Kiosk – Optional module.
l Floor Plan Configuration Utility – Web application used with the optional Floor Plan module. 
l EMS Room Diagramming Service – Web service used by the optional Floor Plan module. 
l HR Toolkit – Customers using the optional HR Toolkit to feed employee and web user data to EMS

should contact their Client Services Consultant to evaluate and discuss any potential impacts to the
interface.

l FM Toolkit – Customers using the optional FM Toolkit to feed facility data to EMS should contact
their Client Services Consultant to evaluate and discuss any potential impacts to the interface.

l EMS – Cisco TMS Interface – Optional interface that feeds video conferences booked in EMS to Cisco
TMS. 

l EMS API – Version 1.1.12 or newer required. 
l Video Display Interface – Customers upgrading from EMS Enterprise 4.0 or below will be required to

reconfigure the Scheduled Task to automatically execute the export process. 

Upgrading the EMS Server Components 
The server upgrade process will upgrade the EMS databases on your MS SQL Server.  If you are upgrading
from EMS Enterprise 4.x or below, your existing EMSEnterprise_Masterdatabase (which contains licensing
information) will be replaced by a new EMS_Master database, and your existing EMS database will be
upgraded to the current version.

Note: A Microsoft SQL Server SA level account will be required to execute the database
upgrade process.

1. Complete the requirements in the Prerequisites Before Upgrading section (above).
2. Verify that the prerequisite software is installed.

3. Secure the EMS.ServerInstall.exe file.

4. Using SQL Server Management Studio, back up your existing EMS databases.

5. Run EMS.ServerInstall.exe. (This .exe can be run from any PC that has access to your database server.)
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6. In the Server field, enter the name of the MS SQL Server.

7. In the Database field, enter the name of the EMS database you want to upgrade.

8. In the Server Authentication area, specify your MS SQL Server authentication credentials.  If SQL
Server Authentication Mode is selected, you will be required to specify a User Name and Password.

9. Click the Execute button.  A Backup Database popup will appear.

10. Click Yes to acknowledge that you have backed-up your EMS databases and it is OK to continue. You
have completed the upgrade process for the server portion of EMS. Next you will upgrade individual
workstations.

Note: For information on installing the optional Email Notification Service or the EMS Cam-
pus Auto Sync Service (EMS Academic Planning only), see Installing or Upgrading the EMS
Email Notification Service and/or Installing or Upgrading the EMS Campus Auto Sync Service.
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Important! If you are upgrading your system using the EMS Pro Server Install or EMS
Server Install, be sure to save and remove all custom functions on the EMS database and
then re-install the functions after upgrade. This ensures that your custom functions reinstate
after installation.

Upgrading Individual Workstations 
Follow the procedures below to upgrade individual workstations to EMS Desktop Client. 

EMS Desktop Client Web Deployment 
Before beginning the installation process, please install or upgrade your EMS databases. EMS Desktop
Client Web Deployment is a new feature to EMS Version 44. If you do not want to use the EMS Desktop
Client Web Deploy option, skip to the Conventional Desktop Client Installation section.

Note:  Existing versions of The EMS Desktop Client Web Deployment must be manually
uninstalled. Be sure to copy and save any files that have been customized.

1. Manually uninstall any previous versions of EMS Desktop Client Web Deployment on your web
server.  

2. Verify that the prerequisite software has been installed.

3. Download the EMSDesktopWebDeploySetup.msi file onto the web server that will be running EMS
Desktop Client Web Deployment.

4. Run the EMSDesktopWebDeploySetup.msi as an administrator.

5. The first screen welcomes you to the EMS Desktop Client Web Deployment Setup Wizard. 
Click Next to begin the installation process.  The Destination Folder dialog will appear.
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6. Select the destination folder where you want to install the EMS Desktop Web Deployment.  The
installation process will create a new physical directory on your web server based on the destination
folder path you entered (“EMSDesktopWebDeploy” in the example above.).

7. In the website URL and Virtual Directory Name fields, enter your SQL instance name.

8. In the EMS Database field, enter your Database Name: the Virtual Directory Name will default to the
destination folder specified in Step 6.  It is recommended that you keep the default setting.  The
installation process will create a virtual directory on your web server based on the virtual directory
entered (“EMS Desktop Web Deploy” in the example above.) 

9. If you will be using a Load Balancer with the EMS Desktop Web Deploy application, enter the Name
or IP Address of your server in the EMS SQL Server field. 

10. Click Next.

Note: The EMS Desktop Client Web Deployment should not be installed in the same virtual
directory as other EMS web-based products OR under a site running another version of the
EMS Desktop Client Web Deployment.

11. The Ready to install the EMS Desktop Client Web Deployment window will appear. Click Install.

12. The Completed EMS Desktop Client Web Deployment Setup Wizard window will appear.  Click Finish.  

13. After following the steps above, verify your EMS Desktop Client Web Deployment installation by
opening a browser and entering the address:
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http://[ServerName]/EMSDesktopWebDeploy/  (replace [ServerName] with the name of your web
server)

Note:  The first time you launch the EMS Desktop Client Web Deployment, it might take a
few extra moments for the page to display.  If you encounter any issues, please
contact Customer Support for assistance.

Use the EMS Desktop Client Web Deployment 

1. To install the EMS Desktop Client, users will need to access the URL for the EMS Desktop Client Web
Deployment.

Note: If your browser is set to block popups, it should be disabled so that EMSAp-
plication.exe and the configuration file can be downloaded.

2. Click Download and Install the EMS Desktop Client to download the EMSApplication.exe.

3. Run the EMSApplication.exe. This will install the client locally from the service:
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Note: When you launch the EMSApplication.exe, you might be prompted to enter the EMS
Desktop Client Web Deployment URL:

http://[ServerName]/EMSDesktopWebDeploy/  (replace [ServerName] with the name of your web server)

4. The EMS icon will be placed on the user's desktop.

Note: When a user launches EMS Desktop Client, it will check the EMS Desktop Client Web
Deployment for a new version of the EMS Desktop Client. EMS Desktop Clients installed
through the EMS Desktop Client Web Deployment will not require administrative permission
to install.

5. If you are upgrading from a significantly older version of EMS, you will be prompted to import your
registration information. The Registration screen appears.  Follow the instructions to import your
EMS license key.
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Note: Your license key only needs to be imported once.

6. At the EMS login screen, type admin as both the User ID and the Password.

7. Click OK.

Note: When an EMS Client is installed through the EMS Desktop Client Web Deployment it
will only be able to connect to the EMS instance received from the service.

Perform Conventional Desktop Client Installation 

Note: Existing versions of EMS must be manually uninstalled.

1. Verify that the prerequisite software has been installed.

2. Secure the EMSClient.msi.

3. Run EMSClient.msi on the client workstation. Follow the on-screen prompts. It is recommended that
you accept the defaults.

4. Start EMS from the shortcut located on your desktop.
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5. If you are upgrading from a significantly older version of EMS, you will be prompted to import your
registration information. The Registration screen appears.  Follow the instructions to import your
EMS license key.

6. At the EMS login screen, enter your User ID and Password.

7. Click OK.

8. To install the software on additional client computers, repeat steps 1-4 above.

Note: Your license key only needs to be imported once.

Install Additional EMS Services 
The following services will also need to be installed if you are interested in using these additional features.

l Automated Reports Service
l Booking Level Check-in Service
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CHAPTER 7: Downgrade the EMS Desktop Client Web Deploy
When determining whether you organization wants to revert to an older version of the EMS Desktop
Client, follow the steps below.

IMPORTANT: You cannot roll back an EMS Patch once it has been applied. Please read the release notes
each month to determine if an upgrade is necessary for your organization. As a best practice, it is
recommended that your system remain current on EMS Desktop Client builds and patches.

1. Uninstall the newer version of the EMS Desktop Client Web Deploy.

2. Run the installer for the older version of the EMS Desktop Client Web Deploy.

IMPORTANT: Once the older version of the EMS Desktop Client Web Deploy is installed, users will need to
close EMS before they will be downgraded to the older version of the software. Any user who has an
individual install of the EMS Desktop Client will also need to have that individual install rolled back, by
uninstalling the EMS Client and installing the older version.

3. After the users' EMS Desktop Clients have been downgraded, they will receive a message stating
there is new client software available:

If you want to avoid this prompt from presenting to your users, after installing the older version of the EMS
Desktop Client Web Deploy, run the following script against the EMS database:

Update tblServerVersion

set ClientVersion = NULL

Contact Customer Support
If you have further questions, please contact Customer Support.

l Option 1 (Recommended): Search the Knowledge Base available in the EMS Customer Portal.
l Option 2: Submit a Case directly via the EMS Customer Portal.
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l Option 3: Email support@emssoftware.com.
l Option 4 (Recommended for critical issues only): Phone (800) 288-4565.

Important! If you do not have a customer login, register here.
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CHAPTER 8: Install Custom Reports in EMS Desktop Client
If your organization has a custom developed report that needs to be deployed there are two methods, one
through the EMS Desktop Client Web Deploy and another through the EMS Desktop Client Install.

Important! As of Update 27 (July 2018), changes were made to the EMS Desktop Client to
better support future custom reports and changes to existing custom reports. As such, any
customers on 44.1 that are currently using an EMS Custom Report will need to contact EMS
Customer Support or their Consultant to obtain a new DLL file if they intend to deploy
Update 27 of EMS Desktop Client.

This change also applies to the Glance DLL, TMS, Polycom, and Custom Badges.

EMS Desktop Client Web Deployment

1. Obtain your organization's Custom Report DLL and SQL Overlay script from support.

2. Locate the EMS Desktop Client Web Deployment location on the Web Server. Typically this is C:\inet-
pub\wwwroot\EmsDesktopWebDeploy\.

3. Open the Installer folder and locate the EMS.zip file.

4. Unzip the EMS.zip file to a location on the PC.

5. Place the Custom Report DLL in the EMS folder.

6. Zip the new EMS folder containing the DLL and name the zip file EMS.

7. Place new EMS.zip file containing the Custom Report DLL back in the Installer folder.

EMS Desktop Client Individual Install

1. Obtain your organization's Custom Report DLL and SQL

2. Overlay script from support. Locate the local install of the EMS Client. Typically it is: C:\Program Files
(x86)\EMS\.

3. Place the Custom Report DLL in the EMS folder.
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CHAPTER 9: Introduction to EMS Desktop Client Configuration
Guide
EMS is user-friendly room scheduling software designed to manage the meetings and events that take
place in your facility. Standard features, which you use to create, manage, and report on events, include the
following:

l The Reservation Wizard room booking tool
l A graphical reservation book
l The Browser and month-at-a-glance Calendar Inquiry
l Numerous daily, sales, and statistical reports
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CHAPTER 10: Overview of Configuration Window
You configure data for your EMS database in two major locations:

l Configuration area—You define core data items (facilities, resources, billing, and so on) in the Con-
figuration area.

l System Administration area—You define system administration data items (global user settings,
security, tools, and so on) in the System Administration area.

To be able to make reservations in EMS, at a minimum, you must configure buildings, rooms, statuses, and
groups. By default, when you configure any data item, the item is configured as an active item, which
means that it is available for use in the system. You can inactivate the vast majority of data items in the
EMS database. When you inactivate a data item, it does not delete the item. All information about the item
is retained for historical purposes; however, the item is no longer available for use in the system. For
example, if you inactivate a room then the space is no longer available for booking, but it remains in place
anywhere it was used before being inactivated. If needed, you can delete a data item, but only if the item
has not been used in some way in your EMS system. For example, you can delete a room only if no
bookings or guest requests reference the room. You can delete a resource only if no service order items
reference the resource. Also, the procedure to edit existing data is identical to the procedure for
configuring data with one difference—instead of clicking New in the <Data> window, you select the data
that is being modified and then click Edit. With the exception of groups, this approach works for editing all
data items in your EMS database.

Using Configuration Windows
On some of the configuration windows, if you click Print, a list of reports that you can generate and print
for the applicable configuration item opens. On other configuration windows, an onscreen report opens
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instead in a Print Preview window. This report simply lists the items you have configured. You can also print
a hard copy of the report from this window.

The Audit tab lists the date that the item was added to your EMS database and the name of the user who
added the item. It also lists the date that the item was last modified in your EMS database and the name of
the user who modified the item.

The Audit tab lists the date that the item was added to your EMS database and the name of the user who
added the item. It also lists the date that the item was last modified in your EMS database and the name of
the user who modified the item.

Example of a data configuration window with Audit tab
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CHAPTER 11: Starting EMS Desktop Client
After EMS has been installed on your desktop, a shortcut icon for the application is placed on your desktop.
An option for the application is also available from your Start menu. You can double-click the EMS icon on
your desktop to launch the EMS application, or you can select the option from your Start menu. The
following procedure is written from the perspective of EMS Enterprise; however, it is applicable for any EMS
product.

1. Do one of the following:

l On your desktop, double-click the EMS icon.
l Open the Windows start menu, in the Search field, enter EMS and then select the EMS option.

If you are the first person to log in to the EMS application at your organization, a dialog box opens in which
you enter the information for the login server and database that your application is accessing. (These are
set up during implementation.) After you enter this information, the EMS Login dialog box opens.

2. As the EMS administrator, enter “admin” in both the User ID and Password fields, and then click OK.
If this is the first time that your EMS application has been accessed at your organization, a Regis-
tration dialog box opens. You must import the license file (License.lic) that was provided with your
EMS software to register your application.

3. Click OK. The EMS application opens. The main menu is open in the application.
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Note: For security reasons, after you log in to EMS the first time using “admin” as both the
username and password, at a minimum, DEA recommends that you change the account pass-
word. Ideally, you should create an entirely new administrator account with a new username
and password. See Configuring User Accounts.
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CHAPTER 12: The EMS Window
The EMS main window is your starting point for the EMS application. The window provides quick access to
all the EMS functions (Reservations, Reports, Configuration, and so on) and system tools. This section is
written from the perspective of EMS Enterprise; however, it is applicable for any EMS product (EMS
Professional, EMS Academic Planning, and so on).

The EMS Main window has four major components:

l Title Bar
l Menu Bar
l Toolbar
l Main Menu

Title Bar
The Server and database name that EMS is currently connected to will appear in the title bar across the top
of the main window.
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Menu Bar
The menu bar is set up in a standard Windows menu format with menu commands grouped into menus
(File, Settings, Reservations, and so on) across the menu bar. Some of these menu commands are also
available in the main menu.

Toolbar
The toolbar provides quick access to the most commonly used EMS functions. The toolbar buttons that are
always displayed by default are the buttons for Book, Calendar, Wizard, Navigator, Browser, Web
Reservations, Clients, Email, Dashboard, and Manage Services. Other buttons for other functions are also
displayed by default depending on the version of EMS that you are running, for example, EMS Academic
Planning or EMS Workplace. Some of the functions that are available on the toolbar are also available from
the main menu. You can customize the appearance of this toolbar to best suit your business needs.

Customizing the Toolbar

1. Right-click the toolbar and click Customize. The Customize Toolbar dialog box opens.
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2. Do one or more of the following:
l To display the toolbar icons as large icons, select Large Icons; otherwise, click Small Icons.
l To hide an icon from the toolbar display, in the Show Buttons panel, select an icon, or CTRL-

click to select multiple icons, and then click the Hide button (<). Conversely, to show an icon on
the toolbar display, in the Hide Buttons panel, select an icon, or CTRL-click to select multiple
icons, and then click the Show button (>).

Note: You can also move a toolbar icon between the Hide and Show panels by
double-clicking the icon. To move all icons from one panel to another in a single
step, you do not have to select any icons. Instead, click the appropriate Hide All
button (<<) or Show All button (>>).

l To change the order (from left to right) in which the icons are displayed on the toolbar, select
the icon, and then click Move Up or Move Down as needed.

3. Click OK. The Customize Toolbar dialog box closes. The toolbar display is updated to reflect the
changes that you made.

Main Menu
Every time you open EMS, the main menu opens in the EMS main window. You can access the primary EMS
system functions—Reservations, Reports, Billing, Configuration, and System Administration—from the
main menu.

The main menu is arranged in a Windows Explorer-style folder structure. The top-level folders are the
system functions of Reservations, Reports, Billing, Billing, Configuration, and System Administration. The
available tasks for each top-level folder are further organized into subfolders. For example, to carry out a
system administration task, you must first open the top-level System Administration folder, and then open
the correct subfolder to view the list of available tasks.
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You can always close the main menu by clicking the Close button (x) in the upper right hand corner of the
menu. To open the main menu again, on the EMS menu bar, click File > Show Main Menu.
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CHAPTER 13: Overview of EMS Desktop Client Configuration
This guide leads you through all aspects of configuring EMS under the assumption that you have installed
the application and have Administrator access. For training in initial setup and configuration, please
contact EMS Professional Services. Titles of many sections in this Guide refer to menu options from the
main menu in EMS Desktop Client.

To enable end-users to make reservations in EMS, at a minimum, you should configure buildings, rooms,
statuses, and groups. We recommend that you configure your system in the following phases:

l Facilities
l Resources
l Groups
l Everyday Users
l Billing
l Administration
l Settings

o Parameters
l Security
l Tools
l Import File Specifications
l Other
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CHAPTER 14: The EMS Browser Window
Many EMS functional areas use a Browser window. For example, the Groups window, the Query Builder
window, and the Service Order Management window are all EMS Browser windows. You use an EMS
Browser window to search for data, add new data, and edit and/or delete existing data. For example, in the
Groups Browser window, you can search for groups or contacts, add new groups or contacts, and edit or
delete existing groups or contacts. Regardless of the EMS functional area, all EMS Browser windows have
the following features in common:

l The click and drag feature enables you use to group data by a specific column, rearrange the order
of the data columns, or change the width of a column. This feature is always indicated by the option
to drag and group by a column header at the top of an EMS Browser window. If a window/window
pane does not display this option, then the window/window pane is not an EMS Browser window.

l A column context menu that has a multitude of options for sorting data, grouping data, sizing
columns and so on. 

l A filtering feature that you can use to find and work with a subset of data in the window. 
l A column sorting feature that you can use to sort data by a specific column. 

This topic provides information on the following:

l Grouping Data by Columns
l Rearranging Columns
l Changing Column Width
l Sorting Columns
l Filtering Data
l Changing the Sort Order of Data 

Note: These procedures are explained using the Groups window; however, the instructions
are applicable for any Browser window in EMS.

Grouping Data by Columns
In any browser window, you can drag a column header to the indicated location and group the data by the
selected column. You can drag multiple column headers to the location. If you sort data by multiple
columns, then the first column is the parent column. All other columns are placed as child columns, and the
data is grouped accordingly in the browser window.
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Rearranging Columns
You can rearrange column order by dragging a column to a new location using the column heading.

Changing Column Width
You can change the width of a column by hovering on the right side of a column heading until the pointer
changes to a double-headed arrow, and then dragging the boundary until the column is the width that
you want.
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Sorting Columns
Right-click in any column in a browser window to open a context menu that has a multitude of options for
sorting data, grouping data, sizing columns, and so on.

Filtering Data

1. Open a browser window, for example, the Groups window.

2. Place your cursor in the data column by which you want to filter the data. For example, to filter data
based on the City for group records, place your cursor in the City column. A Filter icon is displayed in
the column.
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3. Click the Filter icon to choose a filter option. Any filter you create is always displayed in the bottom
left corner of the browser window.

OPTION DESCRIPTION

Custom Opens the Custom AutoFilter dialog box in which you can construct a custom
data filter.

Blanks Filters data based on NULL (blank) data for a field. For example, if you click on
Blanks in the City column in the Groups window, then all group records for which
the City field has a NULL (blank) value are displayed in the Groups window.

Non
blanks

Filters data based on Not Null (not blank) data for a field. For example, if you
click Non blanks in the City column in the Groups window, then all group records
for which the City field does not have a NULL (blank) value are displayed in the
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OPTION DESCRIPTION

Groups window.

<Specific
Data
Value>

A Filter list also displays each unique value that has been entered for the field.
Select a value on this list to filter the data by the value. For example, select
“Denver” in the City column of the Groups window to display only those group
records that have “Denver” specified as the group’s city.

4. To edit the current filter, you can click Edit Filter in the lower right corner to open the Filter Editor
dialog box.

l To add a new condition to a filter, clickAdd/Insert.
l To remove a condition from a filter, clickDelete at the end of the filter.
l To apply a new filter, clickApply.
l To close the Edit Filter dialog box and return to the browser window, clickOK.

Changing the Sort Order of Data 
When a browser window first opens, data are sorted in ascending order based on the data in
the first column of the window. For example, when the Groups window first opens, the group records are
displayed on the Results tab alphabetically by Group name. To change the sort order of the data in a
browser window:

1. Click once in any column header to display a Sort Order icon; an “up” arrow indicates that data is sor-
ted in ascending order.

2. Click the Sort Order icon to sort the records in descending order by the data in the column.
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3. Click the Sort Icon again to sort the records in ascending order.
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CHAPTER 15: Manage Database Connections
After EMS has been installed on your desktop using the EMS Desktop Client Web Deployment, managing
database connections can be done through the EMS Desktop Client using the instructions below.

Change Databases
To change databases while using EMS Desktop Client applications installed with Web Deployment, do the
following:

1. On the EMS Menu select File > Change Database to bring up the Database Connections window.

Note: Any database connection listed in blue is a system record inherited from the EMS Desktop Client
Web Deployment that can not be deleted.

2. To connect to a database that is not the system database select it from the list of Database Con-
nections and then press the Connect button. This will close and reopen EMS Desktop Client con-
nected to the selected database.

Note: The user will need to log in again after changing databases

Create New Database Connections

1. To create a New connection select New in the Database Connections window to bring up the Data-
base Connection window.
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2. Type in the SQL server and EMS database name and then select OK to save the connection. You can
delete connections later when you no longer need them.

3. For EMS to save this connection it will first check to see if it is a valid connection. If the connection is
invalid, it will not be created and the user will receive this error message:
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CHAPTER 16: Configuration > Facilities
Before you can use EMS to manage your organization’s events, you must configure core facilities that are
specific to your organization. For example, before you can reserve a room, you must first configure the
room. This menu is available on the EMS Desktop Client top menu bar under Configuration > Facilities.

Configuring Facilities Menu Options

Note: Floor Plan Diagrams and Floor Plan Indicators are optional features used when your
organization has the optional add-on, EMS Floor Plans.

This section will include information on the following:

l Configuring Rooms
l Configuring Buildings
l Configuring Building Hours
l Configuring Areas
l Configuring Room Types
l Configuring Setup Types
l Building Hours Wizard
l Configuring Features
l Configuring Floors
l Configuring Floor Plans
l Configure Public Views
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Note: If your organization has purchased and installed EMS Campus, then you can syn-
chronize data from your Student Information System (SIS) such as your campus buildings,
rooms, and room types. As a result, before you carry out any configuration of your facilities
data, see the EMS Desktop Client -- Academic Planning Configuration Guide.
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CHAPTER 17: Configure Floors
A floor is optional information when you are defining a room and when you are searching for a room. A
room can be assigned to only a single floor. Example of floors include First Floor, Basement, and Garden
Level. When you configure a floor, you must provide a floor name and a sequence.

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Floors. The Floors con-
figuration page opens to show all the floors that are currently configured in your EMS database.

Floors Configuration Page

2. Click New. The Floor Configuration dialog box opens.
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3. In the Floor field, enter a name or description for the new floor (maximum of 50 characters, including
spaces).

4. Optionally, in the Sequence field, enter a sequence for the new floor. The sequence determines the
order in which the floors are displayed in the Floor drop-down list. The lower the sequence number,
the higher in the list that the floor is displayed. If the sequence is set to the default value of zero for all
floors, then the floors are first sorted numerically, and then alphabetically, in the Floor drop-down
list.

5. Click OK. The Floor configuration page closes. You return to the Floors window with the newly added
floor automatically selected.
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CHAPTER 18: Configure Features
A feature is built-in or permanent attribute of a room, such as a network connection, a built-in plasma TV,
window, and so on. Your users can use features as criteria when they are searching for a room. They can
also filter the available rooms that can be reserved for an event by room features. After you
configure different room features for your organization, you must indicate which rooms have these
features.

1. On the EMS menu bar, click Configuration > Facilities > Features. The Features window opens. This
window lists all the features that are currently configured in your EMS database.

2. ClickNew. The Feature configuration dialog opens.

Accruent Confidential and Proprietary © 2019 Page | 51

CHAPTER 18: Configure Features



3. In the Feature field, enter name or description for the feature (maximum of 50 characters, including
spaces).

4. If this feature is a video conferencing feature, then select Tied to Resource.
5. If you want EMS Web App users to see this feature when they are searching for available space, leave

Available to Everyday Users selected.
6. ClickOK. The Feature configuration dialog closes. You return to the Features window with the newly

configured feature automatically selected.
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CHAPTER 19: Configure Setup Types
Setup type is the physical layout or arrangement of a room, for example, classroom, conference, theater-
style, rounds of 6, as-is, and so on. Setup types predefine rooms for a smoother booking process. Although
configuring setup types is not required, setup type is used for defining the capacity for a room, which is
helpful information for the staff at your organization who prepare rooms for an event. Also, when you
configure a room, you can note, by setup type, the capacity for the room. When searching for available
space, your users can use setup types and capacities to filter their search results.

1. On the menu bar, click Configuration > Facilities > Setup Types. The Setup Types window opens. This
window lists all the setup types that are currently configured in your database and that have a status
of Active
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Setup Types Window

Note:  Optionally, to view all setup types in your EMS database, regardless of status, under
Show, click Inactive

2. ClickNew. The Setup Type dialog box opens.

Setup Type Dialog Box

3. In the Setup Type field, enter a name or description for the new setup type. The setup type can be a
maximum of 30 characters, including spaces. 

4. If you want EMS Web App users to be able to see and request this setup type when they are search-
ing for available space, leave Allow Everyday User Request option selected.

5. Leave Inactive blank to add the setup type as an active type. Optionally, select Inactive to inactive
the setup type.

6. ClickOK. The Setup Type dialog box closes. You return to the Setup Types window with the newly
configured setup type automatically selected.
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CHAPTER 20: Configure Room Types
A room type is the class or category of the room, for example a meeting room, an auditorium, a
workspace, a multi-purpose room, and so on. Users can use room types to filter search results.

1. On the EMS Desktop Client menu bar, navigate to Configuration > Facilities > Room Types. The
Room Types window opens. This window lists all the room types that are currently configured in your
EMS database.

Room Types Window

2. Click New. The Room Type dialog box opens.

3. In the Room Type field, enter a name or description for the new room type. The room type can be a
maximum of 50 characters, including spaces.

4. If you want EMS Web App users to see this room type when they are searching for available space,
leave Available to Everyday Users selected.

5. Click OK. The Room Type dialog box closes. You return to the Room Types window with the newly
configured room type automatically selected.

Note: You can use "Override" Rooms to classify un-configured space.
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An Override Room is used in EMS to loosely define useable space which is not formally configured. For
example, a building might have private offices which are not configured as spaces available for public use,
but you might need to select such a space for an attendee who is participating remotely in a video
conference. In order to provide company employees the ability to schedule meetings in these private
rooms, Override Rooms can be configured in EMS.

Configure an Override Room

1. Name the space in a way that indicates an Override Room (for example, "Override Area1”).

2. Classify the room as "Override Description.”

In the example above, "Override Area 1” can be used repeatedly to serve as a placeholder for any meeting
request which will occur in an un-configured space.

For example, on Monday a user makes a reservation for "Override Area 1” and names it "Meeting in Mike
Thompson’s Office,” and on Wednesday another user makes a reservation for "Override Area 1” and
names it "Meet Guests in Lobby Reception Area Prior to Building Tour” EMS does not track availability for
events booked in Override Rooms; however, EMS reports on events that are scheduled in an override
room as it would for an event scheduled for any other room.
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CHAPTER 21: Configure Buildings
A building is a physical location that contains one or more spaces (rooms, open areas, and so on) that your
users can reserve for an event. Buildings are one of the core data items that you must configure so that
your users can make reservations in EMS.

This topic will provide the following information:

l Configure a Building
l Restrict a Building to Specific Categories
l Associate an Image With a Building
l Set Values for the User Defined Fields (UDFs)
l Specify Unregistered Attendee/Visitor Behavior

Configure a Building

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Buildings. The Buildings win-
dow opens. This window lists all the buildings that are currently configured in your EMS database.

2. Click New. The Building configuration dialog opens on the Building tab.
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3. Enter the information as appropriate for the building using the subtopics in this topic.

Note: By default, when you configure a building, the building hours are set to Open All Day.
To change these hours, see Configuring Building Hours. Only the building name, the build-
ing code, and the time zone are required fields. All other fields on all other tabs are optional
and can be configured at a later date if needed.

FIELD DESCRIPTION

Building Required field. The name of the building (maximum 50 characters, including
spaces).

Building
Code

Required field. Abbreviated text that conveys the building name or
description (maximum 20 characters, including spaces). For example, if a
building is named the Conference Building, then a code for the building
could be CONF.

Notes Free-form text that provides any additional information or description about
the building.

URL The web address of a web page that provides more information about the
building (for example, Google Maps).

Print Notes
on
Confirmation

Include the building notes in any confirmations that are printed for events
that are scheduled in the building.
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FIELD DESCRIPTION

Time Zone Required field. Select the time zone in which the building resides.

Note: If you are configuring buildings in EMS Enterprise, you can select a
unique time zone for each building. If you are configuring buildings in EMS,
all buildings must belong to the same time zone.

Currency Select the currency to be used for pricing all rooms in the building. See
Configure Currencies.

External
Reference

Links the building to an outside program, if needed.

Cost Per Sq.
Ft./Meter Per
Yr.

Building cost. Used on the Room Utilization report.

Annual
Operating
Hours

Total number of hours that the building is open during a calendar year. Used
on the Room Utilization report.

4. Continue with any other configuration for the building as needed in this topic; otherwise, clickOK to
close the Building dialog box and return to the Buildings window. The newly configured building is dis-
played in the window.

Restrict a Building to Specific Categories
You can restrict specific categories to specific buildings only in EMS Enterprise. All categories are available
to all buildings in EMS Professional.

1. From the Building Configuration page, click the Categories tab.
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Note: The Available to All Buildings list in the lower right pane displays all the categories that
are always available to all buildings and you cannot edit this list. You can also link buildings
and categories when you are configuring categories. See Configure Categories.

2. Select the categories you want to be available for use in the building, and then use the arrow buttons
to move the them to the Selected list.

3. Continue with any other configuration for the building as needed; otherwise, clickOK to close the
Building dialog box and return to the Buildings window. The newly configured building is displayed in
the window.

Associate an Image With a Building
Images are displayed as thumbnails in both EMS Desktop Client and EMS Web App when a user views
details about a building. You can associate an image with a building if the image is in one of the following
formats: .gif, .jpeg, .jpg, .bmp, .wmf, or .png and ideally, it should not be larger than 615 x 350 pixels. If you
attach an image larger than this, you might not be able to view the image without scrolling.

1. From the Building Configuration dialog, click the Images tab.
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2. To have an image of the building display in EMS and the EMS Web App when a user is viewing build-
ing details, clickNew to open the Find Image dialog box, and then browse to and select the
image. The Find Image dialog box closes. You remain on the Images tab with an entry for the image
displayed on the tab.

3. You can add enter a longer description of the building in theWeb Long Description field. The
value that you enter here defines the “long desc” attribute for web content accessibility.

4. Continue with any other configuration for the building as needed; otherwise, clickOK to close the
Building dialog box and return to the Buildings window. 

Set Values for the User Defined Fields (UDFs)

1. From the Building configuration dialog, click the UDFs tab.
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2. For each UDF that has been defined for the building, select the UDF, and then click the Set Value
button to open a dialog box in which you can set the value for the UDF.

3. Continue with any other configuration for the building as needed; otherwise, clickOK to close the
Building dialog box and return to the Buildings window.

Specify Unregistered Attendee/Visitor Behavior
The Visitor Management tab is displayed only if your organization has purchased and installed the optional
Visitor Management module, which enables front-desk users such as reception to check in visitors, print
badges, access lists of visitors, and run reports. The values that you specify on this tab are used when a new
visitor checks into your building. 

1. From the Building configuration dialog, click the Visitor Management tab.
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2. Enter the information for the new unregistered visitor/attendee.

OPTION DESCRIPTION

Category Select an Attendee type category. See Configure Categories.

Room The Override room that is booked for the unregistered visitor’s/attendee’s
reservation.

Note: Typically, you would want to book an Override room named something
such as Other Space, Unregistered Space, or so on. See Configuring Rooms.

Status The status that is used for an unregistered visitor’s/attendee’s reservation. See
Configure Statuses.

Event
Type

The event type that is used for the unregistered visitor’s/attendee’s reservation.

Note: Typically, you would want to use an event type named something such as
Unregistered Visitor, Unregistered Attendee or so on. See Configure Event
Types.

Event
Name

The event name that is used for the unregistered visitor’s/attendee’s reservation.

Note: You can include the variable for Group Name (the name of the group that
the visitor/attendee is seeing) in the subject line as described in the Legend. For
example, “Unregistered Visitor for%1%” would result in “Unregistered Visitor for
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OPTION DESCRIPTION

Academic Affairs” being displayed in the subject line.

End
Time

The booking for the unregistered visitor/attendee is created from the current
time until the end time that you specify.

3. Continue with any other configuration for the building as needed; otherwise, clickOK to close the
Building configuration dialog and return to the list of Buildings.
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CHAPTER 22: Configure Building Hours
By configuring building hours, you can set times when buildings and rooms therein are not available for
scheduling. 

In the EMS Desktop Client, configured building hours do not prevent a user from scheduling events
outside these hours. A user is merely warned that the event is being scheduled outside normal operating
hours. In EMS Web App, users cannot schedule events outside the configured building hours. Setup and
teardown hours must also fall within the configured building hours for an event that is scheduled in
EMS Web App.

By default, when you configure a building, the building hours are set to Open All Day, which means that
the building is open 24 hours a day, 7 days a week, 365 days a year. If needed, you can configure the hours
for a building so that a building is open only for a specified time period on a particular date or for a given
date range. You can also configure the hours so that a building is closed all day. You can configure the
hours for a building for a single date, or you can configure the hours for multiple dates in a single step.

Note: You can configure the same hours for multiple buildings using the Building Hours
Wizard.

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Building Hours. The Build-
ing Hours window opens. This window lists buildings that are configured in your EMS database.

Building Hours Window
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2. In the Date field, leave the default value of the current day’s date, or select a different date.

3. Select the building, or CTRL-click to select the multiple buildings for which you are changing the
hours, and then click Change. The Building Hours dialog box opens.
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Note: If you select multiple buildings, then the Building Hours dialog box reflects the hours
for the building that is last in the list of selected buildings. You can set the same building
hours for multiple buildings at once using the Building Hours Wizard.

4. Set the new hours for the buildings as appropriate.

OPTION DESCRIPTION

Set
Building
Hours

Select this option to specify the time period (Open and Close) during which the
building is to remain open for the date. Your EMS Desktop Client users can make
reservations on this date in the selected buildings even if the events are
scheduled outside the indicated time period. They merely receive a warning that
the reservation time exceeds building hours.

Note: EMS Web App users cannot make reservations outside of building hours.

Closed
All Day

Select this option to close the building for the entire day. When you select this
option, then a Web Only option is displayed on the Building Hours dialog box.

l If you do not select Web Only, then none of your users (EMS Desktop Client
or EMS Web App) can make reservations on this date in the selected build-
ings.

l If you do you select Web Only, then your EMS Desktop Client users can
make reservations on this date in the selected buildings; however, your
EMS Web App users cannot.

Open
All Day

The default value. Leave this option selected to have the building remain open
for the entire holiday.

5. Click OK to return to the Building Hours window.
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CHAPTER 23: Building Hours Wizard
The Building Hours Wizard streamlines the configuration process and allows users to configure building
hours for multiple dates.

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Building Hours. The Building
Hours window opens. This window lists all the buildings and their operating hours that are con-
figured in your EMS Desktop Client database.

2. Click Wizard. The Building Hours Wizard opens.
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3. Click Add Dates. The Date Pattern dialog box opens.

4. Enter the appropriate date pattern, and then click OK. (Both the Start Date and End Date are required
values.) The Date Pattern dialog box closes. You return to the Building Hours Wizard. The dates that
meet the pattern that you specified are displayed in the Building Hours Wizard. If any of the dates
that meet the pattern are holidays, then the name of the holiday is displayed next to the date.

5. To view information about a date that is marked as a holiday, you can select the date, and then
click Special Dates. To remove any dates from the list, you can select the date, or CTRL-click to select
multiple dates, and then click Remove.
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6. Click Next. The Building Hours Wizard is updated with a list of the buildings that have been con-
figured in your EMS Desktop Client database.

Building Hours Wizard with a list of configured buildings

7. Select the buildings for which you are configuring the same hours, and then use the arrow button to
move the buildings to the Selected list.

8. Click Next. The Building Hours Wizard is updated with options for configuring the building hours for
the selected buildings.

9. Set the new hours for the buildings as appropriate.

OPTION DESCRIPTION

Set
Building
Hours

Select this option to specify the time period (Open and Close) during which the
building is to remain open for the date. Your EMS Desktop Client users can make
reservations on this date in the selected buildings even if the events are
scheduled outside the indicated time period. They merely receive a warning that
the reservation time exceeds building hours.

Note: EMS Web App users cannot make reservations outside of building hours.

Closed Select this option to close the building for the entire day. When you select this
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OPTION DESCRIPTION

All Day option, then a Web Only option is displayed on the Building Hours dialog box.

l If you do not select Web Only, then none of your users (EMS Desktop Client
or EMS Web App) can make reservations on this date in the selected build-
ings.

l If you do you select Web Only, then your EMS Desktop Client users can
make reservations on this date in the selected buildings; however, your EMS
Web App users cannot.

Open
All Day

The default value. Leave this option selected to have the building remain open
for the entire holiday.

10. Click Finish. The Building Hours Wizard closes. You return to the Building Hours window.
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CHAPTER 24: Configure Areas
An area is a particular region of indefinite boundary that is used to group buildings, for example, Southeast
Region, Campus Wide, Training Sites, and so on. You can use an area as search criteria in EMS and
EMS Web App, in reporting, and so on. When you configure an area, you must specify the buildings that
are to be included in the area.

Note: You can configure areas only in EMS Enterprise. You cannot configure areas in
EMS Professional.

1. On the EMS menu bar, navigate to Configuration > Facilities > Areas. The Areas window opens. This
window lists all the areas that are currently configured in your EMS database.

2. Click New. The Area dialog box opens. The Area tab is the active tab.
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Note: In the Area field, enter a name or description for the new area, for example, Southeast
Region.The area can be a maximum of 50 characters, including spaces.In the Notes field, you
can enter additional information that is pertinent for the area.

For EMS Web App users to be able to see and filter by this area, select the Available to Everyday Users
checkbox.

3. Open the Buildings tab, and on the Available list, select the building,(CTRL-click to select multiple
buildings) you want included in the Area, and then Move to the (>) Selected list. 

Note: You can click Spelling to spell-check the area description before you save the area.
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4. Click OK. The Area dialog box closes. You return to the Areas window with the newly configured area
automatically selected.
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CHAPTER 25: Overview of Configuring Rooms
A room is a physical location that you reserve for an event. You can configure any physical location or
space (meeting room, athletic field, lobby, and so on) as a room, for example:

l Grand Ballroom
l Conference Room A
l Harris Hall Room 200
l South Soccer Field

EMS uses three classifications of rooms:

1. Standard and Combination Rooms
2. Standard and Combination Rooms
3. Override Rooms

Your organization might use a different term to identify the spaces or locations that are booked for
reservations at your facilities. If you want to change the term from “room” to your organization-specific
term throughout your EMS system (menus, window and dialog box titles, confirmation headings, and so
on), you must change the values for the Room Title Plural and Room Title Singular parameters. See
Also: System Parameters.

Standard and Combination Rooms
A standard room is any physical space that can be booked at your facility. You can use standard rooms as

components when you configure a combination room. You can configure a combination room from two
or more standard rooms, or you can configure it based on a logical relationship among multiple rooms. For
example, if your organization is a student union, it might have a space that is designated as the Grand
Ballroom, which is actually made of three standard rooms—Ballroom A, Ballroom B, and Ballroom C—and
you can literally combine or divide these rooms using movable partitions. In another example, you could
configure a combination room that is called the West End and this room includes all rooms in the West End
of a given building, whether the rooms are contiguous.

To configure a combination room, you must first configure the component rooms as standard rooms. You
can then configure the combination room and indicate that its components are the previously defined
standard rooms. Consider the ballroom example cited above: First, define the standard rooms—Ballroom
A, Ballroom B, and Ballroom C. You then configure a room called the Grand Ballroom, give it a classification
of “combo room” and indicate that it is made up of three standard rooms—Ballroom A, Ballroom B, and
Ballroom C. If you want, you can also configure subsets of the Grand Ballroom, such as Ballroom AB,
Ballroom AC, and Ballroom BC. As a result, when the Grand Ballroom is scheduled for an event, the three
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standard rooms—Ballroom A, Ballroom B, and Ballroom C—are unavailable in EMS. Conversely, if you
schedule one of the three standard rooms, for example, Ballroom A, then the Grand Ballroom, Ballroom AB,
and Ballroom AC, are unavailable in EMS. The table below summarizes this example.

ROOM CLASSIFICATION COMPONENTS COMMENTS

Ballroom
A

Standard N/A Available for booking only if Ballroom AB,
Ballroom AC, or the Grand Ballroom are not
already booked.

Ballroom
B

Standard N/A Available for booking only if Ballroom AB,
Ballroom BC, or the Grand Ballroom are not
already booked.

Ballroom
C

Standard N/A Available for booking only if Ballroom BC,
Ballroom AC, or the Grand Ballroom are not
already booked.

Ballroom
AB

Combo Ballroom A,
Ballroom B

Available for booking only if Ballroom A,
Ballroom B, or the Grand Ballroom are not
already booked.

Ballroom
AC

Combo Ballroom A,
Ballroom C

Available for booking only if Ballroom A,
Ballroom C, or the Grand Ballroom are not
already booked.

Ballroom
BC

Combo Ballroom B,
Ballroom C

Available for booking only if Ballroom B,
Ballroom C, or the Grand Ballroom are not
already booked.

Grand
Ballroom

Combo Ballroom A,
Ballroom B,
Ballroom C

Available for booking only if none of the
standard rooms or none of the subset
ballrooms are not already booked.

Override Rooms
An override room is used to book an event in a space that is not managed in EMS. When you configure an
override room, you not only name it in a manner that indicates that the room is an override room (for
example, “Override Area”), but also, you classify the room as “Override Description.” When a user is
searching for a specific room in the Reservation Wizard, and selects the option of “Override Area,” a
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Location field is enabled in which they must enter the specific location of this override room. By using an
override room, the user can schedule a meeting (for example, Dr. Wilson’s Research Group meeting)
without having “Dr. Wilson’s Office” configured as a room in EMS.

Events that are scheduled in rooms that are classified as “Override Description” are displayed in Daily
reports as taking place in the location name specified, in the building in which the room is configured. Sales
and Statistical reports simply report on the use of a room as you defined it, for example as “Override Area."
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CHAPTER 26: Configure Rooms
By defining rooms in your organization, you enable Everyday Users to choose from a list of rooms that
they can intuitively filter by many elements, such as name, location, type, setup, available services, and
physical features.

Note: The Room Configuration Wizard is ideal for configuring multiple rooms at once, when
they should have the same configuration: room type, setup hours, teardown hours, features,
and setup type). For instructions in using the wizard, first familiarize yourself with the general
process of defining rooms in this topic, and then See Also: Room Configuration Wizard.

To configure a room, you will

l Check if the room has already been configured.
l Edit an existing room to add more detail, or configure a new one from scratch. 
l Define the room in detail by going through the tabs along the top of the Room configuration page
l Optional: You can specify the pricing for the room during this process, or you can price it a later date. 

This topic includes information on the following:

l Basic Elements for Configuring a Room
l Notes or Alerts for a Room
l Configure Calculations for a Room
l Configure Pricing for a Room
l Set Setup Types for a Room
l Set Components for a Combination Room
l Set Features for a Room
l Exclude Resources for a Room
l Add Attachments to a Room
l Add an Image for a Room
l Add Drawings for a Room
l Set Values for User Defined Fields (UDFs) for a Room
l Assign the Room to an Everyday User Process Templates
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This topic guides you in configuring a single room; once you have configured everything else under the
Configuration> Facilitiesmenu, room configuration is where "everything comes together," since
defining a room entails all these elements.

Basic Elements for Configuring a Room
At a minimum, you must specify the room code, the room name, the room classification, and the Building
that contains the room. All other information is optional, and you can configure it at a later date if needed.

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Rooms. The Rooms con-
figuration page opens.

2. In the fields along the top, enter any of the following criteria to narrow the list of rooms below or to
set basic information for a new room configuration:
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l Building
l Classification: Leave the default value of (all), or select a specific room classification.
l Room Type: Leave the default value of (all), or select a specific room type.
l Filter: Keyword search (case sensitive, characters must be in correct order).

3. To modify an existing room, double-click on it or select and click Edit.

To create a new room "from scratch," click the New button. The Room configuration page opens on
the Room tab, where you work with basic information.

Note:  You can also click Copy to use an existing room to configure a new one more quickly

4. Enter the information for the new room.

FIELD DESCRIPTION 

Room Code Required field. Abbreviated text that conveys the room name or
description. For example, if a room is named Conference Room 100, then
a code for the room could be CONF100.

Note: The room code can be a maximum of 20 characters, including
spaces.

Room Name Required field. The name of the room.
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FIELD DESCRIPTION 

Note: The room name can be a maximum of 50 characters, including
spaces.

Classification Select the appropriate classification for the room.

Default Setup
Type

Leave the default as (none), or select a setup type from the list.

Note: A user can override this value when reserving the room, or when
editing the event. If the appropriate setup type is not listed, you can
configure it. 

Setup
HoursTeardown
Hours

These settings establish the default setup and teardown hours for the
room, which are automatically added to the beginning and end of the
event time the user specifies in the Reservation Wizard or in EMS Web
App. A user can override these values in the Reservation Wizard.

Book Sequence This value determines the order in which the rooms are listed in the
Reservation Wizard for a standard or best fit room search and in the
Reservation Book. Enter a zero for the first room that is to be listed.
Rooms are ordered from lowest to highest sequence number, with the
room with the lowest sequence number being displayed first.

Note: If you leave the book sequence set to zero for all rooms, then
rooms are sorted numerically by room code, and then alphabetically.

Type Room type. Leave the default as (none), or select a room type from the
list.

Note: If the appropriate room type is not listed, you can configure it.

Building Required field. If you selected a single Building when setting criteria, this
field carries over that value. You can change it.

Account Enter the internal account that should be credited with the room rental
revenue.

Note: If the appropriate account is not listed, you can configure it.
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FIELD DESCRIPTION 

Phone The phone number for the room.

HVAC Zone Optional field used for integration with an HVAC system.

URL The URL (website address) for a web page that provides more
information about the room.

Size Typically used to enter the square footage of the room.

No. of Room
Cards

Indicates how many copies of the Room Cards report should be printed
for this room when the report is run. (Typically, you want one copy for
each entry door). If you do not want a room card to print, enter a zero. 
Note: This controls whether you can generate QR codes for this room.

Requires Check
In

Requires bookings within this room to be checked-in to beginning at a
certain number of minutes prior to the Booking Start Time. 

Academic Available only in EMS Campus. Set an academic” property on the room.

External
Reference

Links the room to an outside program, if needed.

EMS Web App Settings

Available to
Everyday Users

Leave this option selected if events that are scheduled in the room are to
be displayed in EMS Web App.

Hide Group Select this option to hide the name of the Group that booked an event in
the room in the Browse Event tooltip.

Display Alert to
Everyday Users

Select this option to display any alerts that have been configured for the
room when a EMS Web App user schedules an event in the room.

Prompt for
Billing
Reference

Users will see the Billing Reference field during the booking process when
this parameter is set at either the reservation, room, or category level.

Whether the Billing Reference field displays is based on four settings:
global, template, room-level setting, category-level setting. The booking
template setting overrides the global setting. The room and category
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FIELD DESCRIPTION 

level settings can both override the template setting. After the Admin
decides whether to display the field, user entries will be validate based on
the value in the 'Billing Reference Validation' parameter set on the
template.

Billing Reference field options:

l Show (Prompt)
l Require
l Validate (Show and Require)
l Don't Show

Additionally, the Billing Reference Validation parameter will always
determine whether it is optional, required, or required and validated. 

Inactive Leave this option blank to add the room as an active room. Select this
option to inactivate the room.

5. If the room is a Combo room, then see Configure Room Types; otherwise, continue to the sub-
sequent procedures in this topic.

6. ClickOK. The Room configuration page closes and the newly configured room is listed.

Notes or Alerts for a Room

1. From the Room configuration page, open the Notes tab.

2. Enter one or more of the following for the room:

OPTION DESCRIPTION

Notes Free form text that provides any additional information or description about
the room.

Note: These notes are not included in confirmations that are printed for
events that are scheduled in the room. 

Confirmation
Notes

These notes are included in any confirmations that are printed for events
that are scheduled in the room.
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OPTION DESCRIPTION

Alert Free form text that provides any additional information or description about
the room. This text is displayed when an EMS user schedules an event in the
room, and if Display Alert to Everyday Users is selected for the room, when a
EMS Web App user schedules an event in the room as well.

3. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page. The newly configured room is displayed in the list of rooms.

Configure Calculations for a Room

1. From the Room configuration page, open the Calculations tab to link pre-defined calculations to the
room so they are always included in billings for it. (See Also: Configure Calculations).

2. Select the calculation(s) you want to link to the room in the Available list and use the arrow keys to
move to the Selected list.

3. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page. The newly configured room is displayed in the list of rooms

Configure Pricing for a Room

Note: You can also configure the room price on the Edit Pricing window. 

1. From the Room configuration page, open the Pricing tab to link the room to pre-defined pricing
methods so these are used for billing.

2. For each rate schedule, select the Pricing method, which determines the cost for reserving the
room. If the appropriate rate schedule is not listed, you can configure it.

PRICING

METHOD

DESCRIPTION

Half
Day/Full
Day
(Event
Time)

The total number of hours for the event is counted and then compared to the
number of hours that is indicated in the Hours column. If the total number of
hours for the event is less than or equal to the hours that are indicated in the
Hours column, then the Half Day price is charged for the room. If the total
number of hours for the event is greater than the hours that are indicated in the
Hours column, then the Full Day price is charged for the room.
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PRICING

METHOD

DESCRIPTION

Half
Day/Full
Day
(Reserved
Time)

The total number of hours for the Reservation (event time and reserved time) is
counted and then compared to the number of hours that is indicated in the
Hours column. If the total number of hours for the Reservation is less than or
equal to the hours that are indicated in the Hours column, then the Half Day
price is charged for the room. If the total number of hours for the Reservation is
greater than the hours that are indicated in the Hours column, then the Full Day
price is charged for the room.

Hourly
(Event
Time)

The price that is indicated in the Price column is multiplied by the event time (in
hours) for the booking. This price can be used in conjunction with an initial flat”
fee, as well as minimum and maximum fees.

Hourly
(Reserved
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the booking. This price can be used in conjunction with an initial
flat” fee, as well as minimum and maximum fees.

Hourly
(Specific)

The price that is indicated in the Price column is multiplied by the number of
hours indicated when adding a room to a booking.

Unit The price that is indicated in the Price column is applied to the room, regardless
of the event time or reserved time for the booking.

3. After you select a pricing method, edit the amounts in the fields below as needed.

FIELD DESCRIPTION

Price The dollar amount that is used in calculating the room price for a booking. If
the pricing method is Unit, then this value is applied in total to a room,
regardless of the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for a
room, then the actual price, the discount percentage, and the discounted
amount are all displayed on confirmations and invoices.

Min. Used in conjunction with the Hourly pricing methods. If you specify a
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FIELD DESCRIPTION

ChargeMax.
Charge

minimum charge for a room, then the system compares this value to the
calculated hourly rate and applies the greater of the two charges. Likewise, if
you specify a maximum charge for a room, then the system compares this
value to the calculated hourly rate and applies the lesser of the two charges.

Flat Price A room price that remains constant regardless of the total number of hours
booked for a room. Used in conjunction with Hourly (Event Time) and Hourly
(Reserved Time).

Half Day
Price

The dollar amount that is used in calculating the room price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Full Day
Price

The dollar amount that is used in calculating the room price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Hours Multiplier used in calculating the room price for a booking if the pricing unit
is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

4. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Set Setup Types for a Room

1. From the Room Configuration page, open the Setup Types tab and linl pre-defined setup types to
the room.

2. For each setup type you want to apply for the room, select In Use, and use the Min Capacity and/or
Max. Capacity fields to set headcount limits. If the appropriate setup type is not listed, you can con-
figure it. 

Note: If EMS Web App users are able to request a setup type for the room, the Allow Every-
day User Request option will be set to Yes. This is controlled by your Setup Type Con-
figuration.
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3. Continue with any other optional configuration for the room as needed; otherwise, clickOK to close
the Room configuration page.

Set Components for a Combination Room

Note: This tab is available only if you selected Combo for the room classification.

1. From the Room configuration page, open the Components tab.

2. Do one or both of the following:
l On the Building drop-down list, select one of the following—(all) Buildings, a specific Building, a

specific area, or a specific view. If the appropriate Building, area, or view is not listed, you can
configure it.

l On the Room Type drop-down list, leave the default value of (all), or select a specific room
type. If the appropriate room type is not listed, you can configure it. As you select your search
criteria, the list of rooms dynamically updates.

3. On the Available list, CTRL-click to select multiple rooms that will comprise the Combo room, and
then Move (>) to them to the Selected list.

4. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Set Features for a Room

1. From the Room configuration page, open the Features tab.

2. On the Available list, select the feature (CTRL-click to select multiple features) and Move (>) to the
Selected list. If the appropriate feature is not listed, you can configure it. See Configuring Features.

3. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Exclude Resources for a Room
This setting prevents EMS Web App users from selecting a resource from a room. EMS Desktop Client
users just receive a warning, but they can still select the resources for the room.

1. From the Room configuration page, open the Excluded Resources tab.

2. On the Category drop-down list, select the category that contains the resources that are to be
excluded from the room. The resources for the selected category are displayed in the Available list. If
the appropriate category and/or resource is not available, then you can configure it.
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3. Select the resource (use CTRL-click to select multiple resources) to exclude from the room, and Move
(>) to the Selected list.

4. Continue with any other optional configuration for the room as needed; otherwise, clickOK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Add Attachments to a Room
An attachment is a file that is saved with the room record. For example, you might want to add an
attachment to a room record that details any special considerations about the room setup. Users can see
the attachments when they are viewing details about the room.

1. From the Room configuration page, open the Attachments tab.

2. Click New to open the Find Attachment dialog box, and then browse to find and select the
attachment. The Find Attachment dialog box closes. Your attachment displays on the tab.

3. Optionally, do one or more of the following:
l In the Notes field, enter a description and/or additional information about the attachment.
l Click Spelling to spell check the attachment notes before you save the room.
l You can view an attachment: select the attachment, and then click View. Your EMS Desktop Cli-

ent must have a software program installed to view the attachment. For example, to view a
Microsoft Excel spreadsheet, you must have Microsoft Excel installed on your EMS Desktop Cli-
ent.

4. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Add an Image for a Room

Note: Images are displayed as thumbnails in both EMS and EMS Web App when a user
views details about a room. You can associate an image with a room if the image is in one of
the following formats—.gif, .jpeg, .jpg, .bmp, .wmf, .pdf or .png and ideally, it should not be lar-
ger than 615 x 350 pixels. If you attach an image larger than this, you might not be able to
view the image without scrolling.

1. From the Room configuration page, open the Images tab.

2. Click New to open the Find Image dialog box, and browse for your image file. Once you have chosen
on an image, it will be listed on the Images tab.

Tip:You can use the Web App Long Description field to enter a description of the image that will display on
the EMS Web App.
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3. Continue with any other optional configuration for the room as needed; otherwise, clickOK to close
the Room configuration page..

Add Drawings for a Room
A drawing is text-based or image file that is stored on your organization’s network that you can
reference in a booking. Typically, a drawing is a setup diagram of the booking room. If the drawing is an
image file, and you want your users to be able to view the image in EMS and EMS Web App when making a
Reservation, then you should associate the image with the room on the Images tab.

1. From the Room Configuration page, open the Drawings tab.

2. Click Attach to open the Find Drawing dialog box, and then browse for your drawing file. Once you
have chosen the file, the drawing is displayed on the Drawing tab.

3. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.

Set Values for User Defined Fields (UDFs) for a Room

1. From the Room configuration page, open the User Defined Fields tab to add pre-defined fields to the
room that will be used during the booking process.

2. For each UDF defined for the room, select the UDF, and then click Set Value.

3. Continue with any other optional configuration for the room as needed; otherwise, click OK to close
the Room configuration page.

Assign the Room to an Everyday User Process Templates
By assigning a room to an Everyday User process template, you enable these users to select it from
Everyday Applications such as EMS Web App and EMS Mobile App when they book events using the
template.

1. From the Room configuration page, open the Everyday User Process Template tab.

2. On the Available list, select the everyday user template (CTRL-click to select multiple templates) for
which the attached users can book the room, and then Move (>) them to the correct Selected list.

l Move templates for which users can reserve the room without approval (booked into the
Reserve status in EMS Web App) into the Reserve pane.

l Move templates for which users must get approval to reserve the room (booked into the
Request status in EMS Web App) into the Request pane.
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3. Continue with any other optional configuration for the room as needed; otherwise, clickOK to close
the Room configuration page and return to the Rooms window. The newly configured room is dis-
played in the window.
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CHAPTER 27: Room Configuration Wizard
The Room Configuration Wizard enables you to configure multiple rooms at one time. These rooms
should have the following properties in common:

l Room type
l Setup hours
l Teardown hours
l Features
l Setup types

This topic provides information on the following:

l Using the Room Configuration Wizard
l Configure Features for Multiple Rooms 
l Exclude Resources for Multiple Rooms 
l Configure Common Setup Types for Multiple Rooms 
l Configure Common UDFs for Multiple Rooms 

Using the Room Configuration Wizard

1. On the EMS menu bar, click Configuration > Facilities > Rooms. The Rooms window opens.

2. Click Wizard. The Room Configuration Wizard opens, with Features tab (in the Items pane) active.   
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3. Select the common properties for all the rooms that you are configuring and enter the appropriate
values.

OPTION COMMENT

Room
Type

If the appropriate room type is not listed, you can configure it. 

Floor If the appropriate floor is not listed, you can configure it. 

Account If the appropriate account is not listed, you can configure it. 

Default
Setup
Type

If the appropriate setup type is not listed, you can configure it. 

Note: A user can override this value when reserving the room, or when editing
the event.

Setup
Hours

Teardown
Hours

These settings establish the default setup and teardown hours for the room,
which are automatically added to the beginning and end of the event time that
user specifies in the Reservation Wizard or in EMS Web App. A user can
override these default values in the Reservation Wizard.

Accruent Confidential and Proprietary © 2019 Page | 92

CHAPTER 27: Room Configuration Wizard



OPTION COMMENT

Available
to
Everyday
Users

Select if events that are scheduled in the room are to be displayed in EMS Web
App.

Active Select either Yes or No to activate or inactivate a room.

Prompt
for Billing
Reference

Select to prompt for a billing reference when a room is selected for a booking.

Requires
Check In

Requires bookings within this room to be checked-in to beginning at a certain
number of minutes prior to the Booking Start Time.

Note: If you are configuring a room in EMS Academic Planning, then Academic Space is also
a common property that you can configure.

4. If you want the events scheduled in the room to display in EMS Web App, select Available to Every-
day Users.

5. If these rooms are to be active (available immediately for booking events), select Active. (Yes is selec-
ted by default). Otherwise, select No.

6. Click Next. The Room Configuration Wizard presents so you can search for the rooms you want
to configure.
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7. Enter any combination of search criteria, by Building and Room Type. 

8. On the Available list, select the room (CTRL-click to select multiple rooms) to be configured, and then
Move (>) to the Selected list.

9. Click Finish. The Room Configuration Wizard closes. A message opens indicating that the room prop-
erties were set successfully.

10. Click OK. The message closes. You return to the Rooms window. The newly configured rooms are dis-
played in the window.

Configure Features for Multiple Rooms 

1. If all the rooms should have the same features, under Items, select Features.

2. On the Available list, select the feature (CTRL-click to select multiple features) you want the rooms to
have. If the appropriate features are not available, you can configure them. See Configuring Features.

3. If any of the rooms that you select for configuration have existing features and you want to drop
these existing features and apply only the new features, select Overwrite Existing; otherwise, the new
features are simply appended to the list of existing features.

4. Continue with any other optional configuration for the room as needed; otherwise, click Next to con-
tinue in the Room Configuration wizard. 
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Exclude Resources for Multiple Rooms 

1. Under Items, select Excluded Resources. The Excluded Resources tab opens.

2. Select the category that contains the resources that are to be excluded. The category’s resources are
displayed in the Available list.

3. On the Available list, CTRL-click to select multiple resources you want excluded from the rooms.

4. If any of the rooms you select for configuration have existing resources and you want to drop these
existing resources and apply only the new resources, select Overwrite Existing; otherwise, the new
resources are simply appended to the list of existing resources.

5. Click the Move button (>) to move the selected resources to the Selected list.

6. Continue with any other optional configuration for the room as needed; otherwise, click Next to con-
tinue in the Room Configuration wizard.

Configure Common Setup Types for Multiple Rooms 

1. Under Items, select Setup Types. The Setup Types tab opens.

2. If any of the rooms you select for configuration have existing setup types and you want to drop them
and apply only the new setup types, select Overwrite Existing; otherwise, the new setup types are
simply appended to the list of existing setup types.

3. For each applicable setup type, select In Use, and then use the Min. Capacity and/or Max. Capacity
fields to set headcount limits for the setup type.

4. Continue with any other optional configuration for the room as needed; otherwise, click Next to con-
tinue in the Room Configuration wizard. 

Configure Common UDFs for Multiple Rooms 

1. Click User Defined Fields. The User Defined Fields tab opens. All the UDFs that have a type of Room
are displayed on the tab.

2. If any of the rooms you select for configuration have existing UDFs with set values and you want to
drop them and apply only the new values, select Overwrite Existing; otherwise, the new values are
simply appended to the list of existing values.

3. For each UDF you configure for the room, do the following:
a. Select the UDF.

b. Click Set Value to open a Value dialog box.

c. Enter the value for the UDF in the Value field, and then click OK to close the dialog box and
return to the User Defined Fields tab.

4. Continue with any other optional configuration for the room as needed; otherwise, click Next to con-
tinue in the Room Configuration wizard. 
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CHAPTER 28: Configure Room Pricing
You can configure the pricing for a room on the Pricing tab of the Room dialog box, or you can configure
the room, and then configure the pricing for it at a later date on the Edit Pricing window.

Note: You can also configure the room price at the time that you are configuring the room
on the Room dialog box, or when you are configuring rate schedules.

1. On the EMS Desktop Client menu bar, click Configuration > Facilities > Rooms. The Rooms window
opens.

2. On the Building drop-down list, select the building, area, or view that contains the rooms that you
are pricing.

3. Click Pricing. The Edit Pricing window opens.

Accruent Confidential and Proprietary © 2019 Page | 96

CHAPTER 28: Configure Room Pricing



4. On the Rate Schedule drop-down list, select the rate schedule for which you are pricing the rooms.

5. You can leave the Room Type set to the default value of (all), and then click Display to display a list of
all active rooms for all room types that have been configured in your EMS database. On the Room
Type drop-down list, you can select a specific room type, and then click Display for a list of
all active rooms of the selected room type.

6. For each room, select the pricing method, which determines the cost for reserving the room, using
the field definitions below.

Pricing Method Fields

PRICING

METHOD

DESCRIPTION

Half
Day/Full
Day
(Event
Time)

The total number of hours for the event is counted and then compared to the
number of hours that is indicated in the Hours column. If the total number of
hours for the event is less than or equal to the hours that are indicated in the
Hours column, then the Half Day price is charged for the room. If the total
number of hours for the event is greater than the hours that are indicated in the
Hours column, then the Full Day price is charged for the room.

Half
Day/Full
Day
(Reserved
Time)

The total number of hours for the reservation (event time and reserved time) is
counted and then compared to the number of hours that is indicated in the
Hours column. If the total number of hours for the reservation is less than or
equal to the hours that are indicated in the Hours column, then the Half Day
price is charged for the room. If the total number of hours for the reservation is
greater than the hours that are indicated in the Hours column, then the Full Day
price is charged for the room.

Hourly
(Event
Time)

The price that is indicated in the Price column is multiplied by the event time (in
hours) for the booking. This price can be used in conjunction with an initial “flat”
fee, as well as minimum and maximum fees.

Hourly
(Reserved
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the booking. This price can be used in conjunction with an initial
“flat” fee, as well as minimum and maximum fees.

Hourly
(Service

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the service (resource). This price can be used in conjunction with
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PRICING

METHOD

DESCRIPTION

Time) an initial “flat” fee, as well as minimum and maximum fees.

Hourly
(Specific)

The price that is indicated in the Price column is multiplied by the number of
hours indicated when adding the room to a booking.

Unit The price that is indicated in the Price column is applied to the room, regardless
of the event time or reserved time for the booking.

7. After you select a pricing method, click in the appropriate fields to select the currently displayed
amount, and then edit the amount as needed.

FIELD DESCRIPTION

Price The dollar amount that is used in calculating the room price for a booking. If the
pricing method is Unit, then this value is applied in total to a room, regardless of
the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for a
room, then the actual price, the discount percentage, and the discounted amount
are displayed on confirmations and invoices.

Min.
Charge

Max.
Charge

The values that are indicated in these columns are used in conjunction with the
Hourly pricing methods. If you specify a minimum charge for a room, then the
system compares this value to the calculated hourly rate and applies the greater
of the two charges. Likewise, if you specify a maximum charge for a room, then
the system compares this value to the calculated hourly rate and applies the
lesser of the two charges.

Flat
Price

A resource price that remains constant regardless of the total number of hours
booked for the room. Used in conjunction with Hourly (Event Time) and Hourly
(Reserved Time).

Half Day
Price

The dollar amount that is used in calculating the room price for a booking if the
pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation
Time).
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FIELD DESCRIPTION

Full Day
Price

The dollar amount that is used in calculating the room price for a booking if the
pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation
Time).

Hours Multiplier used in calculating the room price for a booking if the pricing unit is
Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

8. Repeat Step 4 through Step 7 for each rate schedule and/or grouping as needed.

9. Click Close. The Edit Pricing window closes. The pricing information is saved for the room.
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CHAPTER 29: Configure Override Rooms
An override room is used in EMS to loosely define useable space which is not formally configured. For
example, a building can have private offices which are not configured as spaces available for public use, but
you might need to select such a space for an attendee who is participating remotely in a video conference.
In order to provide company employees the ability to schedule meetings in these private rooms, Override
Rooms can be configured in EMS.

1. Name the space in a way that indicates an Override Room (for example, "Override Area 1”).

2. Classify the room as "Override Description.”

In the example above, "Override Area 1” can be used repeatedly to serve as a placeholder for any meeting
request which will occur in an un-configured space.

For example on Monday a user makes a reservation for "Override Area 1” and names it "Meeting in Mike
Thompson’s Office”, and on Wednesday another user makes a reservation for "Override Area 1” and
names it "Meet Guests in Lobby Reception Area Prior to Building Tour.”

EMS does not track availability for events booked in Override Rooms; however, EMS reports on events that
are scheduled in an override room as it would for an event scheduled for any other room.
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CHAPTER 30: Configure and Generate Room QR Codes
In order to associate rooms with QR Codes (in EMS Desktop Client), you will: 

l Enable Room Cards for Rooms
l Run the Room Card - QR Code Report to Generate QR Codes

This automatically generates the codes and associates them with the designated rooms.

Enable Room Cards for Rooms 

1. Open the room configuration by navigating to Configuration > Facilities > Rooms.

2. Select a room for which you want to create a QR code. (For complete instructions in configuring
rooms, See Also: Configure Rooms.)

3. Enter a value in the No. Room Cards field (a number greater than one means you can generate a QR
code for this room).

Room Configuration Window

4. Click OK to save your changes.
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Run the Room Card - QR Code Report to Generate QR Codes 

1. Select Reports > Hoteling > Room Card - QR Code.

Accessing Room Card - QR Code Dialog

2. In the report setup window that appears, use the Buildings, Room Types, and Rooms tabs to specify
the parameters for the QR Code report. Use the arrow keys to move your preferences to the selected
list. You must specify preferences on all three tabs.

Buildings Tab of the Room Card - QR Code Report Setup Window
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3. You can add a logo and control the order and titles on the report on the Options tab.
l Click Sort Room Cards By Book Sequence to order the QR Room Cards the way they display in

the Reservation Book (instead of by Room Name). Book Sequence is set in Room Configuration.
l To print separate QR Room Cards for each component (titled by Room Name), click Print

Combo Room Components.

Options Tab of the Room Card - QR Code Report Setup Window

Note: We recommend that you use one method to generate multiple cards for the same
room. Either configure the Room to have more than one room card (see Step 1) or set Copies
To Print (above) to print multiple copies.

4. When you have specified all settings for your QR codes, you can either click Print Preview to see a pre-
view of the report (ideal for emailing, exporting, printing, and so on) or Print to print the file. 
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Sample Print Preview

Important! If you see the error message below, return to the initial step above. The No.
Room Cards field on the Room configuration should be greater than zero.

Error Message
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CHAPTER 31: Import Rooms
You can import rooms from a tab-delimited file into a building, area, or view that you select. After you
import rooms, you must edit the configuration (setup type, features, images, and so on) for each room. See
Also: Room Import File Specifications.

1. On the EMS menu bar, click Configuration > Facilities > Rooms. The Rooms window opens.

Rooms Window

2. On the Building drop-down list, select a specific building, a specific area, or a specific view into which
to import the rooms.

Note: If the appropriate building, area, or view is not available, you can configure it.

3. Click Import. A dialog box opens, indicating the number of rooms that you are about to import and
asking you if you want to continue.

4. Click Yes. A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Rooms window.

6. For each room that was imported, select the room on the Rooms window, and then click Edit to open
the Room in the Room dialog box.

7. Edit the room configuration as needed. See Also: Configuring Rooms.
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CHAPTER 32: Export Pricing Information for Billable Items
(Rooms or Resources)
After you configure a rate schedule and define the pricing for the billable items (rooms and resources) in
the rate schedule, you can export the pricing information on the Edit Pricing window. The information is
exported to a Microsoft Excel file.

Notes: You do not need Microsoft Excel on your EMS client to export the information to the file; however,
you must have Microsoft Excel on your EMS client to view the file. You can also export the pricing
information for rooms and resources after you have configured the information for the room or resource.
See “Exporting Pricing Information for a Room” and “Exporting Pricing Information for a Resource”.

1. On the EMS menu bar, click Configuration > Billing > Rate Schedules. The Rate Schedules window
opens. This window lists all the rate schedules that are currently configured in your EMS database.

2. Click Pricing. The Edit Pricing window opens.   
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3. Do one of the following:

l To export the pricing information for a room or rooms, on the Category drop-down list:
l Select Room Charge.

All active rooms in all buildings that are currently configured in your EMS database are displayed in the
lower pane of the dialog box.

l Optionally, on the Building drop-down list, select a specific building, area, or view to filter the search
results.

l Optionally, on the Grouping drop-down list, select a room type to filter the search results.
l To export the pricing information for all the resources in a category, on the Category drop-down list:
l Select the category, and then click Display.
l Optionally, on the Grouping drop-down list, select a resource grouping to filter the search results.

4. Click Export. A Save As dialog box opens. The export file is named Pricing.xls by default.

5. Optionally, edit the name of the export file, and then save the file to a location of your choice. An
Export Report message opens indicating that the export was successful and asks you if you want to
preview the exported file.

6. Do one of the following:

l Click Yes to open the export file in Microsoft Excel. After viewing the file, you can close it to return to
the Edit Pricing window.

l Click No to close the message and return to the Edit Pricing window.

Accruent Confidential and Proprietary © 2019 Page | 107

CHAPTER 32: Export Pricing Information for Billable Items (Rooms or Resources)



7. Repeat Step 3 through Step 6 for each room or resource for which you are exporting the pricing
information.

8. After you have exported all the necessary pricing information, click Close. The Edit Pricing window
closes. The Rate Schedule dialog box remains open.
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CHAPTER 33: Configure Floor Plans
This optional feature, enabled with an EMS Floor Plans license, allows users to view available rooms and
book a space directly from a floor plan image in EMS Web App or EMS Kiosk App.

This topic provides information on:

l Configure Floor Plan Indicators
l Configure a Floor Plan Diagram
l Map a Floor Plan

Configuring floor plans in the Floor Plan module is a three-step process:

1. Configure the floor plan indicators (the images used indicate whether a room is available or unavail-
able for a floor plan). For example, you might use something as simple as a green square to indicate
that a room on a floor is available and a red square to indicate that a room on a floor is unavailable.

2. Configure a floor plan diagram for each floor of each building for which a floor plan applies. A floor
plan diagram is a drawing, or outline, usually to scale, that shows the relationships between rooms,
spaces, and other physical features for one floor of a building.

3. Map your floor plan indicators to rooms on your diagrams using the Floor Plan Configuration util-
ity.

The availability of each reservable space ultimately determines the indicator (available or unavailable) that
shows on a floor plan in EMS Web App or EMS Kiosk App.

Configure Floor Plan Indicators

1. On the EMS menu bar, navigate to Configuration > Facilities > Floor Plan Indicators. The Floor Plan
Indicators window opens, listing active indicator sets currently configured in your EMS database.
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Floor Plan Indicators Window

Note: To see all indicator sets regardless of status, under Show, click Inactive.

2. Click New. The Floor Plan Indicator dialog box opens.

Floor Plan Indicator Dialog Box
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3. In the Description field, enter a name or description for the new floor plan indicators (max 50 char-
acters including spaces. You can name indicators something as simply as Indicator Set 1, or if you are
using different indicators for different floor plans in different buildings, you could identify them by
building, for example, Memorial Student Union indicators, Fifth Floor Conference Room indicators,
and so on.

4. Next to the Image field, click Search to browse to and select an image to use for
the available indicator.

5. Next to the Secondary Image field, click Search  to browse to and select an image to use for
the unavailable indicator.

Important! The image must be in .gif, .jpeg, .jpg, .bmp, .wmf, or .png format.

6. Click OK. Your new floor plan indicators are added as active. Optionally, select Inactive to deactivate
the set.

Configure a Floor Plan Diagram
You must configure one floor plan diagram for each floor that will be available for booking in EMS Web
App and the EMS Kiosk App.

1. On the EMS menu bar, navigate to Configuration > Facilities > Floor Plan Diagrams. A blank Floor
Plan Diagrams window opens.
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Floor Plan Diagrams Window

2. Optionally, in the Building drop-down list, select (all), or select a specific building to see a list of floor
plans for all buildings or for the selected building in the window.

3. Click New. The Floor Plan Diagram dialog box opens on Floor Plan Diagram tab.
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Floor Plan Diagram Dialog Box

4. In the Description field, enter a name or description for the new floor plan diagram (maximum of 50
characters, including spaces).

5. On the Building drop-down list, select the building for which you are configuring the floor plan dia-
gram.

6. Next to the Image field, Search  to browse and select the image to use for the floor plan diagram.

Important! Image files must be gif, .jpeg, .jpg, .bmp, .wmf, or .png. Optimal image size is
1024 x 768.

7. Open the Floor Plan Indicators tab, and on the Available list, select the floor plan indicator (CTRL-click
to select multiple floor plan indicators) you want to use for this diagram, and then Move (>) to the
Selected list.

8. Click OK. The Floor Plan Diagram dialog box closes and you return to the Floor Plan Diagrams win-
dow with the newly configured floor plan diagram automatically selected.

Map a Floor Plan

1. Log in to the Floor Plan Configuration module. The Configure Rooms option shows above the Login
fields on the main window.
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Configure Rooms Option

2. Click Configure Rooms. The Configure Rooms page opens.

Configure Rooms Page

3. On the Floor Plan drop-down list, select a floor plan diagram. The available indicators that are asso-
ciated with the floor plan diagram are displayed below the selected diagram.

4. Drag an available indicator and place it as needed to indicate where a room (reservable space) is loc-
ated on the floor.

5. Repeat the above steps until you have identified all the reservable spaces on the floor.

6. For each indicator, do the following:
l Click on the indicator to open a Room Details dialog box.
l On the Rooms drop-down list, select the room for the indicator, and then click Save

Note: To filter the list of available rooms, under Filter Options, select a specific floor and/or
room type. An indicator is not saved to a floor plan diagram until you select a room for it.

7. Close the Floor Plan Configuration module.
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CHAPTER 34: Configure Public Views
A public view, or simply a view, is a grouping of specific rooms that you configure. You use views to
organize rooms within one building or across multiple buildings in a manner that makes sense for your
organization. For example, you might create a view that includes only the training rooms across all your
locations, or you might create a view to manage heavily used conference rooms within a building. A room
can be part of multiple views. A user can select a view for changing the information that is displayed in the
Reservation Book or for searching for rooms in the Reservation Wizard. A view can also be particularly
useful for running reports.

1. On the EMS menu bar, navigate to Configuration > Facilities > Public Views. The Public Views win-
dow opens. This window lists all the views that are currently configured in your EMS database.

2. Click New. The View dialog box opens. The View tab is the active tab.

Accruent Confidential and Proprietary © 2019 Page | 115

CHAPTER 34: Configure Public Views



Note: In the Description field, enter a name or description for the new view (maximum 50
characters, including spaces). In the Notes field, you can enter any other pertinent inform-
ation about the view. If you want EMS Web App users to have read-only access to the view,
select Available to Everyday Users.

3. Open the Rooms tab. 
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4. Enter any combination of the following search criteria:
l On the Building drop-down list, select one of the following: (all) buildings, a specific building, a

specific area, or a specific view. If the appropriate building, area, or view is not listed, you can
configure it. See Configuring Buildings or Configuring Areas.

l On the Room Type drop-down list, select a specific room type. If the appropriate room type is
not listed, you can configure it. See Configuring Room Types.

5. On theAvailable list, select the room (CTRL-click to select multiple rooms) you want included in the
view, and then Move (>) to the Selected list.

Note: You can click Spelling to spell check the view description before you save the view.

6. Click OK to return to the Public Views window where your newly configured view is now listed.
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CHAPTER 35: Configuration > Resources

Overview
Resources (also called booking detail items) are the individual items or services that your users can reserve
for an event. Resources are grouped by category. For example, a furniture category might contain tables
and chairs as the resources. Within a category, you can organize resources by groupings. For example, you
might configure Beverages, Entrees, and Desserts groupings for a Food Service category. The Beverage
grouping might contain resources such as soda and coffee, the Entrees grouping might contain resources
such as fish and beef, and so on. You can configure a resource “from scratch,” or you can copy an existing
resource, and then edit the configuration as needed. You can also import resources for a category from a
tab-delimited file. If you are configuring resources for either a Catering category or Resources, w Service
Order category, the first time that you configure resources for the category, you must configure at least
one default service. A service indicates how the resource is to be used or offered. For example, Delivery and
Setup, Cleanup, Plated, Buffet, and so on are possible services for a resource in a Catering category.

You can combine a list of related resources into a package to facilitate the process of adding multiple
resources to a booking. Instead of making multiple repeated selections, a user can simply select a single
resource package. For example, an Instructor A/V package might include a laser pointer, a mobile
microphone, and a flip chart. You can set the price for a package to be the sum total of the prices of the
individual resources that make up the package, or you can set a completely different price for the package,
for example, if you want to discount the package.

You use production items to define the quantity of components that make up a single resource. For
example, a resource called Box Lunch has the following description—a box lunch contains a sandwich, a
bag of chips, two cookies, and bottled water. The productions items for the Box Lunch resource therefore
are the sandwich (quantity =1), chips (quantity =1), cookie (quantity = 2), and bottled water (quantity =1).
This means that if an order for 20 boxed lunches is placed, then the kitchen would need to produce 20
sandwiches, 20 bags of chips, 40 cookies, and 20 bottled waters. To further define the areas of the kitchen
that produce each item, you can define production areas. For example, the Delicatessen area might
produce the sandwich, chips, and bottled water, and the Bakery area might produce the cookies.

After you configure a resource for a category, you can also define selections and selection items for the
resource. A selection is used when you offer choices with a resource. For example, a resource named
Catered Breakfast might have the following description—Catered breakfast includes the choice of one
standard entree, two sides, and assorted mini-muffins, juice, and coffee. The standard entree selection
might include the selection items of french toast, pancakes, or scrambled eggs. The side selection might
include the selection items of bacon, sausage, and sliced fruit. If selection items have been defined for a
resource, then an EMS user or an EMS Web App user must make a selection for the resource.
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CHAPTER 36: Categories, Resources, and Services: What's the Dif-
ference?
In EMS, you might hear these terms used interchangeably sometimes; however, they are different
concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six
Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to “select” from these types of
services.

By contrast, a Service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example, an
"AV Equipment" service category (configured as a Resource without a Service Order Category type) might
have items under it such as a flip chart, whiteboard, (under AV Equipment). The person requesting the
service for this meeting would then select AV equipment; then flipchart and whiteboard would be typical
options to add to the event.

Note: The following Category Types allow Production Items: Catering, Resources with Ser-
vice Orders, and Resources Without Service Orders.

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a
meeting, it can be managed through a review and approval process in the Manage Services toolbar option
in EMS Desktop Client.
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CHAPTER 37: Configure Resources for a Category
Resources (also called booking detail items) are the individual items or services that your users can reserve
for an event. Resources are grouped by category. For example, a furniture category might contain tables
and chairs as the resources. Although you can use categories to track setup notes, meeting attendees, and
activities for a booking, you do not configure resources for these categories. You must configure resources
only for service categories.

This topic will provide information to:

l Configure Resources for a Category
l Assign Calculations to a Resource
l Configure Pricing for a Resource
l Associate an Image with a Resource
l Edit Production Items for a Resource
l Exclude Rooms for a Resource
l Create a Package for a Resource

Configure Resources for a Category

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens. If the appro-
priate category is not listed, you can configure it.

2. Select the category for which you are configuring the resources. The Resources window opens. This
window lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.
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Resources Window

3. Optionally, do one or both of the following:
l To view all resources for the category in your EMS database, regardless of status, under Show,

click Inactive.
l To filter the displayed resources based on the Resource name, in the Filter field, enter a search

string (not case-sensitive, but characters must be in exact order).

Note: The remainder of this procedure describes how to configure a resource “from scratch.”
You can also configure a resource by copying an existing resource. Select the resource that
you want to copy, click Copy.

4. On the Resources dialog box, click New. The Resource dialog box opens.
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Resource Dialog Box, Resource Tab

5. Enter the information for the new resource.

FIELD DESCRIPTION

Description The name or description of the resource.

Note: The description can be a maximum of 50 characters, including spaces.
Resource items are displayed alphabetically in EMS. As a result, when you are
configuring a group of similar items, you might want to start the name of each
with a common feature. For example, if you have black, white, and blue linens,
a good way to name them would be “Linens, black,” “Linens, white,” and so on.

Grouping If needed, select a grouping.

Note: If no groupings are available, or if the appropriate grouping is not
available, you can always configure a grouping, and then edit the resource at
a later date to place it in a grouping.

Account Select the internal account which is to receive the revenue from the use of the
resource.
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FIELD DESCRIPTION

Note: If the appropriate account is not available, you can configure it.

Sequence Enter a number that determines the order in which the resource is displayed in
a list with other resources in either EMS or EMS Web App. Resources are
ordered from lowest to highest sequence number, with the resource with the
lowest sequence number being displayed first.

Note: If you leave the sequence set to the default value of zero for all
resources, then by default, the resources are displayed alphabetically.

Package Select this option if the resource is to be a package.

Note: A package is a collection of related resources.

Use
Package
Item Prices

Available only if Package is selected. Select this option if the package price is
to be the sum total of the prices for the individual resources that make up the
package; otherwise, you can define a different price for the package on the
Pricing tab.

Override
Description

Select this option to allow your EMS users to edit the description when they
are adding it to a booking.

Note: A common use for this feature is to configure a resource called “Other”
for each of your resource categories which users can rename to whatever non-
inventory item is needed when they select it.

Maintain
Inventory

Select this option if you have a limited number of this item and you want EMS
to notify your users if they attempt to overbook it.

Quantity
Available

Available only if you select Maintain Inventory. Enter the number of resource
items of this type that your organization has in its inventory.

External
Reference

Links the resource to an outside program if needed.

Internal Indicates that the resource is internal to your organization.

Note: Used for internal reporting purposes only. The resource is not printed on
external documents such as confirmations and invoices, and it is not hidden in
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FIELD DESCRIPTION

any area of your EMS application.

Production
Item

Available only if the category to which you are adding the resource has been
designated as using production items. Select this option if this resource item is
to be a production item.

Serves The number of users that can be served by the resource. For example, one
lunch buffet might serve ten people.

Min.
Quantity

The minimum quantity required when selecting the resource.

Alert Enter a message that is to be displayed when a user adds the resource to a
booking in the EMS Desktop Client.

Notes Any other additional information that is pertinent to the item itself, the use of
the item, and so on. Notes displayed in EMS and EMS Web App are printed on
confirmations and the Setup Worksheet report.

EMS Web App Settings

Available
to
Everyday
Users

To have this resource be an available option for EMS Web App users who
select this category, leave Available on Web selected.

Note: Not available if Override Description is selected (see Override
Description above).

Available
at
Checkout

Select this option if you want this resource to be displayed on the “checkout”
page (the last page in the Room Request process) in EMS Web App.

Note: Not available if Available to Everyday Users is not selected.

Hide
Special
Instructions

Do not show any special instructions for the resource in EMS Web App.

Display If an alert has been configured for the resource, then display this alert when a
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FIELD DESCRIPTION

Alert to
Everyday
Users

user adds this resource to a booking in EMS Web App.

Note: You can click Spelling to spell check the information that you entered for the resource
before you save it.

6. You can continue to one or more of the subsequent procedures in this topic; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.

7. After you have configured the resource:
l If this is the first time that you have configured resources for the category, and the category is

Catering or Resources, w Service Orders, you must also configure at least one default service
type.

l You can define production items for the resource and/or define selections for the resource.

Assign Calculations to a Resource
You can assign calculations at the category level, as well. If you have already assigned calculations to a
resource’s category, then these calculations are automatically applied to new resources for the category.
These calculations are displayed in the Selected list after you click OK and save the resource.

1. If needed, open the Resource dialog box , and then open the Calculations tab.
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Resource Dialog Box, Calculations Tab

2. On the Available list, select the calculation, or CTRL-click to select the multiple calculations that are to
apply to this resource, and then click the Move button (>) to move the selected calculations to the
Selected list. If the appropriate calculation is not available, you can configure it. See Configuring Cal-
culations.

3. Continue with any other optional configuration for the resource as needed; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.

Configure Pricing for a Resource
You can also configure the resource price on the Edit Pricing window or when you are configuring rate
schedules.

1. If needed, open the Resource dialog box, and then open the Pricing tab.
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Resource Dialog Box, Pricing Tab

2. For each rate schedule, select the pricing method, which determines the cost for reserving the
resource. (See the table on the next page.) If the appropriate rate schedule is not available, you can
configure it.

PRICING

METHOD

DESCRIPTION

Half Day/Full
Day (Event
Time)

The total number of hours for the event is counted and then compared to
the number of hours that is indicated in the Hours column. If the total
number of hours for the event is less than or equal to the hours that are
indicated in the Hours column, then the Half Day price is charged for the
resource. If the total number of hours for the event is greater than the hours
that are indicated in the Hours column, then the Full Day price is charged for
the resource.
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PRICING

METHOD

DESCRIPTION

Half Day/Full
Day
(Reserved
Time)

The total number of hours for the reservation (event time and reserved time)
is counted and then compared to the number of hours that is indicated in
the Hours column. If the total number of hours for the reservation is less
than or equal to the hours that are indicated in the Hours column, then the
Half Day price is charged for the resource. If the total number of hours for
the reservation is greater than the hours that are indicated in the Hours
column, then the Full Day price is charged for the resource.

Hourly (Event
Time)

The price that is indicated in the Price column is multiplied by the event
time (in hours) for the booking. This price can be used in conjunction with
an initial “flat” fee, as well as minimum and maximum fees.

Hourly
(Reserved
Time)

The price that is indicated in the Price column is multiplied by the reserved
time (in hours) for the booking. This price can be used in conjunction with
an initial “flat” fee, as well as minimum and maximum fees.

Hourly
(Service
Time)

The price that is indicated in the Price column is multiplied by the reserved
time (in hours) for the service (resource). This price can be used in
conjunction with an initial “flat” fee, as well as minimum and maximum fees.

Hourly
(Specific)

The price that is indicated in the Price column is multiplied by the number
of hours indicated when adding the resource to a booking.

Unit The price that is indicated in the Price column is applied to the resource,
regardless of the event time or reserved time for the booking.

3. After you select a pricing method, click in the appropriate fields to select the currently displayed
amount, and edit the amount as needed.

FIELD DESCRIPTION

Price The dollar amount that is used in calculating the resource price for a booking. If
the pricing method is Unit, then this value is applied in total to a resource,
regardless of the event time or reserved time for the booking.
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FIELD DESCRIPTION

Discount You can use a discount with any pricing method. If you specify a discount for a
resource, then the actual price, the discount percentage, and the discounted
amount are displayed on confirmations and invoices.

Min.
Charge
Max.
Charge

The values that are indicated in these columns are used in conjunction with the
Hourly pricing methods. If you specify a minimum charge for a resource, then the
system compares this value to the calculated hourly rate and applies the greater
of the two charges. Likewise, if you specify a maximum charge for a resource,
then the system compares this value to the calculated hourly rate and applies the
lesser of the two charges.

Flat
Price

A resource price that remains constant regardless of the total number of hours
booked for the resource. Used in conjunction with Hourly (Event Time) and
Hourly (Reserved Time).

Half Day
Price

The dollar amount that is used in calculating the resource price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Full Day
Price

The dollar amount that is used in calculating the resource price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Hours Multiplier used in calculating the resource price for a booking if the pricing unit
is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

4. Continue with any other optional configuration for the resource as needed; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.

Associate an Image with a Resource
You can associate an image with a resource if the image is in one of the following formats—.gif, .jpeg, .jpg,
.bmp, .wmf, or .png and ideally, it should not be larger than 615 x 350 pixels. If you attach an image larger
than this, you might not be able to view the image without scrolling. Any images that you associate with
the resource are displayed only in EMS Web App. They are not displayed in the EMS Desktop Client.
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1. If needed, open the Resource dialog box, and then open the Images tab.

Resource Dialog Box, Images Tab

2. To display an image of the resource in the EMS Web App interface, click New to open the Find Image
dialog box, and then browse to and select the image. The Find Image dialog box closes. You remain
on the Images tab with an entry for the image displayed on the tab.

3. Optionally, after selecting the image, click in the Web Long Description field and enter a description
of the resource. The value that you enter here defines the “long desc” attribute for web content
accessibility.

4. Continue with any other optional configuration for the resource as needed; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.

Edit Production Items for a Resource
The Production Items tab lists all the production items that have been defined in your EMS database. The
Production Items tab is available only if you did not select Production Item on the Resource tab when you

Accruent Confidential and Proprietary © 2019 Page | 130

CHAPTER 37: Configure Resources for a Category



are configuring the resource.

1. If needed, open the Resource dialog box, and then open the Production Items tab.

Resource dialog box, Production Items tab

2. Optionally, do one or more of the following to filter the production items that are displayed:
l Select a production area. (The default value is (all)).
l To filter the displayed production items based on the Item name, in the Filter field, enter a

search string.
l Select Show Selected Only. Only those production items that have previously been selected for

the resource are displayed.
3. Select a production item and change the quantity for the item. If you do not want a production item

to be assigned to the resource, make sure that the quantity for the item is set to zero.
4. Continue with any other optional configuration for the resource as needed; otherwise, click OK to

close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.
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Exclude Rooms for a Resource
This feature enables you to prevent a resource from being allocated for a specific room.

1. If needed, open the Resource dialog box, and then open the Excluded Rooms tab.

Resource Dialog Box, Excluded Rooms Tab

2. Select the search criteria by which to search for the excluded rooms.
l Building
l Room Type: leave the default value of (all), or select a specific room type.

3. On the Available list, select the room (CTRL-click to select multiple rooms) from which the resource
item is to be excluded, and then Move (>) to the Selected list.

4. Continue with any other optional configuration for the resource as needed; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.
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Create a Package for a Resource
A package is a group of resources. You can combine a list of related resources into a package to streamline
booking. For example, an Instructor A/V package might include a laser pointer, a mobile microphone, and a
flip chart. You select the items for a resource package on the Package Items tab of the Resource dialog box.
You can set the price for a package to be the sum total of the individual resources that make up the
package, or you can set an independent price for the package.

Note: The Package Items tab is available only if you select Package on the Resource tab
when you are configuring the resource.

1. If needed, open the Resource dialog box, and then open the Packaged Items tab. The tab displays all
the resources that have been configured for the selected category.

Resource Dialog Box, Package Items Tab

2. Optionally, to filter the display, click Show Selected Only. Only those resource items that have pre-
viously been selected to be part of the resource package are displayed.
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3. For each resource item that is to be included in the package, double-click in the Quantity field, and
then enter the appropriate quantity for the resource item.

4. Continue with any other optional configuration for the resource as needed; otherwise, click OK to
close the Resource dialog box and return to the Resources window. The newly configured resource is
automatically selected in the window.
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CHAPTER 38: Resource Configuration Wizard
When you configure resources for a category, you have the option of configuring a single resource at a
time through the Resources window, or you can use the Resource Configuration Wizard to configure
multiple resources. You typically use the Resource Configuration Wizard to configure multiple resources
that have common properties such as the grouping, the account, and the EMS Web App settings. Instead
of configuring these resources individually with these same properties, you can use the Resource
Configuration Wizard to configure these resources in a single step.

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are configuring the resources. The Resources window opens. This
window lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.

3. Optionally, do one or both of the following:
l To view all resources for the category in your EMS database, regardless of status, under Show,

click Inactive.
l To filter the displayed resources based on the Resource name, in the Filter field, enter a search

string.
4. Click Wizard. The Resource Configuration Wizard opens.
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Resource Configuration Wizard

5. Configure the properties as needed for the new resources.

FIELD DESCRIPTION

Grouping Select the grouping for the resources.

Note: If the appropriate grouping is not available, you can configure it.
See “Configuring Groupings for a Resource”.

Account Select the internal account which is to receive the revenue from the use of the
resource.

Note: If the appropriate account is not available, you can configure it.
See “Configuring Accounts”.

Serves The number of users that can be served by the resource. For example, one lunch
buffet might serve ten people.

Min.
Quantity

The minimum quantity of the resource that a user must order.
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FIELD DESCRIPTION

Internal Select this option and leave Yes selected to indicate that the resource is internal
to your organization.

Note: Used for internal reporting purposes only. The resource is not printed on
external documents such as confirmations and invoices, and it is not hidden in
any area of your EMS application.

Available
to
Everyday
Users

If these resources must be available for EMS Web App users who select this
category, select this option, and then leave Yes selected. To remove these
resources as an option for EMS Web App, select No.

Note: Not available if Override Description is selected.

Available
at
Checkout

If these resources are to be displayed on the “checkout” page (the last page in
the Room Request process) in EMS Web App, then select this option, and then
leave Yes selected. Tor remove these resources from the “checkout” page, select
No.

Note: Not available if Available to Everyday Users is not selected.

Active To add the resources as active resources to the EMS database, select this option,
and then leave Yes selected. To inactivate these resources, select No.

6. Click Next. The second page of the Resource Configuration Wizard opens. All the resources that are
currently configured in your EMS database for the selected category and that have a status of Active
are displayed on the page.
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Resource Configuration Wizard, Second page

Note: Optionally, to show all resources for the category that are in your EMS database
regardless of status, under Show, click Inactive.

7. On the Available list, select the resource, or CTRL-click to select the multiple resources that you are
configuring with these properties, and then click the Move button (>) to move the selected resources
to the Selected list.

8. Click Finish. A message appears indicating that the resource properties were set successfully.

9. Click OK. The message and the Resource Configuration Wizard close.

Note: You must configure the other properties for the resources, such as the pricing, indi-
vidually. See “Configuring Resources for a Category”.
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CHAPTER 39: Import Resources for a Category
You can import resources for a category from a tab-delimited file. (See Also Resource Import File
Specifications for the import file specifications.) After you import the resources, you can edit their
configurations as necessary.

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are importing the resources. The Resources window opens. This win-
dow lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.

Example of a Resources Window

3. Optionally, do one or both of the following:
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l To view all resources for the category in your EMS database, regardless of status, under Show, click
Inactive.

l To filter the displayed resources based on the Resource name, in the Filter field, enter a search string.

Tip: The search string is not case-sensitive, but your search is limited to the exact order of the characters in
the string and it must begin with the information for which you are searching. For example, a search string
of Cold returns Cold Boxed Lunches, but not Sandwiches (Cold).

4. Click Import. The Import Resources dialog box opens.

Import Resources dialog box

5. Click the Search icon to open the Find Resource Import File dialog, and then browse to and select the
resource file that is to be imported.

6. On the Rate Schedule drop-down list, select the rate schedule that applies to the resource. (See “Rate
schedules”.)

7. Click Import. A dialog box opens, indicating the number of resources that you are about to import,
and asking you if you want to continue.

8. Click Yes. A message appears indicating that the import was successful.

9. Click OK to close the message and return to the Resources window.
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CHAPTER 40: Define Resource Selections and Selection Items
After you configure a resource for a category, you can define selections and selection items for the
resource. A selection is used when you offer choices with a resource. For example, a resource named
Catered Breakfast might have the following description—Catered breakfast includes the choice of one
standard entree, two sides, and assorted mini-muffins, juice, and coffee. The selection of standard entree
might include the selection items of french toast, pancakes, or scrambled eggs. The side selection items
might include bacon, sausage, and sliced fruit. If selection items have been defined for a resource, then an
EMS user or an EMS Web App user must make a selection for the resource.

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are configuring the resources. The Resources window opens. This
window lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.

Example of a Resources window
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3. Optionally, do one or both of the following:

l To view all resources for the category in your EMS database, regardless of status, under Show, click
Inactive.

l To filter the displayed resources based on the Resource name, in the Filter field, enter a search string.

Note:  The search string is not case-sensitive, but your search is limited to the exact order of
the characters in the string and it must begin with the information for which you are search-
ing. For example, a search string of Cold returns Cold Boxed Lunches, but not Sandwiches
(Cold).

4. Select the resource for which you are configuring the selections, and then click Selections. The Selec-
tions window opens. This window lists all the selections that have been configured for the selected
resource and that have a status of Active.

Selections Window
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Note: Optionally, to show all selections for the resource, regardless of status, under Show,
click Inactive.

5. Click New. The Selection dialog box opens. The Selection tab is the active tab.

Selection Dialog Box, Selection Tab
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6. In the Description field, enter a description or name for the selection, for example, Breakfast Entrees.

Note: The description can be a maximum of 255 characters, including spaces.

7. Optionally, do one or more or all the following:

l In the Sequence field, enter a number that determines the order in which the selection is displayed in
a list with other selections.

Note:  Selections are ordered from lowest to highest sequence number, with the selection
with the lowest sequence number being displayed first. If you leave the sequence set to the
default value of zero for all selections, then by default, the selections are displayed alpha-
betically.

l In the Min Pick field, enter the minimum number of selection items that a user is required to pick.
l In the Max Pick field, enter the maximum number of selections items that a user is allowed to pick.

Note:  The maximum pick must be less than or equal to the number of selection items that
are configured for the selection.

8. Open the Items tab, and in the Description field, enter a description or name for each selection item.

Note: The description can be a maximum of 255 characters, including spaces.
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Selection dialog box, Items tab

9. Optionally, for each selection item, do one or both of the following:

l In the Sequence field, enter a number to sort the selection items on the tab.

Note: Selection items are ordered from lowest to highest sequence number, with the selec-
tion item with the lowest sequence number being displayed first. If you leave the sequence
set to the default value of zero for all selection items, then by default, the selection items are
displayed alphabetically.

l In the Notes field, enter any optional information that is pertinent for the item.

10. Click OK. You return to the Selections window with the newly configured resource selection auto-
matically selected.
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CHAPTER 41: Configure Services for a Category
When your users are adding details to a booking, if they select a Catering or Resource, w/ Service Order
category, they must specify a service. A service indicates how the resource is to be used or offered. For
example, Delivery and Setup, Cleanup, Plated, Buffet, and so on are possible services for a resource in a
Catering category. If you are configuring resources for either Catering category or Resources, w/ Service
Order category, the first time that you configure resources for the category, you must configure at least
one default service. You can also configure additional services for a category. See Categories, Resources,
and Services: What's the Difference?

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are configuring the service type. The Resources window opens., list-
ing all the resources that are currently configured in your EMS database for the selected category
and that have a status of Active.

Resources Window
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3. Optionally, do one or both of the following:

l To view all resources for the category in your EMS database, regardless of status, under Show, click
Inactive.

l To filter the displayed resources based on the Resource name, in the Filter field, enter a search string.

4. Click Services. The Services window opens. This window lists all the services that are currently con-
figured for the resource in your EMS database and that have a status of Active. Optionally, to view
only services in your EMS database, regardless of status, under Show, click Inactive.

Services Window
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5. To begin creating a new Service, click New. The Service dialog box opens.

Service Window

6. Enter the information for the new service type.

FIELD Description

Service The description or name for the service. The service can be a maximum of 30
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FIELD Description

characters, including spaces.

Sequence Enter a number that determines the order in which the service is displayed in a
list with other services. Services are ordered from lowest to highest sequence
number, with the service with the lowest sequence number being displayed first.

Note: If you leave the sequence set to the default value of zero for all services,
then by default, the services are displayed alphabetically.

Available
to Every-
day Users

If this service is to be an available option for EMS Web App users who select
this category, leave Available to Everyday Users selected.

Inactive Leave this option blank to add the service as an active service. Select this option
to inactivate the service.

7. Click OK. The Services dialog box closes. You return to the Services window with the newly configured
service automatically selected.

8. Click OK. The Services window closes. The Resources window remains open.
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CHAPTER 42: Configure Groupings for a Resource
Within a category, you can organize resources by Groupings. For example, you might configure Beverages,
Entrees, and Desserts groupings for a Food Service category. The Beverage grouping might contain
resources such as soda and coffee, the Entrees grouping might contain resources such as fish and beef, and
so on. You can configure groupings for a category at the time that you are configuring resources for the
category, or you can carry out the configuration as a separate activity.

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are configuring the grouping. The Resources window opens. This
window lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.

Resources Window
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3. Optionally, do one or both of the following:

l To view all resources for the category in your EMS database, regardless of status, under Show, click
Inactive.

l To filter the displayed resources based on the Resource name, in the Filter field, enter a search string.

4. Click Groupings. The Groupings window opens. This window lists all the groupings that are currently
configured in your EMS database for the selected category.

Groupings Window

5. Click New. The Grouping dialog box opens.
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6. In the Grouping field, enter a name or description for the new grouping(maximum 50 characters,
including spaces).

7. In the Sequence field, enter a number that determines the order in which the groupings are displayed
in EMS Web App. Groupings are ordered from lowest to highest sequence number, with the group-
ing with the lowest sequence number being displayed first. If you leave the sequence set to the
default value of zero for all groupings, then by default, the groupings are displayed alphabetically.

8. Click OK. The Grouping dialog box closes. You return to the Grouping window with the newly con-
figured grouping automatically selected.

9. Click Close. The Grouping dialog box closes. The Resources dialog box remains open.

10. Optionally, see Configuring Resources for a Category.
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CHAPTER 43: Define Production Areas and Production Items for
a Catering Resource
You use production items to define the quantity of components that make up a resource. For example, a
resource called Box Lunch contains the following productions items—sandwich (quantity =1), chips
(quantity =1), cookie (quantity = 2), and bottled water (quantity =1). If an order for 20 boxed lunches is
placed, then the kitchen must produce 20 sandwiches, 20 bags of chips, 40 cookies, and 20 bottled waters.
To identify the areas of the kitchen that produce each item, you can define production areas. For example,
the Delicatessen area might produce the sandwich, chips, and bottled water, and the Bakery area might
produce the cookies. If a category has been defined as using production items, then at the time that you
are configuring a resource for the category, you can define the resource as a production item, or you can
manually define resources as production items for the category at a later date.

This topic will provide information on:

l Define a New Production Area
l Define a New Production Item.

1. On the EMS menu bar, click Configuration > Resources. The drop-down menu presents a list of all
the currently configured categories.
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2. Click on the category for which you are configuring the resources; typically, this is a catering type
resource. The Resources window opens, listing all active resources for the selected category.
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Note: To see all resources that have been configured for a category, regardless of status,
under Show, click Inactive.

3. Click Prod. Items. The button will not be available if the resource category has not been defined to
allow Production Items (only Catering and Resources with or without Service Orders allow Pro-
duction Items). The Production Item window opens, listing all active production items that have been
defined for a category. See Also: Configuring Categories.
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Note: You can filter the displayed production items based on the Production Area, on the
Production Area drop-down list, select an area. 

To see all production items that have been defined for the category regardless of status, under Show, click
Inactive. 

To filter the list by item name, in the Filter field, enter a keyword. This search term is not case-sensitive, but
your search is limited to the exact order of the characters in the string and it must begin with the
information for which you are searching. For example, a search string of "Cold" returns Cold Boxed
Lunches, but not Sandwiches (Cold).

Define a New Production Area

1. Click Prod. Areas. The Production Areas window lists active Production Areas that have been con-
figured for the selected category and that have a status of Active.
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Note: To see all production areas for the category that are in your EMS database regardless
of status, under Show, click Inactive.

2. Click New. The Production Area dialog box opens.

3. Enter a description or name for the production area. The description can be a maximum of 50 char-
acters, including spaces.
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4. Leave Inactive blank to add the production area as an active area. Select Inactivate to inactivate the
production area.

5. You can click Spelling to spell check the description before you save the production area.

6. Click OK. The Production Area dialog box closes. You return to the Production Areas window with the
newly configured production area automatically selected.

Define a New Production Item.

1. Navigate to the Production Items window. Click New. The Production Item dialog box opens.

2. In the Description field, enter description or name for the production item. The description can be a
maximum of 50 characters, including spaces.

3. Optionally, on the Production Area drop-down list, select a production area for the item.

4. Click OK. You return to the Production Items window with the newly configured production item
automatically selected.

5. Click Close on the Production Items window to close the window and return to the Resources win-
dow.

6. On the Resources window, select the resource for which you are configuring the production items,
and then click Edit. The Resource dialog box opens.

7. Open the Production Items tab for the resource, and for each appropriate production item, enter the
quantity.

8. Click OK to close the Resource dialog box and save the resource with its production items.
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CHAPTER 44: Configure the Pricing for a Resource on the Edit Pri-
cing Window
You can configure the pricing for a resource on the Pricing tab of the Resource dialog box, or you can
configure the resource, and then configure the pricing for it at a later date on the Edit Pricing window.

Note: You can also configure the resource price at the time that you are configuring rate
schedules (see Configuring Rate Schedules).

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are pricing the resources. The Resources window opens. This win-
dow lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.

Example of a Resources window
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3. Optionally, do one or both of the following:
l To view all resources for the category in your EMS database, regardless of status, under Show,

click Inactive.
l To filter the displayed resources based on the Resource name, in the Filter field, enter a search

string.

Note: The search string is not case-sensitive, but your search is limited to the exact order of
the characters in the string and it must begin with the information for which you are search-
ing. For example, a search string of Cold returns Cold Boxed Lunches, but not Sandwiches
(Cold).

4. Click Pricing. The Edit Pricing window opens.

5. On the Rate Schedule drop-down list, select the rate schedule for which you are pricing the
resources.

6. Do one of the following:
l Leave the Grouping set to the default value of (all), and then click Display to display a list of

all active resources in all the groupings that have been configured for the selected category.
l On the Grouping drop-down list, select a specific grouping, and then click Display to display a

list of all active resources in the grouping.
7. For each resource, select the pricing method, which determines the cost for reserving the resource.
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Note:  If the appropriate rate schedule is not available, you can configure it. See Con-
figuring Rate Schedules.

Pricing Method Fields

PRICING

METHOD

DESCRIPTION

Half
Day/Full
Day
(Event
Time)

The total number of hours for the event is counted and then compared to the
number of hours that is indicated in the Hours column. If the total number of
hours for the event is less than or equal to the hours that are indicated in the
Hours column, then the Half Day price is charged for the resource. If the total
number of hours for the event is greater than the hours that are indicated in the
Hours column, then the Full Day price is charged for the resource.

Half
Day/Full
Day
(Reserved
Time)

The total number of hours for the reservation (event time and reserved time) is
counted and then compared to the number of hours that is indicated in the
Hours column. If the total number of hours for the reservation is less than or
equal to the hours that are indicated in the Hours column, then the Half Day
price is charged for the resource. If the total number of hours for the reservation
is greater than the hours that are indicated in the Hours column, then the Full
Day price is charged for the resource.

Hourly
(Event
Time)

The price that is indicated in the Price column is multiplied by the event time (in
hours) for the booking. This price can be used in conjunction with an initial “flat”
fee, as well as minimum and maximum fees.

Hourly
(Reserved
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the booking. This price can be used in conjunction with an initial
“flat” fee, as well as minimum and maximum fees.

Hourly
(Service
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the service (resource). This price can be used in conjunction with
an initial “flat” fee, as well as minimum and maximum fees.

Hourly
(Specific)

The price that is indicated in the Price column is multiplied by the number of
hours indicated when adding the resource to a booking.
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PRICING

METHOD

DESCRIPTION

Unit The price that is indicated in the Price column is applied to the resource,
regardless of the event time or reserved time for the booking.

8. After you select a pricing method, click in the appropriate fields to select the currently displayed
amount, and then edit the amount as needed.

FIELD DESCRIPTION

Price The dollar amount that is used in calculating the resource price for a booking. If
the pricing method is Unit, then this value is applied in total to a resource,
regardless of the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for a
resource, then the actual price, the discount percentage, and the discounted
amount are displayed on confirmations and invoices.

Min.
Charge

Max.
Charge

The values that are indicated in these columns are used in conjunction with the
Hourly pricing methods. If you specify a minimum charge for a resource, then the
system compares this value to the calculated hourly rate and applies the greater
of the two charges. Likewise, if you specify a maximum charge for a resource,
then the system compares this value to the calculated hourly rate and applies the
lesser of the two charges.

Flat
Price

A resource price that remains constant regardless of the total number of hours
booked for the resource. Used in conjunction with Hourly (Event Time) and
Hourly (Reserved Time).

Half Day
Price

The dollar amount that is used in calculating the resource price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Full Day
Price

The dollar amount that is used in calculating the resource price for a booking if
the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).
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FIELD DESCRIPTION

Hours Multiplier used in calculating the resource price for a booking if the pricing unit
is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation Time).

9. Repeat Step 5 through Step 8 for each rate schedule and/or grouping as needed.

10. Click Close. The Edit Pricing window closes. The pricing information is saved for the resource.
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CHAPTER 45: Export Pricing Information for a Resource
You can export any pricing information that you configure for a resource on a per rate schedule basis on
the Edit Pricing window. The information is exported to a Microsoft Excel file.

Concept: You Can Assign Rate Schedules to Specific Rooms and Resources.

After you define your organization’s rate schedules, you have three options for manually assigning the
prices to billable items (rooms and resources) based on these schedules:

1. During the configuration of a room or resource. When you are configuring a room or resource,
the configuration dialog box contains a Pricing tab. This tab lists all the rate schedules that are cur-
rently configured in your EMS database. You can specify the pricing method for the billable item that
you are configuring for each rate schedule. You can also specify a discount percentage for the item, a
minimum charge for the item, a maximum charge for the item, or any combination of these options.
(See Configuring Resources for a Category.)

2. After all necessary rooms and resources are configured. Both the Rooms window and the
Resources window contain a Pricing button. You can click Pricing to open an Edit Pricing window. You
can use the options on this window to specify the pricing method for the billable items (rooms and
resources) for a selected rate schedule. You can also specify a discount percentage for the item, a min-
imum charge for the item, a maximum charge for the item, or any combination of these options.
(See Configuring Resources for a Category.)

3. When rate schedules are defined. The Rate Schedules window has a Pricing button. After you have
defined a rate schedule, you can select a rate schedule in the Rate Schedules window and click Pricing
to open an Edit Pricing window. You can use the options on this window to specify the pricing
method for every billable item for the rate schedule. You can also specify a discount percentage for
the item, a minimum charge for the item, a maximum charge for the item, or any combination of
these options.

1. On the EMS menu bar, click Configuration > Resources. A list of all the categories that are currently
configured in your EMS database and for which you can configure resources opens.

2. Select the category for which you are pricing the resources. The Resources window opens. This win-
dow lists all the resources that are currently configured in your EMS database for the selected cat-
egory and that have a status of Active.
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3. Optionally, do one or both of the following:

l To view all resources for the category in your EMS database, regardless of status, under Show, click
Inactive.

l To filter the displayed resources based on the Resource name, in the Filter field, enter a search string.
The search string is not case-sensitive, but your search is limited to the exact order of the characters
in the string and it must begin with the information for which you are searching. For example, a
search string of Cold returns Cold Boxed Lunches, but not Sandwiches (Cold).

4. Click Pricing. The Edit Pricing window opens.
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5. On the Rate Schedule drop-down list, select the rate schedule for which you are exporting the pricing
information.

6. Do one of the following:

l Leave the Grouping set to the default value of (all), and then click Display to display a list of
all active resources and their prices in all the groupings that have been configured for the selected cat-
egory.

l On the Grouping drop-down list, select a specific grouping, and then click Display to display a list of
all active resources and their pricing in the grouping.

7. Click Export. A Save As dialog box opens. The export file is named Pricing.xls by default.

8. Optionally, edit the name of the export file, and then save the file to a location of your choice. An
Export Report message opens indicating that the export was successful and asks you if you want to
preview the exported file.

9. Do one of the following:

l Click Yes to open the export file in Microsoft Excel. After viewing the file, you can close it to return to
the Edit Pricing window.

l Click No to close the message and return to the Edit Pricing window.

10. Repeat Step 5 through Step 9 for each rate schedule and/or grouping for which you are exporting
the information.
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11. After you have exported all the necessary pricing information for a resource, click Close. The Edit Pri-
cing window closes. The Resources window remains opens.
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CHAPTER 46: Core Configuration > Groups and Contacts
A group is an entity for which reservations are made at your facilities. A group is one of the four core data
items that you must configure in EMS so that your users can make reservations. A contact is a person who
serves as the coordinator or focal point for a group.
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CHAPTER 47: Configure Groups
A group is an entity for which reservations are made at your facilities. A group is one of the four core data
items that you must configure so that your users can make reservations. A group can be an internal or
external entity and it can be an organization or an individual. Optionally, if you want to first confirm that a
group has not already been configured, then you can search for the group.

Note:  Your organization might use a different term (such as client, customer, and so on) to
identify the entities for which reservations are made at your facilities. To change the term
from “group” to your organization-specific term throughout your EMS system (menus, win-
dow and dialog box titles, confirmation headings, and so on), you must edit the "Group Title
Plural" and "Group Title Singular" parameters. See Editing System Parameters.

Search for a Group and/or Contact 

1. On the toolbar, click the Groups icon. The Groups window opens. The Results tab is the active tab. By
default, when the Results tab first opens, it lists the first 1000 groups that are currently configured in
your EMS database and that have a status of Active.
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Note: Optionally, to change the number of records that are displayed in the Groups win-
dow, click Options, and then on the Group Options dialog box, select a different number of
records to return.

2. Open the Filter tab and set your search criteria.

OPTION DESCRIPTION

Display l Group—Display all groups that meet your search criteria on the Results tab.
l Contact—Display all contacts that meet your search criteria on the Results

tab.

Note: When a list of contacts is displayed, the contact’s group is also displayed.

Search
Fields

l Starts with—The string is not case-sensitive, but your search is limited to the
exact order of the characters in the string, and the string must begin with the
information for which you are searching. For
example, Assoc returns Association of Broadcasters but not Biomedical Stu-
dent Association.

l Contains—Your search is limited to the exact order of the characters in the
string, but the string is not case-sensitive, and the string can be found any-
where in your search results. For example, Assoc returns both Association of
Broadcasters and Biomedical Student Association.

Group Fields are available if you select Groups for Display. Enter values as needed in any
or all fields.

Contact Fields are available only if you select Contacts for Display. Leave all fields set to
their default search values to search for all active contacts that are currently
configured in your EMS database, or enter values as needed in any or all fields.

Note: If you select Contact, then both the Group fields and the Contact fields are
available for searching. If you enter data in both sets of fields when you are
searching for a contact, then your search criteria must be met for both the
contact and the contact’s group for the contact to be displayed on the Results tab.

Note: To reset the Filter at any time to its default settings, click Reset Filter.
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3. Click Get Data. The Results tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the Results tab, in the Search field, enter a search string. The list of
groups is dynamically updated as you enter your search string.

Note: Your search is limited to the exact order of the characters in the string, but the string
is not case-sensitive, and it can appear anywhere in your search results. For example, a search
string of Assoc returns both Association of Broadcasters and Biomedical Student Association.

Configuring Groups 
The following procedure describes the basic information that an EMS administrator typically configures for
a group. Groups configured this way are generally a satisfactory starting point for the reservationists at
your organization, and they always have the option of configuring additional information for a group if
needed. For example, they can configure comments or reminders for a group. Your reservationists can also
configure and/or edit a groups “on the fly” during the reservation process.

Remember that before you configure a group, you might want to search for the group to verify that it has
not already been configured.

1. On the toolbar, click the Groups icon. The Groups window. The Results tab is the active tab. By
default, when the Results tab first opens, it lists up the first 1000 groups that are currently configured
in your EMS database and that have a status of Active.
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2. Click New. The Group dialog box opens. The Group tab is the active tab.

3. Enter the summary information for the new group. The only required information is the group name.
All other information on all tabs is optional and can be added at a later date when needed.

FIELD DESCRIPTION

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address

City

ST

Country

Zip

The street or mailing address for the group.

International Select this option to drop the State and Zip fields for an international group.

Group Type If the appropriate group type is not available, you can configure it.
See Configuring Group Types.
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FIELD DESCRIPTION

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available from which
you can select a different value (Fax, Mobile, Other, or Phone) for the field
label, or you can enter a user-defined value. To enter a user-defined value,
double-click the current field label to select it, and then enter the user-
defined value over the selected label.

Email
Address

The email address for the group.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

URL The URL for the group’s website.

Note: Web users can link to this group's website on VEMS.

Default
Contact

Populated with the name of the default contact for the group after you have
defined default contacts for the group.

Require
Contacts

Select this option if the group is to always require a contact when a
reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Available to
Web Users

Select this option if users are to be able to look up the group in EMS Web
App.

Inactive Leave this option blank to add the group as an active group. Select this
option to inactivate the group.

Note: The only required information is the group name. All other information on all tabs is
optional and can be added at a later date when needed.

4. Optionally, do one or both of the following; otherwise, go to Step 5.

l Open the Billing Information tab and add the default billing information for the group.
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Note: The values that you specify here are the default values that are applied when a new
reservation is made for the group. An EMS user can change these values if needed.

OPTION DESCRIPTION

Pricing Plan If the appropriate pricing plan is not available, you can configure it.
See Configuring Pricing Plans.

Payment
Type

If the appropriate payment type is not available, you can configure it.
See Configuring Payment Types.

Salesperson The salesperson for the event.

Note: An EMS user is designated as a Salesperson at the time that the user’s
account is configured. If you do not see the appropriate user in the list, you
can edit an existing user account, or create a new user account as needed.
See Configuring User Accounts.

Event
Coordinator

The event coordinator for the group.

Note: An EMS user is designated as an Event Coordinator at the time that the
user’s account is configured. If you do not see the appropriate user in the list,
you can edit an existing user account, or create a new user account as needed.

Sales If the appropriate sales category is not available, you can configure it.
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OPTION DESCRIPTION

Category See Configuring Sales Categories.

Status The status is a way to indicate the standing or ranking of the group. The
default values are the following:

l OK—A reservation can be made for the group. (In your organization, this
status could indicate that the group is current in payments due.)

l Warning—If a group status is set to Warning, then a Warning message
opens when you make a reservation for the group. It does not, however,
prevent a reservation from being made for the group.

l Bad—If a group status is set to Bad, then reservations cannot be made
for the group.

Note: You can always change the default values for these group statuses.

Billing
Reference
Number

You can manually enter data into the field, or you can click the Search icon to
open a master list of billing reference numbers and select a reference.

Note: To define a list of eligible billing references that are specific to the
group, see Configuring Additional Information for a Group.

PO Number You can manually enter data into the field, or you can click the Search icon to
open a master list of PO Numbers and select a PO number.

Note: To define a list of eligible PO numbers that are specific to the group,
see Configuring Additional Information for a Group.

External
Reference

Links the group to an outside program, if needed.

Account If the appropriate account is not available, you can configure it.
See Configuring Accounts.

Note: This field is displayed only if the EMS system parameter “Show Account
Field on Group” is set to “Yes.”

Note: The values that you specify here are the default values that are applied when a new
reservation is made for the group. An EMS user can change these values if needed.
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l Open the Other tab and add any other identifying information for the group as needed.

OPTION DESCRIPTION

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.

5. Click OK. The Group dialog box closes and a group-specific window opens with the newly configured
group automatically selected. You can use the options on this window to carry out additional con-
figuration for the group. See Configuring Additional Information for a Group.
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CHAPTER 48: Configure Additional Information for a Group
After you have configured a new group in your EMS database with the basic group information (group
identifying information, billing information and/or other information), you have the option of configuring
additional information for the group.

This topic will provide information that will allow you to:

l Create a Web User from a Group
l Assign a Group to a Web User
l Assign Calculations to a Group
l Configure a List of Billing Reference Numbers
l Configure a List of PO Numbers

Create a Web User from a Group
A "Web User" is a registered user who can submit requests for reservations or schedule reservations in
VEMS. When you add a new group in your EMS database, you decide the “level” of the group that you are
adding. For a group that is added at the individual (personnel/employee) level, you might also need to
create a web user from the group. This user can then create and view reservations on behalf of a group or
groups in VEMS. You can create only one web user from a group. When you create a web user, you can
also specify one or more delegates for the web user. A delegate is a web user who can create and view
reservations on behalf of another web user. See Also: Configuring Users.

1. Open the Groups window and search for the group for which you are creating the web user.

2. On the Groups window, select the group, and then click Tools > Create web User. A group-specific
dialog box opens. The web user tab is the active tab.

Note: The User Defined Fields tab shows the prompts a web user must answer when
requesting an account through VEMS and it is not relevant to the procedure described
below.
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3. Enter the information for the new web user. You can make additional changes later.

FIELD DESCRIPTION

Name Automatically populated after you select the group from the Groups window.

Password The password that a web user must enter to log in to VEMS.

Email
address

If this information has been entered in the Groups window for the group, then
this field is automatically populated after you select the group from the Groups
window. If the field is blank, you must enter the full email address for the user.
(The user must enter this address to log in to VEMS.)

Phone/Fax Optional fields. If this information has been entered for the group, then these
fields are automatically populated after you select the group from the Groups
window. If the fields are blank, you can enter values if needed.

Accruent Confidential and Proprietary © 2019 Page | 179

CHAPTER 48: Configure Additional Information for a Group



FIELD DESCRIPTION

Notes Optional field.

External
Reference

Optional field. Links the web user to an outside program if needed.

Network
ID

Optional field. The web user’s network ID.

Email Opt
Out

Select this option if the web user is not to receive automatic emails (such as
reservation summary emails) from VEMS. The user will still receive manually
sent emails.

Status Required field. Select the status for the web user:

l Active—the web user can log in to VEMS.
l Inactive—The user cannot log in to VEMS and is instructed to contact the

EMS administrator.
l Pending—the web user cannot log in to VEMS and is informed that he/she

must check back at a later time.

Security
Template
Required
field

This determines the web user's access to the system—the menu items that the
user can see and the information that the user can view in a tooltip when
'rolling-over' an event in VEMS.

Time
Zone

Required field. Select the time zone for the user.

4. Open the Web User Process Templates tab and on the Available list, select one or more process tem-
plates (use CTRL-click to select multiples) to which you are assigning the user, and Move (>) them to
the Selected list.

Note: A "process template" defines the functions available to each type of web user in VEMS
when they submit a request for a reservation.

5. Open the Groups tab, where you specify the groups on whose behalf the web user can view and
make reservations in VEMS. You can use the Find and Group Type fields, and then click Display to
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search for specific groups. In the Available list, select one or more groups and move (>) them to the
Selected list. If you do not search and simply click Display, the list shows all active groups in your sys-
tem.

6. Open the Delegates tab, where you specify the delegates for the web user. You can search for specific
delegates and move (>) them to the Selected list.

Note: The Spelling option enables you to spell-check any information that you manually
entered for the web user.

7. Click OK. The dialog box for creating a web user closes and a message opens indicating that the web
user was created successfully.

8. Click OK to close the message and return to the Groups window.

Assign a Group to a Web User
When you add a new group in your EMS database, you should also assign the group to a web user. This
web user can then create and view reservations on behalf of the group in VEMS. You can assign a group to
one or more web users.

1. Open the Groups window and search for the group to which you are assigning the web user.

2. On the Groups window, select the group, and then click Tools > Assign to web Users. The Assign
Group dialog box opens.

3. Do one of the following to select the web users whom you are assigning to the group:
l Leave the Find field blank, and then click Display to open a list of all currently active web users.

Select the web user, or CTRL-click to select multiple web users, and then Move (>) to the
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Selected list.
l In the Search By drop-down list, select the option by which to search (Email Address or User

Name) and then in the Find field, enter a search string, and then click Display. Select the web
user (CTRL-click to select multiple users), and then Move (>) to the Selected list.

4. Click Finish. A message opens indicating that the group was assigned successfully.

5. Click OK to close the message and return to the Groups window.

Assign Calculations to a Group
Calculations are additional charges that can be applied to billable items (a category, a group, a group type,
a resource, or a room) such as gratuity or sales tax. When you configure a group, you can assign the
calculations that are to always apply to the group.

1. Open the Groups window and search for the group to which you are assigning the calculations. See
Search for a Group and/or Contact.

2. On the Groups window, select the group, and then click Open. A group-specific window opens. The
group is automatically selected in the window.
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3. In the left pane of the group-specific window, select Calculations. The right pane of the group-specific
window displays any calculations that have already been assigned to the group.

4. Click Edit. The Calculations dialog box opens.

5. On the Available list, select the calculation (CTRL-click to select multiple calculations) that you want to
always apply to this group, and then Move (>) to the Selected list.

Note: If the appropriate calculation is not available, you can configure it. See Configuring
Calculations.

Remember, you can also assign calculations to a group type. (See Configuring Group Types.) If you have
already assigned calculations for this group’s type, then these calculations are automatically applied to the
group. The calculations show in the Selected list after you click OK and save the group.

6. Continue with any other optional configuration for the group as needed; otherwise, click OK to close
the Calculations dialog box and return to the group-specific window.
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Configure a List of Billing Reference Numbers
You can configure a master list of billing reference numbers that are specific to the group.

1. Open the Groups window and search for the group for which you are configuring the master billing
reference numbers list.

2. On the Groups window, select the group, and then click Open. A group-specific window opens show-
ing the group as automatically selected.

3. In the left pane of the group-specific window, select Billing References. A list of all currently active
billing reference numbers for the group shows in the right pane of the group-specific window.

Note: You can display all billing reference numbers regardless of status by clicking Show
Inactive. Any inactive billing reference numbers show in italics in the right pane.

4. Click New. The Billing Reference dialog box opens.

5. Enter the information for the new billing reference number.

OPTION DESCRIPTION

Billing
Reference
Number

The billing reference number that is associated with the group. Note: The
reference can be alphanumeric and it has a maximum of 100 characters,
including spaces.

Description A description of the billing reference number.
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OPTION DESCRIPTION

Notes Any other comments or statements that are applicable for the billing
reference number.

Inactive Leave this option blank to add the reference as an active reference (the billing
reference number is to be available when a reservation is made for the group).
Select this option to inactivate the billing reference number.

TIP: You can click Spelling to spell-check the information for the PO number before you save it.

6. Continue with any other optional configuration for the group as needed; otherwise, click OK to close
the Billing Reference Number dialog box and return to the group-specific window.

Configure a List of PO Numbers
You can configure a master list of PO numbers that are specific to the group. That way, if you need to edit
the group information, instead of having to manually enter a new or different PO number, you can simply
select it from this master list.

1. Open the Groups window and search for the group for which you are configuring the master PO
numbers list.

2. On the Groups window, select the group, and then click Open. A group-specific window open. The
group is automatically selected in the window.

3. In the left pane of the group-specific window, select PO Numbers. A list of all currently active PO num-
bers for the group shows in the right pane.

Note: You can display all PO numbers regardless of status: click Show Inactive. Inactive PO
numbers show in italics.

4. Click New. The PO Number dialog box opens.
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5. Enter the information for the new PO number.

OPTION DESCRIPTION

PO
Number

The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of
100 characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO
number.

Inactive Leave this option blank to add the PO number as an active number
(the PO number is to be available when a reservation is made for
the group). Select this option to inactivate the PO number.

Note: You can click Spelling to spell-check the information for the PO number before you
save it.

6. Continue with any other optional configuration for the group as needed; otherwise, click OK to close
the dialog box and return to the group-specific window.
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CHAPTER 49: Edit Group Information
You can edit any and all information for a group. The way that you edit the information depends on the
information itself. You can edit the Summary information, the Billing information, and the Other
information through the Edit function on the group-specific dialog box. You must edit the group’s
contacts, calculations, billing reference numbers, PO numbers, and Web Users on the group-specific
window.

When you select a configuration item (contacts, reminders, and so on) for editing in the group-specific
window, the right pane for the window is an EMS browser window. See EMS Browser Window.

This topic will provide instructions on editing the following group information:

l Edit Summary, Billing, and/or Other Group Information
l Edit the Contacts for a Group
l Edit the Calculations for a Group
l Edit the Billing Reference Numbers for a Group
l Edit the PO Numbers for a Group
l Edit Web Users for a Group

Edit Group Information

1. Open the Groups window and search for the group for which you are editing the information.
See Search for a group and/or contact.

2. Select the group, and then click Open to open the group in the group-specific window. The group is
selected by default. The Summary tab is the active tab.

Group-specific Window
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Edit Summary, Billing, and/or Other Group Information

1. To edit the summary information, billing information, and/or other information for the group, click
Edit. The group-specific dialog box opens.

2. Open the appropriate tab, and then edit the information as needed. See Configure Groups.

Summary Information

FIELD DESCRIPTION

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address

City ST Zip

Country

The street or mailing address for the group.

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a
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FIELD DESCRIPTION

user-defined value, double-click the current field label to select it, and then
enter the user-defined value over the selected label.

Email
Address

The email address for the group.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

URL The URL for the group’s website.

Note: Web users can link to this group's website on VEMS.

Default
Contact

Populated with the name of the default contact for the group after you have
defined default contacts for the group.

Require
Contacts

Select this option if the group is to always require a contact when a
reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Inactive Leave this option blank to add the group as an active group. Select this
option to inactivate the group.

Billing Information

OPTION DESCRIPTION

Pricing Plan If the appropriate pricing plan is not available, you can configure it.
See Configure Pricing Plans.

Account If the appropriate account is not available, you can configure it.
See Configure Accounts.

Payment
Type

If the appropriate payment type is not available, you can configure it.
See Configure Payment Types.

Salesperson The salesperson for the event.

Note: An EMS user is designated as a Salesperson at the time that the user’s
account is configured. If you do not see the appropriate user in the list, you
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OPTION DESCRIPTION

can modify an existing user account, or create a new user account as needed.
See Configure Accounts.

Event
Coordinator

The event coordinator for the group.

Note: An EMS user is designated as an Event Coordinator at the time that the
user’s account is configured. If you do not see the appropriate user in the list,
you can modify an existing user account, or create a new user account as
needed. See Configure Accounts.

Sales
Category

If the appropriate sales category is not available, you can configure it.
See Configure Sales Categories.

Status The status is a way to indicate the standing or ranking of the group. The
default values are the following:

l OK—A reservation can be made for the group. (In your organization, this
status could indicate that the group is current in payments due.)

l Warning—If a group status is set to Warning, then a Warning message
opens when you make a reservation for the group. It does not, however,
prevent a reservation from being made for the group.

l Bad—If a group status is set to Bad, then reservations cannot be made
for the group.

Note: You can always change the default values for these group statuses.
See Edit System Parameters.

Billing
Reference
Number

You can manually enter data into the field, or you can click the Search icon to
open a master list of billing reference numbers and select a reference.

Note: To define a list of eligible billing references that are specific to the
group, see Configure Additional Information for a Group.

PO Number You can manually enter data into the field, or you can click the Search icon to
open a master list of PO Numbers and select a PO number.

Note: To define a list of eligible PO numbers that are specific to the group,
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OPTION DESCRIPTION

see Configue Additional Information for a Group.

External
Reference

Links the group to an outside program, if needed.

Other Information

OPTION DESCRIPTION

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.

3. After you edit the information, click OK. The group-specific dialog box closes. You return to the
group-specific window with the group still selected.

Edit the Contacts for a Group

1. In the left pane of the group-specific window, select Contacts.

2. In the right pane of the window, select the contact that you are editing, and then do one of the fol-
lowing:

l To set the selected contact as the default contact for the group, click Set Default, and then click
Yes at the prompt.

l To edit the information for the contact, click Edit. The Contact dialog box opens. The dialog box
displays the information for the selected contact.

3. Edit the information for the contact as needed. See Configure Contacts.

FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot change
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FIELD DESCRIPTION

this value.

Address Populated with the address of the group that you selected. If the contact
address is not the same as the group address, then clear Use Group Address
and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a user-defined value, double-
click the current field label to select it, and then enter the user-defined value
over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

External
Reference

Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a selected
group at a later date. To do so, select the contact in the right pane of the
group-specific window, click Set Default, and then click Yes at the prompt to
set the selected user as the default contact.

Inactive Leave this option blank to add the contact as an active contact. Select this
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FIELD DESCRIPTION

option to inactivate the contact.

4. Click OK. The Contact dialog box closes. You return to the group-specific window with Contacts still
selected.

Edit the Calculations for a Group

1. In the left pane of the group-specific window, select Calculations, and then click Edit. The Calculations
dialog box opens.

2. Do one or both of the following:
l On the Available list, select the calculation, or CTRL-click to select the multiple calculations that

are to always apply to this group, and then click the Move button (>) to move the selected cal-
culations to the Selected list. If the appropriate calculation is not available, you can configure it.
See Configuring Calculations.

l On the Selected list, select the calculation, or CTRL-click to select the multiple calculations that
are not to apply to this group, and then click the Remove button (<) to move the selected cal-
culations to the Available list.

Note:  Remember, you can also assign calculations for a group type. If you have already
assigned calculations for this group’s type, then these calculations are automatically applied
to the group. To edit group type calculations, you must either edit the calculations at the
group type level (see Configure Group Types), or you must edit the group type for the
group.

3. After you edit the information, click OK. The Calculations dialog box closes. You return to the group-
specific window with Calculations still selected.

Edit the Billing Reference Numbers for a Group

1. In the left pane of the group-specific window, select Billing References.

2. In the right pane of the window, select the billing reference number that you are editing, and then
click Edit. The Billing Reference dialog box opens. The dialog box displays the information for the selec-
ted billing reference number.

3. Edit the information for the billing reference number as needed.
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OPTION DESCRIPTION

Billing
Reference

The billing reference number that is associated with the group.

Note: The PO number can be alphanumeric and it has a maximum of 100
characters, including spaces.

Description A description of the billing reference number.

Notes Any other comments or statements that are applicable for the billing
reference number.

Inactive Leave this option blank to add the reference as an active reference (the billing
reference number is to be available when a reservation is made for the group).
Select this option to inactivate the billing reference number.

4. Optionally, click Spelling to spell check the information for the billing reference number before you
save it.

5. After you edit the information, click OK. The Billing Reference Number dialog box closes. You return
to the group-specific window with Billing References still selected.

Edit the PO Numbers for a Group

1. In the left pane of the group-specific window, select PO Numbers.

2. In the right pane of the window, select the PO number that you are editing, and then click Edit. The
PO Number dialog box opens. The dialog box displays the information for the selected PO number.

3. Edit the information for the PO number as needed.

OPTION DESCRIPTION

PO
Number

The PO number that is associated with the group.

Note: The reference can be alphanumeric and it has a maximum of 100
characters, including spaces.

Description A description of the PO number.

Notes Any other comments or statements that are applicable for the PO number.

Inactive Leave this option blank to add the PO number as an active number (the PO
number is to be available when a reservation is made for the group). Select
this option to inactivate the PO number.
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4. Optionally, click Spelling to spell check the information for the billing reference number before you
save it.

5. After you edit the information, click OK. The PO Number dialog box closes. You return to the group-
specific window with PO Numbers still selected.

Edit Web Users for a Group
When you edit the Web Users for a group, you can select additional Web Users for the group, or you can
remove Web Users for the group. If you need to edit the Web User itself or the delegates for a Web User,
you must do so in the Web User configuration area. (See Configure Web Users.)

1. In the left pane of the group-specific window, select Web Users. The Web Users dialog box opens.

2. Do one or both of the following:
l To add a new Web Users for the group:
l Leave the Find field blank, and then click Display to open a list of all currently active Web Users.

Select the Web User, or CTRL-click to select multiple Web Users, and then click the Move but-
ton (>) to move the selected Web Users to the Selected list.

l In the Search By drop-down list, select the option by which to search (Email Address or User
Name) and then in the Find field, enter the string by which to filter your search, and then click
Display. Select the Web User, or CTRL-click to select multiple Web Users, and then click the
Move button (>) to move the selected users to the Selected list.
Tip: The string is not case-sensitive, but your search is limited to the exact order of the
characters in the string and the string must begin with the information for which you are
searching. For example, if searching by Email Address, a search string of bob
returns bob.worth@accruent.com but not dbobbett@dea.com.

l To remove a Web User from a group, in the Selected field, select the user, or
CTRL-click to select the multiple Web Users that you are removing from the group, and then
click the Remove button (<) to move the selected Web Users to the Available list.

3. After you edit the information, click OK. The Web User dialog box closes. You return to the group-spe-
cific window with Web Users still selected.
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CHAPTER 50: Import Groups
You can import groups into your EMS database from a tab-delimited text file. (See Also: Group Import
File Specifications.)

1. On the toolbar, click the Groups icon. The Groups window opens.

2. Click More, and then click Import Groups. The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that are importing. A dialog box opens, indic-
ating the number of groups that you are about to import, and asking you if you want to continue.

4. Click Yes. A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.
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CHAPTER 51: Configure Contacts
A contact is a person who serves as the coordinator or focal point for a group. You have two options
for configuring a contact for a group. You can configure a” free form” contact, which requires you to
manually enter the contact information, or you can configure a contact from another group, which means
that you do not have to manually enter the contact information. Instead, the group information is
automatically used for the contact.

Note: You can also configure and edit a contact “on the fly” during the reservation process. See Configure
Contacts a Group for details.

Configure contacts 

1. Open the Groups window and search for the group for which you are configuring the contact.
See Search for a group and/or contact.

2. Select the group, and then click Open. A group-specific window open. The group is automatically
selected in the window.
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Group-specific window

3. In the left pane of the group-specific window, select Contacts. A list of all currently active contacts for
the group is displayed in the right pane of the group-specific window.

Note: Optionally, to display all group contacts regardless of status, click Show Inactive. Any inactive
contacts are displayed in red italics in the right pane.

4. Continue to one of the following:
l Configure a contact manually below.
l Configure a contact from a group.

configure a contact manually 

1. Click New. The Contact dialog box opens.

Accruent Confidential and Proprietary © 2019 Page | 198

CHAPTER 51: Configure Contacts



Contact dialog box

2. Enter the information for the new contact.

FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot change
this value.

Address Populated with the address of the group that you selected. If the contact
address is not the same as the group address, then clear Use Group Address
and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the contact. By default, they are set to
the phone number and fax number for the group, but you can always edit
these values.

Note: The Phone and Fax fields have a drop-down list available from which
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FIELD DESCRIPTION

you can select a different value (Fax, Mobile, Other, or Phone) for the field
label, or you can enter a user-defined value. To enter a user-defined value,
double-click the current field label to select it, and then enter the user-
defined value over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

External
Reference

Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a selected
group at a later date. To do so, select the contact in the right pane of the
group-specific window, click Set Default, and then click Yes at the prompt to
set the selected user as the default contact.

Inactive Leave this option blank to add the contact as an active contact. Select this
option to inactivate the contact.

3. Optionally, do one or both of the following:
l Click Spelling to spell check the information for the contact before you save it.
l Create a web user from the contact. See Create a web user.

4. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific win-
dow remains open.
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configure a contact from a group 

1. Click Tools > Create Contact from Another Group. A second Groups window opens.

2. Search for the group that is to be the source of the contact, and then click Select. (See Search for a
group and/or contact.) The Contact dialog box opens. The name of the group that you just selected
is displayed in the Group field and you cannot edit this value. The remainder of the fields display the
information for the selected group or user (Contact Name, Address, Phone, and so on.)

Contact dialog box

3. If needed, edit the information for the new contact.

FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected first (the group for
which you are configuring the contact). You cannot change this value.

Address Populated with the address of the contact. If the contact address is the same
as the group address, then select Use Group Address to populated the
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FIELD DESCRIPTION

address fields with the group address; otherwise, you can edit these values.

International Not applicable if Use Group Address is selected. Select this option to drop
the State and Zip fields from the address for an international contact.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available from which
you can select a different value (Fax, Mobile, Other, or Phone) for the field
label, or you can enter a user-defined value. To enter a user-defined value,
double-click the current field label to select it, and then enter the user-
defined value over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

External
Reference

Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a selected
group at a later date. See Edit the contacts for a group.

Inactive Leave this option blank to add the contact as an active contact. Select this
option to inactivate the contact.

4. Optionally, do one or both of the following:
l Click Spelling to spell check the information for the contact before you save it.
l Create a web user from the contact. See Create a web user from a contact.
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5. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific win-
dow remains open.

To create a web user from a contact 
A web user is a registered user who can submit requests for reservations or schedule reservations in VEMS.
When you add a contact to a group in your EMS database, you might also need to create a web user from
the contact. This web user can then create and view reservations on behalf of the contact in VEMS. You can
create only one web user from a contact. When you create a web user, you can also specify one or more
delegates for the web user. A delegate is a web user who can create and view reservations on behalf of
another web user.

1. If needed, open the group that contains the contact in the group’s specific window. See Configure
contacts.

2. In the left pane of the group-specific window, make sure that Contacts is selected.

3. In the right pane of the window, select the contact from which you are creating the web user.

4. Click Tools > Create Web User from Contact. A contact-specific dialog box opens. The Web User tab
is the active tab.

Note: The User Defined Fields tab displays the questions that a web user was required to answer when the
user requested to create an account through VEMS and it is not relevant to the procedure that is described
below.

Contact-specific dialog box, Web User tab
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5. Enter the information for the new web user. Ideally, you should enter all the necessary information
for your web user before you save the web user; however, at any time if you need to access your web
user, on the EMS menu bar, click Configuration > Web > Web Users.

FIELD DESCRIPTION

Name Automatically populated after you select the contact.

Password The password that a web user must enter to log in to VEMS.

Email
address

If this information has been entered for the contact, then this field is
automatically populated after you select the contact. If the field is blank, you
must enter the full email address for the user. (The user must enter this address
to log in to VEMS.)

Phone/Fax Optional fields. If this information has been entered for the contact, then these
fields are automatically populated after you select the contact. If the fields are
blank, you can enter values if needed.

Notes Optional field.

External
Reference

Optional field. Links the web user to an outside program if needed.

Network
ID

Optional field. The web user’s network ID.

Email Opt
Out

Select this option if the web user is not to receive automatic emails (such as
reservation summary emails) from VEMS. The user will still receive manually
sent emails.

Status Required field. Select the status for the web user:

l Active—The web user can log in to VEMS.
l Inactive—The user cannot log in to VEMS and is instructed to contact the

EMS administrator.
l Pending—The web user cannot log in to VEMS and is informed that

he/she must check back at a later time.

Security Required field. This determines the web user's access to the system—the menu
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FIELD DESCRIPTION

Template items that the user can see and the information that the user can view in a
tooltip when 'rolling-over' an event in VEMS.

Note: For detailed information about web security templates, see Configure
Web Templates.

Time
Zone

Required field. Select the time zone for the user.

Note: Ideally, you should enter all the necessary information for your web user before you save the web
user; however, at any time if you need to access your web user, on the EMS menu bar, click Configuration >
Web > Web Users.

6. Open the Process Templates tab and on the Available list, select the web process template or CTRL-
click to select the multiple templates to which to which you are assigning the user, and then click the
Move button (>) to move the selected templates to the Selected list.

Note: A web process template defines the functions that are available to each type of web user in VEMS
when the user is submitting a request for a reservation. For detailed information about web process
templates, see Configure Web Templates.

7. Open the Groups tab and do one of the following to specify the groups on whose behalf the web
user can view and make reservations in VEMS.

l The contact’s group is selected by default. You can leave this group in the Selected list, or you
can select the group and click the Remove button (<).

l Specify any combination of search criteria for the Find field and Group Type, and then click Dis-
play to produce a list of all groups that meet the criteria. In the Available list, select a group, or
CTRL-click to select multiple groups, and then click the Move button (>) to move the selected
groups to the Selected list.

Note: If you leave the Find field blank, then a list of all currently active groups for the selected group type is
displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is
limited to the exact order of the characters in the string and it must begin with the information for which
you are searching. For example, a search string of AAA returns AAAColorado, but not Colorado AAA.

8. Open the Delegates tab, and on the Search by drop-down list, do one of the following to specify the
delegates for the web user:

l Leave the Find field blank, and then click Display to open a list of all currently available web
users. Select a web user, or CTRL-click to select multiple web users, and then click the Move
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button (>) to move the selected web users to the Selected list.
l On the Search By drop-down list, select the option by which to search (Email Address or User

Name), and in the Find field, enter the string by which to filter your search, and then click Dis-
play. Select a web user, or CTRL-click to select multiple web users, and then click the Move but-
ton (>) to move the selected web users to the Selected list.

Note: The string is not case-sensitive, but your search is limited to the exact order of the characters in the
string and it must begin with the information for which you are searching. For example, if searching by
Email Address, a search string of bob returns bob.worth@dea.com but not dbobbett@dea.com.

9. Optionally, click Spelling to spell check any information that you manually entered for the user.

10. Click OK. The dialog box for creating a web user closes and a message opens indicating that the web
user was created successfully.

11. Click OK to close the message and return to the group-specific window.
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CHAPTER 52: Configuration > Billing

Overview
Before you can use EMS to manage your organization’s events, you must configure core data items that
are specific to your organization. For example, before you can automatically price items in a reservation,
you must first configure rate schedules and pricing plans.

Initial configuration for billing in EMS Desktop Client is extensive. If your organization uses EMS for
revenue and billing, please consult your Professional Services representative for assistance. Consider
configuring your billing information in phases:

l EMS Billing Concepts
l Configure Accounts
l Configure Currencies
l Configure Billing Reference and PO Numbers
l Configure Payment Types
l Configure Sales Categories
l Calculations 
l Pricing Plans 
l Configure Rate Schedules

In EMS, rate schedules and pricing plans allow you to define the pricing for your resources and rooms so
that the pricing is automatically applied to the resources or rooms when a reservation is made.

EMS Billing Concepts

Rate Schedules
A rate schedule is a pricing sheet that lists prices for billable items in your EMS database. For example, if
your organization is an academic organization, then at the most basic of levels, you would configure three
different rate schedules for the three primary groups that book events at your facilities—an Internal group
(students, faculty, staff, and so on), an External group (outside organizations that are not affiliated with
your organization in any way), and an Alumni group. These rate schedules could detail the prices for such
things as the room charge, A/V equipment charges, catering charges, and so on.

Rate Schedule Example
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Four factors affect how pricing is applied for a rate schedule

1. Pricing method (flat rate, hourly rate, and so on)

2. Calculations (taxes, gratuities, and so on)

3. Discount percentage

4. Minimum/maximum charge

You specify the pricing method, and if applicable, the discount percentage, and the minimum and
maximum charges when you assign the prices to billable items based on your rate schedules. You can
assign calculations directly to a category, a group, a group type, a resource, or a room or you can assign
calculations through pricing plans. (See Calculations.)

Rate Schedules and Billable Items (rooms and resources) 
After you define your organization’s rate schedules, you have three options for manually assigning the
prices to billable items (rooms and resources) based on these schedules:

1. During the configuration of a room or resource. When you are configuring a room or resource, the
configuration dialog box contains a Pricing tab. This tab lists all the rate schedules that are currently
configured in your EMS database. You can specify the pricing method for the billable item that you
are configuring for each rate schedule. You can also specify a discount percentage for the item, a min-
imum charge for the item, a maximum charge for the item, or any combination of these options. (See
Configuring Rooms and Configuring Resources for a Category.)

2. After all necessary rooms and resources are configured. Both the Rooms window and the Resources
window contain a Pricing button. You can click Pricing to open an Edit Pricing window. You can use
the options on this window to specify the pricing method for the billable items (rooms and resources)
for a selected rate schedule. You can also specify a discount percentage for the item, a minimum
charge for the item, a maximum charge for the item, or any combination of these options. (See Con-
figuring Rooms and Configuring Resources for a Category.)

3. Where rate schedules are defined. The Rate Schedules window has a Pricing button. After you have
defined a rate schedule, you can select a rate schedule in the Rate Schedules window and click Pricing

Accruent Confidential and Proprietary © 2019 Page | 208

CHAPTER 52: Configuration > Billing



to open an Edit Pricing window. You can use the options on this window to specify the pricing
method for every billable item for the rate schedule. You can also specify a discount percentage for
the item, a minimum charge for the item, a maximum charge for the item, or any combination of
these options. (See Configuring Rate Schedules.)

Calculations 
Calculations are additional charges that can be applied to billable items (a category, a group, a group type,
a resource, or a room) such as gratuity or sales tax. A calculation can be applied to a resource item every
time a group uses the item, or the calculation can be applied only when a particular pricing plan is used for
a group’s reservation. For a calculation to be applied every time a group uses a resource item, the
calculation must be defined not only for the resource item, but also, for the group that is using the item.
For a calculation to be applied to a resource item on as-needed basis, then you must use pricing plans.

Pricing Plans 
A pricing plan bundles rate schedules. When your users apply a pre-configured pricing plan to a
reservation, EMS automatically calculates the pricing for the billable items that are reserved for an event.

You can use a pricing plan to customize the pricing for a specific group type or even a specific group. When
you configure a group type or group, you can assign a default pricing plan to the group type or group.
When your users book a reservation for the group type or group, then the default pricing plan is applied to
the reservation and EMS automatically calculates the pricing for the billable items that are reserved for the
group’s reservation. For example, consider the following rate schedules:

RATE SCHEDULE CHARGES

Internal l Room Charge - $10/hour (event time). 100% discount.
l A/V (for example, overhead projector) - $20/unit. 100% discount.

External l Room Charge - $10/hour (event time). $50 minimum.
l A/V (for example, overhead projector) - $20/unit.

Alumni l Room Charge - $10/hour (event time). $50 minimum. 25% discount.
l A/V (for example, overhead projector) - $20/unit. 25% discount.

Standard l Catering (for example, coffee) - $5/unit. 5% sales tax.

Based on the rate schedules that are defined above, you would configure your pricing plans as shown in
the example.

Pricing Plans Example
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NOTE: These three pricing plans do not make a distinction between External for Profit groups and External
for Non-Profit groups; however, if you want to customize the pricing so that External for Profit groups pay
sales tax, but External Not For Profit groups do not, you could configure the pricing plans listed in the
following table.

PRICING PLAN BILLABLE ITEM RATE SCHEDULE

Internal l Room Charge
l A/V
l Catering

l Internal
l Internal
l Standard

External for Profit l Room Charge
l A/V
l Catering

l External
l External
l Standard

External Not For Profit l Room Charge
l A/V
l Catering

l Alumni
l Internal
l Standard (No Tax)

Alumni l Room Charge
l A/V
l Catering

l Alumni
l Internal
l Standard

A pricing plan is also required to apply calculations correctly to invoiced items. A calculation can be applied
to a resource item every time a group uses the item, or the calculation can be applied only when particular
pricing plan is used for a group’s reservation. For a calculation to be applied every time a group uses a
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resource item, the calculation must be defined not only for the resource item, but also for the group that is
using the item. For a calculation to be applied to a resource item on as needed basis, then you must use
pricing plans. When you are configuring a pricing plan, you have the option to:

l Have no calculations associated with the pricing plan.
l Add charges in addition to what a group already pays.
l Override a group’s set charges with different charges.

Also, the pricing for a billable item is determined at the time that the item is reserved for an event. If your
users do not select a pricing plan at the time they are making a reservation, no pricing information is
retrieved. If your users select a pricing plan after the fact, or if they change the pricing plan for a
reservation, then they can update the prices of the billable items that are reserved for the event only by
using the Update Pricing function in the Navigator.
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CHAPTER 53: Configure Rate Schedules
When you configure a rate schedule, you can configure one “from scratch,” or you can copy an existing rate
schedule and edit the name and any configured pricing as needed to make a new rate schedule. After you
configure a rate schedule, you can define the pricing for the billable items (rooms and resources) in the rate
schedule.

This topic will include information on the following:

l Configure a Rate Schedule:
l Configure Pricing for Billable Items in a Rate Schedule 

Note: You can assign rate schedules to specific rooms and resources.

After you define your organization’s rate schedules, you have three options for manually assigning the
prices to billable items (rooms and resources) based on these schedules:

l During the configuration of a room or resource. When you are configuring a room or resource, the
configuration dialog box contains a Pricing tab. This tab lists all the rate schedules that are currently
configured in your EMS database. You can specify the pricing method for the billable item that you
are configuring for each rate schedule. You can also specify a discount percentage for the item, a min-
imum charge for the item, a maximum charge for the item, or any combination of these options.

l After all necessary rooms and resources are configured. Both the Rooms window and the Resources
window contain a Pricing button. You can click Pricing to open an Edit Pricing window. You can use
the options on this window to specify the pricing method for the billable items (rooms and resources)
for a selected rate schedule. You can also specify a discount percentage for the item, a minimum
charge for the item, a maximum charge for the item, or any combination of these options.

l Where rate schedules are defined. The Rate Schedules window has a Pricing button. After you have
defined a rate schedule, you can select a rate schedule in the Rate Schedules window and click Pricing
to open an Edit Pricing window. You can use the options on this window to specify the pricing
method for every billable item for the rate schedule. You can also specify a discount percentage for
the item, a minimum charge for the item, a maximum charge for the item, or any combination of
these options.

Configure a Rate Schedule:

1. On the EMS menu bar, click Configuration > Billing > Rate Schedules. The Rate Schedules window
opens. This window lists all the rate schedules that are currently configured in your EMS database.

Accruent Confidential and Proprietary © 2019 Page | 212

CHAPTER 53: Configure Rate Schedules



2. Click New. The Rate Schedule dialog box opens.

3. In the Rate Schedule field, enter a name or description for the new rate schedule (maximum of 30
characters, including spaces).

4. Click OK. The Rate Schedule dialog box closes. You return to the Rate Schedules window with the
newly configured rate schedule automatically selected.

Configure Pricing for Billable Items in a Rate Schedule 

1. If you have not already done so, open the Rate Schedule window (click Configuration > Billing
> Rate Schedules) and then select the rate schedule for which you are configuring the pricing for bil-
lable items. 

2. Click Pricing. The Edit Pricing window opens.
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3. Do one of the following:
l To configure the pricing for a resource category, on the Category drop-down list, select the cat-

egory, and then click Display.
l Optionally, on the Grouping drop-down list, select a resource grouping to filter the search res-

ults.
l To configure the pricing for rooms, on the Category drop-down list, select Room Charge.

All rooms in all buildings that are currently configured in your EMS database are displayed in
the lower pane of the dialog box.

l On the Building drop-down list, select a specific building, area, or view to filter the search res-
ults.

l On the Grouping drop-down list, select a room type to filter the search results.
4. For each billable item (resource or room), select the pricing method, which determines the cost for

reserving the item.

PRICING

METHOD

DESCRIPTION

Half
Day/Full
Day
(Event
Time)

The total number of hours for the event is counted and then compared to the
number of hours that is indicated in the Hours column. If the total number of
hours for the event is less than or equal to the hours that are indicated in the
Hours column, then the Half Day price is charged for the billable item. If the
total number of hours for the event is greater than the hours that are indicated
in the Hours column, then the Full Day price is charged for the billable item.

Half
Day/Full

The total number of hours for the reservation (event time and reserved time) is
counted and then compared to the number of hours that is indicated in the
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PRICING

METHOD

DESCRIPTION

Day
(Reserved
Time)

Hours column. If the total number of hours for the reservation is less than or
equal to the hours that are indicated in the Hours column, then the Half Day
price is charged for the billable item. If the total number of hours for the
reservation is greater than the hours that are indicated in the Hours column,
then the Full Day price is charged for the billable item.

Hourly
(Event
Time)

The price that is indicated in the Price column is multiplied by the event time (in
hours) for the booking. This price can be used in conjunction with an initial “flat”
fee, as well as minimum and maximum fees.

Hourly
(Reserved
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the booking. This price can be used in conjunction with an initial
“flat” fee, as well as minimum and maximum fees.

Hourly
(Service
Time)

The price that is indicated in the Price column is multiplied by the reserved time
(in hours) for the service. This price can be used in conjunction with an initial
“flat” fee, as well as minimum and maximum fees.

Hourly
(Specific)

The price that is indicated in the Price column is multiplied by the number of
hours indicated when adding a billable item to a booking.

Unit The price that is indicated in the Price column is applied to the billable item,
regardless of the event time or reserved time for the booking.

5. After you select a pricing method, click in the appropriate fields to select the currently displayed
amount, and edit the amount as needed.

FIELD DESCRIPTION

Price The dollar amount that is used in calculating the room or resource price for a
booking. If the pricing method is Unit, then this value is applied in total to the
resource or room, regardless of the event time or reserved time for the booking.

Discount You can use a discount with any pricing method. If you specify a discount for a
room or resource, then the actual price, the discount percentage, and the
discounted amount are all displayed on confirmations and invoices.
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FIELD DESCRIPTION

Min.
Charge

Max.
Charge

The values that are indicated in these columns are used in conjunction with the
Hourly pricing methods. If you specify a minimum charge for a room or resource,
then the system compares this value to the calculated hourly rate and applies the
greater of the two charges. Likewise, if you specify a maximum charge for a
room or resource, then the system compares this value to the calculated hourly
rate and applies the lesser of the two charges.

Flat
Price

A resource or room price that remains constant regardless of the total number of
hours booked for a room or resource. Used in conjunction with Hourly (Event
Time) and Hourly (Reserved Time).

Half Day
Price

The dollar amount that is used in calculating room or resource price for a
booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Full Day
Price

The dollar amount that is used in calculating the room or resource price for a
booking if the pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day
(Reservation Time).

Hours Multiplier used in calculating the room or resource price for a booking if the
pricing unit is Half Day/Full Day (Event Time) or Half Day/Full Day (Reservation
Time).

6. Click Close. The Edit Pricing window closes. You return to the Rate Schedules window with the rate
schedule automatically selected.
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CHAPTER 54: Configure Pricing Plans
A pricing plan bundles different rate schedules. When you configure a pricing plan, you can not only specify
different rates schedules for the billable items in the plan, but also you can specify the calculation that is to
be applied to a billable item when the plan is used for a group’s reservation. After you configure pricing
plans, you can assign a default plan to a group’s record. Whenever a user makes a reservation for the
group, the default pricing plan is displayed automatically in the Pricing Plan field on the Billing tab of the
Reservation Wizard.

Note: To help you keep track of your pricing plans and how they are used (for instance, to
keep track of all your discounts), export your pricing plans periodically. 

1. On the EMS menu bar, click Configuration > Billing > Pricing Plans. The Pricing Plans window opens.
This window lists all the pricing plans that are currently configured in your EMS database and that
have a status of Active.

Note: Optionally, to view all pricing plans, regardless of status, under Show, click Inactive.

2. Click New. The Pricing Plan dialog box opens. The Pricing Plan tab is the active tab.
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3. In the Pricing Plan field, enter a name or description for the new plan (maximum of 30 characters,
including spaces).

4. Optionally, on the Calculation Type drop-down list, select the type of calculation that is to be applied
to a resource when the plan is used for a group’s reservation and then go to Step 5; otherwise, go
to Step 6.

l In Addition to Group—The group must pay the calculations that are set for the billable items in the
pricing plan in addition to any calculations that it must always pay.

l Override Group—Override any calculations that are defined at the Group level and pay what is
defined for the billable items in the pricing plan.

5. Open the Calculations tab, and on the Available list select the calculation, or CTRL-click to select the
multiple calculations that are to always apply to this pricing plan, and then click the Move button (>)
to move the selected calculations to the Selected list.

Note:  If the appropriate calculation is not available, you can configure it. See Configure Cal-
culations.

6. Open the Rate Schedules tab, and for each resource category (including Room Charge) that is to
have its price set by this pricing plan, double-click in the Rate Schedule field, and then select the
appropriate rate schedule from the drop-down list.

Note: If you do not select a rate schedule for a resource category, or for the Room Charge,
then the pricing for these items is set to zero in the pricing plan.

7. Click OK. The Pricing Plan dialog box closes. You return to the Pricing Plans window with the newly
configured pricing plan automatically selected.
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CHAPTER 55: Export Pricing Information for Billable Items
(Rooms or Resources)
After you configure a rate schedule and define the pricing for the billable items (rooms and resources) in
the rate schedule, you can export the pricing information on the Edit Pricing window. The information is
exported to a Microsoft Excel file.

Notes: You do not need Microsoft Excel on your EMS client to export the information to the file; however,
you must have Microsoft Excel on your EMS client to view the file. You can also export the pricing
information for rooms and resources after you have configured the information for the room or resource.
See “Exporting Pricing Information for a Room” and “Exporting Pricing Information for a Resource”.

1. On the EMS menu bar, click Configuration > Billing > Rate Schedules. The Rate Schedules window
opens. This window lists all the rate schedules that are currently configured in your EMS database.

2. Click Pricing. The Edit Pricing window opens.   
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3. Do one of the following:

l To export the pricing information for a room or rooms, on the Category drop-down list:
l Select Room Charge.

All active rooms in all buildings that are currently configured in your EMS database are displayed in the
lower pane of the dialog box.

l Optionally, on the Building drop-down list, select a specific building, area, or view to filter the search
results.

l Optionally, on the Grouping drop-down list, select a room type to filter the search results.
l To export the pricing information for all the resources in a category, on the Category drop-down list:
l Select the category, and then click Display.
l Optionally, on the Grouping drop-down list, select a resource grouping to filter the search results.

4. Click Export. A Save As dialog box opens. The export file is named Pricing.xls by default.

5. Optionally, edit the name of the export file, and then save the file to a location of your choice. An
Export Report message opens indicating that the export was successful and asks you if you want to
preview the exported file.

6. Do one of the following:

l Click Yes to open the export file in Microsoft Excel. After viewing the file, you can close it to return to
the Edit Pricing window.

l Click No to close the message and return to the Edit Pricing window.
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7. Repeat Step 3 through Step 6 for each room or resource for which you are exporting the pricing
information.

8. After you have exported all the necessary pricing information, click Close. The Edit Pricing window
closes. The Rate Schedule dialog box remains open.
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CHAPTER 56: Configure Calculations
Calculations are additional charges that can be applied to billable items (a category, a group, a group type,
a resource, or a room) such as gratuity or sales tax. Both pricing methods and calculations determine the
final cost for a billable item; however, unlike pricing, which is applied when a billable item is reserved (and
retained, even if the price for the item later changes), calculations are figured each time a confirmation or
an invoice is generated. When you configure a calculation, you must specify the rate for the calculation, the
calculation sequence (the order in which the calculation is carried out relative to other calculations), and if
applicable, the minimum charge for the calculation. You must also indicate whether the calculation should
be carried out on the base amount or on a running total, and whether the result of the calculation should
be added to the base amount and then considered in subsequent calculations. For example, consider the
following four calculations for a base amount of $1,000.00:

ITEM CALCULATED ON CALCULATION RESULT RUNNING TOTAL

l Gratuity 10%
l Calc Sequence = 1
l Calc on Base = Yes
l Calc Incl in Tot =

Yes

$1000 $100 $1100

l Sales Tax 5%
l Calc Sequence = 2
l Calc on Base = No
l Calc Incl in Tot =

Yes

$1100 $55 $1155

l State Tax 5%
l Calc Sequence = 3
l Calc on Base = Yes
l Calc Incl in Tot =

No

$1000 $50 $1155

l Federal Tax 10%
l Calc Sequence = 4
l Calc on Base = No
l Calc Incl in Tot =

$1155 $115.50 $1155

Accruent Confidential and Proprietary © 2019 Page | 222

CHAPTER 56: Configure Calculations



ITEM CALCULATED ON CALCULATION RESULT RUNNING TOTAL

No

Total Calculations: $320.50

Grand Total (Base + Calculations): $1320.50

After you configure calculations, you can assign the calculations to a category, group, group type, resource,
or room.

Configure calculations 

1. On the EMS menu bar, click Configuration > Billing > Calculations. The Calculations window opens.
This window lists all the calculations that are currently configured in your EMS database and that
have a status of Active.

Note: Optionally, to show all calculations, regardless of status, under Show, click Inactive.

2. Click New. The Calculation dialog box opens.
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3. Enter the information for the new calculation.

FIELD DESCRIPTION

Calculation The name or description for the calculation.

Note: The calculation can be a maximum of 30 characters, including spaces.

Account Optional field. The account within your internal accounting system that should
be credited with the revenue.

Note: If the appropriate account is not available, you can configure it.
See Configuring Accounts.

Currency The currency symbol that is used to display the results of the calculation.

Rate The percentage for the calculation rate, for example 5%.

Sequence The order in which multiple calculations are to be carried out.

Note: This value is critical when multiple calculations are to be carried out and
the order of the calculations affects the resulting value.

Minimum
Charge

Optional field. The minimum charge that is to applied to a billable item for
which this calculation applies.
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FIELD DESCRIPTION

Base

Include in
Total

l Both Base and Include in Total selected—The calculation is carried out
on the original base amount. The result of the calculation is added to the
current running total to make a new running total. The result is also
added to the grand total (Base + All Calculations) that is current at the
time that the calculation is carried out.

l Only Include in Total selected—The calculation is carried out on
the current running total and the result of the calculation is added to the
current running total to make a new running total. The result of the cal-
culation is also added to the grand total (Base + All Calculations) that is
current at the time that the calculation is carried out.

l Only Base selected—The calculation is carried out on the original base
amount. The result of the calculation is added to the grand total (Base +
All Calculations) that is current at the time that the calculation is carried
out.

l Neither Base nor Include in Total selected—The calculation is carried out
on the current running total. The result of the calculation is added to the
grand total (Base + All Calculations) that is current at the time that the
calculation is carried out.

Inactive Leave this option blank to add the calculation as an active calculation. Select
this option to inactivate the calculation.

4. Click OK. The Calculation dialog box closes. You return to the Calculations window with the newly con-
figured calculation automatically selected.

5. Optionally, continue to assign calculations.

assign calculations 
After you configure a calculation, you can assign the calculation to a category, group, group type, resource,
or room from the Calculations window.

Remember, you also have the option of assigning calculations to a category, group, group type, resource,
or room at the time that you are configuring the category, group, group type, resource, or room. The
advantage to assigning a calculation after you configure it is that you can assign the calculation to multiple
items in a single step.
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1. If needed, click Configuration > Billing > Calculations to open the Calculations window.

2. Click Assign. The Assign Calculations dialog box opens.

3. On the Calculation drop-down list, select the calculation that you are assigning.

4. On the Assign To drop-down list, select the item (category, group, group type, resource, or room) to
which you are assigning the calculation.

ITEM

SELECTED

COMMENTS

Category A list of all categories that are currently configured in your EMS database is
displayed. If you assign a calculation at the category level, then the calculation
is assigned to all resources that are configured for the category. To assign a
calculation to a specific resource in a category, then select Resource on the
Assign To drop-down list.

Group A list of all groups that are currently configured in your EMS database is
displayed. Two additional fields are displayed—Group Type and Starts with.
Optionally, select a Group Type and/or enter a search string in the Starts with
Field to filter the list of groups that are displayed.
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ITEM

SELECTED

COMMENTS

Group
Type

A list of all group types that are currently configured in your EMS database is
displayed.

Resource A Category drop-down list opens. Select the appropriate category for the
resource. A list of all resources that are currently configured for the selected
category in your EMS database is displayed.

Room A Building drop-down list opens. Select the appropriate building. A list of all
the rooms that are currently configured for the selected building in your EMS
database is displayed.

5. On the Available list, select the item, or CTRL-click to select the multiple items to which the cal-
culation is being assigned, and then click the Move button (>) to move the selected items to the
Selected list.

6. Click Close. The Assign Calculations dialog box closes. You return to the Calculations window.
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CHAPTER 57: Configure Accounts
EMS uses accounts to indicate where the monies that your organization receives for billable items should
be deposited, based on your internal accounting system.

Note: Accounts in EMS are used for reporting purposes only. EMS does not provide any
functions for physically moving funds.

Examples of accounts include the following:

l Facilities Account
l Catering Fees Account
l Miscellaneous Charges Accounts

Income for each resource or room is recorded into only one account. The account that is credited typically
corresponds to the operational department that receives the income credit for the sale of the resource or
room. For instance, in this model, room charges might be credited to the Facilities Account and food and
beverage resources would be credited to the Catering Account. When you configure an account, you must
specify both an account name and an account code. After you configure accounts, you can use them to
label billable items (rooms, equipment items, and so on). If you invoice out of EMS, then you can run the
General Ledger Distribution report to group your receivables by account.

Configure Accounts 

1. On the EMS menu bar, click Configuration > Billing > Accounts. The Accounts window opens. This
window lists all the accounts that are currently configured in your EMS database.

Accounts Window
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2. Click New. The Account dialog box opens.

Account Dialog Box

3. Enter the information for the new account.

FIELD DESCRIPTION

Description The name or description for the account.

Note: The description can be a maximum of 50 characters, including spaces.

Account The code for the account. Typically, this is numerical, but it can be abbreviated
text that conveys the account name or description.

Note: The code can be a maximum of 50 characters, including spaces.

4. Click OK. The Account dialog box closes. You return to the Accounts window with the newly con-
figured account automatically selected.
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CHAPTER 58: Configure Payment Types
A payment type indicates the forms of payment that your organization accepts. Payment types are also
used to track the forms of payment that your groups are using. Examples of payment types include checks,
credit card, and cash. Because payment types are for informational purposes only and do not affect the
pricing or billing of an event, configuration of payment types is not required; however, after
you configure payment types, you can assign a default payment type to a group’s record. Whenever a user
makes a reservation for the group, the default payment type is displayed automatically in the Payment
Type field on the Billing tab of the Reservation Wizard.

1. On the EMS menu bar, click Configuration > Billing > Payment Types. The Payment Types window
opens. This window lists all the payment types that are currently configured in your EMS database
and that have a status of Active.

Note: Optionally, to show all payment types, regardless of status, under Show, click Inact-
ive.

2. Click New. The Payment Type dialog box opens.

3. In the Payment Type field, enter a name or description for the new payment type.
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Note: The payment type can be a maximum of 30 characters, including spaces.

4. Leave Inactive blank to add the payment type as an active payment type. Optionally, select Inactive
to inactivate the payment type.

5. Click OK. The Payment Type dialog box closes. You return to the Payment Types window with the
newly configured payment type automatically selected.
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CHAPTER 59: Configure Sales Categories
You can configure sales categories to sort your groups for the purposes of tracking sales figures. For
example, you could sort your groups based on local, regional, and national sales figures. Because sales
categories are for informational purposes only and do not affect the pricing or billing of an event,
configuration of sales categories is not required; however, after you configure sales categories, you can
assign a default category to a group’s record. Whenever a user makes a reservation for the group, the
default sales category is displayed automatically in the Sales Category field on the Billing tab of the
Reservation Wizard.

1. On the EMS menu bar, click Configuration > Billing > Sales Categories. The Sales Categories window
opens. This window lists all the sales categories that are currently configured in your EMS database
and that have a status of Active.

Note:  Optionally, to show all sales categories regardless of status, under Show, click Inact-
ive.

2. Click New. The Sales Category dialog box opens.
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3. In the Sales Category field, enter a name or description for the new sales category.

Note: The sales category can be a maximum of 30 characters, including spaces.

4. Leave Inactive blank to add the sales category as an active category. Optionally, select Inactive to
inactivate the sales category.

5. Click OK. The Sales Category dialog box closes. You return to the Sales Categories window with the
newly configured sales category automatically selected.
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CHAPTER 60: Configure Billing Reference and PO Numbers
When you configure billing reference numbers and PO numbers, they are assigned to a “master list.” When
end-users are making a reservation or submitting a reservation request, they can look up the available
billing references or PO numbers on this master list and assign the appropriate value to the reservation or
request. Because billing references and PO numbers are for informational purposes only and do not affect
the pricing or billing of an event, configuration of these items is not required; however, after you configure
billing references and PO numbers, you can assign a default value to a group’s record. Whenever a user
makes a reservation for the group, the default value is displayed automatically in the Billing Reference field
and/or PO number field on the Billing tab of the Reservation Wizard, but a user can change the values if
needed.

Configuring Billing Reference Numbers and PO Numbers 
The following procedure is written from the perspective of billing reference numbers; however, by analogy,
you can follow this procedure to configure PO numbers.

1. On the EMS menu bar, click Configuration > Billing > Billing Reference Numbers. The Billing Refer-
ence Numbers window opens. This window lists a specific number of billing references that are cur-
rently configured in your EMS database and that have a status of Active.

Note:  You can set the specific number of records that are to be returned under Options in
the top right corner of the Billing References window.

Billing Reference Numbers window
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2. Optionally, do one or more of the following:
l Click Options, and then select a different number of records that are to be returned in the win-

dow.
l To filter the list based on the Billing Reference, enter a search string in the Find field, and then

click Display.
Note: The string is not case-sensitive, but your search is limited to the exact order of the
characters in the string and it must begin with the information for which you are searching. For
example, a search string of Alu returns AlumniNE, but not NEAlumni.

l To show both active and inactive billing references, under Show, click Inactive.
3. Click New. The Billing Reference Number dialog box opens.
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4. Enter information for the billing reference number.

FIELD DESCRIPTION

Billing Reference
Number

Required field. Alphanumeric data allowed.

Note: The number can be a maximum of 100 characters, including
spaces.

Description A name or description for the billing reference number.

Note: The description can be a maximum of 50 characters, including
spaces.

Notes Any additional information that is pertinent for the billing reference.

Note: This field is available for reporting in the Query Builder. See the
EMS User’s Manual.

5. Leave Inactive blank to add the item as an active billing reference. Select Inactive to inactivate the
billing reference.

6. Optionally, to check the spelling for the billing reference before you save it, click Spelling.

7. Click OK. The Billing Reference Number dialog box closes. You return to the Billing Reference Num-
bers window with the newly configured reference automatically selected.
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Note:  The following Administration parameters control the name of the Billing Reference
and PO fields: Billing Reference Title Singular, Billing Reference Title Plural, PO Number Title
Singular, PO Number Title Plural.
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CHAPTER 61: Configure Currencies
A currency in EMS is either an abbreviation or symbol that indicates how a room or resources in a category
should be charged. For example, the currency for the US dollar could be either USD or $. Because
currencies are for informational purposes only and do not affect the pricing or billing of an event,
configuration of these items is not required; however, after you configure currencies, you can assign a
default value to a room’s record or a service category’s record. If a reservation is made with multiple
currencies, then the billable items, the items’ prices, and the currencies used for items’ charges are broken
out by currency in sales reports, in confirmations, in EMS Web App, and so on.

Note: You can also configure multiple currencies in a single step. See Currency Con-
figuration Wizard.

1. On the EMS menu bar, click Configuration > Billing > Currencies. The Currencies window opens. This
window lists all the currencies that are currently configured in your EMS database and that have a
status of Active. To show all currencies, regardless of status, under Show, click Inactive.

2. Click New. The Currency dialog box opens.
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3. Enter the information for the new currency.

FIELD DESCRIPTION

Description The name or description for the currency.

Note: The description can be a maximum of 50 characters, including
spaces.

Symbol Required field. The abbreviation or symbol for the currency, for
example, USD or $ for US dollars.

Tip: To add special characters, copy and paste from a text file. 

Trailing Symbol Leave this option blank if the currency symbol is to be displayed in a
leading position, for example, $45.00. Select this option if the symbol
is to be displayed as the far right hand character.

Note: As you enter the information for the currency, an example currency entry is displayed in
the Sample field.

4. Leave Inactive blank to add the currency as an active currency. Select Inactive to inactivate the cur-
rency.

5. Click OK. The Currency dialog box closes. You return to the Currencies window with the newly con-
figured currency automatically selected.
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CHAPTER 62: Configuration > Booking Elements
Before you can use EMS to manage your organization’s events, you must configure core data items that
are specific to your organization. For example, before you can add resources (equipment, catering
information, and so on) to a booking, you must first configure the categories for these resources.
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CHAPTER 63: Configure Categories
In EMS, you might hear these terms used interchangeably sometimes; however, they are different
concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of six
Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to “select” from these types of
services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example, an
"AV Equipment" service category (configured as a Resource without a Service Order Category type) might
have items under it such as a flip chart, whiteboard, (under AV Equipment). The person requesting the
service for this meeting would then select AV equipment; then flipchart and whiteboard would be typical
options to add to the event.

Note: The following Category Types allow Production Items: Catering, Resources with Ser-
vice Orders, and Resources Without Service Orders.

1. On the EMS menu bar, click Configuration > Administration > Categories. The Categories window
opens, where you can define categories of services you can add to booking templates. This window
lists all the Categories and their types that are currently configured in your EMS database and that
have a status of Active. To filter all Categories regardless of status, under Show, click Inactive.

Accruent Confidential and Proprietary © 2019 Page | 241

CHAPTER 63: Configure Categories



Note: You can define a Category here with the Category Type of Attendees to enable users
to add attendees to a booking on the EMS Web App Services page. If you define this Cat-
egory and then add it to a booking template for Everyday Users, then they can control
attendees as part of editing Services.

2. ClickNew. The Category dialog box opens on the Category tab. 
3. Enter the information for the new Category.

FIELD DESCRIPTION

Category The name or description for the Category, for example, A/V Equipment or
Furniture (maximum of 30 characters, including spaces)

Print
Sequence

If items from multiple Categories have been reserved for an event, then the
Print Sequence determines the order in which this information is printed on the
Confirmation and other reports. Categories are ordered from lowest to highest
sequence number, with the Category with the lowest sequence number being
displayed first.

Note: If you leave the print sequence set to the default value of zero for all
items, then by default, the items are displayed alphabetically.
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FIELD DESCRIPTION

Category
Type

Typically, the determining factor is how the category is to be used.

l Activities—Agenda-type entries that describe what is to occur during an
event, for example: 8:30 a.m. - 9:00 a.m., Registration; 9:00 a.m. - 10:00
a.m, Keynote Speaker, and so on.

l Attendees—Individuals who are attending an event. You can use this cat-
egory for attendees such as VIPs or guest speakers, or to serve as an
attendee checklist for smaller meetings.

Note: The "Attendee" Category Type does not typically relate to attendees
invited to a meeting using the optional Integration to Microsoft Exchange
module for EMS Web App or EMS Mobile App or using EMS for Outlook.

l Notes—A free-form block of text that is used to enter clarifying or mis-
cellaneous information about the event. For example, your users can
describe room setup for an event such as “Set room temp. at 70 degrees
one hour prior to event” or “Please unlock doors at 7 a.m.”

l Resources w/o Service Orders—Resources that are assigned to a
booking from this Category Type are assigned for the entire event time.
Typically, this Category Type is used to manage Audio/Visual Equipment
and Furniture categories.

l Resources w/ Service Orders—Similar to Resources w/o Service
Orders categories with one exception—you must indicate the specific
time that the items assigned to a booking are needed. The end result is
one or multiple service orders with specific services times before, during
or after the event. Typically, this Category Type is used manage staffing
for an event.

l Catering—Used to manage categories specific to food & beverage ser-
vice. Provides capability similar to the Resources, w/ Service Order cat-
egory in addition to the catering specific fields of Estimated Count,
Guaranteed Count, and Actual Count.

Tip: If you choose Resources w/o Service Orders, Resources w/ Service
Orders, or Catering, then the Use Production Items option becomes available.
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FIELD DESCRIPTION

Default
Service

Services are defined at the resource level. After you define your resources and
services, then you can edit this category if needed and define a default service.

Default
Time in
Use

Available only if Catering, Resources w/ Service Orders, or Resources w/o
Service Orders is selected as the Category Type. Indicates the time that the
items in the selected category should be in use—for the Reserved Time or for
the Event Time.

Default
Quantity

Depending the category that was selected, one or more of the following
options are available:

l 1
l Setup Count
l Estimated Count

Currency Select the currency to be used for pricing all the resources in the category.

Note: If the appropriate currency is not available, you can configure it.

Available
to All
Buildings

Select this option if resources from this category are to be available to all
buildings.

Note: If you do not select this option, then on the Buildings tab, you must
specify the buildings for which resources from this category are to be
available.

Allow
Resources
Notes Edit

If selected, EMS Desktop Client users can edit the Notes field for the resource.

Exclude
from
Services
Indicator

In various EMS locations (the Reservation Book, the Navigator, the Edit
Booking form, and so on) EMS provides an indication that services exist for a
booking. Select this option to exclude a category from displaying as a service
on the booking.

Use
Production

Select this option to define production items for the category. Production
Items are typically used for Catering Category Types where EMS software will
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FIELD DESCRIPTION

Items be used by a production kitchen.

Note: Production items are defined at the resource level.

Use States Select this option if you want to define process phases, or states, for the
category, for example, “Assigned,” “Out for Delivery,” “Delivered,” and so on.

Note: After you define your states, then you can edit this category if needed
and specify a default state.

BEO
Column

Indicates in which column the category is to be displayed when the Banquet
Event Order report is printed in its standard two column format. Select Column
1 to display the category in the left column. Select Column 2 to display the
category in the right column.

External
Service

Select this option if the provider of the resources for this category is external
to your organization, and then select the provider on the Provider drop-down
list.

Note: Available only for a Category Type of Notes and if the EMS system
parameter “Show External Service Orders on Categories” is set to “Yes.”

Note: If the appropriate service provider is not available, contact EMS
Support for assistance in configuring the provider.

Attendees
are
Visitors

Select this option to automatically mark all attendees who are added to a
booking as a Visitor. (The Visitor option is automatically selected on the
Attendee dialog box.)

4. Open the Everyday Applications tab and enter the appropriate information. 

Important! Settings on this tab control behavior for Everyday User Applications: EMS Web
App. EMS for Outlook, and EMS Mobile App.

FIELD DESCRIPTION

Display to
Everyday

If selected, EMS Web App and EMS for Outlook users can view this category if it
has been added as a booking detail to one of their bookings.
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FIELD DESCRIPTION

Users

Expand
Groupings

If selected, the resource items for a grouping are displayed immediately when
a EMS Web App or EMS for Outlook user makes a reservation. If cleared, only
the grouping is displayed and a user must expand the grouping to view the
resource items. Typically, this option is selected if an option has a small list of
resources within the category.

Use
Specific
Cutoff
Time

Indicates how far in advance of a booking a EMS Web App or EMS for
Outlook user can add, edit, or cancel this category. For example, if you select
the Cutoff Time/Number of Days option, and you specify 11:00 a.m. and one
day, then EMS Web App or EMS for Outlook users cannot assign, edit, or cancel
categories or resources after 11:00 a.m. on the day before the event.

Cutoff
Hours

Available only if you do not select the Use Specific Cutoff Time option. With
this option, the restriction is imposed based on the number of hours before the
event occurs rather than time of day.

Default
Quantity

The default quantity (either 1, Attendance, or Blank) that is automatically filled
in by the system when a EMS Web App or EMS for Outlook user selects an item.

Available
at
Checkout

Select this option if this category is to be displayed as part of the initial Room
Request process in EMS Web App. If not selected, EMS Web App users must
first complete the Room Request process before they can request the category.

Note: For example, if an Attendee type Category is associated with a booking
template and this option is selected, then users will be able to add or remove
attendees during the booking. If it is de-selected, by contrast, they will only be
able to manage attendees on the Reservation Details > Services page once the
reservation is created and they are in edit mode. 

Prompt
for Billing
Reference

Prompt

Select this option if EMS Web App users are to be prompted to enter a billing
reference and/or PO number when they select a resource from the category. 

Note: Selecting these options does not require the user to enter these values,
only that they will be prompted to enter values. The behavior of these fields
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FIELD DESCRIPTION

for PO
Number

(required, validated, or displayed) is controlled in the Billing Reference
Validation and PO Number Validation EMS Web App parameter settings in
EMS Desktop Client. Users will see the Billing Reference field during the
booking process when this parameter is set at either the reservation, room, or
category level. Whether the Billing Reference field displays is based on four
settings: global, template, room-level setting, category-level setting. The
booking template setting overrides the global setting. The room and category
level settings can both override the template setting. After the Admin decides
whether to display the field, user entries will be validated based on the value in
the "Billing Reference Validation" parameter set on the template.

Billing Reference field options:

l Show (Prompt)
l Require
l Validate (Show and Require)
l Don't Show

Additionally, the Billing Reference Validation parameter will always determine
whether it is optional, required, or required and validated. 

Allow
Add On
Weekend

Select this option to allow a EMS Web App user to add a service order to a
Saturday or Sunday booking.

Sequence Determines the order in which the category is displayed in a list of categories in
EMS Web App or EMS for Outlook. Categories are ordered from lowest to
highest sequence number, with the category with the lowest sequence number
being displayed first.

Note: If you leave the sequence set to the default value of zero for all
categories, then by default, the categories are displayed alphabetically.

Minimum
Amount

The minimum purchase amount that is required for a user to submit a new
service order in EMS Web App or EMS for Outlook for this category.
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FIELD DESCRIPTION

Inactive Leave this option blank to add the category as an active category. Select this
option to inactivate the category.

5. If you did not select Available to All Buildings then go to Step 6; otherwise, open the Buildings tab,
and on the Available list, select the building, or CTRL-click to select the multiple buildings for which
the category is to be available, and then click the Move button (>) to move the selected buildings to
the Selected list.

6. Optionally, do one or more of the following:
l Open the Calculations tab and on the Available list, select the calculation (CTRL-click to select

multiple calculations) you always want to apply to this category, and then Move (>) the them
to the Selected list. These calculations apply to all new resources that are added to the cat-
egory. If the appropriate calculations are not available, you can configure them. You can also
define calculations at the resource item level. See Configuring Resources for a Category.

l Open the Provider tab and enter the contact information for the provider of the items or ser-
vices in the category. Select International to drop the State and Zip fields for an international
provider. None of the provider information is displayed or printed anywhere outside of EMS
Desktop Client.

l Open the Terms and Conditions tab and format a Terms and Conditions message that must be
acknowledged by EMS Web App or EMS for Outlook users when they select the
category. Design is selected by default. Use the standard Windows plain text formatting
options to format the message (spacing, number of lines, capitalization, and so on) so that it is
displayed the way that you want; otherwise, you can select HTML and enter the necessary
HTML code to format the message.

7. If you did not select Use States, go to Step 8; otherwise, open the States tab, and then do the fol-
lowing:

l In the Description field, enter a name or description for each state or phase that is to be used
for managing this category (maximum of 50 characters, including spaces

l Optionally, to define a color for each state, select the state, and then click Set Color to open the
Select Color dialog box and select a color for the state.

l After you have defined the states for a category, you can select a default state on the Category
tab.

8. Click OK. The Category dialog box closes. You return to the Categories window with the newly added
category automatically selected. You can now define the resource items for the categories.
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CHAPTER 64: Configure Departments

Note: You only need to define departments responsible for hosting or servicing events in
EMS.

This element is only used to link an event with a Department that either hosts or services a meeting (so
they can send notifications & confirmations, track billing, and initiate invoices), so you do not need to
define departments in EMS other than these. Typically, these are departments that absorb the cost of
hosting events, and departments like A/V or Catering that provide services. All financial transactions in
EMS are batched by department. Groups and customers make payments to one or more departments for
the events they schedule at your organization’s facilities

As the EMS administrator, you configure departments for your organization so they can notify attendees
and send invoices linked to billing and PO numbers.

1. On the EMS menu bar, click Configuration > Administration > Departments. The Departments win-
dow opens. The window displays all departments that are currently configured in your EMS database
and that have a status of Active. To view all departments in your EMS database, regardless of status,
under Show, click Inactive.

2. Click New. The Department dialog box opens. The Department tab is the active tab.
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3. Enter the information for the new department.

FIELD DESCRIPTION

Department The name of the department.

Note: The department can be a maximum of 50 characters, including spaces.

Address, City
ST Zip

The address for the department.

Country The country for the department.

Phone

Fax

The phone and fax number for the department.

International Select this option to drop the State and Zip fields for an international
department.

Note: The name, address, phone, and fax that you define here are printed at the top of
confirmations and invoices.

Email
Address

The email address for the department.

Notes Any descriptive or clarifying information that is pertinent for the department.

Invoice Not required for the first department that you configure. Required if multiple
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FIELD DESCRIPTION

Prefix

Invoice
Suffix

departments have been configured. This information clarifies which
department generated an invoice.

Next Invoice
No.

Required field. The value must be a number between 1 and 999999. The
invoice number entered here is the number of the first invoice that is
generated by a user in the department. This number is automatically
incremented by one each time a user in the department generates an
invoice.

Transaction
Lock Days

The number of days after a transaction is generated that it can still be
modified. For example, if the field is set to 30, an invoice generated by this
department can be voided only within 30 days of its creation.

Inactive Leave this option blank to add the department as an active department.
Select this option to inactivate the department.

4. Optionally, do one or more of the following:

l Open the Logo tab and do the following:
l In the Description field, enter a name or description for the logo that is to be printed on the con-

firmations and invoices generated by the department (maximum of 50 characters, including spaces
l Click Browse to browse to open the Find Logo dialog box, and then browse to and select the logo.
l The logo must be one of the following file types—.gif, .jpg, .jpeg, .bmp, .wmf, and .png. By default, the

logo is printed at the top left of confirmations and invoices. You can select Align Right to align the
logo at the top right instead of the top left.

l Open the Confirmation Header Fields tab, and on the Available list, select the field, or CTRL-click to
select the multiple fields that are to be included in the header of every confirmation that is generated
by the department.

l Open the Invoice Header Fields tab, and on the Available list, select the field, or CTRL-click to select
the multiple fields that are to be included in the header of every invoice that is generated by the
department.

l Click Spelling to spell check the information that you entered before you save it.

5. Click OK. The Department dialog box closes. You return to the Departments window with the newly
configured department automatically selected.
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CHAPTER 65: Configure Statuses
A status automates the booking workflow, especially for booking requests that must be approved and
then completed. A status is one of four core data items that you must configure so that your users can
make reservations.

Note: You can associate a status to reservations and to bookings, but only booking-level
statuses affects room availability. Every booking must have a status.

You can configure your own statuses to automate the booking request workflow, such as Confirmed,
Tentative, Wait List, and Canceled. You can configure as many statuses as you need and give them any
names you want; however, you must always assign one of the four following status types to a status:

l Book Space
l Wait
l Info Only
l Cancel

Important!  Status type determines if a room remains available to other users.

The name that you assign to a status is a convenient label that assists you in managing your organization’s
business. The status type is what is actually used by EMS to determine if a room must be taken out of
inventory.

Configure statuses 

1. On the EMS menu bar, click Configuration > Administration > Statuses. The Statuses window opens.
This window lists all the statuses that are currently configured in your EMS database and that have a
status of Active.
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Note: Optionally, to view all statuses in your EMS database, regardless of status, under
Show, click Inactive.

2. Click New. The Status dialog box opens.

3. Enter the information for the new status.

FIELD DESCRIPTION

Status The name of the status.

Note: The status can be a maximum of 30 characters, including spaces.

Status Type Required. You must select one of the following four values:

l Book Space—The room is taken out of inventory and cannot be
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FIELD DESCRIPTION

reserved by another booking. (The system prevents the space from
being double-booked.)

l Cancel—Booking information is retained, but the room is released back
into inventory.

l Info Only—Booking information is retained, but the space is not taken
out of inventory.

l Wait—Booking information is retained in case the space becomes avail-
able prior to the event date. Wait bookings show up on the Wait List
Report and in the Dashboard.

Note: If you are configuring a conflict status, then it must Status Type Info
Only or Wait.

Reserved
Color

The color that is used by this status in the Reservation Book to
indicate reserved time. When the reserved time extends before or after event
time, thin bars of this color extend out from the beginning and/or end of the
event. To use the system default colors, click Default.

Event Color The color for events of this status in the Navigator and Reservation Book. To
use the system default colors, click Default.

Note: Lighter colors are the better colors to use for events because they make
it easier to read the event name in the Reservation Book, which is in black
text.

Reconfirm
Date

Select this option if you want the system to require a reconfirm date when a
reservation is made in EMS. When a user gives a booking a status that
requires a reconfirm date, the system displays an additional field, prompting
the user to enter the date. You can identify bookings with a reconfirm date in
the Dashboard.

Commits
Inventory

Select this option if the status should remove resources from inventory.

Note: Typically, you would select this option for a status with a Book Space
type whereas you would not select this option for a status with a Cancel type.
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FIELD DESCRIPTION

Inactive Leave this option blank to add the status as an active status. Select this
option to inactivate the status.

Virtual EMS Settings

Display on
Web

Select this option to display the event details for bookings with this status in
VEMS.

Allow
Booking
Edit

Select this option to allow the editing of bookings with this status in VEMS.

Allow
Service Edit

Select this option to allow the editing of services for bookings with this status
in VEMS.

Allow
Booking
Cancellation

Select this option to allow the canceling of bookings with this status in VEMS.

4. Click OK. The Status dialog box closes. You return to the Statuses window with the newly configured
status automatically selected.
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CHAPTER 66: Configure Notification Rules
Notification Rules determine which EMS users are emailed about additions or changes are made in EMS.
You can set these rules to trigger for new or changed bookings or service orders, changes to VIP events,
new web user accounts, or when specific UDF options are selected. Triggers are based on rooms, statuses,
event types, group types, setup types, and/or categories.

For a Notification to be generated, all the criteria in the rule must be met. Typically, notifications are an
internal function for reservation schedulers and service providers, but when you are configuring a
Notification Rule, you can specify the email address for whomever you want to receive an Email
Notification.

This topic contains information on the following:

l Configure a Notification Rule
l Booking Notification Rules
l Service Order Notification Rules
l Notification Rules for Anything On A VIP Event
l New Web Users Notification Rules
l User Defined Field Notification Rules
l Select Users to Notify 
l Selecting Rooms Requiring Notifications 
l Select Booking Statuses Requiring Notifications 
l Select Event Types Requiring Notifications 
l Copy a Notification Rule 

Note: The EMS Email Notification Service must be installed and configured for Email Noti-
fications to be sent. See the Email Notification Service Install Instructions for details.

The timing of notification emails also depends on settings in three EMS system parameters:

l Exclude Building Closures on Notifications
l Exclude Weekends on Notifications
l Ignore Building Closure/Weekend Notification Settings Beyond xx Days
l  See System Parameters.

EMS enables you to set detailed rules that trigger when notifications are sent to people and groups. This
highly customizable feature guides you through a series of screens where you fine-tune your notification
rules so that notices are more meaningful and timely, and so that notices automatically go to the right
people at the right time. You can set your rules to trigger notifications for specific people, rooms, event
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statuses, and event types. Take extra time with this step and revisit your rules regularly to make sure they
are continuing to serve your needs.

Configure a Notification Rule

1. On the EMS menu bar, click Configuration > Administration > Notification Rules. The Rules window
opens, listing all active Notification Rules configured in your implementation. To view any de-activ-
ated Rules, select Inactive in the Show section.

2. Click New. The Notification Rule Wizard opens.
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3. In the Description field, enter a name or description for the new Notification.

4. Leave the Inactive box unchecked to add the Notification Rule as an active Rule. 

5. Select the Notification Type; these are defined below and your selection in this field changes addi-
tional fields that become available.

Booking Notification Rules
Any of the following notification types are considered booking notifications, and are available when
creating new Notification Rules in the wizard:

l New Bookings
l Changes to Date/Time
l Room Changes 
l Status Changes 
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1. The Setup Type field in the Notification Rule Wizard enables you to ensure that changes to a
booking's room setup will appropriately notify attendees. (See this section for configuring Setup
Types). You can select one of the existing setup types, or one of the options below.

l (all) - The rule will trigger on all Setup Types.
l (any other than Room default) - Notifications will trigger for all Setup Types except for the

Room's default Setup Type. (To change the default Setup Type you can go to Configuration >
Facilities > Rooms, then select a Room and press "Edit"; then make your changes in the "Default
Setup Type" field.) 

2. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down list.

3. The Display New Booking As field enables you to specify whether the Notification occurs as Booking
Information or Reservation Information. For example, for new reservations that contain multiple
bookings (recurring meetings), if Booking Information is selected, then a Notification occurs for every
individual booking. If Reservation Information is selected, then a single Notification occurs for the
entire reservation.

4. For Source, indicate whether additions and/or changes in the EMS Desktop Client, VEMS, or both will
trigger a Notification.

Note: The Booking options described here only apply to EMS Enterprise. In EMS Pro-
fessional, only one global Booking Notification can be configured at any time in your EMS
database and it is only available if a Booking Notification is not currently configured in your
EMS database.

Service Order Notification Rules
Any of the following notification types are considered service order notifications:
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l New Service Orders
l Changes to Service Orders
l Deleted/Canceled Service Orders

1. On the Category drop-down list, select the category for which the service order Notification is to be
generated. If the appropriate category is not available, you can configure it. See Configuring Cat-
egories. 
After selecting a category, the State, Grouping, and Resource options appear. You can select (all),
(multiple), (none), or an individual item on the list. To notify on a whole category, keep the selections
set to (all).

l State - Select the corresponding state that you the Notification to trigger on.  "New Service
Orders" will have to start in that state.  "Changes To Service Orders" will have to change into
that state.  More than one state can be selected.

l Grouping - Select the grouping that a resource is in. These are set at the resource level in EMS. 
l Resource - Select an individual resource from the list.

Note: When you choose a Group or Category, all three items (New Service Orders, Changes
To Service Orders, and Deletion/Cancelation Of Service Orders) will become auto-
selected. The notification will now only fire on all three. To set the rule to trigger notifications
on only one or two of these three, you must select (all) on both Group and Category.

2. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down.

3. For Source, indicate whether additions and/or changes in the EMS Desktop Client, VEMS, or both will
trigger a Notification.

Notification Rules for Anything On A VIP Event
VIP Event is an option available when creating a reservation in the Reservation Wizard. Select this option to
notify users when any changes are made to a VIP Event. 

NewWeb Users Notification Rules
Select this option to notify users when a new web user account is created. For Source, indicate whether
additions and/or changes from the EMS Desktop Client, VEMS, or both should trigger a Notification.

User Defined Field Notification Rules

1. In Type field, select the User Defined Field type for which the Notification is to be generated. If the
appropriate UDF is not available, you can configure it. See Configuring User Defined Fields (UDFs).
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2. Select the UDF for which the Notification is to be generated. (Available UDFs have a field type of List.
UDFs with other field types are not displayed on the User Defined Field drop-down list.)

3. Select the UDF value for which the Notification is to be generated.

4. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down list.

5. For Source, indicate whether additions and/or changes in the EMS Desktop Client, VEMS, or both will
trigger a Notification.

Note: The Service Order options described here only apply to EMS Enterprise. In EMS Pro-
fessional, only one service order Notification per category can be configured at any time in
your EMS database.

Select Users to Notify 

1. Click Next. The Users window opens.

2. Select users and email addresses to which to send notifications:

3. On the Available list, select the EMS user, or CTRL-click to select the multiple users who are to receive
the email Notification, and then click the move button (>) to move the selected users to the Selected
list. If the appropriate user is not available, you can configure it.
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4. In the Email Address field, for each user and/or group that is to receive the email Notification, enter
the appropriate email address, and then click Add.
OR
Leave the Email Address field blank, and then click Add to open the Select Names dialog box in which
you can search for and add the necessary email addresses from your Groups/Contacts lists, your
Global Address List, or your Outlook address book.

5. The following additional options are available on this screen:
l Group Users Tied To Rule - This Rule controls how users are notified as a group. If a user is des-

ignated on the Rule as recipient and this option is selected, then no notifications will fire. If,
however, this option is not selected and that user triggers it, the notifications will go to all
the other users and email recipients designated as recipients on the Rule.

l Send to Event Coordinator - Send notifications to the Reservation Event Coordinator's email
address or dashboard when checked.

l Send To Web User - Send notifications to the web user's email address when checked.
l Send to Reservation Group/Contacts - Send notifications to the first contact's email address, or

the group's email address.

Selecting Rooms Requiring Notifications 

1. If you have not selected New Web Users, click Next. The Rooms window opens.

2. Search for the rooms to which the Notification applies:
l For Building, select one of the following—(all) buildings, a specific building, a specific area, or a

specific view.
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l For Room Type, leave the default value of (all), or select a specific room type.

Note: To search for active and inactive rooms, select Show Inactive.

If the appropriate building, area, room type, or view is not available, you can configure it.

3. On the Available list, select a room, or CTRL-click to select multiple rooms, and then click the Move
button (>) to move the selected rooms to the Selected list.

4. Click Next. The Statuses window opens.

Select Booking Statuses Requiring Notifications 

1. On the Available list, select the booking status, or CTRL-click to select the multiple statuses for which
the Notification is to apply, and then click the Move button (>) to move the selected statuses to the
Selected list.

2. If the appropriate status is not available, you can configure it.

Select Event Types Requiring Notifications 

1. Click Next. The Event Types window opens.
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2. On the Available list, select the event type, or CTRL-click to select the multiple event types for which
the Notification is to apply, and then click the Move button (>) to move the selected event types to
the Selected list. If the appropriate event type is not available, you can configure it.

3. Click Finish. The Notification Rule Wizard closes. You return to the Rules window with the newly con-
figured Notification Rule automatically selected.

Copy a Notification Rule 
Notification Rules can be configured by making a copy of an existing Rule. 

1. On the Notification Rules screen click the Copy button. The Rule will be completely the same as the
previous one, except for the Description having "Copy of " added to the beginning of the name.
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CHAPTER 67: Types of Notification Rules
This topic details the types of Notification Rules in EMS:

l Booking Notification Rules
l Service Order Notification Rules
l Notification Rules for Anything On A VIP Event
l New Everyday Users Notification Rules
l User Defined Field Notification Rules

Booking Notification Rules
Any of the following notification types are considered booking notifications, and are available when
creating new Notification Rules in the wizard:

l New Bookings
l Changes to Date/Time
l Room Changes
l Status Changes

1. The Setup Type field in the Notification Rule Wizard enables you to ensure that changes to a book-
ing's room setup will appropriately notify attendees. You can select one of the existing setup types,
or one of the options below.

l (all) - The rule will trigger on all Setup Types.
l (any other than Room default) - Notifications will trigger for all Setup Types except for the

Room's default Setup Type. (To change the default Setup Type you can go to Configuration >
Facilities > Rooms, then select a Room and click Edit; then make your changes in the "Default
Setup Type" field.)

2. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down.

3. The Display New Booking As field enables you to specify whether the Notification occurs as Booking
Information or Reservation Information. For example, for new reservations that contain multiple
bookings (recurring meetings), if Booking Information is selected, then a Notification occurs for every
individual booking. If Reservation Information is selected, then a single Notification occurs for the
entire reservation.

4. For Source, indicate whether additions and/or changes in the EMS Desktop Client, EMS Web App, or
both will trigger a Notification.
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Note: The Booking options described here only apply to EMS Enterprise. In EMS Professional, only one
global Booking Notification can be configured at any time in your EMS database and it is only available if a
Booking Notification is not currently configured in your EMS database.

Service Order Notification Rules
Any of the following notification types are considered service order notifications:

l New Service Orders
l Changes to Service Orders
l Deleted/Canceled Service Orders

1. On the Category drop-down list, select the category for which the service order Notification is to be
generated. If the appropriate category is not available, you can configure it. See Configuring Cat-
egories.

2. After selecting a category, the State, Grouping, and Resource options appear. You can select (all),
(multiple), (none), or an individual item on the list. To notify on a whole category, keep the selections
set to (all).

l State—Select the corresponding state that you the Notification to trigger on. "New Service
Orders" will have to start in that state. "Changes To Service Orders" will have to change into
that state. More than one state can be selected.

l Grouping—Select the grouping that a resource is in. These are set at the resource level in EMS.
l Resource—Select an individual resource from the list.

NOTE: When you choose a Group or Category, all three items (New Service Orders, Changes To Service
Orders, and Deletion/Cancelation Of Service Orders) will become auto-selected. The notification will now
only fire on all three. To set the rule to trigger notifications on only one or two of these three, you must
select (all) on both Group and Category.

3. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down.

4. For Source, indicate whether additions and/or changes in the EMS Desktop Client, EMS Web App, or
both will trigger a Notification.

Notification Rules for Anything On A VIP Event
VIP Event is an option available when creating a reservation in the Reservation Wizard. Select this option to
notify users when any changes are made to a VIP Event.
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New Everyday Users Notification Rules
Select this option to notify users when a new everyday user account is created. For Source, indicate
whether additions and/or changes from the EMS Desktop Client, EMS Web App, or both should trigger a
Notification.

User Defined Field Notification Rules

1. In Type field, select the User Defined Field type for which the Notification is to be generated. If the
appropriate UDF is not available, you can configure it. See Configuring User Defined Fields (UDFs).

2. Select the UDF for which the Notification is to be generated. (Available UDFs have a field type of List.
UDFs with other field types are not displayed on the User Defined Field drop-down list.)

3. Select the UDF value for which the Notification is to be generated.

4. Next to the Notification triggers if change occurs within... field, you can specify the timeframe (in days
or hours) leading up to the booking when notifications generate. Enter a number and select "Days"
or "Hours" from the drop-down.

5. For Source, indicate whether additions and/or changes in the EMS Desktop Client, EMS Web App, or
both will trigger a Notification.

Note: The Service Order options described here only apply to EMS Enterprise. In EMS Professional, only
one service order Notification per category can be configured at any time in your EMS database.
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CHAPTER 68: Configure Group Notification Rules
Group notification rules determine the conditions under which groups that are holding events at your
facility are reminded through an email notification about their events. You configure group notifications
based on rooms, statuses, event types, group types, and/or categories. A group notification is generated
only if all the criteria that you specified is met. For example, if you specify Room 100, Confirmed
status with catering, then a Confirmed meeting in Room 100 without a catering service order
does not result in a notification being generated. Group notification emails contain a summary of the
group's events. For example, if a group has a weekly Friday meeting (a booking) that continues for several
months, and you define a group notification rule with a monthly frequency, then the group receives a
notification email once a month that lists all the Friday meetings for the month.

Note: Configuring Group Notification Rules is similar to configuring notification rules for individuals. If you
are familiar with this process, you can apply the same rules for groups.

You can configure multiple group notifications in EMS Enterprise. You can configure only a single group
notification in EMS Professional. For notification emails to be sent, the EMS Email Notification Service must
be installed and configured. Refer to the EMS Installation instructions for details.

This section contains information on the following:

l Configure a Group Notification 
l Specify the Confirmation Settings for a Group Notification Email 

Configure a Group Notification 
Note: You can configure multiple group notifications in EMS Enterprise. You can configure only a single
group notification in EMS Professional.

1. On the EMS menu bar, click Configuration > Administration > Group Notification Rules. The Group
Notification Rules window opens. This window lists all the group notification rules that are currently
configured in your EMS database and that have a status of Active.
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Tips: Optionally, to view all group email notification rules in your EMS database, regardless of status, under
Show, click Inactive.

The remainder of this procedure describes how to configure a group email notification rule “from scratch.”
You can also configure a group email notification rule by copying an existing rule. Select the notification
rule that you want to copy, click Copy, and then go to Step 3.

2. Click New. The Group Notification Rule dialog box opens. The Group Notification Rule tab is the active
tab.

3. Enter the information for the new group notification rule.
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OPTION DESCRIPTION

Description The name or description for the group notification rule.

Note: The description can be a maximum of 50 characters, including
spaces.

Header
Message

Footer
Message

Select a header and/or footer message that is to be displayed on every
notification that is sent to the group.

Note: If the appropriate message is not available, you can configure it.
See “Configuring Messages”.

Email Format Select the format (HTML or Plain Text) for the email.

Frequency Select the frequency with which the notification is to be sent.

• Daily—You must indicate how many days prior to/after the Booking
Date/Last Booking Date that the notification is to be sent.

• Weekly—You must select the day on which the notification is to be sent
and for which bookings. (For example, every Friday for bookings that start
on the following Monday).

• Monthly—You must indicate how many days prior to the end of the
month that the notification is to be sent.

Multiple
Bookings Only

Available only in EMS Workplace. Select this option to notify users if they
have multiple bookings on a particular day.

Send
Confirmation

Select this option to attach a full detailed confirmation to the group email;
otherwise, leave this option blank to have the group email contain only a
simple listing of bookings.

Note: The contents of the full confirmation email are determined by the
confirmation settings that you specify. See “To specify the confirmation
settings for a group notification email”.

Email
Notification
At/Time Zone

Select the time of day (based on the time zone) at which the email
notification is to be sent.
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OPTION DESCRIPTION

Include Cancel
Link

Available only if Send Confirmation is not selected. Provides a link in the
notification email so that a user can cancel the booking directly from the
notification email.

Include
Reconfirm
Link/Reconfirm
Status

Available only if Send Confirmation is not selected. Provides a link in the
notification email so that a user can reconfirm the booking directly from
the notification email. If you select this option, then you must also select a
Reconfirm Status that is to be applied to the booking.

Note: If the appropriate status is not available, you can configure it.
See “Configuring Statuses”.

Email Group

Email 1st
Contact

Email 2nd
Contact

Email Web
User

Select the appropriate options to indicate to whom the group notification
is to be sent.

Note: If the appropriate group, contact, and/or web user is not available,
you can configure it. See “Configuring Groups”, “Configuring Contacts”,
and/or “Configuring Web Users”.

Email From Enter the email address that is to be displayed in the Email From field for
the group notification.

Note: If you leave the Email From field blank, then the Email From address
that was defined during the installation and configuration of the EMS
Email Notification Service is used.

Email Subject
Line

Enter the text that is to be displayed in the email subject line. Variables
pull in selected data from the event for which the notification is being
emailed. You can include variables as described in the Legend. For
example,%2% is the code for the group name, so “Notification for %2%”
would result in “Notification for Consumer Electronics Association” being
displayed in the subject line. By default, email notifications for booking-
level notifications also display the actual booking date (and not just the
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OPTION DESCRIPTION

first booking date of the reservation) in the subject line of the email.

Inactive Leave this option blank to add a group email notification rule as an active
rule. Select this option to Inactivate the group notification rule.

4. Do one or more or all the following to set the criteria that triggers the generation of the notification:

l Open the Rooms tab and do the following to search for the rooms for which the notification is to
apply:

l On the Building drop-down list, select one of the following—(all) buildings, a specific building, a spe-
cific area, or a specific view.

Tips: If the appropriate building, area, or view is not available, you can configure it. See “Configuring
Buildings”, “Configuring Areas”, or “Configuring Public Views”.

l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.

Tip: If the appropriate room type is not available, you can configure it. See “Configuring Room Types”.

l On the Available list, select the room, or CTRL-click to select multiple rooms, and then click the Move
button (>) to move the selected rooms to the Selected list.

Tip: If the appropriate room is not available, you can configure it. See “Configuring Rooms”.

l Open the Statuses tab, and on the Available list, select the status, or CTRL-click to select the multiple
statuses, and then click the Move button (>) to move the selected statuses to the Selected list.

Tip: If the appropriate status is not available, you can configure it. See “Configuring Statuses”.

l Open the Event Types tab, and on the Available list, select the event type, or CTRL-click to select mul-
tiple event types, and then click the Move button (>) to move the selected event types to the Selec-
ted list.

Tip: If the appropriate event type is not available, you can configure it. See “Configuring Event Types”

l Open the Group Types tab, and on the Available list, select the group type, or CTRL-click to select
multiple group types, and then click the Move button (>) to move the selected group types to the
Selected list.

Tip: If the appropriate group type is not available, you can configure it. See “Configuring Group Types”.

l Open the Categories tab, and on the Available list, select the category, or
CTRL-click to select multiple categories, and then click the Move button (>) to move the selected cat-
egories to the Selected list.

Accruent Confidential and Proprietary © 2019 Page | 273

CHAPTER 68: Configure Group Notification Rules



Tip: If the appropriate category is not available, you can configure it. See “Configuring Categories”.

5. Click OK. The Group Notification Rule dialog box closes. You return to the Group Notification Rules
window with the newly configured notification rule automatically selected.

6. If you selected Send Confirmation for the notification rule, then continue to “To specify the con-
firmation settings for a group notification email”.

Specify the Confirmation Settings for a Group Notification Email 

1. If you have not already done so, on the EMS menu bar, click Configuration > Administration > Group
Notification Rules to open the Group Notification Rules window.

2. Select the rule for which you are specifying the confirmation settings, and then click
Confirmation. The Confirmation Settings dialog box opens. The Date Range tab is the active tab.   

3. Specify the settings for the confirmation.

Tip: At a minimum, you must specify buildings and statuses. All other information is optional.

Date Range Tab—The department name that appears at the top of a printed confirmation.  

Buildings Tab—Select the specific buildings, areas, and/or views that are to be included in the confirmation.

Note: If the appropriate building, area, and/or views is not available, you can configure it. See “Configuring
Buildings”, “Configuring Areas”, and/or “Configuring Public Views”.  

Categories Tab—Select the specific booking details that are to be included in the confirmation.

Note: If the appropriate category is not available, you can configure it. See “Configuring Categories”.  

Accruent Confidential and Proprietary © 2019 Page | 274

CHAPTER 68: Configure Group Notification Rules



Statuses Tab—Select the specific statuses that are to be included in the confirmation.

Note: If the appropriate status is not available, you can configure it. See “Configuring Statuses”.   

Options Tab—Format settings for a printed confirmation.  See the following table for option descriptions.

FIELD DESCRIPTION

Confirmation Title Appears bold and centered at the top of the confirmation.

Header Message

Footer Message

Pre-configured blocks of text that appear in the header and
footer of the confirmation.

Note: If the appropriate message is not available, you can
configure it. See “Configuring Messages”.

Paper Size The size of the paper on which the confirmation is printed.
Values are Letter, Legal, and A4.

Print Comments Include the reservation’s comments in the printed
confirmation.

Print Reminders Include the reservation’s reminders in the printed
confirmation.

Print Cancel Reasons Include reasons for cancellation in the printed confirmation.

Print User Defined Fields Include user defined fields and their values in the printed
confirmation.

Suppress Reserved Time Hide the reserved time for the booking and show only the
event time.

Suppress Location Hide the location for the reservation.

Suppress Pricing Do not show the reservation’s room charges or resource
charges in the printed confirmation.

Suppress Logo Do not show your organization’s logo in the printed
confirmation.

Suppress Item Notes Do not show resource notes for any booking items in the
printed confirmation.
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FIELD DESCRIPTION

Suppress Item Special
Instructions

Do not show special instructions for any booking items in the
printed confirmation.

Limit Bookings to Those
With Details in Selected
Categories

Show only those bookings in the printed confirmation that
contain details for the categories that are selected on the
Categories tab.

Web Options Tab—Select your settings for VEMS.  See the following table for option descriptions.

FIELD DESCRIPTION

Display Web Link Select this option to include a link (URL) to the reservation in VEMS.

Web Link Message The message that is to be included with the link.

Tip: At a minimum, you must specify buildings and statuses. All other information is optional.

4. Click OK. The Confirmation Settings dialog box closes. You return to the Group Notification Rules win-
dow with the notification rule still selected.
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CHAPTER 69: Configure Room Card Formats
A room card format is a user-configured layout that can be selected in lieu of the default By Date formats
(By Date or By Date [Landscape]) when printing the Room Cards report.

1. On the EMS menu bar, click Configuration > Administration > Room Card Formats. The Room Card
Formats window opens. This window lists all the Room Card formats that are currently configured in
your EMS database. The two default By Date formats are displayed as a single entry—By Date
Formats ([Standard).

2. Click New. The Room Card Format dialog box opens.

3. Enter the information for the new room card format.

Room Card Format Fields
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FIELD DESCRIPTION

Description The name or description for the room card format.

Note: The description can be a maximum of 30 characters, including spaces.

Print
Landscape

Select this option if the Room Card report is to be printed in a landscape
orientation; otherwise, the report is printed in a portrait orientation.

Header l Top Margin (inches)—Specify a top margin for the report in inches.
l Show Room—If the name of the event room is to be printed on the

report, select this option, and then on the Font drop-down list, select the
font in which the name is to be printed.

l Show Date—If the date of the event is to be printed on the report, select
this option, and then on the Font drop-down list, select the font in which
the date is to be printed.

Fields l Top Margin (inches)—Specify the top margin in inches between the
room and/or date field and the first field in the report.

l First Field/Second Field/Third Field—Specify the fields that are to be dis-
played on the report as well as the font in which the fields are to be dis-
played.

4. Click OK. The Room Card Format dialog box closes. You return to the Room Card Formats window
with the newly configured room card format automatically selected.
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CHAPTER 70: Configure Calendar Formats
You can configure calendar formats, which determine the data items that are printed for an event on the
Event Calendar report, for example, Group, Event Time, and Event Location.

1. On the EMS menu bar, navigate to Configuration > Administration > Calendar Formats. The Cal-
endar Formats window opens. This window lists all the calendar formats that are currently configured
in your EMS database.

Calendar Formats Window

2. Click New. The Calendar Format dialog box opens. The Calendar Format tab is the active tab.

Calendar Format Tab

3. In the Description field, enter a name or description for the new calendar format.
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Note: The description can be a maximum of 30 characters, including spaces

4. Optionally, to filter events so that the information for only those events that meet one or more filter
criteria are printed on the Event Calendar report, select Set Filter to open four additional tabs—Build-
ing, Statuses, Event Types, and Group Types—and then do the following:

Calendar Format Tab with Set Filter Selected

l Open the Buildings tab, and on the Available list, select the building, area or view, or CTRL-click to
select multiple buildings, areas, and/or views, and then click the Move button (>) to move the selec-
ted statuses to the Selected list.

Note:  If the appropriate building, area, and/or view is not available, you can configure it.
See Configuring Buildings, Configuring Areas, and/or Configuring Public Views.

l Open the Statuses tab, and on the Available list, select the status, or CTRL-click to select multiple
statuses, and then click the Move button (>) to move the selected statuses to the Selected list.

Note: If the appropriate status is not available, you can configure it. See Configuring
Statuses.

l Open the Event Types tab, and on the Available list, select the event type, or CTRL-click to select mul-
tiple event types, and then click the Move button (>) to move the selected event types to the Selec-
ted list.

Note:  If the appropriate event type is not available, you can configure it. See Configuring
Event Types.
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l Open the Group Types tab, and on the Available list, select the group type, or CTRL-click to select
multiple group types, and then click the Move button (>) to move the selected group types to the
Selected list.

Note: If the appropriate group type is not available, you can configure it. See Configuring
Group Types.

5. Open the Fields tab, and on the Available list, select the field, or CTRL-click to select the multiple fields
that are to make up the calendar format, and then click the Move button (>) to move the selected
fields to the Selected list.

Note: The information is printed in the order in which the fields are listed from top to bot-
tom in the Selected list. If needed, select a field and change its order by clicking Move Up or
Move Down.

6. Click OK. The Calendar Format dialog box closes. You return to the Calendar Formats window, with
the newly configured calendar format automatically selected.
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CHAPTER 71: Configure Check-in Notification Rules (Excludes Pro-
fessional)
Check-in Notification Rules help you automate the process of reminding users to check in and managing
no-shows. You configure Check-in Notification rules based on rooms, statuses, event types, and/or group
types. When you configure a Check-in Notification rule, you can configure it generate an email to remind
users to check in and to cancel no-showed events. To do this for group bookings, all the criteria you specify
with these rules must be met. For example, if you specify "Room 100, Confirmed status, Analyst group
type," then a Confirmed meeting for a Partner group type in Room 100 does not result in a notification
being generated.

Note: For notification emails to be sent, the EMS Check-in Notification Service must be
installed and configured. Refer to the EMS Installation instructions for details.

1. On the menu bar, click Configuration > Administration > Check-in Notification Rules. The Check-in
Notification Rules window opens. This window lists all the Check-in notification rules that are cur-
rently configured in your EMS database and that have a status of Active.
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Note: You can view all Check-in notification rules in your EMS database, regardless of
status, under Show, click Inactive.

The remainder of this procedure describes how to configure a Check-in notification rule “from scratch.” You
can also configure a Check-in notification rule by copying an existing rule. Select the notification rule that
you want to copy, click Copy, and then go to Step 3.

2. Click New. The Check-in Notification Rule dialog box opens. The Check-in Notification Rule tab is the
active tab. 

3. Enter the information for the new Check-in Notification rule.
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OPTION DESCRIPTION

Description The name or the description for the notification rule.

Note: The description can be a maximum of 50 characters, including
spaces.

Apply Rule When to apply the rule; this determines when the Check-in notification rule
will be applied and trigger. This can be either before or after the Booking
Event Start Time. 

Change Status Select this option if the group’s bookings are to be changed to the status
selected on the No Show Status drop-down list.

Note: If the appropriate status is not available, you can configure it.
See “Configuring Statuses”.

No Show
Status

The status to which the group’s bookings are changed if the group “no-
shows” (do not check in within the allotted time).

Cancel Reason Optional; available only if the No Show Status is a Cancel Status type.
Select a reason for canceling the “no-show” group.

Note: If the appropriate cancel reason is not available, you can configure
it. See “Configuring Cancel Reasons”.

Send Email If this box is checked it will send a notification email to the selected
party/parties (Group, 1st Contact, 2nd Contact, Web User).

Header
Message

Footer
Message

Select a header and/or footer message that is to be displayed on every
Check-in notification that is sent.

Note: If the appropriate message is not available, you can configure it.
See “Configuring Messages”.

Include Web
App Link

Includes a link to the reservation summary in EMS Web App.

Include Cancel
Link

Available only if Change Status is not selected. Provides links in the
notification email so that a user can cancel or check into the booking
directly from the notification email.
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OPTION DESCRIPTION

Include Check
In Link

Email Group

Email 1st
Contact

Email 2nd
Contact

Email Web
User

Select the appropriate options to indicate to whom the Check-in
notification is to be sent.

Note: If the appropriate group, contact, and/or web user is not available,
you can configure it.

Email From Enter the email address that is to be displayed in the Email From field for
the group notification.

Note: If you leave the Email From field blank, then the Email From address
that was defined during the installation and configuration of the EMS
Email Notification Service is used.

Email Subject
Line

Enter the text that is to be displayed in the email subject line. Variables
pull in selected data from the event for which the notification is being
emailed. You can include variables as described in the Legend. For
example,%2% is the code for the group name, so “Notification for %3%”
would result in “Notification for Consumer Electronics Association” being
displayed in the subject line if "Consumer Electronics Association" was the
name of the event.

4. Do one or more or all the following to set the criteria to trigger a notification:
l Open the Rooms tab and do the following to search for the rooms for which the notification is

to apply:
l On the Building drop-down list, select one of the following—(all) buildings, a specific building, a

specific area, or a specific view. If the appropriate building, area, or view is not available, you can
configure it.

l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.

Accruent Confidential and Proprietary © 2019 Page | 285

CHAPTER 71: Configure Check-in Notification Rules (Excludes Professional)



l On the Available list, select the room, or CTRL-click to select multiple rooms, and then click the
Move button (>) to move the selected rooms to the Selected list. If the appropriate room type
is not available, you can configure it.

l Open the Statuses tab, and on the Available list, select the status, or CTRL-click to select the
multiple statuses, and then click the Move button (>) to move the selected statuses to the
Selected list. If the appropriate status type is not available, you can configure it.

l Open the Event Types tab, and on the Available list, select the event type, or CTRL-click to
select the multiple event types, and then click the Move button (>) to move the selected event
types to the Selected list. If the appropriate event type is not available, you can configure it.

l Open the Group Types tab, and on the Available list, select the group type, or CTRL-click to
select multiple group types, and then click the Move button (>) to move the selected group
types to the Selected list. If the appropriate group type is not available, you can configure it.

5. Click OK. The Check-in Notification Rule dialog box closes. You return to the Check-in Notification
Rules window with the newly configured notification rule automatically selected.
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CHAPTER 72: Configure Reservation Wizard Templates
The reservation wizard templates simplify the reservation making process for your users. A reservation
wizard template sets the default values for many of the fields in the Reservation Wizard. For example, you
could configure a video conference reservation wizard template such that the default values for status,
room type, event name, and event type are all set to “Video Conference.”

Note: Your users can always over-write the default values you set here when they use the Reservation
Wizard.

This topic includes information on the following:

l To Configure the Reservation Wizard Template
l Set Default Event Information for a Reservation Wizard Template
l Set Default Room Features for a Reservation Wizard Template
l Set User-Defined (UDF) Field Values for a Reservation Wizard Template

To Configure the Reservation Wizard Template

1. On the EMS Workplace menu bar, click Configuration > Administration > Reservation Wizard Tem-
plates. The Reservation Wizard Templates window opens. This window lists all the reservation wizard
templates that are currently configured in your EMS database and that have a status of Active.

Reservation Wizard Template Window

Tip: Optionally, to view all reservation wizard templates in your EMS database, regardless of status, under
Show, click Inactive.
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2. Click New. The Reservation Wizard Template dialog box opens. The Reservation Wizard Template tab
is the active tab.

3. Enter the summary information for the new reservation wizard template.

Note: The only required information is the template description. All other information on all tabs is optional
and can be added at a later date when needed.

Reservation Wizard Fields

FIELD DESCRIPTION

Description Required field. The name or description of the reservation wizard template.

Note: This is the only required information for the group. All other information
on all tabs is optional and can be added at a later date when needed. The
description can be a maximum of 50 characters, including spaces.

Prompt for
Date

Number of
Days to
Select

Select this option if a reservationist/user is to be prompted with a start date
for the reservation in the Reservation Wizard, and then in the Number of Days
to Select field, enter the number of days that are to be automatically selected
in the Reservation Wizard after the reservationist/user enters a start date for
the event.

Video
Conference

Select this option to apply the Video Conference option as a default field on
the last page of the Reservation Wizard when this template is used.

Note: This option is not available in EMS Professional.
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4. Click OK to close the Reservation Wizard Template dialog box and return to the Reservation Wizard
Templates window with the newly configured template automatically selected.

Set Default Event Information for a Reservation Wizard Template

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard template that
you are configuring.

2. Open the Defaults tab, and do the following for each reservation variable for which you want to spe-
cify a default value:

l Select the variable, and then click edit to open a Set Default Value dialog box.
l Enter the default value for the variable, and then click OK to close the Set Default Value dialog

box and return to the Defaults tab.

3. Continue with any other optional configuration for the template as needed; otherwise, click OK to
close the Reservation Wizard Template dialog box and return to the Reservation Wizard Templates
window with the newly configured template automatically selected.

Set Default Room Features for a Reservation Wizard Template
A feature is built-in or permanent attribute of a room, such as a network connection, a built-in plasma TV,
window, and so on. You can configure a reservation wizard template so that the initial list of rooms that are
available to a user who is making a reservation using the template is limited to only those rooms with these
default features.

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard template that
you are configuring.

2. Open the Features tab, and on the Available list, select the feature, or CTRL-click to select the mul-
tiple features that the rooms are to have, and then click the Move button (>) to move the selected
features to the Selected list.
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3. Continue with any other optional configuration for the template as needed; otherwise, click OK to
close the Reservation Wizard Template dialog box and return to the Reservation Wizard Templates
window with the newly configured template automatically selected.

Set User-Defined (UDF) Field Values for a Reservation Wizard Template
User defined fields, or UDFs, are custom fields that store additional information or data for a a reservation.
For example, for a reservation, you might want to note the date that the contract for the event was
received and if the event was approved by a supervisor. You can select the default user defined fields that
are to always apply to a reservation wizard template. These fields are displayed on the User Defined Fields
tab in the Reservation Wizard.

1. If needed, open the Reservation Wizard Template dialog box for the reservation wizard template that
you are configuring.

2. Open the User Defined Fields tab, and on the Available list, select the UDF, or CTRL-click to select the
multiple UDFs that are to always apply to the template, and then click the Move button (>) to move
the selected fields to the Selected list.
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3. Continue with any other optional configuration for the template as needed; otherwise, click OK to
close the Reservation Wizard Template dialog box and return to the Reservation Wizard Templates
window with the newly configured template automatically selected.
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CHAPTER 73: Core Configuration > Other Data Types
Before you can use EMS to manage your organization’s events, you must configure core data items that
are specific to your organization. For example, before you can make a reservation for a group, you must
first configure the group. Likewise, before you can add a comment to the group, you must first configure
comment types.
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CHAPTER 74: Configure Event Types
You can configure event types, which you use to classify or categorize the different events that your
organization has. For example, you might configure lectures, meetings, and conferences, and so on as
some of your event types.

configure event types 

1. On the EMS menu bar, navigate to Configuration > Other > Event Types. The Event Types window
opens. This window lists all the event types that are currently configured in your EMS database and
that have a status of Active.

Event Types window

Tip: Optionally, to view all event types in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Event Type dialog box opens. The Event Type tab is the active tab.
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Event Type Dialog Box, Event Type Tab

3. Enter the information for the new event type.

FIELD DESCRIPTION

Event Type The name or classification for the event.

Note: The event type can be a maximum of 30 characters, including spaces.

Internal Indicates that the event type is internal to your organization.

Note: Used for internal reporting purposes only. The event type is not printed
on external documents such as confirmations and invoices, and it is not
hidden in any area of your EMS application.

Reserved
Color

Select the color that is to be used in the Reservation Book to indicate when
the reserved time extends past the event time.

Event Color Select the color that is to be used in the Navigator and in the Reservation
Book to indicate this type of event.

Note: Lighter colors are a better choice so as not to obscure the
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FIELD DESCRIPTION

reservation/booking name.

EMS Web App Settings

Display to
Everyday
Users

Indicates that events of this type are to be displayed when a user browses for
events in EMS Web App.

Note: If an event is labeled with a type for which this option has been cleared,
then the event is not displayed when a user browses for the event in EMS
Web App.

Allow Guest
Request

Indicates that this event type is an available option in EMS Web App when
requesting a room.

Available to
All Process
Templates

Select this option to assign this event type to all everyday user process
templates.

Inactive Leave this option blank to add the event type as an active event type. Select
this option to inactivate the event type.

4. Open the Comment Types tab, and on the Available list, select the comment type, or CTRL-click to
select the multiple comments types that are to be automatically applied when you create a new reser-
vation with this event type, and then click the Move button (>) to move the selected comment types
to the Selected list.
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Event Type Dialog Box, Comment Types Tab

Tip: If the appropriate comment type is not available, you can configure it. See Configure Comment
Types.

5. Open the Reminder Types tab, and on the Available list, select the reminder type, or CTRL-click to
select the multiple reminder types that are to be automatically applied when you create a new reser-
vation that uses this event type, and then click the Move button (>) to move the selected reminder
types to the Selected list.
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Event Type dialog box, Reminder Types tab

Tip: If the appropriate reminder type is not available, you can configure it. See Configure Reminder
Types.

6. Click OK. The Event Type dialog box closes. You return to the Event Types window with the newly con-
figured event type automatically selected.
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CHAPTER 75: Configure Group Types
You can configure group types, which you use to classify or categorize the different groups that sponsor or
hold events at your facilities. For example, if your organization is an academic organization, you might
configure student groups, alumni groups, and so on for some of your group types.

To configure group types 

1. On the EMS menu bar, click Configuration > Other > Group Types. The Group Types window opens.
This window lists all the group types that are currently configured in your EMS database.

Group Types window

2. Click New. The Group Type dialog box opens. The Group Type tab is the active tab.

Group Type dialog box, Group Type tab

3. Enter the information for the new group type.
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FIELD DESCRIPTION

Group
Type

The name or classification for the group type.

Note: The group type can be a maximum of 50 characters, including spaces.

Default
Pricing
Plan

Select the default pricing plan that is to be applied when creating a new group.

Note: If you select or edit a pricing plan for a group type, the information is not
updated for existing groups of this group type. Instead, it applies only to new
groups of this group type.

Note: If the appropriate pricing plan is not available, you can configure it.
See Configure Pricing Plans.

Available
on the
Web

Select this option if VEMS users are to be able to filter events by this group type
when they are browsing for events.

4. Optionally, open the Calculations tab and on the Available list, select the calculation, or CTRL-click to
select the multiple calculations that are to always apply to this group type, and then click the Move
button (>) to move the selected calculations to the Selected list.

Group Type dialog box, Calculations tab

Tip: If the appropriate calculation is not available, then you can configure it. See Configure Calculations.

5. Click OK. The Group Type dialog box closes. You return to the Group Types window with the newly
configured group type automatically selected.
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CHAPTER 76: Configure Reminder Types
A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a booking detail
that is a service order. A reminder is a comment that has a due date associated with it. You can
configure reminder types, which you use to classify or categorize the different reminders that are applicable
for your organization’s business needs. For example, if your organization requires a deposit before a
tentative reservation can be confirmed, then you might configure a reminder type of “Deposit Due.”

To Configure a Reminder Type 

1. On the EMS menu bar, click Configuration > Other > Reminder Types. The Reminder Types window
opens. This window lists all the reminder types that are currently configured in your EMS database
and that have a status of Active.

Reminder Types Window

Optionally, to view all reminder types in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Reminder Type dialog box opens.

Reminder Type Dialog Box
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3. Enter the information for the new reminder type.

FIELD DESCRIPTION

Reminder
Type

The name or classification for the reminder.

Note: The reminder type can be a maximum of 30 characters, including spaces.

Days
Allowed

Enter a value, or leave the default value of zero to use the current day’s date as
the basis for calculating the due date for the reminder.

Due Date
Based On

Used in conjunction with the value that is specified in the Days Allowed field.

l Reminder Added Date—Indicates that the reminder is due within the spe-
cified number of days after the date on which the reminder was applied.

l Event Date—If the reminder is attached to a booking or to a service order,
then the reminder is due within the specified number of days prior to the
booking date. If the reminder is attached to a reservation, then the
reminder is due within the specified number of days prior to
the first booking date in the reservation.

Notes Text entry that further defines or explains the reminder type. For example, a
reminder called “Final Count for Catering” might have a default note that
provides the name and phone number for the contact at the catering company.

Note: The text that you enter here is displayed by default when you apply the
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FIELD DESCRIPTION

reminder, but you can always edit it or delete it if needed.

Internal Indicates that the reminder type is internal to your organization.

Note: Used for internal reporting purposes only. The reminder type is not
printed on external documents such as confirmations and invoices, and it is not
hidden in any area of your EMS application.

Inactive Leave this option blank to add the reminder type as an active reminder type.
Select this option to inactivate the reminder type.

4. Click OK. The Reminder Type dialog box closes. You return to the Reminder Types window with the
newly configured reminder type automatically selected.
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CHAPTER 77: Configure Comment Types
A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a booking detail
that is a service order. You can configure comment types, which you use to classify or categorize the
different comments that are applicable for your organization’s business needs. For example, if your
organization’s facilities are regularly scheduled for outside conferences, then applicable comment types
could include Event Directions, Admission Cost and Requirements, Event Recap, and so on.

To configure comment types

1. On the EMS menu bar, click Configuration > Other > Comment Types. The Comment Types window
opens. This window lists all the comment types that are currently configured in your EMS database
and that have a status of Active.

Optionally, to view all reminder types in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Comment Type dialog box opens.  
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3. Enter the information for the new comment type.

FIELD DESCRIPTION

Comment
Type

The name or classification for the comment type.

Note: The comment type can be a maximum of 30 characters, including
spaces.

Comments Free form text that is appropriate for the selected comment type.

Note: The information that you enter here is displayed by default when you
apply the comment, but you can always edit it or delete it if needed.

Internal Indicates that the comment type is internal to your organization.

Note: Used for internal reporting purposes only. The comment type is not
printed on external documents such as confirmations and invoices, and it is
not hidden in any area of your EMS application.

Print in
Confirmation
Footer

Select this option if the comment type is to be printed in the footer of
reservation-level confirmations.

Virtual EMS Settings

Display on Select this option if the comment is to be displayed in VEMS when it is
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FIELD DESCRIPTION

Web attached to a reservation or booking.

Web
Description

Provides an expanded description of the comment type in VEMS when users
are browsing events.

Inactive Leave this option blank to add the comment type as an active comment
type. Select this option to inactivate the comment type.

4. Click OK. The Comment Type dialog box closes. You return to the Comment Types window with the
newly configured comment type automatically selected.
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CHAPTER 78: Configure Messages
Messages are typically added to the headers of confirmations, notifications, and invoices to further
customize them.

A message is a block of text that your users can add to the headers and footers of confirmations, emails,
and invoices. One header message, one footer message, or both can be added. You associate them with
confirmations, emails, and invoices in reservation or booking under Settings > Confirmation Settings >
Email Options:

Messages can be used for a variety of purposes, such as providing a simple greeting to a group who is
making a reservation, providing event instructions and contact information, and so on. For example, a
Greeting message might be something such as “Thank you for reserving...” You can configure and store a
variety of messages and then your users can select whichever is most appropriate for a given situation.

1. On the EMS menu bar, click Configuration > Other > Messages. The Messages window opens. This
window lists all the messages that are currently configured in your EMS database.
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2. Click New. The Message dialog box opens. The Message tab is the active tab.

3. Enter the information for the new message.

FIELD DESCRIPTION

Message The name for the message.

Note: The message name can be a maximum of 50 characters, including
spaces.
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FIELD DESCRIPTION

Message
Text

The un-formatted message in its entirety.

4. Open the Confirmation HTML tab and do one of the following:

l Design is selected by default. Use the standard Windows plain text formatting options to format the
message (spacing, number of lines, capitalization, and so on) so that it is displayed the way that you
want in the headers and footers.

l Select HTML and enter the necessary HTML code to format the message (spacing, number of lines,
capitalization, and so on) so that it is displayed the way that you want in the headers and footers.

5. Optionally, click Spelling to spell check the message before you save it.

6. Click OK. The Message dialog box closes. You return to the Messages window with the newly con-
figured message automatically selected.
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CHAPTER 79: Configure Special Dates or Holidays
Special Dates are days that have special significance for your organization, for example, New Year’s Day,
Spring Break, Staff Retreat, and so on. Special Dates are displayed in various places throughout your EMS
system. The special date designation is for informational purposes only and unless you specifically close the
date to your users, your users are not prevented from making reservations or booking rooms on a special
date or holiday.

This topic will provide information on the following:

l Work with Special Dates or Holidays
l Configure a Single Special Date or Holiday
l Configure Multiple Special Dates or Holidays
l Import a List of Special Dates or Holidays
l Configure Building Hours for a Special Date or Holiday

Note: You must configure your organization’s Special Dates each calendar year. EMS Desktop Client does
not assume that a day that is a special date or holiday for the current calendar year is also a special date or
holiday for the next calendar year.

You can configure Special Dates on an individual basis; you can configure multiple Special Dates; or you can
use a wizard to import a list of Special Dates in a single step. Optionally, after you configure or import a list
of Special Dates, you can configure the hours for the buildings that are affected by the special date or
holiday.

By default, buildings are configured to be “Open All Day.” You can configure the hours for a building so
that the building is open for only a specific time period on the special date or holiday or the building is
closed for the entire special date or holiday.

Work With Special Dates or Holidays

1. On the EMS menu bar, click Configuration > Other > Special Dates. The Special Dates window opens.
This window lists all the Special Dates that are currently configured for all buildings in your EMS data-
base and that have a date greater than or equal to the current day’s date.
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Special Dates Window

2. Optionally, do one or both of the following:
l To view all Special Dates in your EMS database, regardless of date, under Show, clickOld.
l To view all Special Dates for a specific building, select the building on the Building drop-down

list.

Configure a Single Special Date or Holiday

1. ClickNew. The special date or holiday dialog box opens.
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Special Date Dialog Box

2. Enter the information for the special date or holiday.

FIELD DESCRIPTION

Date The date for the special date or holiday.

Description The description or name of the special date or holiday.

Note: The description can be a maximum of 50 characters, including
spaces.

Building Select the building to which the special date or holiday applies. (The
default value is all buildings.)

Notes Any special notes or information about the special date or holiday.

Calendar Style Select the print characteristics for the special date or holiday on the event
schedule.

EMS Web App Settings

Display to Clear this option if you do not want the special date or holiday
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FIELD DESCRIPTION

Everyday Users description to be displayed in EMS Web App .

3. Optionally, click Spelling to spell check the special date or holiday description before you save it.

4. Click OK. The special date or holiday dialog box closes. You return to the Special Dates window with
the newly configured special date or holiday automatically selected.

Configure Multiple Special Dates or Holidays

1. Click Wizard. The special date or holiday Wizard opens.
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Special Date Wizard

2. ClickAdd. The Add special date or holiday dialog box opens.
3. Enter the information for the special date or holiday.
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FIELD DESCRIPTION

Date The date for the special date or holiday.

Description The description or name of the special date or holiday.

Note: The description can be a maximum of 50 characters, including spaces.

Calendar
Style

Select the print characteristics for the special date or holiday on the event
schedule.

Note: See Configuring Calendar Styles.

Notes Any special notes or information about the special date or holiday.

4. Click OK. The Add special date or holiday dialog box closes. You return to the special date or holiday
Wizard window with the newly added special date or holiday selected in the window.

5. Repeat Step 2 through Step 4 until you have added all the needed Special Dates.

6. Click Next. The special date or holiday Wizard window is updated with a list of all the buildings that
are currently configured in your EMS database.

7. Select the building, or CTRL-click to select the multiple buildings for which the special date or holiday
is to apply, and then click Finish. You return to the Special Dates window with the newly configured
Special Dates displayed in the window.

Import a List of Special Dates or Holidays
If you use the wizard to import a list of multiple Special Dates, you can set the values only for the special
date or holiday date, description, and notes. You cannot specify the calendar style, enter notes for the
special date or holiday, or indicate that the special date or holiday is not to be displayed in EMS Web App.
To configure any of the latter information for a special date or holiday, you must edit the special date or
holiday.

1. Create a tab-delimited file that contains the information (in the order listed) for the Special Dates that
are being imported.

l Date of special date or holiday (Required. Format is mm-dd-yy.)
l Description of special date or holiday (Required. 50 characters maximum, including spaces.)
l Notes (Optional. No maximum.)

Tip: Each special date or holiday must be a separate line entry. To see the required format for the tab-
delimited file, on the Special Dates window, click Print > Import Format. See Also: Special Date Import
File Specifications.
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2. Click Wizard. The special date or holiday Wizard opens.

3. Click Import, and in the Open File dialog box, browse to and select the tab-delimited text file that con-
tains that Special Dates that you are importing, and then click Open. The special date or holiday Wiz-
ard window is updated with a list of all the buildings that are currently configured in your EMS
database.

4. Select the building, or CTRL-click to select the multiple buildings for which the Special Dates are to
apply, and then click Finish. You return to the Special Dates window with the newly imported Special
Dates displayed in the window.

5. Optionally, select a newly imported special date or holiday, and then do one or both of the following:
l Click Edit to edit the Notes, Calendar Style, and/or EMS Web App. Settings for the special date

or holiday.
l Configure the building hours for the special date or holiday. 

Configure Building Hours for a Special Date or Holiday

1. If you have not already done so, on the EMS menu bar, click Configuration > Other > Special Date to
open the Special Dates window.

2. Select a special date or holiday, and then click Hours. The Building Hours window opens. The date and
title of the special date or holiday are displayed at the top of the window. A list of all the buildings for
which the special date or holiday applies as well as the hours of operation for each building are dis-
played in the window.
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Building Hours Window

3. Select the building, or CTRL-click to select the multiple buildings for which you are modifying the
hours of operation, and then click Change. The Building Hours dialog box opens.

Building Hours Dialog Box
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4. Select the appropriate option on the Building Hours dialog box.

OPTION DESCRIPTION

Set
Building
Hours

Select this option to specify the time period (Open and Close) during which the
building is to remain open for the special date or holiday. Your EMS users can
make reservations on this date in the selected buildings even if the events are
scheduled outside the indicated time period. They merely receive a warning that
the reservation time exceeds building hours.

Note: EMS Web App users cannot make reservations outside of building hours.

Closed
All Day

Select this option to close the building for the entire special date or holiday
period. When you select this option, then a Web Only option is displayed on the
Building Hours dialog box.

l If you do not select Web Only, then none of your users (EMS or EMS Web
App) can make reservations on this date in the selected buildings.

l If you do select Web Only, then your EMS users can make reservations on
this date in the selected buildings; however, your EMS Web App users can-
not.

Open
All Day

The default value. Leave this option selected to have the building remain open
for the entire special date or holiday.

5. Click OK. The Building Hours dialog box closes. You return to the Building Hours window.

6. Repeat Step 3 through Step 5 until you have configured the building hours for all the buildings as
needed.

7. Click Close. You return to the Special Dates window.
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CHAPTER 80: Configure User Defined Fields (UDFs)
You can configure User Defined Fields, or UDFs, which are custom fields that store additional information
or data for a Building, a Group, a Group with a Reservation, a Reservation, a room, a service order, a guest
request, or a web user.

For example, for a Reservation, you might want to note the date that the contract for the event was
received and if the event was approved by a supervisor. For a guest request, you might want to inquire if
alcohol will be served at the event. User defined fields are displayed on the User Defined Fields tab in the
Reservation Wizard and on the User Defined Fields tab in the Navigator. If User Defined Fields have been
completed for a Reservation, then these fields can be displayed on any confirmations and invoices that are
generated for the Reservation.

User Defined Fields can also have dependencies, allowing for a parent/child setup.  Based on the answer of
the parent, different child User Defined Fields can appear along with the parent.

1. On the EMS menu bar, navigate to Configuration > Other > User Defined Fields. The User Defined
Fields window opens. This window lists all the User Defined Fields of any type that are currently con-
figured in your EMS database and that have a status of Active.
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l To view inactive User Defined Fields in your EMS database, under Show, click Inactive.
l To view only a specific type of User Defined Field, on the Type drop-down list, select a different

type (Booking, Building, Group, Group/Reservation, which is a Group for which a Reservation
has been made, Reservation, Room, Service Order, Guest Request, or Web User).

2. Click New. The User Defined Field dialog box opens.

3. Enter the information for the new User Defined Field. To see more detailed information on UDF Field
Types, refer to the following table.

User Defined Field Options 

FIELD DESCRIPTION

Field
Description

A name or description for the field.

Field Type Select the type of data that the field is to hold (Text, Date, List, or Numeric).

Note: If you select Text, then an option for displaying a multi-line textbox in
EMS and VEMS is available. If you select List, then an Items tab is displayed
on the User Defined Field dialog box. You must define the items that are to
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FIELD DESCRIPTION

be displayed in the list. (See Step 5 below.)

If you select List, then the Allow Multi-Select option appears.  This lets your
users pick multiple items from the list whenever the User Defined Field is
used.

Field Applies
To

Select the item to which the field applies:

l Booking - Provides the ability for a user to enter a User Defined Field
when creating a booking.

l Building — Provides the ability to define a custom Building property
for reporting in Query Builder.

l Course — EMS Academic Planning only.
l Group — Provides the ability to enter User Defined Fields inside the

group screen for each Group.
l Group/Reservation — The UDF that is assigned to a Group when a new

Reservation is created for the Group
l Guest Request — Provides the ability for users to enter a User Defined

Field when making a Guest Request.
l Reservation — Provides the ability for users to enter a User Defined

Field when making a Reservation.
l Room — Provides the ability to define a custom Room property for

reporting in Query Builder.
l Service Order — Provides the ability for users to enter a User Defined

Field when adding a Service Order.
l Web User — Provides the ability for users to enter a User Defined Field

when inside a web user's options.

Category Available only if you select Service Order for Field Applies To. Select the
service order category for which the field applies.

Note: If the appropriate category is not available, you can configure it.
See Configuring Categories.

Default Optional field. You can enter a default value for the User Defined Field. This
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FIELD DESCRIPTION

Value value is displayed in the field but a user can edit it if needed.

Note: If you assign a default value to a UDF, then the UDF is always added to
the item. For example, if you assign a default value to a UDF that applies to
Reservations, then the UDF is always added to any Reservation that any user
makes in your EMS system.

Internal Indicates that the UDF is internal to your organization.

Note: Used for internal reporting purposes only. The UDF is not printed on
external documents such as confirmations and invoices, and it is not hidden
in any area of your EMS application.

Sequence If a booking, Building, Group, a Group with a Reservation, a Reservation, a
room, a service order, a guest request, or a web user is to have multiple User
Defined Fields, then specify the display order of these fields. Fields are
ordered from lowest to highest sequence number, with the field with the
lowest sequence number being displayed first.

Note: If you leave the sequence set to the default value of zero for all fields,
then by default, the fields are displayed alphabetically.

Dependency

Dependent
Upon

Select a parent UDF.  Your child UDF will be dependent on that parent.  The
parent UDF must be configured first and be a List type.

Answer Select the answer that will cause your child UDF to display with the parent. 
If the right answer is not selected the child UDF will not show.

Value

Required in
EMS Desktop
Client

Select this option if a user must enter a value in the field when making a
Reservation in the EMS Desktop Client.

Virtual EMS/Web App Settings

Accruent Confidential and Proprietary © 2019 Page | 321

CHAPTER 80: Configure User Defined Fields (UDFs)



FIELD DESCRIPTION

Display on
Web

Select this option if you want the User Defined Field to be displayed when
users are making a Reservation in VEMS.

Display Text Enter the text that is to be displayed for the field in VEMS or EMS Web App.

Inactive Leave this option blank to add the User Defined Field an active field. Select
this option to inactivate the field.

4. If you selected any field type other than List, go Step 5. Otherwise, an Items tab is displayed on the
dialog box. Open the Items tab, and for each list item for the UDF, do the following:

l In the Sequence field, enter the sequence for the list item.
l Items are ordered in a list from lowest to highest sequence number, with the item with the low-

est sequence number being displayed first. If you set the sequence for all items to zero, then
the items are displayed in the list alphabetically.

l In the Description field, enter a name or description for the item.

Note: The description can be a maximum of 50 characters, including spaces.
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5. Optionally, click Spelling to spell check the User Defined Field before you save it.

6. Click OK. The User Defined Field dialog box will close and you will be returned to the User Defined
Fields window.

UDF Field Types 

Date UDF 
Allows the user to enter a value into a date field.

List UDF 
Allows the user to select an item or items from a list that you populate. The Allow Multi-Select option lets
the user pick more than more than one item from the list.

Items of a list are configured on the Items tab.

Numeric UDF 
Allows the user to enter ONLY a number into a text field.
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Text UDF 
Allows the user to enter any text into a text field.
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CHAPTER 81: Configure Reservation Sources
A reservation source indicates the origination of a reservation request(e.g., walk-up, email, VEMS, etc.). You
can specify a reservation source at the time that the reservation is being made in the Reservation Wizard,
or at a later date. You can also specify the reservation source as part of the search criteria when searching
for a reservation in the Browser. Configuring a reservation source simply consists of naming or describing
the source.

To configure a reservation source 

1. On the EMS menu bar, click Configuration > Other > Reservation Sources. The Reservation Sources
window opens. This window lists all the reservations sources that are currently configured in your
EMS database and that have a status of Active.

Reservation Sources window

Tip: Optionally, to view all reservation sources in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Reservation Source dialog box opens.

Reservation Source dialog box
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3. In the Reservation Source field, enter a name or description for the new source, for example, Phoned
In.

Tip: The reservation source can be a maximum of 50 characters, including spaces.

4. Leave Inactive blank to add the reservation source as an active source. Optionally, select Inactive to
inactivate the source.

5. Click OK. The Reservation Source dialog box closes. You return to the Reservation Source window
with the newly configured source automatically selected.
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CHAPTER 82: Configure Cancel Reasons
When you are canceling a reservation in your EMS system, you can indicate a reason for the cancellation.
You can configure a cancel reason that is as simple as a single word or phrase (for example, Event
Postponed, Other, Will Reschedule), or you can configure it so that the user who is canceling the
reservation must enter additional information about the cancellation.

To configure a cancel reason

1. On the EMS menu bar, click Configuration > Other > Cancel Reasons.

The Cancel Reasons window opens. This window lists all the cancel reasons that are currently configured in
your EMS database and that have a status of Active.

Cancel Reasons window

Optionally, to view all cancel reasons in your EMS database, regardless of status, under
Show, click Inactive.

2. Click New.

The Cancel Reason dialog box opens.
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Cancel Reason dialog box

3. In the Cancel Reason field, enter a name or description for the new cancel reason, for example, Cus-
tomer Postponed.

The cancel reason can be a maximum of 50 characters, including spaces.

4. Optionally, do one or more of the following:

l If you want the user who is canceling the reservation to enter supporting information for this cancel
reason, select Require Notes.

l If you want the cancel reason to be listed as an option for a user who is canceling the event in VEMS,
then select Display on Web.

l By default, a cancel reason is added as an active reason. Select Inactive to inactivate the reason.

5. Click OK.

The Cancel Reason dialog box closes. You return to the Cancel Reasons window with the newly added
reason automatically selected.
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CHAPTER 83: Configure Attachment Types
The term attachment is used to describe any file that you can add to or store on a reservation or booking.
(Unlike a drawing, which is simply referenced, an attachment is actually stored in the EMS database with
the reservation or booking record.) Attachments can be used for a variety of purposes, such as providing
information about your company’s alcohol policies, any special food concerns for the event’s attendees,
and so on. You can configure and store a variety of attachment types and then your users can select
whichever type is most appropriate when working with attachments for a reservation or booking.

An attachment can also be a file that is saved with the room record or a group record. You do not specify
an attachment type for a room record. For information about adding an attachment to a room record,
see To add attachments to a room. For information about adding an attachment to a group, see the EMS
User’s Manual.

To configure an attachment type

1. On the EMS menu bar, click Configuration > Other > Attachment Type. The Attachment Types win-
dow opens. This window lists all the attachment types that are currently configured in your EMS data-
base and that have a status of Active.

Attachment Types Window
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Tip: Optionally, to view all attachment types in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Attachment Type box opens.

Attachment Type Dialog Box

3. In the Description field, enter a name or description for the new attachment type, for example, Alco-
hol Policy.

Tip: The description can be a maximum of 30 characters, including spaces.

4. By default, an attachment type is added as an active type. Select Inactive to inactivate the attachment
type.

5. Click OK. The Attachment Type dialog box closes. You return to the Attachment Types window with
the newly added attachment type automatically selected.
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CHAPTER 84: Configure Word Merge Documents (Optional Mod-
ule)
EMS provides options for producing pre-formatted documents that contain reservation information such
as confirmations. Your organization, however, might have
organization-specific information that must be included in these documents. Using the optional Word
Merge module, you can configure Word Merge documents to produce confirmations, contracts, and so on
that contain not only selected reservation information from EMS, but also, any information that is required
by your organization. To configure a Word Merge document, you must first create the Word document
and apply the appropriate tags to indicate the information in EMS that is to be pulled into the document.
You can then add this document to your EMS database and use it to generate confirmations, contracts,
and so on.

This topic will provide the following information: 

l Create and Tag a Word Document
l Add the Tagged Word Document to Your EMS Database

Create and Tag a Word Document

1. Create the necessary document in Microsoft Word.

2. Tag the text that is to be replaced with EMS field values accordingly. For example, if you want the
Reservation Status in the Word document to be replaced with the EMS field value for Reservation
Status, then any reference to Reservation Status in the Word document should be tagged as
<<Reservation Status>>.

Tip: To view a complete list of the text that can be replaced in the Word document with EMS field values
and the correct tags for this text, on the EMS menu bar, click Configuration > Other > Word Merge
Documents, and on the Word Merge Documents window that opens, click Print > Word Merge Format. If
you want to save this document for easier access and reference, then after opening the document, click
Export on the document toolbar, and export the document as a Rich Text Format (.rtf) document to a
location of your choosing. You can then use Microsoft Word to open the document at any time.

Add the Tagged Word Document to Your EMS Database

1. On the EMS menu bar, click Configuration > Other > Word Merge Documents. The Word Merge
Documents window opens. This window lists all the Word Merge documents that are currently con-
figured in your EMS database and that have a status of Active

Word Merge Documents Window
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Tip: Optionally, to view all Word Merge documents in your EMS database regardless of status, under Show,
click Inactive. The Word Merge Document dialog box opens.

2. Click New.

Word Merge Document Dialog Box

Accruent Confidential and Proprietary © 2019 Page | 332

CHAPTER 84: Configure Word Merge Documents (Optional Module)



3. In the Description field, enter the name or description for the Word Merge document.

Tip: The description can be a maximum of 50 characters, including spaces.

4. Click the Search icon to open the Find Microsoft Word Document dialog box, and then browse to and
select the Word document. The Find Microsoft Word Document dialog box closes. You remain on the
Word Merge Document dialog box tab with an entry for the document displayed in the Document
field.

5. Optionally, do one or more of the following:

l Select a default attachment type for the document.

Tip: If the appropriate attachment type is not available, you can configure it. See Configuring Attachment
Types.

l Click Spelling to spell check the attachment notes before you save the document.
l By default, a Word Merge document is added as an active document. Click Inactive to inactivate the

document.

6. Click OK. The Word Merge Document dialog box closes. You return to the Word Merge Documents
window with the newly configured document automatically selected.
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CHAPTER 85: Configure Calendar Styles
Calendar styles determine the font, font size, and color (for example, Arial, 9 pt., Black) that are used when
event information is printed on the Event Schedule report and on the Event Calendar report.

For both reports, you must select the Use Calendar Styles option on the Options tab. You set the calendar
style that is to be used for an event when making the reservation for the event in the Reservation Wizard.
See the EMS User’s Manual.

To configure calendar styles

1. On the EMS menu bar, click Configuration > Other > Calendar Styles. The Calendar Styles window
opens. This window lists all the calendar styles that are currently configured in your EMS database
and that have a status of Active.

Calendar Styles Window

Tip: Optionally, to view all calendar styles in your EMS database, regardless of status, under Show, click
Inactive.

2. Click New. The Calendar Style dialog box opens.

Calendar Style Dialog Box
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3. Enter the information for the new calendar style.

l In the Calendar Style field, enter name or description for the calendar style.

Tip: The calendar style can be a maximum of 50 characters, including spaces.

l In the Font field, the default calendar style is listed. You can leave this value as is, or you can click the
Browse button to open the Font dialog box, and specify the font, font size, and font color for the new
calendar style.

Tip: To reset the font characteristics to their default values, click Reset.

4. Leave Inactive blank to add the calendar style as an active style. Optionally, select Inactive to inactive
this calendar style.

5. Click OK. The Calendar Style dialog box closes. You return to the Calendar Styles window with the
newly configured calendar style automatically selected.
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CHAPTER 86: System Administration Configuration > Settings
In addition to configuring core data items that are specific to your organization, you must configure
settings that determine a variety of operational factors for your EMS installation, such as system-wide
parameters, registration information, email settings, and Reservation Wizard required fields.
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CHAPTER 87: Edit System Parameters
System parameters are global settings that affect all your EMS users, your VEMS users, or your EMS Kiosk
users. The parameters are grouped first by system (EMS, VEMS, or EMS Kiosk) and then by the functional
areas that they affect (Billing, Email, and so on). When any system is first installed, the parameters are set to
their default value. Although you can edit the value for a system parameter whenever necessary, you
typically set the value for a system parameter at the time you are configuring your EMS, VEMS, and EMS
Kiosk implementations.

See System Parameters, for detailed definitions of the available system parameters and their default
values.

1. On the EMS menu bar, click System Administration > Settings > Parameters. The Parameters win-
dow opens. This window lists all the current global settings for the parameters that affect all EMS
users (EMS tab), all VEMS users (Virtual tab), and all EMS Kiosk users (Kiosk tab). The EMS tab is the
active tab.

Parameters window, EMS tab

2. Open the tab that contains the parameter that you are editing.

3. Optionally, filter the list by area, by the parameter description, or both.

Tip: To filter by the parameter description, enter a search string in the Filter field. The search string is limited
to the exact order of the characters in the string, but the string is not case-sensitive, and it can appear
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anywhere in the search results. For example, a search string of Security both Security Status for a User and
Default Security Template for a User.

4. Select the parameter that you are editing, and then click Edit. The Parameter dialog box opens. This
dialog box displays the information that you can edit for the selected parameter.

5. Edit the parameter as needed, and then click OK. The Parameter dialog box closes. You return to the
Parameters window with the edited parameter automatically selected.

6. Confirm in the Value column that you have correctly edited the value for the parameter.

7. Click Close.
l If you edited EMS parameters, you might have to log out and then log back in to EMS to have

the changes take effect.
l If you edited VEMS parameters, a message opens indicating that virtual parameters have

changed, and that you must clear the VEMS cache for the changes to take affect. Click OK to
close the message, and then clear the VEMS cache by logging in to VEMS, clicking Admin >
Admin Functions, and then clicking Clear Cache.

l If you edited EMS Kiosk parameters, a message opens indicating that kiosk parameters have
changed, and that you must clear the kiosk cache for the changes to take affect. Click OK to
close the message, and then clear the kiosk cache by opening the EMS Kiosk config.aspx page.
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CHAPTER 88: Import Registration Information
The first time that your EMS application is accessed at your organization, a Registration dialog box opens.
You must import the license file (License.lic) that was received with the software to register your software.
You can change the database that your EMS system is using.

If you need to make any corrections to your registration information, contact sales@dea.com or 800-
440-3994, ext. 863 to have a license file with the corrected registration information sent to you. You can
then import this license file to update the registration information.

1. On the EMS menu bar, click System Administration > Settings > Registration. The Registration dialog
box opens. This dialog box displays the registration information that is contained in the license file—
your organization’s name and address, the EMS edition (Enterprise, Professional, and so on), the
license expiration date, the limits for your software edition, and any additional packages for which
your organization is licensed (for example, VEMS).

2. If the registration information is correct, then continue to Step 3; otherwise, if the information is incor-
rect, contact sales@dea.com or call 1-800-440-3994 to have a corrected license file sent to you.

Registration dialog box

3. Click Import, and in the Open File dialog box, browse to and select the license file (License.lic) that you
are importing, and then click Open. The License file is imported.

4. If you need to change the database that your EMS application is using, go to Step 5; otherwise, click

Accruent Confidential and Proprietary © 2019 Page | 339

CHAPTER 88: Import Registration Information



OK. The Registration dialog box closes. Your EMS application is now registered and is ready for use.
5. Click Change Database. The Provide Server Parameters dialog box opens.

Provide Server Parameters dialog box

6. Edit the server name and/or database name, and then click OK. EMS closes and the EMS Login win-
dow opens. You can now log in to EMS using the newly specified database.

Accruent Confidential and Proprietary © 2019 Page | 340

CHAPTER 88: Import Registration Information



CHAPTER 89: Configure the Confirmation Email Subject Line
In EMS, users can produce printed confirmations for events. They can also email confirmations directly to
the contact person. To make the emailing of confirmations efficient, EMS automatically fills in the subject
line on the email with text that you configure in the Confirmation Email Subject Line dialog box. Examples
of confirmation email subject lines include the following:

l Reservation 5421 for Acme, Inc., beginning 3/15/2012
l Confirmation for your event in Smith Hall on 3/22/2012

1. On the EMS menu bar, click System Administration > Settings > Confirmation Email Subject Line. The
Confirmation Email Subject Line dialog box opens. This dialog box displays the confirmation subject
line currently in use.

2. Enter the text and variables that are to make up the default subject line for every confirmation that is
emailed.

Concept: Variables pull in selected data from the event for which the confirmation is being
emailed.
You can include variables in the subject line as described in the Legend. For example, %2% is the code for
the group name, so “Reservation for %2%” would result in “Reservation for Academic Affairs” being
displayed in the subject line. Available variables include the following: Reservation ID, Group Name, Event
Name, Date of First Booking, Building Code, Room Code, and Location.

3. Click OK.
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CHAPTER 90: Configure Email Settings
The system administration email settings determine how your EMS implementation interacts with your
organization’s email standard—will it interact with Microsoft Outlook or must you configure it to use a
simple mail transfer protocol (SMTP), which is the default value? After installation of your EMS system, you
must configure these settings.

1. On the EMS menu bar, click System Administration > Settings > Email Settings. The Email Settings
dialog box opens.

2. Use one of the following methods to configure email:

l Leave Use SMTP selected, and then enter the appropriate values for Mode, Server, and Port in the
SMTP Email panel.

l Select Use Microsoft Outlook Only.
l Select SMTP for Mass Email Only Otherwise Use Microsoft Outlook, and then enter the appropriate

values for Mode, Server, and Port in the SMTP Email panel. Select this third option if you want to use
Outlook or Lotus Notes for all of your individual emails but use the mass email function found in the
Browser and the Calendar. If you select this option and you use Lotus Notes, then individual emails
open in the mass email window, but they are still sent via Lotus Notes.

l Select Use Lotus Notes. (Available only if Lotus Notes is installed on your computer.)

3. Click OK.
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CHAPTER 91: Configure Required Fields in the Reservation Wiz-
ard
To ensure that your users supply the information that is critical for your organization when making a
reservation, you can configure required fields in the Reservation Wizard. Required fields are marked with a
red dot in the Reservation Wizard.

1. On the EMS menu bar, click System Administration > Settings > Reservation Wizard Required Fields.
The Reservation Wizard Required Fields dialog box opens. This dialog box lists all the fields that are
available on the Reservation Wizard.

Reservation Wizard Required Fields dialog box

2. On the Available list, select the field or CTRL-click to select the multiple fields that are to be marked as
“Required” in the Wizard, and then click the Move button (>) to move the selected fields to the Selec-
ted list.

3. Click OK.
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CHAPTER 92: Video Conference Configuration
Standard EMS room configuration is suitable for organizations that use only built-in/fixed video conference
rooms for video conferences. For environments that use video conference mobile carts, however,
additional configuration options are available to simplify the video conference room/mobile cart request
process. When configured properly, EMS searches for all rooms that have a built-in video conferencing
feature and it searches for all rooms that can accommodate a mobile video conferencing cart. A room that
has a built-in video conferencing feature is displayed in the search results only if the room is available. A
room that can accommodate a mobile video conferencing cart is displayed in the search results only if the
room is available and at least one mobile video conferencing cart is available for selection. The end result of
this configuration is that after a reservation is complete, booking details are automatically created for a
user and does not have to add them manually. If a user selects a room that has a built-in conferencing
feature, then the feature is indicated for the room. If the user selects a room that uses a mobile video
conferencing cart, then the mobile cart is automatically added to the booking. This information can be
viewed like any other booking detail in the Navigator and on reports like the Setup Worksheet report.

Reservation with Video Conferencing Features Automatically Added to Bookings

You must configure the following three types of rooms to provide enhanced searching capability for rooms
that have a video conferencing feature:

l Meeting rooms with built-in video conference capability. Room availability for this type of room is
based on the true availability of the room for the time slot selected. If a user selects one of these
rooms, a booking detail (for example, “Built-in Video Conference Equipment”) is automatically cre-
ated after the reservation is submitted. This provides indication that a user is requesting use of the
video conferencing equipment in the room.

l Standard meeting rooms that can accommodate a mobile video conferencing cart. Room availability
for this scenario is based on the availability of the room and on the availability of the mobile video
conferencing cart resource pool. For a room to be displayed as available, at least one mobile video
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conferencing cart must be available for the time slot selected. If a user selects one of these rooms, a
booking detail for a mobile video conferencing cart is automatically added to the booking after the
reservation is submitted.

l A room or other location that is not managed in EMS that can accommodate a mobile video con-
ferencing cart. The room is configured as an Override Description room type. Room availability for
this scenario is based only on the availability of the mobile video conferencing cart resource pool. If a
user selects this room, the user is provided an option for entering a location. After the reservation is
submitted, a booking detail for a mobile video conferencing cart is automatically added to the book-
ing.

This behavior is driven in the EMS client by the selection of the video conferencing feature in the
Reservation Wizard. In VEMS, after you correctly configure a web process template that has the Video
Conference option selected, a VEMS user is not required to make any selections—the search for the
feature is carried out automatically and the user can select from a list of available rooms that meet the
search criteria.
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CHAPTER 93: Configure Video Conference Capabilities
When you are configuring video conferencing capabilities you must first configure the necessary features
and resources. After you configure the necessary features and resources, you can then configure the
rooms, the override rooms, and the web process templates that are needed to accommodate reservations
or room requests that require video conferencing capability. When you configure the rooms, one room
type must use the built-in video conferencing resource and one room type must use the mobile video
conferencing cart resource.

This topic provides information that will allow you to:

l Configure Video Conference Features and Resources
l Configure a Built-in Video Conference Room
l Configure a Room that Accommodates a Mobile Video Conferencing Cart
l Configure an Override Room that Can Accommodate a Mobile Video Conferencing Cart
l Configure a Video Conference Web Process Template

Configure Video Conference Features and Resources

1. Configure a video conferencing feature, for example, one named as simply as Video Conferencing.
When you configure this feature, you must select Tied to Resource. See Configuring Features.

2. Configure a category in which the video conferencing resources will be placed, for example, A/V, A/V
Equipment, Video Conferencing, or so on. See Configuring Categories.

3. Configure two distinct video conferencing resources for the category that you just created. See Con-
figuring Resources for a Category.

l A resource for built-in video conferencing equipment, for example, Built-in Video Conference Equip-
ment.

TIP: Do not select the Maintain Inventory option when you are configuring this resource.

l A resource for mobile video conferencing cart, for example, Mobile Video Conferencing Cart.

TIP: You must select the Maintain Inventory option when you are configuring this resource and you must
enter a value in the Quantity Available field.

Configure a Built-in Video Conference Room

1. Search for a room for which the video conferencing feature that you defined in Step 1.

2. Select the room, and then click Edit. The Room dialog box opens.
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3. Open the Features tab on the Room dialog box, and on the Available list, select this video con-
ferencing feature. The Resource Selector dialog box opens.

TIP: The feature is designated as being “tied to a resource.”

4. Select the resource that you designated for built-in video conferencing equipment. The Selected list
on the Features tab is updated with the selected feature/resource combination.

5. Click OK to save your changes.

6. Repeat this procedure for every room in your organization that has built-in video conferencing fea-
tures.

TIP: Remember, you can use the Room Configuration Wizard to mass assign a feature to multiple rooms in
a single step. See Room Administration Wizard.

Configure A Room That Accommodates a Mobile Video Conferencing Cart

1. Search for a room for which the video conferencing feature that you defined in Step 1 of To configure
features and resources is applicable.

2. Select the room, and then click Edit. The Room dialog box opens.

3. Open the Features tab on the Room dialog box, and on the Available list, select this video con-
ferencing feature. The Resource Selector dialog box opens.

TIP: The feature is designated as being “tied to a resource.”
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4. Select the resource that you designated for the mobile video conferencing cart. The Selected list on
the Features tab is updated with the selected feature/resource combination.

5. Click OK to save your changes.

6. Repeat this procedure for every room in your organization that can accommodate a mobile video
conferencing cart.

TIP: Remember, you can use the Room Configuration Wizard to mass assign a feature to multiple rooms in
a single step. See Room Administration Wizard.

Configure an Override Room That Can Accommodate a Mobile Video Con-
ferencing Cart

1. Configure an override room (for example, “Other”). See Configuring Rooms.

TIP: When you configure this room, make sure to select Override Description for the room classification.

2. On the Room dialog box, in the Available list, select the video conferencing feature that you defined
in Step 1 of To configure features and resources. The Resource Selector dialog box opens.

TIP: The feature is designated as being “tied to a resource.”
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3. Select the resource that you designated for the mobile video conferencing cart. The Selected list on
the Features tab is updated with the selected feature/resource combination.

4. Click OK to save your changes.

5. Repeat this procedure for every override room that can accommodate a mobile video conferencing
cart at your organization.

TIP: Remember, you can use the Room Configuration Wizard to mass assign a feature to multiple rooms in
a single step. See Room Administration Wizard.

Configure a Video Conference Web Process Template

1. Configure two video conferencing specific event types—one event type that is used to designate
which of the bookings in the reservation is the host location (for example, “Host VC”) and one event
type that is applied to all the other bookings in the reservation (for example, “VC”).

2. Configure a web process template with the following characteristics:

l The mode is Self Serve.
l The Video Conference option is selected for the template.
l The two Event Types that you created in Step 1 are selected for the template.
l On the Video Conference tab, On the Feature drop-down list, select the video conferencing feature

that you defined in Step 1 of To configure features and resources.
l On the Host Event Type drop-down list, select the video conferencing host Event Type that you

defined in Step 1.
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CHAPTER 94: Academic Import Utility
This appendix section details the purpose and implementation of the Academic Import Utility, which is an
optional, add-on component for EMS that is designed to communicate with academic scheduling
programs for one-off imports of course schedule data.
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CHAPTER 95: Configure the Academic Import Utility
The Academic Import Utility (AIU) is an optional, add-on component for EMS that is designed to manually
import from your Student Information System, or SIS. For each scheduled class that is being imported, a
single reservation with multiple bookings is created. One booking is created for each date on which the
class meets. All class reservations created by the import process are assigned to one Group (customer,
client, and so on) that you have configured in your EMS database. The imported class data can be one of
two formats, tab-delimited or fixed width. In addition, prior to using the AIU, you should have
certain items configured in your EMS database.

To import data, you must configure a session for each block of data (i.e. quarter or semester). After you
have configured a session, AIU saves the settings for use in both the initial import and any subsequent re-
import. When a session is re-imported, only events in the import file that have changed since the last
import are recreated in the EMS database. This prevents the unnecessary re-import of unchanged events
and the associated invalidation of large ranges of reservation numbers. After configuring a session, you
import the session.

WARNING: Creating reservations can take an extended time and must be performed when no users are
logged on to EMS. (To log off active users, see Viewing and Emailing Logged-In Users.) The time
required to create reservations varies depending on the amount of data involved and the processing
power of the computer making the reservations. After the import process completes, the system
automatically displays a report listing booking conflicts, if any.

Reservations that were added to the EMS database using the AIU can be removed from the database using
the AIU as well. Deleting a session removes all reservations created using the session.

TIP: Before you configure an AIU session, you should review the Academic Import Days of the Week setting
in your system parameters. This setting dictates whether the AIU interprets days of the week based on
their position within the data (with options for Sunday first or Monday first) or based on specific text
entries (Su = Sunday, M = Monday, and so on). See EMS System Parameters.

TIP: All fields are required unless noted otherwise.

FIELD FIELD

SEQUENCE

MAX

WIDTH

TYPE FORMAT EXAMPLE

Department 1 10 Alpha
numeric

Left Justified ACCT

Course 2 10 Alpha
numeric

Left Justified 101
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FIELD FIELD

SEQUENCE

MAX

WIDTH

TYPE FORMAT EXAMPLE

Section 3 10 Alpha
numeric

Left Justified 1

CourseTitle 4 50 Alpha
numeric

Left Justified Intro to Accounting

Instructor 5 50 Alpha
numeric

Left Justified Bob Smith

Days 6 7 Alpha
numeric

Left Justified Parameter driven. 
Positional or specific
text.

(e.g., “M W F” for
Positional, Monday
First)

Building 7 10 Alpha
numeric

Left Justified AC

Room 8 20 Alpha
numeric

Left Justified 101

BegTime 9 4 Numeric Zero Filled
(Numerics
only)

1400

EndTime 10 4 Numeric Zero Filled
(Numerics
only)

1450

StartDate
(Optional)

11 10 Date Formatted
(mm/dd/yyyy)

8/30/2017

EndDate
(Optional)

12 10 Date Formatted
(mm/dd/yyyy)

12/17/2017
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FIELD FIELD

SEQUENCE

MAX

WIDTH

TYPE FORMAT EXAMPLE

Attendance
(Optional)

13 5 Numeric Zero Filled
(Numerics
only)

35

Fixed Width Format 
TIP: All fields are required unless noted otherwise.

FIELD COLUMN WIDTH FIELD

TYPE

FORMAT EXAMPLE

Department 1 10 Alpha
numeric

Left Justified,
Trailing Spaces

ACCT

Course 11 10 Alpha
numeric

Left Justified,
Trailing Spaces

101

Section 21 10 Alpha
numeric

Left Justified,
Trailing Spaces

1

CourseTitle 31 225 Alpha
numeric

Left Justified,
Trailing Spaces

Intro to Accounting

Instructor 81 50 Alpha
numeric

Left Justified,
Trailing Spaces

Bob Smith

Days 131 7 Alpha
numeric

Left Justified,
Trailing Spaces

Parameter driven.
Positional or specific
text.

(e.g., “M W F” for
Positional, Monday
First)

Building 138 10 Alpha
numeric

Left Justified,
Trailing Spaces

AC
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FIELD COLUMN WIDTH FIELD

TYPE

FORMAT EXAMPLE

Room 148 20 Alpha
numeric

Left Justified,
Trailing Spaces

101

BegTime 168 4 Numeric Right Justified, Zero
Filled (numerics
only)

0800

EndTime 172 4 Numeric Right Justified, Zero
Filled (numerics
only)

1450

StartDate
(Optional)

176 10 Date Formatted
(mm/dd/yyyy)

08/30/2017

EndDate
(Optional)

186 10 Date Formatted
(mm/dd/yyyy)

12/17/2017

Attendance
(Optional)

196 5 Numeric Right Justified, Zero
Filled (numerics
only)

00035

Configured Items for the AIU 
Prior to using the AIU, you should have the following items configured in your EMS database:

ITEM DESCRIPTION

Group When reservations are created through the import process, one Group (client,
customer, and so on) is the reservation holder for all reservations. You might
want to define a group that is used specifically for the reservations that are
created through the import process, for example, Registrar's Office.

New
Bookings
Status

When running the AIU, you must specify a status for the new bookings that are
created. This status must of the “Book Space” status type. While you can use an
existing status such as Confirmed, it is generally best to create a new status (for
example, Academic - Confirmed) to denote the imported data.
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ITEM DESCRIPTION

Conflict
Status

You must create a conflict status to give to the new bookings if the room they
require is already booked. This status should have a status type of either “Info
Only” or “Wait,” as those types of bookings can be created even if there is
already a confirmed booking in the room. Academic - Conflict is a commonly
used name for this status.

Cross List
Status

You must create a status to apply to bookings when the system encounters
conflicts within an import file (i.e., the same class with different names). This
status should have a status type of either “Info Only” or “Wait.”

Override
Status

You can configure the settings in an AIU session to allow AIU bookings to
override existing bookings, if appropriate. The status is changed for the existing
bookings and the room is reserved for the imported bookings. You must create
an override status to apply to the bookings that have been bumped. This status
should have a status type of either “Info Only” or “Wait.”

In addition, you might want to define a unique Event Type and Setup Type that is to be used solely for class
reservations.

To import data, you must configure a session for each block of data (i.e., quarter or semester). After you
have configured a session, AIU saves the settings for use in both the initial import and any subsequent re-
import. When a session is re-imported, only events in the import file that have changed since the last
import are recreated in the EMS database. This prevents the unnecessary re-import of unchanged events
and the associated invalidation of large ranges of reservation numbers. After configuring a session,
you import the data for the session.

TIP: Creating reservations can take an extended time and must be performed when no users are logged in
to EMS. (To log off active users, see Viewing and Emailing Logged-In Users.) The time required to create
reservations varies depending on the amount of data involved and the processing power of the computer
making the reservations. After the import process completes, the system automatically displays a report
listing booking conflicts, if any.

Reservations that were added to the EMS database using the AIU can be removed from the database using
the AIU as well. Deleting a session removes all reservations created using the session.

TIP: Before you configure an AIU session, you should review the Academic Import Days of the Week setting
in your system parameters. This setting dictates whether the AIU interprets days of the week based on
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their position within the data (with options for Sunday first or Monday first) or based on specific text
entries (Su = Sunday, M = Monday, and so on). See EMS System Parameters.

Configure an AIU session 
TIP: This section describes the steps for configuring a new session for the AIU. If you simply need to load an
existing session, then after opening the Sessions window, skip to “To import the data into the session”.

1. On the EMS menu bar, click Reservations > Academic Import > Academic Import Utility. The Sessions
window opens. This window lists all the sessions that are currently configured in your EMS database.

2. Click New. The Session dialog box opens.

3. Enter the information for the new AIU session.
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FIELD DESCRIPTION

Session
Code

A unique identifier for the session, for example, SPRING18.

Description An expanded definition of the session code, for example, Spring Semester
2018.

Note: The description can be a maximum of 50 characters, including spaces.

Start Date

End Date

The start date and end date for the session, for example, 1/15/18 and
5/31/18.

Group The reservation holder for all reservations in the session. For example,
Registrar's Office. You can select a value from the Group drop-down list, or
you can click the Search icon to open the Groups window and create the
necessary group. See Configuring Groups.

Event Type Select a value from the drop-down list. If none of the event types that are
currently configured in your EMS database meets your needs, then you can
configure a type (for example, Academic). See Configuring Event Types.

Setup Type Select a value from the drop-down list. If none of the event types that are
currently configured in your EMS database meets your needs, then you can
configure a type (for example, Classroom). See Configuring Setup Types.

Status The status for the new bookings that are created.

Note: While you can use an existing status such as Confirmed, it is generally
best to create a new status (for example, Academic - Confirmed) to denote
the imported data. See Configuring Statuses.

Conflict
Status

Available after you specify a Status. Select a value from the drop-down list. If
none of the statuses that are currently configured in your EMS database meets
your needs, then you can configure a status (for example, Academic -
Conflict). See Configuring Statuses.

Use Cross
List Status

Select this option if the system is to apply a special status to classes that are
cross-listed in the import file. (The class appears twice in the file, with each
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FIELD DESCRIPTION

occurrence having a different name.)

Cross List
Conflict
Status

Available if you select Use Cross List Status. The status that is to be applied to
cross-listed classes. Select a value from the drop-down list. If none of the
statuses that are currently configured in your EMS database meets your needs,
then you can configure a status (for example, Academic - Cross List).
See Configuring Statuses.

Override
Existing
Bookings

Select this option if the system is to give import file events precedence over
existing events in the EMS database.

Override
Conflict
Status

Available if you select Override Existing Bookings. The status that is to be
applied to existing events if they are overridden by imported events. Select a
value from the drop-down list. If none of the statuses that are currently
configured in your EMS database meets your needs, then you can configure a
status (for example, Academic - Conflict). See Configuring Statuses.

Reservation
Source

Select a source for the reservation. If none of the sources that are currently
configured in your EMS database meets your needs, you can configure a
source. See Configuring Reservation Sources.

4. Click OK. The Session dialog box closes. You return to the Sessions window with the newly configured
session displayed in the window.

5. Continue to “To import the data into the session.”

Import the Data into the Session 

1. Select the session that you are using for importing classes, and then click Load. The first of three AIU
windows opens.
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2. Click the Search icon to browse to and select the file that you are importing.

3. On the Import Format drop-down list, select the format for the file (Fixed Width or Tab Delimited).

4. Click Next. Two results are possible:

l If any of the records in the import file have any issues (missing data, data that is not in the correct
format, data that falls outside the start and/or end dates, and so on) a message opens that details
the issue and if applicable, the number that cannot be imported, and asking if you want to continue.
You can click No in the message, and then correct the errors in the file before you load the file again,
or you can click Yes in the message, and then click Next to continue.

Optionally, you can do one or both of the following:

l You can click View Errors for more information.
l You can click Export Errors to export the errors in the import file an XML format.

l The import file is complete and there are no issues with the file, so no message opens. Click Next to
continue.

The second of three AIU windows opens. This window lists the academic Building and the Room that are
currently reserved for all the classes in the import file. For a new import file, the Building/Room
combinations have a status of Assigned or Do not Import. Unassigned classes must be assigned to a room
in EMS. Classes with a status of “Do Not Import” are not to be assigned to a room in EMS. 
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5. Optionally, select a different View option and/or a different Building option to filter the information
that is displayed in the window. (The default display is all views (Assigned, Unassigned, and Do not
Import) for all buildings.)

6. Select an unassigned class, or CTRL-click to select the multiple unassigned classes, and then click
Assign. The Room Selector dialog box opens.

7. On the Building drop-down list, select the building or view by which to filter the available rooms list.

8. On the Available rooms list, select the room to which the classes are to be assigned, and then click
OK. Two results are possible:

l If you selected a single class to assign to the room, then the class status is changed to Assigned in the
AIU window. The EMS Building code and EMS room name are displayed for the class in the AIU win-
dow.

l If you selected multiple classes to assign to the same room, then a message opens asking you if you
are sure that you want to assign all the selected items to the same room. Click Yes in the message.
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The class status is changed to Assigned for all the selected classes in the AIU window. The EMS Build-
ing code and EMS room name are displayed for the classes in the AIU window.

9. Click Next. The third AIU window opens. In the right pane, the window lists the dates for which book-
ings will be created for the selected classes.

10. Optionally, do one or both of the following:

l To add more booking dates, select the date in the left pane, and then click the Add button to open
the Date Pattern dialog box and specify the date patterns for the bookings that should be created.

l To delete booking dates, select the date in the right pane, and then click Delete.

11. After you have added or deleted the necessary booking dates, click Finish. A message appears indic-
ating that the session was successfully imported.

12. Click OK to close the message and return to the Sessions window.
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CHAPTER 96: System Administration Configuration > User Secur-
ity
In addition to configuring core data items that are specific to your organization, you must configure
settings that determine a variety of operational factors for your EMS installation, including user security
settings. These settings determine the functions to which your users have access in your EMS installation.

User Security enables you to control security (what users have access to) by:

l User templates (and processes)
l Users
l User security

Security Menu

Plan Your Security Configuration
You can fine-tune security by configuring actions users should be allowed to take, information they can
see, and rooms and buildings they can book. We recommend you configure security for EMS in the
following phases:

l Configure Booking Templates
l Configure User Templates (and associate them with User Processes)
l Configure Users (using User Templates as needed)

Concept: You Can Grant User Access to Categories, Processes, Buildings, Rooms, Statuses, and
Queries by Group With User Templates. (Click to Expand)
A user template defines the categories, processes, buildings, rooms, statuses, and queries to which a group
of EMS users has access. Instead of defining users individually and then configuring security for each user,
you can configure a template and then assign all the users who are to have the same security settings to a
given template in a single step. You can configure a user template entirely from “scratch,” or you can copy
an existing user template, and then make the necessary edits to configure another template.
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CHAPTER 97: Overview of User Processes
When you configure a user template or a user account, you must assign one or more processes to the
template or account. Each process grants a specific permission to the user. The following sections detail
the event processes or academic event processes that you can assign to a user template or account, or an
academic user template or account, respectively, and the permissions that are granted to the user by each
process.

Tip: Before assigning processes to a user template account, read through all the processes and note the
implied relationships between certain items. For example, if you plan to give a user the right to edit a
booking, you must also give the user the right to open a booking.

Event Processes 
Event processes are categorized according to the following:

l Billing Processes 
l Configuration Processes 
l Inquiry Processes 
l Report Processes 
l Reservation Processes 
l Special Processes 
l Hoteling Processes (Available only in EMS Workplace)

Billing Processes 

PROCESS PERMISSION GRANTED

Ageing Report Run the Ageing report.

Browse Transactions Use the Browse Transaction function.

General Ledger Distribution Run the General Ledger Distribution report.

Invoice Detail Report Run the Invoice Detail report.

Invoicing Run the Billing Worksheet report and generate
invoices.

Payments, Deposits & Enter payments, deposits, and adjustments.
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PROCESS PERMISSION GRANTED

Adjustments

Reprint an Invoice Reprint an existing invoice.

Statements Print financial statements for groups.

Transaction Report Print the Transaction report.

Void an Invoice Void an existing invoice.

Voided Transaction Report Print the Voided Transaction report.

Configuration Processes 

PROCESS PERMISSION GRANTED

Configure Web
Template LDAP
Groups

Shows the LDAP Groups tab in the Web Process Template settings
window.

Warning: This tab reveals the names of your Active Directory or other
LDAP-type Groups.

Define and Edit
[Configuration
Item]

Add, change, or delete indicated configuration item. For example, Define
& Edit Accounts provides add, change, or delete rights to the Accounts
that are configured in your system.

Resource
category items
[Category
Name]

Resource categories that you have defined are also included as
Configuration processes. Add, change, or delete resources from the
selected categories.

Web Data
Translation

Allows a user to provide translations for items on the web.

Inquiry Processes 

PROCESS PERMISSION GRANTED

Browse Use the Browser to search for existing reservations, bookings, service
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PROCESS PERMISSION GRANTED

Reservations orders, and resources.

Calendar
Inquiry

View the Calendar Inquiry, which shows the number of bookings on each
day of a month in a wall calendar-type format.

Open
Reservation
Book

View the Reservation Book, which displays bookings for a day, week, or
month as colored bars on a room/timeline grid.

Resource
Calendar
Inquiry

View the Resource Calendar, which shows, on a monthly calendar, the
number of times an item is reserved.

Visitors Open the Visitors browser, which lists attendees by date and identifies
visitors as such.

Report Processes 

REPORT NAME PERMISSION GRANTED

< > Report Run, review, and print the indicated report.

Define and Edit
Queries

Create and edit the queries that have been created in the Query
Builder.

Reservation Processes 

PROCESS PERMISSION GRANTED

Academic Import
(Academic Import
Module)

Run the Academic Import Utility, which you use to manually
import an academic course schedule into EMS.

Attendance Entry Use the Attendance Entry function to note the actual attendance
for bookings that took place on a particular date.

Delete Attachments Give a user the ability to delete attachments for a room record, a
reservation, a booking, or a group.
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PROCESS PERMISSION GRANTED

Email History Review email history.

Manage Services Give a user access to Manage Services option on the EMS toolbar
and under the Reservations menu.

Open Navigator Open a reservation in the Navigator window.

Open Reservation
Wizard

Create a single-date or series reservation using the Reservation
Wizard. This process also provides read-only access to groups.

Reminders Use the Dashboard to add and manage reminders.

Special Processes 

PROCESS PERMISSION GRANTED

Allow
Department
Selection

Select any of the defined departments when billing.

Copy
Reservation

Copy a reservation, including all its bookings and details, from one date or
date range, to another reservation.

Define Public
Memorized
Reports

Define the settings for public memorized reports.

EMS API Web
Service Access

Used for optional EMS API.

Explode
Combo Room

Use the Explode Combination Bookings utility, which takes the booking of
combination room and breaks it down into bookings for the components
of the combination room.

Edit Booking
Details

Add or edit booking detail information.

Edit Critical Edit booking information that could cause one booking to be in conflict
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PROCESS PERMISSION GRANTED

Booking
Information

with another. The critical booking data items are date, reserved time,
room, and status.

Edit Non-
Critical
Booking
Information

Edit booking information that will not cause one booking to be in conflict
with another (for example, the event name or the setup type and count).

Edit Pricing Change the pricing on a booking detail item that has been reserved.

Edit
Reservation
Information

Edit reservation information.

View and Book
Access On All
Rooms

Grants rights to an EMS user for all rooms without having to explicitly
provide access on the Rooms tab.

Note: This overrides any selections that have been made in the Room
Access area.

Web Processes (Web Admin and Guest Request) 

PROCESS PERMISSION GRANTED

Define and Edit Web
Cultures

Define and edit web cultures (the languages that are available for
translation) in VEMS.

Define and Edit Web
Menus

Define and edit web menus, including the creation and
modification of links from VEMS to other web pages.

Define and Edit Web
Process Templates

Define users’ access to process templates that are used in VEMS.

Define and Edit Web
Security Templates

Define users’ access to security templates that are used in VEMS.

Define and Edit Web
Text

Define and edit web help text, page labels, and so on.
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PROCESS PERMISSION GRANTED

Define and Edit Web
Users

Define and edit the users who have access to VEMS.

Web Reservations Run the Web Reservations Browser, which displays reservations
entered into your EMS database through VEMS.

Hoteling Processes 

PROCESS PERMISSION GRANTED

Booking Notice
Statistics

Run, review and print the Booking Notice Statistics report.

Check In Status Run the Check In Status utility, which allows users to determine
whether a group has checked in (or out) at your facility.

Check In Statistics Run, review and print the Check In Statistics report.

Define and Edit
Reservation Wizard
Templates

Add, change, or delete reservation wizard templates.

Early Check Out Report Run, review and print the Early Check Out Report.

Arrivals and Departures
Report

Run the Arrivals and Departure report, which lists the respective
arrival and departure times for each booking.

Groups With Multiple
Bookings

Run, review and print the Groups With Multiple Bookings report.

No Show Report Run, review and print the No Show Report.

No Show Wizard Run the No Show Wizard.

Room Occupancy
Summary

Run, review and print the Room Occupancy Summary report.

Transition Report Run, review and print the Transition report.

Visitor Report Run, review and print the Visitor report.
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Academic Event Processes 
Academic event processes are categorized according to the following:

l Administrative processes
l Academic Planning Interface processes
l Configuration processes
l Course processes
l Inquiry processes
l Report processes

Administrative Processes 

PROCESS PERMISSION GRANTED

Administrative processes

Allow Domain
Selection

Allows the user to select from all domains that are configured in
the Academic planning area.

Copy Term
Preferences

Allows a user to copy course preferences from one term to another.

Define and Edit
Domains

Create and/or edit domains within the Academic Planning-
Configuration area of EMS Academic Planning.

Define and Edit Final
Exam Schedule
Templates

Allows the user to create or make changes to the Final Exam
Schedule template.

Define and Edit Final
Exam Sessions

Allows the user to create and publish final exam sessions.

Define and Edit
Optimization
Scenarios

Allows the user to create and apply an optimization scenario.

Edit Terms Allows the user to edit the mode of a term.

Manually Update SIS Allows the user to manually push location updates back to the SIS,
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PROCESS PERMISSION GRANTED

assuming that this has not been automated in the system
parameters.

Publish/Unpublish
Terms

Allows the user to publish a term and create room reservations in
EMS or unpublish a term and delete room reservations in EMS.

EMS ACADEMIC Planning Interface Processes

PROCESS PERMISSION GRANTED

Web
Administrator

Grants access to the administrative functions after the user is logged in to
the EMS Academic Planning Interface client.

CPI Configuration Processes 

PROCESS PERMISSION GRANTED

Define and Edit
Academic Units

Allows the user to add or edit academic units.

Define and Edit Course
Types

Allows the User to assign course types to event types.

Define and Edit
Instructors

Allows the user to set the importance level of synchronized
instructors.

Match Course
Type/Room Types

The user can match a course type to a room type (or vice-versa)
for course optimization.

Synchronize Academic
Unit

User can synchronize the specified item from the SIS.

Synchronize Buildings User can synchronize the specified item from the SIS.

Synchronize Course
Types

User can synchronize the specified item from the SIS.

Synchronize Courses User can synchronize the specified item from the SIS.
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PROCESS PERMISSION GRANTED

Synchronize Instructors User can synchronize the specified item from the SIS.

Synchronize Room
Types

User can synchronize the specified item from the SIS.

Synchronize Rooms User can synchronize the specified item from the SIS.

Synchronize Subjects User can synchronize the specified item from the SIS.

Synchronize Terms User can synchronize the specified item from the SIS.

CPI Course Processes 

PROCESS PERMISSION GRANTED

Add Courses Allows the user to add new courses during Define & Edit mode or Dual
mode.

Add Sections Allows the user to create a new section of an existing course (copy
courses) during Define & Edit mode or Dual mode.

Edit Course
Credit Hours

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Days of the
Week

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Enrollment

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Instructor

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Notes

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Number

User can edit the specified course detail during Define & Edit mode or
Dual mode.
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PROCESS PERMISSION GRANTED

Edit Course
Seat Fill

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Section

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Start/End Dates

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Start/End Times

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Subject

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Title

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit Course
Type

User can edit the specified course detail during Define & Edit mode or
Dual mode.

Edit/Cancel
Courses

The user edit or cancel existing courses during Define & Edit mode or
Dual mode.

Override Time
Block Patterns

The user can edit the Time Block for a term during Define & Edit mode or
Dual mode.

Preassign
Scenarios

The user can create and run Pre-assignment optimization scenarios
during Set Preferences mode or Dual mode.

Search for
Rooms

The user can search for rooms during Define & Edit mode or Dual mode.

Set Preferences The user can set preferences for the course (for optimization) during Set
Preferences mode or Dual mode.

Set Specific
Room

The user can choose a specific room in Set Preferences mode or Dual
mode.
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PROCESS PERMISSION GRANTED

Preferences

Share Space
Across Domains

The user can share space between two courses on different domains
during Define & Edit mode or Dual mode.

Share/Unshare
Space

The user can share space (or unshare space) between two courses on the
same domain during Define & Edit mode or Dual mode.

CPI Inquiry Processes 

PROCESS PERMISSION GRANTED

Academic Book The user can access the Academic Book.

Academic Browser The user can access the Academic Browser.

Open Course Navigator The user can open a course in the Navigator window.

CPI Report Processes 

REPORT NAME PERMISSION GRANTED

< > Report User can run and print the indicated report.
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CHAPTER 98: Configure Users
Users are the people who log in to EMS Desktop Client whether they are making reservations or just using
the system in a read-only capacity. When your EMS Desktop Client application is first installed, it is installed
with a default user admin account with “admin” for both the User ID and password. As EMS recommends,
for security reasons, after you log in to EMS Desktop Client the first time using “admin” as both the
username and password, at a minimum, you should change the account password. Ideally, you should
configure an entirely new administrator account with a new username and password. You must also
configure all the necessary accounts for your users, which includes assigning processes to the user account.
You can create user accounts entirely from “scratch,” or you can copy an existing user account, and then
make the necessary edits to the account for another user. You can also export a list of all your user
accounts to an Excel spreadsheet.

Tip: Instead of configuring user accounts individually, you can configure a template and then assign it all
users you want to have the same security settings. See Also: Configuring User Templates.

This topic will provide information on the following:

l Configure an EMS Desktop Client User
l Set EMS Desktop Client User Event Security
l Set EMS Desktop Client User Categories
l Set EMS Desktop Client User Processes
l Configure EMS Desktop Client User Building Rights
l Specify EMS Desktop Client User Room Access
l Set User Status Options
l Set User Queries Option
l Set User Academic Security (EMS Academic Planning Only)
l Set User Processes (EMS Academic Planning Only)
l Export a List of User Accounts

Configure an EMS Desktop Client User

1. On the EMS menu bar, navigate to System Administration > Security > Users. The Users window
opens. This window lists the names and types for all users who currently have an account for your
EMS installation and that have a status of Active.

Users Window
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Tip: You can see all user accounts, regardless of status: under Show, click Inactive.

Note: The remainder of this procedure describes how to configure a user account “from scratch.” You can
also configure a user account by copying an existing account. Select the user account that you want to
copy, click Copy, and then continue to Step 3.

2. Click New. The User dialog box opens.

User Dialog Box

3. Enter basic information for the new user in this dialog box and use the menu options to the left to
define the user's access for each of the following: categories, processes, building configuration, room
access, statuses and queries, and for EMS Academic Planning, academic properties and processes
(see the additional procedures in this topic).

User Fields
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FIELD DESCRIPTION

Name First and last name for the user.

Administrator Select this option if the user is to be an EMS Administrator.

Note: If you select this option, then only Event Properties remains displayed
on the User dialog box as an EMS administrative user has access to all EMS
functions (categories, processes, buildings, rooms, statuses, and queries).

Initials The user’s initials, which are printed at the bottom of all reports as well as
the date and time that the user ran the report.

Login Section

User ID The ID that the user must use to log in to EMS.

Note: The User ID must be 20 characters or less, including spaces.

Password The password that the user must use to log in to EMS.

Note: The user can change this password.

Network ID If you enter a value in this field, the user is automatically logged in to EMS
based on the user’s Windows credentials without being asked to enter a
user ID and password.

NOTE: Enter the network domain along with the network ID, such as
DOMAIN\john.doe.

External
Reference

Links the user account to an outside program, if needed.

Contact Information

Phone The phone number for the user. This value is not printed on any
correspondence (reports, emails, and so on) from the user.

Fax The fax number for the user. This value is not printed on any
correspondence (reports, emails, and so on) from the user.

Email The email for the user. This value is not printed on any reports that the user
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FIELD DESCRIPTION

Address generates; however, this is a required value if the user wants to email
reports or confirmations from EMS using the SMTP email option.

Job Information

Title The user’s title, such as Mr., Ms., and so on.

Notes Any additional information that is relevant to the user.

Note: This information is not printed on any report.

Inactive Leave this option blank to add the user as an active user. Select this option
to inactive the user’s account. An inactive user cannot log in to EMS.

4. Click OK. The User dialog box closes. You return to the Users window with the newly configured user
automatically selected.

Set EMS Desktop Client User Event Security

1. If needed, open the User dialog box.

2. Select Event Properties. The User dialog box is refreshed with options for the event security settings
for the user.

User Dialog Box, Event Properties

3. Specify the event security settings for the user.

Event Properties Field
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FIELD DESCRIPTION

Event Properties Section

Template If you select a template, then only the Event Properties options remain available.
The categories, processes, buildings, rooms, statuses, and queries are
automatically assigned to the user based on the selected template.

Defaults Section

All the values that you select here (Building, Status, Event Type, Event Name,
Event Time, Reservation Source, and Time Zone) are displayed by default when
the user opens the Reservation Wizard to make a reservation; however, the user
can edit any and all values as needed.

4. Continue with any other configuration for the user as needed; otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Set EMS Desktop Client User Categories 
You specify the categories that a user can add to a booking or edit for a booking on the Categories tab.

1. From the User Dialog Box, select Categories. The User dialog box is refreshed with a list of all the act-
ive categories that you can select for the user.

User Dialog Box, Categories
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3. On the Available list, select the category or CTRL-click to select the multiple categories to which a
user is to have access, and then click the Move button (>) to move the selected categories to the
Selected list.

Tip: To add these categories to a booking, a user needs access to the Edit Booking Details process.

4. Continue with any other configuration for the user as needed; otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Set EMS Desktop Client User Processes 

1. From the User dialog box, select Processes. The User dialog box is refreshed with a list of all the pro-
cesses that you can select for the user.

User Dialog Box, Processes

2. On the Available list, select the process or CTRL-click to select the multiple processes to which a user
is to have access, and then click the Move button (>) to move the selected processes to the Selected
list.

Tip: For an explanation of each process, see Overview of User Processes.

3. Continue with any other configuration for the user as needed; otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Configure EMS Desktop Client User Building Rights
You specify the building configuration rights for a user on the Buildings tab.
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1. From the User dialog box, select Configure Buildings. The User dialog box is refreshed with a list of all
the buildings that you can select for the user.

User Dialog Box, Buildings

3. On the Available list, select the building or CTRL-click to select the multiple buildings to which a user
is to have access, and then click the Move button (>) to move the selected buildings to the Selected
list.

Tip: Define and Edit Buildings andDefine and Edit Rooms security processes are required for a user to
have configuration access to selected buildings.

4. Continue with any other configuration for the user as needed. Otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Specify EMS Desktop Client User Room Access 
You specify the rooms to which a user has access on the Room Access tab.

1. From the User dialog box, select Room Access. The User dialog box is refreshed a options for search-
ing for the rooms to add to the user account.

User Dialog Box, Room Access
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2. Search for the rooms to which the user is to have access by doing one or both of the following and
the Available list will update with a list of rooms that meet your search criteria:

l On the Building drop-down list, select (all) buildings, a specific building, an area, or a view.
l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.

3. On the Available list, select the room or CTRL-click to select the multiple rooms to which a user is to
have access, and then click the Move button (>) to move the selected rooms to the appropriate Selec-
ted list.
Tip: EMS Enterprise has both the View and Book and the View Only access for user security. EMS
Professional has just the View and Book access for user security.

l View and Book—A user who has access to the Special - Edit Critical Booking Information
process and who is assigned to this option can reserve the room, move an event into or out of
the room, change the time or status of an event that is scheduled in the room, and add
resources to events in the room.
Tip: The Special - View and Book Access On All Rooms process can be used as an alternative to
manually assigning all rooms to the View and Book list.

l View Only—A user who is assigned to this option cannot reserve the room, move an event into
or out of the room, or change the time or status of an event that is scheduled in the room; how-
ever, as long as the user has access to the appropriate category and to the Special - Edit Book-
ing Details process, the user can view events in the room and add resources to events in the
room.

4. Continue with any other configuration for the user as needed; otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.
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Set User Status Options
You select the statuses to which a user is to have access on the Statuses tab. A user needs access to a
status in order to create a reservation with the status or edit a booking with the status.

1. From the User dialog box, select Statuses. The User dialog box is refreshed with a list of all the active
event statuses that you can select for the user.

User Dialog Box, Statuses

2. On the Available list, select the status or CTRL-click to select the multiple statuses to which a user is
to have access, and then click the Move button (>) to move the selected statuses to the Selected list.

3. Continue with any other configuration for the user as needed. Otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Set User Queries Option
You specify the queries that a user can run on the Queries tab.

Tip: You can specify the queries to run by user only in EMS Enterprise. All queries are available to all users in
EMS Professional.

1. From the User dialog box, select Queries. The User dialog box is refreshed with a list of all the defined
queries that you can select for the user account.

User Dialog Box, Queries
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2. On the Available list, select the query or CTRL-click to select the multiple queries to which a user is to
have access, and then click the Move button (>) to move the selected queries to the Selected list.

3. Continue with any other configuration for the user as needed; otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Set User Academic Security (EMS ACADEMIC PLANNING Only) 

1. From the User dialog box, select Academic Properties. The User dialog box is refreshed with options
for the academic security settings for the user.

User Dialog Box, Academic Properties (EMS Academic Planning only)

2. Specify the academic security settings for the user.
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Academic Security Fields

FIELD DESCRIPTION

Type l Domain — The domain (typically renamed to campus or school) to which
the user belongs.

l Academic Unit — The academic unit (typically renamed to academic
department or division) to which the user belongs.

Domain The domain to which the user belongs.

Academic
Unit

Available only if the user is assigned the type of “Academic Unit.” The academic
unit to which the user belongs.

Template The academic template to which the user is assigned. The template determines
the academic processes to which the user has access.

3. Continue with any other configuration for the user as needed. Otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Set User Processes (EMS Academic Planning Only) 

1. From the User dialog box, select Processes (under Academic Properties). The User dialog box is
refreshed with a list of all the academic processes that you can select for the user.

User Dialog Box, Academic Processes (EMS Academic Planning only)
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2. On the Available list, select the academic process or CTRL-click to select the multiple academic event
processes to which a user is to have access, and then click the Move button (>) to move the selected
processes to the Selected list.

3. Continue with any other configuration for the user as needed. Otherwise, click OK to close the User
dialog box and return to the Users window with the newly configured user automatically selected in
the window.

Export a List of User Accounts 

1. On the EMS menu bar, navigate to System Administration > Security > Users. The Users window
opens. This window lists the names and types for all users who currently have an account for your
EMS installation.

2. Click Export. The Save As dialog box opens. The default file name is User List and the file type is *.xls.

3. You can change the file name and save the file in a location of your choosing.
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CHAPTER 99: Configure User Templates
Users are the people who log on to EMS, whether they are making reservations or just using the system in
a read-only capacity.

A user template defines the categories, processes, buildings, rooms, statuses, and queries to which a group
of EMS users has access. Instead of defining users individually and then configuring security for each user,
you can configure a template and then assign all the users who are to have the same security settings to a
given template in a single step. You can configure a user template user entirely from “scratch,” or you can
copy an existing user template, and then make the necessary edits to configure another template.

If the users you are configuring are also EMS Academic Planning users, then you must also define academic
user templates for these users.

This topic provides information on the following

l Configure a User Template
l Specifying Categories
l Configure Processes
l Configure Buildings
l Specify Room Access
l Specify Statuses
l Specify Queries

Configure a User Template

1. On the EMS menu bar, click System Administration > Security > User Templates. The User Templates
window opens. This window lists all the user templates currently configured in your EMS database
and that have a status of Active.
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TIP: Optionally, to show all templates, regardless of status, under Show, click Inactive. The remainder of this
procedure describes how to configure a user template “from scratch.” You can also configure a user
template by copying an existing template. Select the user template that you want to copy, click Copy, and
then continue to Step 3.

2. Click New. The User Template dialog box opens.

3. In the Description field, enter a name or description for the new user template.

TIP: The name or description can be a maximum of 50 characters, including spaces.
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4. Defining the user access for each of the following—categories, processes, building configuration,
room access, statuses and queries.

5. Click OK. The User Template dialog box closes. You return to the User Templates window with the
newly configured template automatically selected.

Specifying Categories 
You specify the categories that a user who is assigned to this template can add to a booking or edit for a
booking on the Categories tab.

1. If needed, open the User Template dialog box.

2. Select Categories. The User Template dialog box is refreshed with a list of all the active categories you
can select for the user template.

3. On the Available list, select the category or CTRL-click to select the multiple categories to which a
user is to have access, and then click the Move button (>) to move the selected categories to the
Selected list.

TIP: To add these categories to a booking, a user needs access to the Edit Booking Details process.

4. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.
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Configure Processes 

1. From the User Template dialog box, select Processes. The User Template dialog box is refreshed with
a list of all the processes that you can select for the user template.

2. On the Available list, select the process or CTRL-click to select the multiple processes to which a user
is to have access, and then click the Move button (>) to move the selected processes to the Selected
list.

TIP: See Also: For an explanation of each process, see Event Processes.

3. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.

Configure Buildings 
You select the building configuration rights for a user who is assigned to this template on the Buildings tab.

1. From the User Template dialog box, select Buildings. The User Template dialog box is refreshed with a
list of all the buildings you can select for the user template.
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2. On the Available list, select the building or CTRL-click to select the multiple buildings to which a user
is to have access, and then click the Move button (>) to move the selected buildings to the Selected
list.

Tip: Define and Edit Buildings and Define and Edit Rooms security processes are required for a user to have
configuration access to selected buildings and/or rooms.

3. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.

Specify Room Access 
You specify the room access for a user who is assigned to this template on the Room Access tab.

1. From the User Template dialog box, select Room Access. The User Template dialog box is refreshed a
options for searching for the rooms to add to the user template.
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2. Search for the rooms to which to add to the user template by doing one or both of the following and
the Available list will update with a list of rooms that meet your search criteria:

l On the Building drop-down list, select (all) buildings, or select a specific building.
l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.

3. On the Available list, select the room or CTRL-click to select the multiple rooms to which a user is to
have access, and then click the Move button (>) to move the selected rooms to the appropriate Selec-
ted list.

TIP: EMS Enterprise has both the View and Book and the View Only access for user security. EMS
Professional has just the View and Book access for user security.

l View and Book—A user who has access to the Special - Edit Critical Booking Information
process and who is assigned to this template can reserve the room, move an event into or out of the
room, change the time or status of an event that is scheduled in the room, and add resources to
events in the room.

TIP: The Special - View and Book Access On All Rooms process can be used as an alternative to manually
assigning all rooms to the View and Book list.

l View Only—A user who is assigned to this template cannot reserve the room, move an event into or
out of the room, or change the time or status of an event that is scheduled in the room; however, as
long as the user has access to the appropriate category and to the Special - Edit Booking Details pro-
cess, the user can view events in the room and add resources to events in the room.

4. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.
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Specify Statuses 
You specify the statuses to which a user who is assigned to this template is to have access on the Statuses
tab. A user needs access to a status in order to create a reservation with the status or edit a booking with
the status.

1. From the User Template dialog box, select Statuses. The User Template dialog box is refreshed with a
list of all the active event statuses you can select for the user template.

2. On the Available list, select the status or CTRL-click to select the multiple statuses to which a user is
to have access, and then click the Move button (>) to move the selected statuses to the Selected list.

3. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.

Specify Queries 
You specify the queries that a user who is assigned to this template can run on the Queries tab.

TIP: You can specify the queries to run by user only in EMS Enterprise. All queries are available to all users in
EMS Professional.

1. From the User Template dialog box, select Queries. The User Template dialog box is refreshed with a
list of all the defined queries you can select for the user template.
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2. On the Available list, select the query or CTRL-click to select the multiple queries to which a user is to
have access, and then click the Move button (>) to move the selected queries to the Selected list.

3. Continue with any other configuration for the template as needed; otherwise, click OK to close the
User Template dialog box and return to the User Templates window with the newly configured user
template automatically selected in the window.
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CHAPTER 100: Configure Academic User Templates
If the EMS users who are to have the same security settings are also EMS Academic Planning users, then
you must configure academic user templates for these users. An academic user template defines the
academic event processes to which a group of EMS Academic Planning users has access. Instead of
defining campus users individually and then configuring security for each user, you can configure a
template and then assign all the users who are to have the same security settings to a given template in a
single step. You can configure an academic user template user entirely from “scratch,” or you can copy an
existing academic user template, and then make the necessary edits to configure another template.

1. On the EMS menu bar, click System Administration > Security > Academic User Templates. The Aca-
demic User Templates window opens. This window lists all the academic user templates that are cur-
rently configured in your EMS database and that have a status of Active.

Academic User Templates window

TIP: Optionally, to show all templates, regardless of status, under Show, click Inactive.

The remainder of this procedure describes how to configure an academic user template “from scratch.” You
can also configure an academic user template by copying an existing template. Select the academic user
template that you want to copy, click Copy, and then go to Step 3.
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2. Click New. The Academic User Template dialog box opens.

Academic User Template dialog box

3. In the Description field, enter a name or description for the new academic user template.

TIP: The name or description can be a maximum of 30 characters, including spaces.

4. Select Processes, and define the user access for the appropriate academic processes.

TIP: For an explanation of each process, see Academic event processes.

5. Click OK. The Academic User Template dialog box closes. You return to the Academic Users Template
window with the newly configured template automatically selected.
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CHAPTER 101: Configure User Security for Multiple User
Accounts
If you configure users individually (that is, you are not using user templates) and you need to mass assign
security to multiple users (for example, you have added a new room and many of your users need access to
the room), then you can use the User Security function. You can use the User Security function to mass
assign security for categories, processes, rooms, and statues for multiple users that have been individually
configured.

This topic will provide information on:

l Configure User Security for Multiple User Accounts
l Configure Mass User Security for a Category
l Configure Mass User Security for a Process
l Configure Mass User Security for a Room
l Configure Mass User Security for a Status

TIP: If you need to mass assign security for queries to multiple users, you can do so from within the Query
Builder itself. See the EMS User’s Manual for detailed information.

Configure User Security for Multiple User Accounts 

1. On the EMS menu bar, click System Administration > Security > User Security. The User Security dia-
log box opens.

User Security Dialog Box
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2. On the Type drop-down list, select the item for which you are configuring user security—Category,
Process, Room, or Status.

Configure Mass User Security for a Category 

1. On the Category drop-down list, select the specific category for which you are configuring user secur-
ity. The User Security dialog box is refreshed with a list of all individual users who do not have access
to the selected category (the left Users list), and a list of all individual users who do have access to the
selected category (the right Users list). All administrator users are displayed as well. (By default, an
administrator user has access to all categories in an EMS database, and therefore, this list is not
enabled.)

User Security dialog box, Categories
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2. On the left Users list, select the user, or CTRL-click to select the multiple users who are to have access
to the selected category, and then click the Move (>) button to move the selected users to the right
Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close the User
Security dialog box.

Configure Mass User Security for a Process 

1. On the Process drop-down list, select the specific process for which you are configuring user security.
The User Security dialog box is refreshed with a list of all individual users who do not have access to
the selected process (the left Users list), and a list of all individual users who do have access to the
selected process (the right Users list). All administrator users are displayed as well. (By default, an
administrator user has access to all processes in an EMS database, and therefore, this list is not
enabled.)

User Security dialog box, Processes
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2. On the left Users list, select the user, or CTRL-click to select the multiple users who are to have access
to the selected process, and then click the Move (>) button to move the selected users to the right
Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close the User
Security dialog box.

Configure Mass User Security for a Room 

1. On the Building drop-down list, select a building, and then on the Room drop-down list select the
specific room in the building for which you are configuring user security. The User Security dialog box
is refreshed with a list of all individual users who do not have access to the selected room (the left
Users list), a list of all individual users who have View and Book access to the selected room and a list
of all individual users who have View Only access to the room. All administrator users are displayed
as well. (By default, an administrator user has access to all processes in an EMS database, and there-
fore, this list is not enabled.)

User Security dialog box, Rooms
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2. On the left Users list, select the user, or CTRL-click to select the multiple users who are to have access
to the selected room, and then click the Move (>) button to move the selected users to the appro-
priate Users list.

TIP: EMS Enterprise has both the View and Book and the View Only access for user security. EMS
Professional has just the View and Book access for user security.

l View and Book—A user who has access to the Special - Edit Critical Booking Information
process and who is assigned to this option can reserve the room, move an event into or out of the
room, change the time or status of an event that is scheduled in the room, and add resources to
events in the room.

TIP: The Special - View and Book Access On All Rooms process can be used as an alternative to manually
assigning all rooms to the View and Book list.

l View Only—A user who is assigned to this option cannot reserve the room, move an event into or
out of the room, or change the time or status of an event that is scheduled in the room; however, as
long as the user has access to the appropriate category and to the Special - Edit Booking Details pro-
cess, the user can view events in the room and add resources to events in the room.

3. Continue with any other security configuration as needed; otherwise, click Close to close the User
Security dialog box.

Configure Mass User Security for a Status 

1. On the Status drop-down list, select the specific status for which you are configuring user security.
The User Security dialog box is refreshed with a list of all individual users who do not have access to
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the selected status (the left Users list), and a list of all individual users who do have access to the selec-
ted status (the right Users list). All administrator users are displayed as well. (By default, an admin-
istrative user has access to all statuses in an EMS database, and therefore, this list is not enabled.)

User Security dialog box, Statuses

2. On the left Users list, select the user, or CTRL-click to select the multiple users who are to have access
to the selected status, and then click the Move (>) button to move the selected users to the right
Users list.

3. Continue with any other security configuration as needed; otherwise, click Close to close the User
Security dialog box.
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CHAPTER 102: System Administration > Tools
You have several tools at your disposal in EMS to assist you in your administrative duties. These include a
tool to update various group attributes such as pricing plans or account name, managing memorized
reports, viewing logged-in users and if necessary, log these users off your EMS system, emailing logged-in
users, deleting old data in your EMS database, and so on.
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CHAPTER 103: Change Group Wizard
You use the Change Group Wizard to update various group attributes. You can reassign an account, an
event coordinator, a group type, a payment type, a pricing plan, a sales category, or a salesperson.

To use the Change Group Wizard 
The following procedure is written from the perspective of changing an account, but by analogy, you can
follow this procedure to change any of the allowed properties for your group records.

1. On the EMS menu bar, click System Administration > Tools > Change Group Wizard. The Change
Group Wizard opens.

Change Group Wizard

2. Select Account (the property to change), and then click Next. You are prompted to select an account
to change.

Change Group Wizard
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3. Select the account that you want to change, for example Equipment Charges. The Change Group Wiz-
ard is updated with information that indicates the number of groups that use the account that you
are changing.

Change Group Wizard

4. Click Next. The Change Group Wizard prompts you to select an account to replace all instances of
Equipment Charges.

Change Group Wizard

5. Select the appropriate account, for example, Denver A/V, and then click Finish.

6. A Property Changed message opens, indicating that the property was changed and the number of
groups that were affected.

7. Click OK to close the message and the Change Group Wizard.
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CHAPTER 104: Change Reservation Wizard
You use the Change Reservation Wizard to change various properties for all reservations or all future
reservations with bookings after a specific date in a single step. You can change the calendar style, the
event coordinator, the event type, the sales category, the salesperson, the reservation source, or the web
user.

TIP: The following procedure is written from the perspective of changing the event type, but by analogy,
you can follow this procedure to change any of the allowed properties for your reservations.

1. On the EMS menu bar, click System Administration > Tools > Change Reservation Wizard. The
Change Reservation Wizard opens.

Change Reservation Wizard

2. Select Event Type for the property to change, and then do one of the following:
l Select All Reservations.
l Select Future Reservations with Bookings After, and then select a booking date.

TIP: The date must be greater than or equal to the current day’s date.

3. Click Next. The Change Reservation Wizard prompts you to select an event type to change.
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Change Reservation Wizard

4. Select an event type, for example, Fundraiser. The Change Reservation Wizard is updated with inform-
ation that indicates the number of reservations that use the selected event type.

Change Reservation Wizard

5. Click Next. The Change Reservation Wizard prompts you to select an event type to replace all
instances of “Fundraiser.”

Accruent Confidential and Proprietary © 2019 Page | 406

CHAPTER 104: Change Reservation Wizard



Change Reservation Wizard

6. Select a different event type, for example, Fundraising Dinner, and then click Finish. A Property
Changed message opens, indicating that the property was changed, and the number of reservations
that were affected.

7. Click OK to close the message and the Change Reservation Wizard.
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CHAPTER 105: Room Administration Wizard
You use the Room Administration Wizard to identify new rooms that have been configured in your EMS
database and add these rooms to or delete these rooms from public views, notification rules, group
notification rules, users, user templates, web process templates, and if applicable, kiosk profiles. (If you are
using the Room Administration Wizard in EMS Academic Planning, then you can add specific rooms to or
delete specific rooms from domains and/or academic units.)

This topic will include the following information:

l Using the Room Administration Wizard 
l Use the Room Administration Wizard to Add Rooms 
l Using the Room Administration Wizard to Delete Rooms 

Using the Room Administration Wizard 

1. On the EMS menu bar, click System Administration > Tools > Room Administration Wizard. The
Room Administration Wizard opens.

Room Administration Wizard

2. Do one of the following:
l If you are using the wizard to add rooms to a view, rule, or so on, then leave Add On or After

Date selected, if needed, select a date, and then continue to “To use the Room Administration
Wizard to add rooms”.
Tip: The default value for the date is the current day’s date.
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l If you are using the wizard to delete rooms from a view, rule, or so on, select Remove, and then
continue to “To use the Room Administration Wizard to delete rooms”.

Use the Room Administration Wizard to Add Rooms 

1. On the Building drop-down list, select all buildings, a specific building, or an area. All rooms that have
been added to the selected building or area on or after the indicated date are displayed.

2. Optionally, do one or both of the following to filter the rooms that are displayed. As you select your
search criteria, the list of rooms that meet the search criteria is dynamically updated.

l On the Classification drop-down list, leave the default value of (all), or select a specific room clas-
sification.

l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.
3. Optionally, to further filter the displayed search results based on the Room Name, in the Filter field,

enter a search string.
Tip: The search string is not case-sensitive, but your search is limited to the exact order of the
characters in the string and it must begin with the information for which you are searching. For
example, a search string of Mee returns Meeting room, but not Science Meeting room.

4. Select the room or CTRL-click to select the multiple rooms that you are adding, and then click Next.
The Room Administration Wizard is updated with a list of the public views that are currently con-
figured in your EMS database.

Room Administration Wizard, Public Views

5. Do one of the following:
l To keep all public views as is (none of the selected rooms are to be added to any existing public

views), leave Keep Existing Settings selected, and then click Next.
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l To add the selected rooms to one or more of the existing public views, click Add to Existing Set-
tings, and on the Available list, select the view or CTRL-click to select the multiple views, click
the Move (>) button to move the selected views to the Selected list, and then click Next.

6. Repeat the process detailed in Step 5 to move through the configuration process for each of the
remaining configuration items—Notification Rules, Group Notification Rules, Users, User Templates,
web Process Templates, and if applicable, Kiosk Profiles.

l For Users, User Templates, and web Process Templates, a third option, Overwrite Existing Set-
tings is available. If you select this option, then the current (existing) room access for the con-
figuration item is replaced by the room access that you define here. For example, if you select
Overwrite Existing Settings for Users, then any room access that has been previously defined
for a selected user is replaced by the room access that you define here.

7. Do one or more or all of the following as needed:
l For Notification Rules, Group Notification Rules, and Kiosk Profiles, go to Step 8.
l For Users and User Templates, select the appropriate access, and then go to Step 8.

Tip: EMS Enterprise has both the View and Book and the View Only access for user security.
EMS Professional has just the View and Book access for user security.

l View and Book—A user who has access to the Special - Edit Critical Booking Information
process and who is assigned to this option can reserve the room, move an event into or out of
the room, change the time or status of an event that is scheduled in the room, and add
resources to events in the room.
Tip: The Special - View and Book Access On All Rooms process can be used as an alternative to
manually assigning all rooms to the View and Book list. See “Configuring User Security for
Multiple User Accounts”.

l View Only—A user who is assigned to this option cannot reserve the room, move an event into
or out of the room, or change the time or status of an event that is scheduled in the room; how-
ever, as long as the user has access to the appropriate category and to the Special - Edit Book-
ing Details process, the user can view events in the room and add resources to events in the
room.

l For web Process Templates, select the appropriate access, and then go to Step 8.
l Move rooms that can be reserved without approval (that is, booked into the Reserve Status on

the web Process Template tab) into the Reserve pane.
l Move rooms that require approval (that is, booked into the Request Status on the web Process

Template tab) into the Request pane.
8. Click Finish. A Process message opens indicating that you are about to process the selected rooms

and possibly overwrite data, and asking you if it is OK to continue.
9. Click Yes. A message appears indicating that the rooms were processed successfully, and asking you

if you want to select more rooms.
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10. Do one of the following:
l Click Yes to close the message and return to the Room Administration Wizard.
l Click No to close the message and the Room Administration Wizard.

Using the Room Administration Wizard to Delete Rooms 

1. On the Building drop-down list, select all building, a specific building, or an area. All rooms that have
been configured for the selected building, area, or view are displayed.

2. Optionally, do one or both of the following to filter the rooms that are displayed. As you select your
search criteria, the list of rooms that meet the search criteria is dynamically updated.

l On the Classification drop-down list, leave the default value of (all), or select a specific room clas-
sification.

l On the Room Type drop-down list, leave the default value of (all), or select a specific room type.
3. Optionally, to further filter the displayed search results based on the Room Name, in the Filter field,

enter a search string.
Tip: The search string is not case-sensitive, but your search is limited to the exact order of the
characters in the string and it must begin with the information for which you are searching. For
example, a search string of Mee returns Meeting room, but not Science Meeting room.

4. Select the room or CTRL-click to select the multiple rooms that you are removing, and then click
Next. The Room Administration Wizard is updated with a list of the public views that are currently con-
figured in your EMS database and that contain the selected room or rooms.

Room Administration Wizard, Public Views

5. Do one of the following:
l To keep all public views as is (none of the selected rooms are to be removed from any of these

public views), leave Keep Existing Settings selected, and then click Next.
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l To remove the selected rooms from one or more of the public views, on the Available list, select
the view, or CTRL-click to select the multiple views from which you are removing the rooms,
click the Move (>) button to move the selected views to the Selected list, and then click Next.

6. Repeat the process detailed in Step 5 to move through the configuration process for each of the
remaining configuration items—Notification Rules, Group Notification Rules, Users, User Templates,
web Process Templates, and if applicable, Kiosk Profiles.

7. Click Finish. A Process message opens indicating that you are about to process the selected rooms
and possibly overwrite data, and asking you if it is OK to continue.

8. Click Yes. A message appears indicating that the rooms were processed successfully, and asking you
if you want to select more rooms.

9. Do one of the following:
l Click Yes to close the message and return to the Room Administration Wizard.
l Click No to close the message and the Room Administration Wizard.
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CHAPTER 106: Manage Saved Reports
A saved report is a report for which the filter settings have been saved, or saved, so that you do not have to
adjust the filter settings every time you run the report. A saved report always has an owner, and it can be a
public report (available to all users in your EMS database), or it can be a private report (available only to the
owner of the report.) You use the Manage saved Reports tool to edit or delete a saved report.

1. On the EMS menu bar, click System Administration > Tools > Manage Saved Reports. The saved
Report Setups window opens. By default, this window lists the saved reports of all types that are con-
figured in your EMS database.

2. Optionally, select on the Report Type drop-down list, select a report type to filter the list of reports
that are displayed.

3. Select a saved report, and then continue to one of the following:

Edit a Saved Report 

1. Click Edit. A Save Report Setup dialog box opens, populated with the information for the selected
report.

2. Edit one or more of the following for the report—the report description, the availability of the report
(if the report is not to be available to the all users, then clear the Public option; otherwise, select the
Public option), and/or the report owner.
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3. Click OK. The save Report Setup dialog box closes and you return to the save Report Setups window
with the newly edited report automatically selected.

Delete a Saved Report 

1. Click Delete. A message opens asking you if you are sure that you want to delete the selected saved
report.

2. Click Yes. The message closes. The report is deleted.
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CHAPTER 107: Override Existing Bookings Utility
In some situations, such as a building closure, a scheduled maintenance repair, a priority event, and so on,
you might need to “bump” one or more bookings from their scheduled location. You use the Override
Existing Bookings Utility to bump all the bookings that meet specific criteria and place them in a Conflict
status. A new all day booking that uses the settings (Event Name, Event Type, and Group) that you specify
is created in place of these bumped bookings.

1. On the EMS menu bar, click System Administration > Tools > Override Existing Bookings Utility. The
Override Existing Bookings Utility window opens.

Override Existing Bookings Utility window

2. Do the following to search for the rooms that contain the bookings that you are bumping. A list of all
the rooms configured for the selected building, area, or view and that are of the indicated Room Type
will display on the Available list.

l On the Building drop-down list, select a specific building, area, or view.
l On the Room Type drop-down list, leave the Room Type set to the default value of (all), or select a

specific room type.

3. Select the room, or CTRL-click to select the multiple rooms that contain the bookings that you are
bumping, and then click the Move button (>) to move the selected rooms to the Selected list.
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4. Repeat Step 2 and Step 3 until you have selected all the rooms that contain the bookings that you
are bumping.

5. Enter a Start Date and an End Date to filter the list of bookings that you are bumping for the selected
rooms.

6. Optionally, to see a list of the bookings that you are bumping, click View Bookings; otherwise, go
to Step 7. The View Bookings window opens. A list of all rooms with the bookings that you are bump-
ing is displayed in the window.

TIP: Optionally, you can select a booking in this window, and then click Open to open the booking’s
reservation in the Navigator for a more detailed examination, and you can also click Export to export the list
of bookings to an Excel spreadsheet. After you have viewed the bookings and/or exported the booking,
click Close to close the View Bookings window and return to the Override Existing Bookings Utility window.

View Bookings window

7. Specify the event type, event name, the status, and the group for the new all day bookings that are
to be created in place of the bumped bookings.

TIP: If the appropriate event type is not available, you can configure it. See “Configuring Event Types”. If the
appropriate status is not available, you can configure it. See “Configuring Statuses”. You can select a group
from the Group drop-down list, or you can search for a group. If the appropriate group is not available, you
can configure it.

8. Select the Override Existing Bookings Conflict Status (the status to which the bumped bookings are
changed).

TIP: If the appropriate status is not available, you can configure it. If you select a status with a Cancel type, a
Cancel Status dialog box opens. You must enter a cancel reason and indicate who canceled the booking for
Cancel type status. Optionally, you can also enter notes about the booking cancellation.

9. To update the reservation status to the status for the new all day bookings, leave Update Reser-
vation Status; otherwise, clear this option to leave the reservation status unchanged.

10. Click Finish. A message appears indicating that the existing bookings (which are all the bookings the
meet the search criteria) will be overridden and set to the conflict status that you selected and asking
you if it is OK to continue.
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11. Click Yes. The message closes and the Navigator opens, displaying the new all day bookings with
their new status.
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CHAPTER 108: Import Reservations Utility
This utility enables you to import existing reservations into your EMS database from a tab-delimited text
file. Importing reservations is a two-step process.

1. Configure the reservation import.

2. After you configure the import, you must import the reservations. You an can also delete an import
session.

This topic will include information on the following:

l Best Practices for Using the Reservation Import Utility
l Configure the Reservation Import 
l Import Reservations Into a Session 
l Delete a Reservation Import 

Best Practices for Using the Reservation Import Utility
The practices below are recommended for preparing existing reservations for import into EMS.

To view the fields you are importing in order, from EMS System Administration > Tools > Import
Reservation Utility, you can use Print > Import Format to view the fields in order. These fields are explained
below.

l Date (This can be in MM/DD/YYYY format if you are in US. If your computer is using DD/MM/YYY
format, your file should match that format.

l Start time (This must be HHMM, like 0800 - Excel will try removing the leading zero, so you can
format the column as Text, or as More Number Formats > Custom and enter "HHMM" as the cus-
tom format).

l End time (This must be HHMM, like 1700).
l Building (This is EMS Building Code, not description).
l Room (This is EMS Room Code).
l Event Name (255 character max).
l Group (e.g., Host, Customer, Employee if you have relabeled it in your organization).
l 1st Contact
l Setup Count
l Reservation Grouping (this number behaves similarly to an EMS reservation number: you should use

the same number for each booking that should be grouped together. You can start with 1 and work
upwards from there; all lines with a "1" will go under one reservation, so if you have a three day meet-
ing, "1" would appear on the first three lines, then start with #2 for the next reservation).

l Billing Reference (this can be left blank if not required).
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Additional Best Practices

l Your import file must be tab-delimited. The easiest way to generate the file is by using Excel and then
copying and pasting into Notepad, and saving that file.

l Make sure the Group, 1st Contact, and Billing Reference are the same for all bookings within any
single reservation. (For example, Taylor cannot be the contact for Monday while Chris is the contact
for Tuesday)

l Group Name will be matched based on the first one found in your database. If you have two groups
called "Pat Lee", EMS will pick the first one and assign it to all matching reservations.

l Values for 1st Contact will create contacts in EMS as temporary contacts.
l Web User and Web Templates will not be assigned to imported reservations.
l If you choose to map web users to your imported reservations, you should also make sure the web

user you assigned is set to "Active" security status. If a web user logs on for the first time and they
already have reservations created, they will be moved from "Activate on Logon" status to "Pending"
status and you will need to manually activate their account. You can prevent this by making their
account "Active" in advance.

l Be sure not to copy any header rows when you import. Your first row in Notepad should have tabs
between, instead of spaces.

l Selecting the checkbox to "Skip Notifications" causes all imported bookings to bypass the checks for
any EMS Notification Rules. The utility has been successfully used for importing tens of thousands of
records at a time, but if you are processing notification rules, large batches could take a very long
time to complete.

l The Import Utility only allows you to specify the Start Date. If your start time is greater than your end
time, EMS will assume your end date is one day later. You cannot import a single booking longer
than 24 hours.

l All times should be local to the time zone of the building you’re booking. For example, 0800 for New
York, and 0800 for London would create 8:00 am bookings in the respective buildings.

l Once you start loading your import file, if you see "Unassigned" rooms or groups/people," that
means the data in your import file did not find an exact match. You can manually fix rooms and
groups individually, but if you notice that there are way too many to cleanup individually, you might
be better off deleting the import session, then fixing your import file, and then creating a new ses-
sion. If you create manual mappings, they will be remembered for future import sessions.

l After launching an import, you might see a failure message. The import might have completed any-
ways, so after waiting a while, check to see before re-launching the import.

l If you are importing VC reservations, you will need to one more step for them to have associated
reservation numbers: after the import, for these reservations use the “Move Bookings” option to
move them to a primary reservation number. That reservation should then be marked as “Video-
conference” in EMS, and a host site designated.

Accruent Confidential and Proprietary © 2019 Page | 419

CHAPTER 108: Import Reservations Utility



l Setup and Teardown time are not included in the import. If you need the room blocked including
setup/teardown time, you can set your start time and end time to reflect the entire duration for
which you want to block the room, or you can modify the bookings post-import.

Configure the Reservation Import 
Note: This section describes the steps for configuring a new reservation import. If you simply need to load
an existing import, then after opening the Reservation Import Sessions window, skip to the following
section, Import Reservations Into a Session.

1. On the EMS menu bar, click System Administration > Tools > Import Reservations Utility. The Reser-
vation Import Sessions window opens. This window lists all the reservation sessions that have been
imported into your EMS database.

2. Click New. The Reservation Import Session dialog box opens.

3. Enter the information for the new import session. 
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OPTION DESCRIPTION

Conflict
Status

Available only if you select a status with a type of Book Space. This status is
applied only if the status that you selected results in the imported bookings
being in conflict with existing bookings.

Note: If the appropriate status is not available, you can configure it.
See Configure Statuses.

Description A name or description for the import session.

Note: The name can be a maximum of 50 characters, including spaces.

Event Type Select the event type for the imported reservations.

Note: If the appropriate event type is not available, you can configure it.
See Configure Event Types.

Override
Conflict
Status

Available only Override Existing Bookings is selected. If imported bookings
override existing bookings, then select the conflict status into which the
overridden bookings are to be placed.

Note: If the appropriate status is not available, you can configure it.
See Configure Statuses.

Override
Existing
Bookings

Select this option if the imported bookings are to override existing bookings.

Reservation
Source

Select a source if applicable.

Note: If the appropriate reservation source is not available, you can configure
it. See Configure Reservation Sources.

Setup Type Select the setup type for the imported reservations.

Note: If the appropriate setup type is not available, you can configure it.
See Configure Setup Types.

Status Select the status that is to be applied to the imported reservations.

Note: Only statuses that do not have a Reconfirm Date are available. If the
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OPTION DESCRIPTION

appropriate status is not available, you can configure it. See Configure
Statuses.

4. Click OK. The Reservation Import Session dialog box closes. You return to the Reservation Import Ses-
sions window. The newly configured import session is displayed in the window.

Import Reservations Into a Session 

1. On the EMS menu bar, click System Administration > Tools > Import Reservations Utility to open the
Reservation Import Sessions window.

2. Select the reservation session into which you are importing the reservations, and then click Load. The
Import Reservations wizard opens.

3. Click the Search icon to browse to and select the file you are importing, and then click Next. The
Import Reservations wizard displays all the reservations in the import file by the building/room com-
binations that have been assigned to them. 

Tip: If a Building/Room combination in the import file is identical to a Building Code/Room code in the EMS
database, then the record is automatically assigned; otherwise, the record remains unchanged.
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4. To filter the list, select a different view on the View drop-down list and/or a different building on the
Building drop-down list.

5. To work with room assignments:
l To Assign a Room, select a Building/Room Combination, or CTRL-click to select multiple com-

binations, and then click Assign to open the Room Selector dialog box and select the room in
your EMS database.

l To Exclude a Room from the Import, select a Building/Room Combination, or CTRL-click to
select multiple combinations, and then click Do Not Import. This excludes all the reservations
that are assigned to this Building/Room combination.

l To Unassign a Room, select a Building/Room Combination, or CTRL-click to select multiple com-
binations, and then click Unassign.

6. Click Next. The Import Reservations Wizard displays all groups that are assigned to reservations in
the import file.
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Tip: If a group name in the import file is identical to a group name in the EMS database, then the record is
automatically assigned; otherwise, the record remains unassigned.

7. To work with groups:
l To Assign a Group, select a group, or CTRL-click to select multiple groups, and then

click Assign to open the Groups window, and select the group in your EMS database for which
all reservations that are assigned to the selected group will be made.

l To Exclude a Group From the Import, select a group, or CTRL-click to select multiple groups,
and then click Do Not Import to exclude all reservations that are assigned to this group.

l To Unassign a Group, select a group, or CTRL-click to select multiple groups, and then
click Unassign to undo a Group assignment.

8. Click Finish. A message opens indicating that the reservations were imported successfully.

9. Click OK to close the message and the Import Reservations Wizard and return to the Reservation
Import Sessions window.

Delete a Reservation Import 
You can delete a reservation import session. If you delete an import session, all reservations in the session
are deleted. Because you cannot recover these reservations other than to repeat the import process, make
certain you want to delete the session.

1. On the EMS menu bar, click System Administration > Tools > Import Reservations Utility. The Reser-
vation Import Sessions window opens. This window lists all the reservation sessions that have been
imported into your EMS database.

2. Select the import session that you are deleting, and then click Delete. A message opens informing
you that all reservations related to the session will be deleted and asking you if it is OK to continue.

3. Click Yes. The message closes. The import session is deleted.
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CHAPTER 109: View and Email Logged-In Users
A user who is currently logged in to your EMS system is referred to as an active user. You view logged-in
users and if necessary, log these users off your EMS system. You can also send an email to all users who are
currently logged in to EMS.

Tip: To receive email, a user must have an email address configured for his/her user account.

1. On the EMS menu bar, click System Administration > Tools > Active Users. The Active Users window
opens. This window lists all the users who are currently logged in to your EMS system, the date and
time they logged in to the system, and in multi-EMS database environments, the database that they
are logged in to. An asterisk (*) marks the user account that you used to log in.

Active Users Window

2. Optionally, do one or both of the following:
l To log a user off of the system, select the user, or CTRL-click to select multiple users, and then

click Logout.
Tip: Users who are logged off of the system can complete the process they are currently
involved in (making a reservation, editing a booking, and so on), but when they attempt to
start another process, a message opens informing them that they have been logged out and
must restart EMS.

l To send an email to a user, select the user and then click Email. A blank email, pre-addressed to
the user, opens. The To field is populated with the email address that was defined for the user,
but you can edit this value if needed. Create and send the email as you normally would.
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SMTP Email Window
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CHAPTER 110: Delete Old Data
As the EMS administrator, you can delete bookings, historical data, email history, holidays, building hours,
notifications, and if applicable, EMS Kiosk transactions that occur on or before a specific date. You can
also delete unused groups, contacts and web users (groups, contacts, and web users who have no
associated records in your EMS database). If you delete all the bookings for a reservation, the reservation is
also deleted from the EMS database. As a safeguard, it is a system requirement that the date that you
specify for bookings, historical data, email history, holidays, building hours, or notifications be at least three
months prior to the current day’s date.

Before using the Delete Old Data utility, make a backup of your EMS database. Deletion of data using this
utility is a permanent deletion and you can recover the data only by using a backup copy of your EMS
database.

1. On the EMS menu bar, click System Administration > Tools > Delete Old Data. The Delete Old Data
dialog box opens.

Delete Old Data dialog box

2. Select that data that is being deleted, and then, if applicable enter the on/or before deletion date.

Tip: The date that you specify for bookings, historical data, email history, holidays, building hours,
notifications, and /or kiosk transactions must be at least three months prior to the current day’s date.

3. Click OK. A message appears indicating that deleting this data is a permanent action and asking you
if it is OK to continue.

Tip: Remember, if you delete all the bookings for a reservation, the reservation is also deleted from the EMS
database; however, no message opens indicating that the reservation was also deleted.
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4. Click Yes. A message opens when all the data is deleted.

5. Click OK.
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CHAPTER 111: Currency Configuration Wizard
Once you configure a currency in your EMS database, you can assign the currency to buildings, categories,
and/or calculations. You can assign the currency to a single building, category, or calculation during
configuration, or you can use the Currency Configuration Wizard to assign the currency to multiple
buildings, categories, and/or calculations in a single step.

1. On the EMS menu bar, click System Administration > Tools > Currency Configuration Wizard. The
Currency Configuration Wizard opens. All the active currencies that are currently configured in your
EMS database are displayed on the Currency drop-down list.

2. On the Currency drop-down list, select the currency that you are assigning, and then click Next. The
Currency Configuration Wizard, Buildings page opens. This page lists all the buildings that are cur-
rently configured in your EMS database.  
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3. On the Available list, select the building, or CTRL-click to select the multiple buildings to which you
are assigning the currency, and then click the Move button (>) to move the selected buildings to the
Selected list. When you assign a currency to a building, the currency is used to price all the rooms in
the building. If the appropriate building is not available, you can configure it. See Configure Build-
ings.

4. Click Next. The Currency Configuration Wizard, Categories page opens. This page lists all the active
categories that are currently configured in your EMS database.

5. Select the category, or CTRL-click to select the multiple categories to which you are assigning the cur-
rency, and then click the Move button (>) to move the selected categories to the Selected list. When
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you assign a currency to a category, the currency is used to price all the resources in the category. If
the appropriate category is not available, you can configure it. See Configure Categories.

6. Click Next. The Currency Configuration Wizard, Calculations page opens. This page lists all the active
calculations that are currently configured in your EMS database.

7. On the Available list, select the calculation, or CTRL-click to select the multiple calculations to which
you are assigning the currency, and then click the Move button (>) to move the selected calculations
to the Selected list. When you assign a currency to a calculation, the currency symbol is used to dis-
play the results of the calculation. If the appropriate calculation is not available, you can configure it.
See Configure Calculations.

8. Click Finish. A message opens, asking you if you are sure that you want to set the currency on the
selected items to be <selected currency>? For example, "Are you sure that you want to set the cur-
rency on the selected items to be US Dollars?"

9. Click Yes. The message closes and another message opens indicating that the currency configuration
was successful.

10. Click OK to close the second message and the Currency Configuration Wizard.
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CHAPTER 112: Booking Move/Change Status Wizard
The Booking Move/Change Status Wizard allows you to change critical information (date and/or status)
for multiple bookings across multiple reservations in a single step.

TIP: Your users have access to the Change Booking Date/Time Wizard and the Change Booking Status
Wizard in the Navigator. They can use these wizards to change critical booking information for multiple
bookings in a single reservation.

This topic will provide the following information:

l Use the Booking Move/Change Status Wizard
l Move Multiple Bookings to a Different Date 
l Change the status for multiple bookings 

Use the Booking Move/Change Status Wizard

1. On the EMS main menu, click System Administration > Tools > Booking Move/Change Status Wiz-
ard. The Booking Move/Change Status Wizard opens.

2. In the Start Date field, enter the starting date for the bookings for which you are changing the date
and/or status, and in the End Date field, enter the ending date.

3. Leave the default values set to (all) for the other search criteria (Building, Status, and Event Type), or
optionally, select different values as needed.

TIP: For Building, you can select (all) buildings, a specific building, a specific area, or a specific view.

4. Click Get Data. The Select Bookings window opens. This window displays all the bookings that meet
your search criteria.

Accruent Confidential and Proprietary © 2019 Page | 432

CHAPTER 112: Booking Move/Change Status Wizard



5. Continue to one of the following:
l To move multiple bookings to a different date below.
l To change the status for multiple bookings.

Move Multiple Bookings to a Different Date 

1. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the date.

2. On the Select Bookings window, click Move. The Move Bookings dialog box opens.

3. Select a different value for the date, and then click OK. The Results window opens. This window dis-
plays a list of all the selected bookings, whether the date change was successful.

VALUE DESCRIPTION

Reschedule Booking
Earlier

The default value. Reschedule the bookings to an earlier date that is
based on the number of days that you specify.

Reschedule Booking
Later

Reschedule the bookings to a later date based on the number of
days that you specify.
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VALUE DESCRIPTION

Reschedule Booking
to Specific Date

Reschedule the bookings to a new date that you specify.

The Results Window

TIP: Optionally, to view only the bookings for the selected reservation that were NOT successfully changed,
select Show Unchanged Only. To view the details for a specific booking that was changed, select the
booking, and then click Go To.

4. Click Close to close the Change Booking Date Results window and return to the Select Bookings win-
dow.

5. Repeat Step 1 through Step 4 until you have moved all the bookings as needed.

6. Do one of the following:
l If you are done moving bookings to a different date, click Close to close the Select Bookings win-

dow.
l If you also want to change the status for any of the bookings, continue to the next section.

Change the status for multiple bookings 

1. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the
status.

2. On the Select Bookings window, click Change Status. The Change Status dialog box opens.
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3. On the Status drop-down list, select the new status for the bookings.

TIP: If you select any type of Canceled status, then three additional fields—Reason, Who Canceled and
Notes—are displayed on the Change Booking Status window. You must enter data in all three of these
fields before you can continue in the Wizard.

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, select Update Reservation Status to have the reservation-level status changed as well.

6. Click Finish. The Results window opens. This window displays a list of all the selected bookings,
whether the status change was successful or not.
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TIP: Optionally, to view only the bookings for the selected reservation that were NOT successfully changed,
select Show Unchanged Only. To view the details for a specific booking that was changed, select the
booking, and then click Go To.

7. Click Close to close the Change Booking Status Results window and return to the Select Bookings win-
dow.

8. Repeat Step 1 through Step 7 until you have changed the status for all the bookings as needed.

9. Do one of the following:
l If you are done changing the status for the bookings, click Close to close the Select Bookings

window.
l If you also want to move any of the bookings to a new date, see section above, “To change the

status for multiple bookings”.
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CHAPTER 113: System Parameters
This section details the EMS system parameters you can configure as the EMS Administrator.

You can access system parameters from the System Administration > Settings > Parameters menu option.
From there, you select the parameters for the EMS product you want to work with.

l EMS System Parameters
l VEMS System Parameters
l EMS Kiosk System Parameters

Accruent Confidential and Proprietary © 2019 Page | 437

CHAPTER 113: System Parameters



CHAPTER 114: EMS System Parameters 

AREA DESCRIPTION

Academic

Import

(Academic

Import

Module)

Academic Import Days of the Week: Indicates how EMS determines the days of the

week in import data.

Note: If a positional option is selected, then the system does not recognize standard

day of the week abbreviations. For example, if Positional, Monday First is selected and

the import data file contains MWF as the indicator for days of the week for a class, then

the system interprets this as a Monday/Tuesday/Wednesday class because there are

no spaces between the characters. A Monday/Wednesday/Friday class is correctly

indicated, in Positional, Monday First format as M_W_F, where the underscores

represent spaces.

Billing Default Rounding Method for Hourly Pricing: Allows you to specify the time increment,

from one minute to sixty minutes, by which to round the time for hourly pricing.

Billing Determine Invoice Due Date by Adding “xx” Days: Sets the number of days specified to

determine the invoice due date, for example, 30 days.

Billing Service Order End Time if None Specified: Select Event Time or Reserved Time as the

Service Order End Time, unless otherwise specified.

Campus Academic Book Course Color: Color used for courses displayed in the Academic Book.

Campus Academic Book Cross-listed Course Color: Color used for cross-listed courses

displayed in the Academic Book.

Campus Academic Unit Title Plural: System-defined label for Academic Units. (Typically

renamed to “Departments.”)
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AREA DESCRIPTION

Campus Academic Unit Title Singular: System defined label for Academic Unit. (Typically

renamed to “Department.”)

Campus Accumulate Enrollment On Shared Space Courses (non-crosslisted only): Accumulate

enrollment on courses that share space instead of using the largest enrollment (which

is the approach for crosslisted courses).

Campus Allow Cross-Domain Cross Listings: If set to “Yes,” this indicates that courses can be

cross-listed across multiple domains.

Campus Allow Sync of Academic Units from SIS: If set to “Yes,” the Synchronize Academic Units

option is enabled in Academic > Configuration.

Campus Auto Sync - Automatically Process Cancellations: If auto-sync is enabled, then course

cancellations in your SIS are automatically processed in EMS.

Campus Auto Sync - Automatically Process New Courses not assigned to a Room: If auto-

synch is set to “Yes,” then new courses without a room in your SIS are automatically

processed in EMS.

Campus Auto Sync - Automatically Process Room Capacity Violations: If auto-synch is set to

“Yes,” if a new course is added in your SIS that violates room capacity, then the course

is automatically processed in EMS.

Campus Auto Sync User: The EMS user account that is used by the auto-sync service for

authentication.

Campus Course User Defined Field 01: Maps an EMS user-defined field to a custom field in your
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SIS.

Campus Course User Defined Field 02: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 03: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 04: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 05: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 06: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 07: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 08: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 09: Maps an EMS user-defined field to a custom field in your

SIS.

Campus Course User Defined Field 10: Maps an EMS user-defined field to a custom field in your

SIS.
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Campus Day Label - First Day of the Week: The default value is Sunday. Determines which day

of the week is designated as the first day in various areas of EMS Academic Planning

such as the Academic Book. The other allowed value is Monday.

Campus Day Label 1 - Sunday: Determines the label that indicates Sunday in various areas of

EMS Academic Planning such as the Time Block Template configuration area. The

default value is U.

Campus Day Label 2 - Monday: Determines the label that indicates Monday in various areas of

EMS Academic Planning such as the Time Block Template configuration area. The

default value is M.

Campus Day Label 3 - Tuesday: Determines the label that indicates Tuesday in various areas of

EMS Academic Planning such as the Time Block Template configuration area. The

default value is T.

Campus Day Label 4 - Wednesday: Determines the label that indicates Wednesday in various

areas of EMS Academic Planning such as the Time Block Template configuration area.

Default value is W.

Campus Day Label 5 - Thursday: Determines the label that indicates Thursday in various areas

of EMS Academic Planning such as the Time Block Template configuration area.

Default value is R.

Campus Day Label 6 - Friday: Determines the label that indicates Friday in various areas of EMS

Academic Planning such as the Time Block Template configuration area. Default value

is F.
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Campus Day Label 7 - Saturday: Determines the label that indicates Saturday in various areas

of EMS Academic Planning such as the Time Block Template configuration area.

Default value is S.

Campus Default Cancel Reason: Used for courses when publishing a term.

Campus Default Event Type: Used for courses when publishing a term.

Campus Default Group: Used for courses when publishing a term.

Campus Default Reservation Source: Used for courses when publishing a term.

Campus Default Seat Fill Percentage: Used to determine an appropriate room size for a class of

a specific estimated enrollment (typically 100%).

Campus Default Setup Type: Used to build a setup type and capacity (from the SIS) when

synchronizing rooms (typically “classroom”).

Campus Domain Title Plural: System defined label for Domains (typically renamed to

“Campuses”).

Campus Domain Title Singular: System defined label for Domain (typically renamed to

“Campus”).

Campus Final Exam Event Type: Used when creating a final exam booking.

Campus Include CRN in Reservation Event Name: Include the Course Reservation Number

(CRN) in front of the event name post-publish in all areas of EMS Academic Planning

where the event name is used.
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Campus Keep Sibling Crosslisting Room Assignments in Sync: A sibling cross-list describes a

crosslist that has at least three courses and the two child courses have a meeting

pattern that is not shared with the parent course. If set to “Yes,” then these sibling

crosslist courses become a matched set and are placed in Crosslist status and not

Conflict.

Campus Large Class Size (If More Than XX Students): Used to determine what constitutes a

“large” class for weighting by enrollment in the room optimization process. Explained

in detail in the Room Optimization section of the EMS User’s Manual.

Campus Large Class Size Weight Adjustment: Used to adjust the optimization weighting for a

“large” class. Explained in detail in the Room Optimization section of the EMS User’s

Manual.

Campus Lock Academic Unit Room Access: Used during optimization process. If set to Yes, a

room will be assigned to an Academic Unit' (i.e., Department) course only if that

Academic Unit owns the room.

Campus Manually Update SIS/ERP System After Publishing: If set to “No”, course location in the

SIS will be automatically updated during the publishing process.

Campus SIS/ERP Title: System defined label for SIS/ERP (typically “SIS”).

Campus Small Class Size (If Less Than XX Students): Used to determine what constitutes a

“small” class for weighting by enrollment in the room optimization process. Explained

in detail in the Room Optimization section of the EMS Academic Planning User’s

Guide.
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Campus Small Class Size Weight Adjustment: Used to adjust the optimization weighting for a

“small” class. Explained in detail in the Room Optimization section of the EMS

Academic Planning User’s Guide.

Campus Subject Title Plural: System defined label for Subjects (typically “Subjects”).

Campus Subject Title Singular: System defined label for Subject (typically “Subject”).

Campus Sync Course Dates Without Start/End Times: If set to No, Courses with incomplete

course date records (i.e. missing start/end times or dates) will not be imported into

EMS Academic Planning.

Campus Web Service URL: The URL to the EMS Campus Planning Interface service.

Email Enable Email Support: When set to “Yes,” you can, directly from EMS, email a

Confirmation to the contact person for the group that is making a reservation.

Email SMTP — Save Email Attachments (Database Size Will Increase): When set to “Yes,” an

option is available to save all attachments (invoices, confirmations, and so on) when

emailing a group and/or contact.

Email SMTP – Use SSL: Used if your SMTP Server is enabled for SSL

Groups &

Contacts

Allow Change to External Reference: When set to “Yes,” allows users to change external

reference on groups and contacts.

Groups &

Contacts

Allow Search by External Reference: When set to “Yes,” allows users to search groups

and contacts by external reference.
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Groups &

Contacts

Default Address Format as International: Defaults the International checkbox to true

when adding a new group or contact.

Groups &

Contacts

Default Country: Defaults the Country field to the value that is specified when adding a

new group or contact.

Groups &

Contacts

Default Pricing Plan For New Groups: Used when a creating a new group record.

Groups &

Contacts

Default Require Contact: Used when creating a new group record.

Groups &

Contacts

Group Bad Status Title: Label used for “Bad” value on the Group Status drop-down list.

Groups &

Contacts

Group OK Status Title: Label used for “OK” value on the Group Status drop-down list.

Groups &

Contacts

Group Warning Status Title: Label used for “Warning” value on the Group Status drop-

down list.

Groups &

Contacts

Offer Dropdown Selection of Groups: When set to “Yes,” the system automatically

populates the Group window with all active groups in your EMS database. A user can

enter a search string in the Starts with field to and the list of groups that meet the

search criteria is dynamically updated as the user enters the string. When set to “No,”

users must manually search for groups.

Groups & Pricing Plan Required For Groups: When set to “Yes,” users must specify a pricing plan
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Contacts for new groups and contacts.

Groups &

Contacts

Show Account Field on Group: When set to “Yes,” an Account field is displayed on

Group/Contact records.

Groups &

Contacts

Web Users Linked to Groups via External Reference: Links group and web user records

if group records are defined as individual employees (i.e., not departments) in your

system. When making a new reservation in EMS, the web user field is automatically

populated based on the group selected.

Reservations Reservation Book 'Checked In' Color: The color used when a booking has been

checked-in to.

Reservations Reservation Book 'Not Checked In' Color: The color used when a booking has not been

checked-in to yet.

Reservations Reservation Book 'Room Does Not Require Check In' Color: The color used when the

room for the booking does not require check-in.

Labels 1st Contact Title: The label for the 1st Contact field.

Labels 2nd Contact Title: The label for the 2nd Contact field.

Labels Area Title Plural: The plural label for the Area field.

Labels Area Title Singular: The singular label for the Area field.

Labels Attendee Attended: The label for what an attendee attended.
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Labels Attendee Company Name: The label for the attendee's company.

Labels Attendee Email Address: The label for an attendee's email address.

Labels Attendee Name: The label for and attendee's name.

Labels Attendee Notes: The label for the Notes field for attendees.

Labels Attendee Phone: The label for attendee's phone numbers.

Labels Attendee Visitor: The label for the Attendee Visitor field.

Labels Billing Reference Title Plural: The plural label for the Billing Reference field.

Labels Billing Reference Title Singular: The singular label for the Billing Reference field.

Labels Building Title Plural: The plural label for the Building field.

Labels Building Title Singular: The singular label for the Building field.

Labels Check Number Title: The label for the Check No. field.

Labels Confirmation Grand Total Title: The label for the Confirmation Grand Total field.

Labels Confirmation Subtotal Title: The label for the Confirmation Subtotal field.

Labels Default Phone 1 Label: The default label for the first phone-type number field.

Labels Default Phone 2 Label: The default label for the second phone-type number field.
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Labels Event Coordinator Title: The label for the Event Coordinator field.

Labels External Reference Title: The label for the External Reference field.

Labels Group Title Plural: Plural of the term that is used in your organization’s EMS system to

refer to people who hold events in your facility (for example, employees, groups,

clients, customers, and so on).

Labels Group Title Singular: Singular of the term that is used in your organization’s EMS

system to refer to people who hold events in your facility (for example, employees,

groups, clients, customers, and so on).

Labels Payment Type Title Plural: The plural label for the Payment Type field.

Labels Payment Type Title Singular: The singular label for the Payment Type field.

Labels Phone/Fax Labels List: Specifies the options that are available in fields shown for phone

numbers. Enter the text items, separated by semicolons, that you want to appear in

the drop-down menu for phone-type numbers. The default is “Phone; Fax; Mobile;

Pager; Other”.

Labels PO Number Title Plural: The plural label for the PO Number field.

Labels PO Number Title Singular: The singular label for the PO Number field.

Labels Room Size Title: The label for the Room Size field.

Labels Room Title Plural: Plural of the term that is used in your organization’s EMS system

refer to reservable spaces (e.g., rooms, fields, and so on).
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Labels Room Title Singular: Singular of the term that is used in your organization’s EMS

system refer to reservable spaces (e.g., rooms, fields, and so on).

Labels Sales Category Title Plural: The plural label for the Sales Category field.

Labels Sales Category Title Singular: The singular label for the Sales Category field.

Labels Salesperson Title: The label for the Salesperson field.

Notifications Allow Users To Delete Notifications: When set to “Yes,” allows users to delete

notifications.

Notifications Exclude Building Closures On Notifications: When set to “No,” building closures are not

excluded from notification date calculations.

Notifications Exclude Weekends On Notifications: When set to “No,” weekends are not excluded

from notification date calculations.

Notifications Ignore Building Closure/Weekend Notification Settings Beyond xx Days: Specifies the

number of days after which building closures and/or weekends are ignored for

notification date calculations.

PAM Allow date/time changes on PAM Bookings in EMS Client: If set to “No,” then EMS

users are prevented from making any changes to bookings created on VEMS using the

PAM module.

Note: Before enabling, please contact your DEA consultant to discuss.

PAM PAM Web Service URL: The URL to the optional Plan A Meeting (PAM) module. Specify

only if the optional PAM module is enabled in your environment.
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Reports Calendar Inquiry Print Format: The format that is automatically selected when the

Print button is clicked for the Event Calendar report.

Note: You select the format for the Event Schedule report as you run the report.

Reports Include Activities on Service Order Forms: If set to “No,” activities are not included on

service order forms.

Reports Include Catering Details on Setup Worksheet: If set to “Yes,” catering details are

displayed on the Setup Worksheet report.

Reports Include this Notes Category on Service Order Forms: Allows you to select the notes

category on service order forms.

Reports Reset Page Numbers by SO on Service Order Forms: If set to “Yes,” page numbers are

reset by the service order on service order forms.

Reports Room Description Format: Determines how room information is displayed in reports:

as a code or as a description, with or without building code.

Reservations Allow Bookings to Be Added to Outlook Personal Calendar: If set to “Yes,” then EMS

users can click an Outlook option to add bookings to their personal calendars.

Reservations Book Building Closed Color: The color that is used in the Reservation Book to indicate

building closures.

Reservations Book Holiday Color: The color that used in the Reservation Book to designate holidays.

Reservations Book Weekend Color: The color that is used in the Reservation Book to designate

weekends.
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Reservations Building Display: Indicates how building information is to be displayed in

reservations—by building code or building description.

Reservations Default Event Coordinator: When set to “No,’ no default value is provided when a user

is making a reservation in the Reservation Wizard.

Reservations Exclude Room Charge from Services Indicator: In various EMS locations (the

Reservation Book, the Navigator, the Edit Booking form, and so on) EMS provides an

indication that services exist for a booking. If set to “Yes,” then a room charge category

is excluded from displaying as a service on the booking.

Reservations Group Bookings by UTC times and keep together on Video Conferencing

Reservations: When set to “Yes,” then any changes that are made to a booking that

belongs to video conference occurrence cascade to the other related bookings within

the occurrence.

Reservations Lock Booking Details if Booking Is Locked: If set to “No,” the booking details remain

editable even when the booking is locked because of invoicing or its age.

Reservations Lock Bookings Older Than “xx” Days: The number of days after a booking has occurred

that is automatically locked and cannot be edited.

Reservations Lock Occurring / Past Reservations For Non-Administrators: If set to “Yes,” then a

reservation is locked for editing by non-administrator users after one booking in the

reservation has occurred. EMS administrators have full editing capability.

Reservations Max Length for Event Name: The maximum number of characters, including spaces,

that a user can enter in the Event Name field when creating a new reservation.
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Reservations Room Display: Indicates how room information is to be displayed in reservations—by

room code or room description.

Reservations Update Billing Information When Changing Group: If set to “Yes,” automatically

updates the billing information when a user selects a different group for a reservation.

Reservations Update Room Charge When Room Changes: If set to “Yes,” automatically updates the

room charge when a user selects a different room for a reservation.

Reservation Use Billing Reference Allocation: Enables an EMS user to allocate reservation, booking,

or service order charges across multiple Billing Reference numbers by percentage.

Reservations Use Calendar Styles: Select Yes or No to enable the use of calendar styles on the Event

Schedule report and on the Event Calendar report.

Reservation Use PO Number Allocation: Enables an EMS user to allocate reservation, booking, or

service order charges across multiple PO Numbers by percentage.

Reservation Validate Billing Reference: Validates the Billing Reference entered against the Billing

Reference table. Specify No Validation, Valid Only, or Warning for Invalid (Blanks Are

Invalid), or Warning for Invalid (Blanks are Valid).

Reservation Validate PO Number: Validates PO Numbers entered against the PO Number table.

Specify No Validation, Valid Only, or Warning for Invalid (Blanks Are Invalid), or

Warning for Invalid (Blanks are Valid).

Reservations Validation of Building Hours: Specify On Reserved Time or On Event Time.

Reservations Warn When Booking More Than “xx” Months in Future: System warns user if they
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attempt to create a reservation that has bookings that will take place x number of

months in the future.

Resources Check Inventory When Using Reservation Tools: If set to “Yes,” the system

automatically verifies resource availability when you copy details, copy reservations or

change the date, time or room for multiple bookings.

Resources Use Resource Selector: If set to “Yes,” a special resource selector window is used when

adding detail to bookings.

Service

Orders

Auto Adjust Service Order Times: If set to “Yes,” then Service Order Times are

automatically adjusted when a booking is edited.

Service

Orders

Default Service Order Times and Count from Booking: When creating a new service,

sets the default service order times to the event/reserved time. If set to (none), no

default service order times are set.

Service

Orders

Show External Service Option on Categories: When Set to “Yes,” an External Service

field is displayed on the Category dialog box for a Catering category or a Resource w/

Service Orders category.

System Dashboard Check Interval: Indicates how frequently the Dashboard should check for

updates.

Note: Setting this for more frequent updates might impact application performance.

System Disable Online Help: If set to “Yes,” then Online Help is not available for the EMS

system. (The link Help > Contents is not displayed on the EMS main menu.)
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System Hide Currency Indicator: Hides the currency symbol (for example, $) on confirmations

and invoices.

System Server Time Zone: Sets the time zone for the server to the indicated value.

System Use Integrated Authentication Only: If set to “Yes,” then EMS users are required to

manually log-in and authenticate against LDAP.

System Virtual EMS URL: The VEMS URL that is displayed in VEMS emails and EMS group

notifications.
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CHAPTER 115: VEMS System Parameters
The default values for VEMS parameters are also applied as the default values for new web process
templates; however, you can edit these values for the template.

AREA DESCRIPTION

Account

Management

Allow Web User to Opt Out of Automatic Emails: Allows web users to specify if

they want to receive any automatic emails (for example, confirmation, reminders,

and so on) from VEMS.

Account

Management

Auto Create Web User Account (for Integrated Authentication): A web user

account is automatically created via the integrated authentication process if a new

user “hits” the VEMS site.

Account

Management

Default Security Template for User: The default VEMS Web Security template that

is assigned to new web users.

Account

Management

Field Used to Authenticate Web User: Indicates the field—Email Address, Network

ID, or External Reference—that is used to authenticate a web user that logs in to

VEMS.

Account

Management

Note Label on Account Management: Label for the large text field on the Account

Management window.

Account

Management

Security Status for User: This entry becomes the default status (Active, Inactive,

Pending) for new web users.

Account

Management

On Login Automatically Set Web User Time Zone to First Building’s Time

Zone: After a VEMS user logs in, the time zone for the user is set to the time zone

for the first building that is stored in the EMS database. If this building, however, is
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not listed on the Facilities drop-down list, then the time zone is set to the first

available time zone on the Time Zone drop-down list, but the user can always

select a different value if one is available.

Authentication Portal Authentication Cookie Key: See the VEMS Integrated Authentication

Configuration instructions.

Authentication Portal Authentication Method: See the VEMS Integrated Authentication

Configuration instructions.

Authentication Portal Authentication Variable: See the VEMS Integrated Authentication

Configuration instructions.

Book Display Setup/Teardown Times: If enabled, setup/teardown bars are visible on

reservations in the Reservation Book.

Book Ignore Room Display on Web Flag: Ignores the Room Display on Web setting to

determine if an event should be marked as ‘Private’.

Book Room Description Format in Book: Determines how room information is

formatted. Options are Room Description or Room Code.

Booking Details Make Add to Personal Calendar Link Appear: If this option is set to Yes, the Add to

Personal Calendar link is displayed when a web user views the details of an event.

Booking Details Show Social Networking Options: If set to “Yes,” then displays links to various

social networking sites when a user views the details of a booking.

Browse Events Browse Event Default Display Format: Determines the initial format in which the
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Browse Events function displays information. Options are: Day, Week List, Month

List, Week Calendar, and Month Calendar.

Browse Events Collapse Bookings into Reservations in Browse Events: Specify No or Yes to

collapse bookings into reservations.

Browse Events Drop Events from Daily View After They Occur: Specify No or Yes to drop events

from the daily view after the event occurs.

Browse Events Location Format: Determines how location information is displayed in the list

views of the Browse Events function.

Browse Events Maximum Number of Events/Day to Display: Controls the number of events that

are available for display, per day, in the daily views of the Browse Events function.

Note: In some circumstances, you must click a link to see additional events.

Browse Events Maximum Number of Events/Day to Display in Monthly View: Controls the

number of events that are available for display, per day, in the monthly views of

the Browse Events function.

Note: In some circumstances, you must click a link to see additional events.

Browse Events Maximum Number of Events/Day to Display in Weekly View: Controls the number

of events that are available for display, per day, in the weekly views of the Browse

Events function.

Note: In some circumstances, you must click a link to see additional events.

Browse Events Secondary Event Sort (After Date/Time): If date and time information for multiple

events are identical, Location or Event Name is used to sort events on the
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calendar.

Browse Events Show End Time in Browse Events: If this option is set to No, only start time is

shown in Browse Events.

Browse Events Show Group Name in Browse Events: If set to “Yes,” then the name of the group

that is holding an event is shown in Browse Events.

Browse Events Show Group Type Filter in Browse Events: If set to “Yes,” then the group type filter

is an option in Browse Events.

Browse Events Show Location on Browse Events: If set to “Yes,” then the event location is

displayed in the calendar view on the Browse Events page.

Browse Events Show Room Type Filter in Browse Events: If set to “Yes,” then a Room Type filter is

displayed on the Browse Events page.

Browse for Space Description in Event Bar on Browse for Space: Determines what information

should show in the free/busy bar in the Book. Options include: None, Event Name

or Group Name.

Browse for Space Number of Hours to Show on Browse for Space: Determines the number of hours

that are displayed on the grid. Options include: 12 Hours (optimized for a

800x600 display) and 16 Hours (optimized for a 1024 x768 display).

Browse for Space Start Time on Browse for Space: Determines the start time for the grid.

Email Account to Use for Sending Email: This is the email account against which

outgoing email from VEMS is authenticated.
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Email Allow Email My Password: Allows web users to email their passwords to

themselves.

Email Default Subject for Email: This entry appears in the Subject line of email the

reservation summary email that is generated when a web user submits a

reservation.

Email Email Address of Sender: This entry indicates the “From” email address in the

reservation summary email that is generated when a web user submits a

reservation.

Email Format for Request Summary: Specify a detailed or summarized report for the

reservation summary email that is generated when a web user submits a

reservation.

Email Name of Email Sender: This entry indicates the “From” name in the reservation

summary email generated when a web user submits a reservation.

Email Name or IP Address of SMTP Server: SMTP server used solely for VEMS.

Email Password of Email Account: This entry indicates the password for the email

account.

Email Send Request Summary upon Submit: Determines whether reservation summary

information is emailed to the web users when a reservation is submitted.

Email SMTP Server Port: The default email port for your SMTP server.

EMS for Outlook Outlook Book Bookings Color: Used for the EMS for Outlook module. Color used
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to designate “busy” times for rooms.

EMS for Outlook Outlook Book Bookings Conflict Color: Used for the EMS for Outlook module.

Color used to identify a conflict for a room selection.

EMS for Outlook Outlook Book Selected Booking Color: Used for the EMS for Outlook module.

Color used to designate room selection.

EMS for Outlook Show Attendees in Book: If set to “Yes,” then the attendees for an event are

displayed in the Grid view for the event.

EMS for Outlook Text to display under icon in for EMS for Outlook: The text that is displayed for the

EMS for Outlook desktop icon.

Floor Plans Floor Mapping Web Service URL: Used for the Floor Plan module. URL address for

the floor mapping web service.

Labels Event Title Plural: This is the plural version of the label for “events.”

Labels Event Title Singular: This is the singular version of the label for “event.”

Labels Label for Login box: The label for the User ID field on the Login page.

Labels Label for “Private” in Book: The default label for a private event entry in various

windows, for example, Browse for Space page.

Reservations -

Checkout

Allow Billing Reference Lookup: If set to “Yes,” then a user can look up pre-

configured billing references when making a reservation in the Reservation

Wizard.
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Reservations -

Checkout

Allow PO Number Lookup: If set to “Yes,” then a user can look up pre-configured

PO numbers when making a reservation in the Reservation Wizard.

Reservations -

Checkout

Allow Temporary Contacts: If set to “Yes,” then a user can specify a temporary

contact for a group when making a reservation in the Reservation Wizard.

Reservations -

Checkout

Attachments Allowed Extensions: The allowed attachment types for room

requests.

Reservations -

Checkout

Billing Reference Validation: Select from No Validation, Required But Not

Validated, or Required and Validated.

Reservations -

Checkout

PO Number Validation: Select from No Validation, Required But Not Validated, or

Required and Validated.

Reservations -

Checkout

Require Contact Email: Specify No or Yes to require contact email at checkout.

Reservations -

Checkout

Require Contact Phone: Specify No or Yes to require a contact phone number at

checkout.

Reservations -

Checkout

Reservation Comment Type on Checkout: Select the reservation comment type

that is to be displayed upon checkout.

Reservations -

Checkout

Show 2nd Contact: If set to “Yes,” then the 2nd contact fields are displayed on the

reservation upon checkout.

Reservations -

Checkout

Show Billing Reference on Reservation: If set to “Yes,” then the billing reference is

displayed on the reservation upon checkout.
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Reservations -

Checkout

Show PO Number on Reservation: If set to “Yes,” then the PO number is displayed

on the reservation upon checkout.

Reservations -

Checkout

Attachments Allowed on Room Request: If set to “Yes,” then a user can add

attachments to a room request.

Reservations –

Room Request

Allow User to Change Setup Count in Selected Locations Area: If set to “Yes,” then

a user can change the setup count in the “cart” after adding a room.

Reservations –

Room Request

By Default, Enable Add to Calendar Checkbox (for PAM): Defaults the Add to

Calendar checkbox to Yes in the optional Plan-a-Meeting module.

Reservations –

Room Request

Default Pricing Plan: Indicates the default pricing plan that is used to display

pricing in VEMS.

Reservation –

Room Request

Default Room Availability View: When a user searches for available rooms, this

parameter drives the default display. Options are Grid, List or Floor Map.

Reservations –

Room Request

Default Value for Attendance: A default value for attendance when users make a

room request.

Reservations –

Room Request

Display Areas as Filter: If set to “Yes,” areas are available as a filter. (Shown as a

drop-down list.)

Reservations –

Room Request

Exclude Closures from Date Calculations: If set to Yes, closures are not taken into

account on booking rule date calculations.

Reservations –

Room Request

Exclude Weekends from Date Calculations: If set to Yes, weekends are not taken

into account on booking date calculations.
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Reservations –

Room Request

Allow Single Day Requests for Unavailable Rooms (for PAM): If set to “Yes,” then a

PAM user making a one day booking request can book an unavailable room.

Reservations –

Room Request

Hide Daily Recurrence Option: Hide the daily recurrence option on the Room

Request page.

Reservations –

Room Request

Hide Monthly Recurrence Option: Hide the monthly recurrence option on the

Room Request page.

Reservations –

Room Request

Hide Random Recurrence Option: Hide the random recurrence option on the

Room Request page.

Reservations –

Room Request

Hide Weekly Recurrence Option: Hide the weekly recurrence option on the Room

Request page.

Reservations –

Room Request

Number of Available Rooms upon Search: Specify the number of available rooms

that are displayed.

Reservations –

Room Request

Override Default Room Setup/Teardown Times: If set to “Yes,” the default

setup/teardown times defined for a room are ignored and the Setup Time in

Minutes for All Rooms and Teardown Time in Minutes for All Rooms parameters

are used instead.

Reservations –

Room Request

Reservation Source for New Reservation: Specify the only reservation source that a

user can select for a reservation.

Reservations –

Room Request

Sequence of Available Rooms upon Search: Select from Room Description or Book

Sequence.
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Reservations -

Room Request

Setup Time in Minutes for All Rooms: If the Override Default Room

Setup/Teardown Times parameter is set to “Yes,” this value is used for the setup

time.

Reservations –

Room Request

Setup Type Validation Rule: Determines how VEMS deals with the attendance

specified in a request as compared to the capacity for a room. Four options are

available:

No Setup and No Validation: Do not show the Setup Type field in the reser-
vation process and do not validate the number in the Attendance field against
room capacities (i.e., show all available rooms).

Validate But Don't Show: Do not show the Setup Type field but validate the
number in the Attendance field against the default capacity (regardless of
setup type) for each room.

Show and Validate: Show the Setup Type field and validate the attendance and
setup type against setup type/capacity pairings for the rooms.

Show But Don't Validate: Show the Setup Type field but do not validate setup
type or attendance.

Reservations –

Room Request

Show Additional Filters Initially: If set to “Yes,” then by default, the Availability

Filters section is expanded.

Reservations –

Room Request

Show Attendance on Room Request: Specify No or Yes to display the Attendance

field in a Room Request.

Reservations –

Room Request

Show Check Availability on Guest Request: If this option is set to Yes, the Check

Availability option is displayed on the Room Request page (web process template

mode = Request).

Reservations – Show Feature Filter: Set to “Yes” to show the Feature list as a room request search
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Room Request option.

Reservations –

Room Request

Show Floor Filter: Set to “Yes” to show the Floor list as a room request search

option.

Reservations –

Room Request

Show Room Pricing: Set to “Yes” to show the room’s price in a Room Request.

Reservations –

Room Request

Show Room Type Filter: Set to “Yes” to show the Room Type list as room request

search option.

Reservations –

Room Request

Show Room Drop Down on Classic Request: If set to “Yes,” then the Rooms drop-

down list is displayed on the Room Request page if the web process template

mode = Request.

Reservations –

Room Request

Teardown Time in Minutes for All Rooms: If the Override Default Room

Setup/Teardown Times parameter is set to “Yes,” this value is used for the setup

time.

Reservations –

Room Request

Validation of Building Hours: Specify on Reserved Time or on Event Time.

Reservation –

Room Request

Warn User if Room Selected is Not Available for All Dates: Specify Yes if you want a

user to be notified if a selected room is not available for all requested dates.

Reservations –

Summary

Allow Add Booking to Reservation: If set to “Yes,” users can add bookings to

reservations.

Reservations – Allow Edit UDFs on Reservation: If set to “Yes,” users can edit their UDFs on the
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Summary Reservation Summary page.

Reservations –

Summary

Allow Reservation Edits: Specify Yes to allow a web user to edit his/her reservation

information (group, contact, event name, and so on).

Reservations -

Summary

ICS File (Calendar Appointment) Status: Specify Busy or Tentative as the default

calendar appointment status.

Reservation

Summary

Require Cancellation Reason: If set to “Yes,” then if a user cancels a

reservation/booking, the user is required to supply a cancellation reason.

Reservations –

Summary

Show Service Availability: Displays Service Availability link on the Reservation

Summary page.

Services Adjust Service Order Times upon Booking Edit: If set to “Yes,” then Service Order

Times are automatically adjusted if the booking time is modified.

Services Allow Edit of Services: If this option is set to “Yes,” users can edit the services they

have added to events.

Services Maintain Inventory: If this option is set to “Yes,” the system notifies the user if an

attempt to reserve a resource would cause the resource to be overbooked. The

user must then select a new quantity.

Services Populate Service Setup with Attendance: If set to “Yes,” populates the service

setup with the expected attendance number.

Services Restrict Service Order Times Within Event Times: If set to “Yes,” then VEMS users

cannot specify service order start/end times that fall outside the event start/end
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times.

Services Set Service Time Default from the Event Time: If set to “Yes,” then the service

start/end times are set by default to the event start/end times.

Services Show Resource Pricing: Set to “Yes” to display the prices of resources.

Unauthenticated

Requests

Access to Classic Request for Unauthenticated Users: Specify No or Yes to allow

access to the Room Request page when the web process template mode =

Request.

View My

Requests

Show Group Column on View My Requests: Specify No or Yes to display the

Group column in View My Requests.
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AREA DESCRIPTION

Floor Plans Floor Plan Web Service URL: The full URL for the web service used by the optional

Floor Plan Configuration module. See Configuring Floor Plans.

Hoteling Allow Check In From Kiosk (EMS Workplace): If set to “Yes,” allows a user to check in

to a workspace from EMS Workplace.

Hoteling Enable Group Type Filtering on Make Reservation (EMS Workplace): If set

to “Yes,” enables feature filtering and/or room type filtering by group type on the

Make a Reservation page.

Hoteling Group Type Filtering Space Label on Make Reservation (EMS Workplace): The label

used if group type filtering is enabled.

Make

Reservation

Conflict Status for New Reservation: The status that is applied to bookings that are in

conflict with an existing booking.

Make

Reservation

Default End Time for New Reservation: The daily end time for new reservations. This

setting is only used if the parameter Allow Start/End Time Editing is set to “No,” or if

multi-day bookings are allowed.

Make

Reservation

Default Event Name for New Reservation: The default name for new reservations that

are created through EMS Kiosk The %USER% text is a variable that is replaced with

the group name. You can remove this variable.

Make

Reservation

Default Search=Floor Map on Make Reservation: If set to “Yes,” then when an EMS

Kiosk user searches for available rooms, the floor plan view is used for the default
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results.

Make

Reservation

Default Start Time for New Reservation: The default start time for new reservations

that are created through EMS Kiosk. This setting is only used if the parameter Allow

Start/End Time Editing is set to “No,” or if multi-day bookings are allowed.

Make

Reservation

Display Start/End Time Drop Downs: If set to “Yes,” the Start Time and End Time

drop-down lists are displayed on the Make Reservation page. If set to “No,” the

default start and end times are used for bookings.

Make

Reservation

Enable Web Process Security Template: If set to “Yes,” the user's web process

templates in addition to the rooms that are configured in the kiosk profile are used to

determine which rooms are displayed on the Make Reservation page.

Make

Reservation

Event Type for New Reservation: The event type that is applied to reservations

created through EMS Kiosk.

Make

Reservation

Number of Future Concurrent Days Allowed for New Reservations: The number of

days in the future that bookings can be made.

Make

Reservation

Reservation Source for New Reservation: The reservation source that is applied to

reservations created through EMS Kiosk.

Make

Reservation

Start Date Allowed for New Reservation (days): The number of days after the current

day’s date that a reservation can be made through EMS Kiosk.

Make

Reservation

Status for new Reservation: The status that is applied to reservations created through

the EMS Kiosk.
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Make

Reservation

Time Drop Down Increment: The time increment that is used on Time drop-down

menus.

Miscellaneous Browser Title: The text that is displayed in the title bar of the Kiosk browser.

Miscellaneous Default Page: The first page that first opens in EMS Kiosk or that is displayed when

EMS Kiosk times-out.

Miscellaneous Disable Stand-by Mode on Timeout: If set to “No,” then EMS Kiosk goes into

Standby-by Mode (a Stand By button is displayed) after timing out.

Miscellaneous Display Cancel Button for Group Searches: If set to “Yes,” the Cancel button is

displayed for group searches, allowing the user to cancel a search.

Miscellaneous Location Format: Select from Building Code, Room or Room Description or Building

Description, Room or Room Description.

Miscellaneous Max Records Returned for Group Searches: The maximum number of records

returned when searching for a group.

Miscellaneous Max Booking/Availability Records Returned: The maximum number of rooms that are

displayed when making a reservation.

Miscellaneous Page Timeout (seconds): The period of inactivity in EMS Kiosk, after which the default

page is displayed.

My

Reservations:

Allow User to Cancel Bookings: If set to “Yes,” then users can cancel bookings from

the Reservations page.
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My

Reservations:

Allow User to End Bookings: If set to “Yes,” then users can end their bookings from

the My Reservations page.

My

Reservations:

Cancel Status: The status that is applied to canceled bookings.

My

Reservations:

Future Booking Cancellation Cutoff (days): The number of days prior to a future

booking that the booking can be canceled.

My

Reservations:

Same Day Booking Cancellation Cutoff (minutes): Used in conjunction with the Allow

User to Cancel Bookings parameter. A user can cancel an in-progress booking up to

the number of indicated minutes before the booking occurs.

Security Group Field used for “Exact Match” Authentication: The field that is compared with

the ID that the user enters: External Reference, Badge Number, Personnel Number

(all of these are group settings). This parameter is used in conjunction with the

Primary User Authentication Type parameter, which must be set to Exact Match.

Security Primary User Authentication Types: The options are as follows:

• Standard - Partial names are enough for a match, and all groups that match are

listed.

• Exact Match - The ID entered must exactly match what is set in the parameter

Group Field Used for “Exact Match” Authentication.

• LDAP - Both the user's network ID and password must be entered.

Security Require Authentication for all Kiosk Functions: Requires users to identify themselves

before using EMS Kiosk. Used for kiosks in a public location where an exact user ID

match is needed.
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Security Require Timeout/Logoff to Terminate User Session: If set to “Yes,” then a user must

“hit” the Log Off button to end their EMS Kiosk session.

Security Secondary User Authentication Types for Badge Authentication: (Used only if

“Badge” is primary security). Alternate authentication method that is used when a

user doesn't have his/her badge.

Security Show 10 Key as Modal: Used with the Use 10-Key Keyboard for Authentication

parameter. Displays 10-key keyboard as a modal popup on the page.

Security Use 10-Key Keyboard for Authentication: Uses a numeric 10-key numeric keyboard

instead of the full keyboard.

Today’s

Events

Display Building Drop Down: If set to “Yes,” users can filter by building on the Today's

Events page.

Today’s

Events

Display Event Name Search: If set to “Yes,” then the Search for Events button is

displayed on the Today’s Events page.

Today’s

Events

Display Floor Drop Down: If set to “Yes,” users can filter by floor on the Today's

Events page.

Today’s

Events

Display Room Type Drop Down: If set to “Yes,” users can filter by room type on the

Today's Events page.

Today’s

Events

Drop Events in Past: If set to “Yes,” then events that occurred before the current day’s

time are not displayed on the Today's Events page.
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CHAPTER 117: Import File Specifications
You can streamline data entry by importing a variety of data items into your EMS database from tab-
delimited text files, including holidays, rooms, resources, groups, reservations, and course schedule
patterns. This appendix section details the import file specifications for each of these data items.

Tip: If your organization has licensed the optional EMS module, EMS Human Resources Toolkit, refer to the
HR Toolkit Installation Guide.

If you are importing data to your EMS database using a spreadsheet, due to the extraneous formatting
hidden in Microsoft® Excel, the best practice is:

l Build your spreadsheet
l Copy and paste it into Notepad
l Import it from the Notepad file

How Do I Import Data?
For instructions in importing data, follow the links in the table below:

TYPE OF IMPORT IMPORTING INSTRUCTIONS File Specifications

Reservations Reservation Import File
Specifications

Special Dates (Holidays) Configure Special Dates or
Holidays

Resources Importing Resources for a
Category

Groups (People) Import Groups

Rooms Import Rooms

(EMS Academic Planning) Final
Exam Schedules

Importing Final Exam Sched-
ule Templates

TIP: Your organization might also have licensed the Academic Import Utility, which enables you to import
lists of reservations for academic or Campus implementations.
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CHAPTER 118: Special Date Import File Specification

FIELD FIELD

SEQUENCE

MAX

WIDTH

DATA TYPE FORMAT OPTIONAL

OR

REQUIRED

EXAMPLE

Date 1 10 Date mm/dd/yyyy Required 01/23/2018

Description 2 30 Alphanumeric Left Justified Required Thanksgiving

Day

Notes 3 7000 Alphanumeric Left Justified Optional Staff Holiday

– No Events

Allowed
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CHAPTER 119: Room Import File Specification

FIELD FIELD

SEQUENCE

MAX

WIDTH

DATA TYPE FORMAT OPTIONAL

OR

REQUIRED

EXAMPLE

Room

Code

1 16 Alphanumeric Left

Justified

Required BCR

Room

Description

2 50 Alphanumeric Left

Justified

Required Breckenridge

Conference

Room
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CHAPTER 120: Resource Import File Specification
FIELD FIELD

SEQUENCE

MAX

WIDTH

DATA TYPE FORMAT OPTIONAL

OR

REQUIRED

EXAMPLE

Grouping 1 50 Alphanumeric Left
Justified

Required Beverages

Description 2 50 Alphanumeric Left
Justified.
Must be
a unique
value.

Required Coffee

Notes 3 7000 Alphanumeric Optional Decaf
provided
upon
request

Price 4 2
decimal
places

Decimal (##.##) Required 10.00

Available
On Web

5 5 Alphanumeric True or
False

Required True

Express
Checkout

6 5 Alphanumeric True or
False

Required False

Serves 7 2
decimal
places

Decimal (##.##) Required 10.00

Min.
Quantity

8 2
decimal
places

Decimal (##.##) Required 05.00
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CHAPTER 121: Group Import File Specifications
FIELD FIELD

SEQUEN

CE

MAX

WIDT

H

DATA TYPE FORMA

T

OPTIONA

L OR

REQUIRE

D

EXAMPLE

Group
Name

1 50 Alphanumer
ic

Left
Justifie
d

Require
d

Accounting
Department

Address
1

2 50 Alphanumer
ic

Left
Justifie
d

Optiona
l

834 Colorado Blvd.

Address
2

3 50 Alphanumer
ic

Left
Justifie
d

Optiona
l

Box 286

City 4 50 Alphanumer
ic

Left
Justifie
d

Optiona
l

Denver

State 5 2 Alphanumer
ic

Left
Justifie
d

Optiona
l

CO

Zip
Code

6 10 Alphanumer
ic

Left
Justifie
d

Optiona
l

80111

Country 7 50 Alphanumer
ic

Left
Justifie
d

Optiona
l

USA

Email
Address

8 75 Alphanumer
ic

Left
Justifie
d

Optiona
l

sales@organization.c
om
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FIELD FIELD

SEQUEN

CE

MAX

WIDT

H

DATA TYPE FORMA

T

OPTIONA

L OR

REQUIRE

D

EXAMPLE

Phone 1 9 30 Alphanumer
ic

Left
Justifie
d

Optiona
l

303-740-4428

Phone 2 10 30 Alphanumer
ic

Left
Justifie
d

Optiona
l

303-740-4429

Billing
Referen
ce

11 50 Alphanumer
ic

Left
Justifie
d

Optiona
l

10-24670
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CHAPTER 122: Reservation Import File Specifications

FIELD FIELD

SEQUENCE

MAX

WIDTH

DATA TYPE FORMAT OPTIONAL

OR

REQUIRED

EXAMPLE

Date 1 10 Date mm/dd/yyyy Required 01/15/2018

Event Start

Time

2 4 Numeric hhmm Required 0800

Event End

Time

3 4 Numeric hhmm Required 1300

Building 4 50 Alphanumeric Left Justified Required Adams

Room 5 50 Alphanumeric Left Justified Required Arapahoe

Conference

Room

Event

Name

6 255 Alphanumeric Left Justified Required Staff

Meeting

Group

Name

7 50 Alphanumeric Left Justified Required Accounting

Department

Contact

Name

8 50 Alphanumeric Left Justified Optional Mindy

Brady

Setup 9 5 Numeric ## Required 8
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FIELD FIELD

SEQUENCE

MAX

WIDTH

DATA TYPE FORMAT OPTIONAL

OR

REQUIRED

EXAMPLE

Count

Reservation

Reference

10 20 Alphanumeric Unique

identifier that

is used to

group

bookings into

one

reservation

Optional R1
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CHAPTER 123: Course Schedule Import File Specifications
COLUMN TYPE REQUIRED 

UNIQUE

MAX CHARS.

Sunday True/False Yes

Monday True/False Yes

Tuesday True/False Yes

Wednesday True/False Yes

Thursday True/False Yes
Sequence

Friday True/False Yes

Saturday True/False Yes

Start Time Text (HHMM) Yes 4

End Time Text (HHMM) Yes 4

Final Exam Day Of Week Text (UMTWRFS) Yes

Final Exam Start Time Text (HHMM) Yes 4

Final Exam End Time Text (HHMM) Yes 4

Accruent Confidential and Proprietary © 2019 Page | 481

CHAPTER 123: Course Schedule Import File Specifications



CHAPTER 124: Import Spreadsheets
If you are importing data to your EMS database using a spreadsheet, due to the extraneous formatting
hidden in Microsoft® Excel, the best practice is:

1. Build your spreadsheet

2. Copy and paste it into Notepad

3. Import it from the Notepad file
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CHAPTER 125: The Video Display Interface
The EMS Video Display Interface (VDI) is an optional, add-on component for EMS that exports meeting
and event information to a video display system such as Janus, Target Vision, and so on. It does this by
periodically saving booking information to a file which the video display system then retrieves and displays
on video monitors. You use the windows-based Task Scheduler to set the frequency at which the EMS
Video Display Interface program (EMS.exe) runs. This program stores the booking information and creates
the export file. You set parameters in EMS that define the types of bookings that are to be included in the
export file (based on buildings, statuses, and so on), where the exported file should reside, and other
information. You must manually export the booking information once and create the export file before you
can configure EMS to automatically export the information.

To integrate EMS with your video display, you will:

l Run the tool from EMS Desktop Client
l Configure settings for exporting booking information
l Export the data to your video display system
l Configure Windows Task Scheduler to automatically export data at a regular interval

1. On the EMS menu bar, click System Administration > Tools > Video Display Interface. The Video Dis-
play Interface dialog box opens. The Date Range tab is the active tab.

Video Display Interface

2. Specify the settings for exporting the booking information:
l The first time you configure the VDI, or if you edit your VDI settings, you must specify a date

range for the system to save the settings. Going forward, the system automatically exports the
information only for the bookings that are taking place on the current day’s date based on the
frequency that you specify.
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l To export data for a different date or date range, on a one-time only basis, enter the date or
range. If the export is to contain only bookings taking place in a particular time frame, check the
Use Specific Times box and enter the starting and ending times. After this manual update, the
system reverts to exporting data for the current day’s date based on the frequency that you
specify.

l In the Format field, select the pre-defined VDI export format. (If you select PowerPoint as the
pre-defined VDI export format, then the Bookings for Slide fields is enabled. You must also
indicate the number of bookings that are to appear on a slide.)

l In the Export File Path, click the Search icon to open Export File Path dialog box and browse to
and select the file to which you are exporting the data, or you can manually enter the full path
to the file with the file name and extension.

l On the Buildings tab, Statuses tab, Event Types tab, and Group Types tab, specify the build-
ing/room, status, event type, and group criteria by which to filter the booking information that
you are exporting.

3. Click Export. A message appears indicating that the export file was created successfully.
Tip: After you configure your export settings, you can click Memorize to save the export settings as a
memorized report so that you do not have to specify the export settings every time you export your
meeting and event information. If you save the export settings as a memorized report, you can make
the report public (available to all users in your EMS database) or private (available only to you.)

4. Click OK.

After you have manually run the export once, you can set up the system to export events automatically.
Following the steps outlined in your Windows operating system documentation, use the Task Scheduler to
define a scheduled task that executes EMS.exe on a regular basis (typically once each day). The file is located
in the folder in which the client portion of the EMS system is installed. (The default is C:\Program Files\ EMS
[PRODUCT NAME and VERSION NUMBER]). Before existing the Task Scheduler, select “Open advanced
properties for this task when I click Finish” and append /vdi to the end of the EMS path in the “Run”
textbox, for example:
“C:\Program Files\EMS [PRODUCT NAME and VERSION NUMBER]\EMS.exe”/vdi.
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CHAPTER 126: EMS Desktop Client User Guide (V44.1)
This desktop application is used by expert users to automate workflows and communications for maximum
scheduling efficiency. This tool enables everyday users to request space and services, see available space,
check their calendar, check into meetings, change event details, end and cancel events, resolve booking
conflicts, delegate space management to other users, send invitations, invoices, and notifications, approve
requests, track resource usage, and track space utilization.
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CHAPTER 127: Launch EMS
After EMS has been installed on your desktop, a shortcut icon for the application is placed on your desktop.
An option for the application is also available from your Start menu. You can double-click the desktop icon
to launch the EMS application, or you can select the option from your Start menu.

1. On your desktop, double-click the EMS icon. Alternatively, enter EMS in the Windows start menu in
the Search field and then select the EMS option. The application launches, prompting you to enter
your credentials.

NOTE: If you are the first person to log in to the EMS application at your organization, a dialog box opens
where you enter the information for the login server and database that your application is accessing.
(These are set up during implementation.) After you enter this information, the EMS Login dialog box
opens.

2. Enter yourUser ID and Password. ClickOK. The EMS Desktop Client application opens. The main
menu is open in the application.
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TIP: If you have an EMS Enterprise license, you can change the server and database you are connecting to
by right-clicking on the About EMS Enterprise option.

This launches a pop-up window where you can choose a different server and database.
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NOTE: For security reasons, after you log in to EMS the first time using “admin” as both the username and
password, at a minimum, we recommend that you change the account password. Ideally, you should cre-
ate an entirely new administrator account with a new username and password. See Also: Configuring
User Accounts.
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CHAPTER 128: Manage Database Connections
NOTE FOR EMS CLOUD SERVICES CUSTOMERS:
EMS Cloud Services Customers using the EMS Desktop Client Web Deployment will not change database
connections from within the EMS Desktop Client. Please refer here for instructions on switching database
connections.

If EMS Desktop Client has been installed on your desktop using the EMS Desktop Client Web Deployment,
you can point to a different database through EMS Desktop Client. Contact your system administrator for
guidance in databases to use.

This topic will provide information on:

1. Changing Databases
2. Create a New Database Connection

Changing Databases

1. On the EMS Menu, select File > Change Database to bring up the Database Connections window.

Note: Any database connection listed in blue is a system record inherited from the EMS Desktop Client
Web Deployment that can not be deleted.

2. To connect to a database that is not the system database select it from the list of Database Con-
nections then press the 'Connect' button. This will close and reopen the EMS Desktop Client
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connected to the selected database.
Note: The user will need to log in again after changing databases.

Create a New Database Connection

1. To create a New connection select 'New' in the Database Connections window (shown above) to
bring up the Database Connection window.

2. Type in the SQL server and EMS database name then select 'OK' to save the connection. You can
delete connections later when you no longer need them.

3. For EMS to save this connection it will first check to see if it is a valid connection. If the connection is
invalid, it will not be created you will see this error message:
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CHAPTER 129: User Settings
As an EMS Desktop Client user, you can manage multiple aspects of your account for a superior user
experience.

This section provides information on the following settings:

l Set user preferences and default values
l Change your password
l Reset window coordinates
l Reset column settings
l Define your views

Set user preferences and default values
Preferences, like system parameters, are settings that affect the basic functioning of your EMS
system. The difference is that system parameters are global settings that affect all users on the
system, whereas preferences are applicable only to your user account. You can set the values for
many preferences for your EMS instance to better suit your working needs. These preferences
include the time interval for Time drop-down fields, the size of the paper on which reports,
confirmations, and invoices are to be printed, the format in which to send emails from your
computer, and the default values for specific fields in the Reservation Wizard and other EMS client
windows.

1. On the EMS main menu, click Settings> Preferences. The Preferences dialog box opens.
The Preferences tab is the active tab.

2. Edit your user preferences as needed.

FIELD DESCRIPTION

Close Report Setup After
Running Reports

Time Drop Down Interval The time interval displayed on a Time drop-down
list (for example, if you select 30 minutes, then
options on the drop-down list are displayed as
1:00 1:30, 2:00 and so on). All Time drop-down lists
are 24 hour lists.
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FIELD DESCRIPTION

Paper Size The size of the paper on which reports,
confirmations, and invoices are printed. Values are
Letter, Legal, and A4.

Review Notifications When
Navigator Opens

If this option is selected, then a notification in the
Dashboard is automatically marked as “Reviewed”
if you select the notification, and then click Go To.
If this option is not selected, then you must select a
notification, and then click Reviewed to manually
mark the notification as “Reviewed.”

Do Not Save Window
Coordinates

Email Format The format in which your emails are sent—HTML
or Plain Text.

Send Emails Using Department
Email Address

Select this option if you want the From email
address for all the emails that you send from EMS
to be the email address of the department that is
associated with your user account.

Use Global Email Settings If you want to use the global email settings that
your EMS administrator has defined, then select
this option.

Use Gmail

Use Microsoft® Outlook

SMTP Email Contact your EMS administrator with assistance in
specifying these values.

Note: If you are using SMTP Email settings that are specific to your account, then you
also have the option of creating a signature that is to be included in all the emails that
you send from EMS. You can design the signature in plain text on the Design tab or in
HTML format on the HTML tab. You can always preview the signature on the Preview
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FIELD DESCRIPTION

tab.

3. Open the Defaults tab, and set the default values for the indicated items.

FIELDS DESCRIPTION

Building

Status

Event Type

Event Name

Event Time

Reservation Source

Time Zone/Display Audit Times
in This Time Zone

Drawing Application

Payments Currency

The values that you select here automatically
populate the appropriate fields in the Reservation
Wizard, and other EMS client pages.

Note: The event name can be a maximum of 30
characters, including spaces.

4. ClickOK to close the Preferences dialog box and apply your edited preferences and default val-
ues.

Change your password
When your EMS administrator first sets up your user account, your password is predefined for you.
You can change this password if you want.

1. On the EMS main menu, click Settings > Change Password. The Change Password dialog
box opens.

2. In the Old Password field, enter your current EMS password.

3. In the New Password field, enter the new password.

4. In the Re-enter New Password field, enter your new password again, exactly as you entered it
in the New Password field. 

5. ClickOK to close the Change Password dialog box. The next time that you log in to EMS, you
must use your new password.
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Reset window coordinates

1. On the EMS main menu, click Settings > Reset Window Coordinates.
2. You will receive a prompt notifying you that window coordinates have been successfully reset.

Reset column settings

1. On the EMS main menu, click Settings > Reset Column Settings.
2. You will receive a prompt notifying you that the column settings have been successfully reset.

Define your views

1. On the EMS main menu, click Settings >My Views. The My Views dialog box appears.
2. To create a new view, clickNew.
3. Under theView tab, provide a Description and Notes.
4. Under theRooms tab, you can search for rooms by Building or Room Type.

l To search by Room Type, choose a Room from the Room Type drop-down. A list will
appear on the left-hand side of the View screen, including the available rooms, descrip-
tion, building, and room type

l To search by Building, choose a Building from the Building drop-down. A list will appear
on the left-hand side of the View screen, including the available rooms, description, build-
ing, and room type

l Highlight the desired room and click> to select the room. To select multiple rooms, click

>> or << to remove the selected rooms.
5. Click theAudit tab to view details on the View, including the date it was added, who it was

added by, the date it was changed and who it was changed by.
6. ClickOK to save your View.
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CHAPTER 130: Reservations and Bookings
The two essential EMS components for meeting and event scheduling are reservations and bookings. To
use the EMS Web Client efficiently and effectively, you must understand the structure of a reservation in
EMS, the concept of an event timeline for a reservation booking, and how to make a reservation. This
section covers the following topics:

l Reservation Structure
o Reservations
o Booking Details

l Event Timeline

Reservation Structure
An event in EMS Desktop Client is comprised of the following:

1. A Reservation
2. One or moreBookings
3. Booking details

These three components exist in a hierarchy—a reservation contains one or more bookings and each
booking can have one or more details associated with it.

Reservations

A reservation is the who and the what of an event. For example, Group X (the who) can reserve some space
for an Event Y (the what). A booking is the where and the when of an event. For example, Group X can
schedule the conference room (the where) for a staff meeting on the second Monday in January (the
when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules
the conference room (the where) for a staff meeting on the second Monday of each month for a calendar
year (the when), then Group X now has a single reservation with twelve bookings in EMS.

Booking Details

A booking can have one or more booking details associated with it. Booking details are the resources or
services that are needed for an event, the notes for the event, the activities for the event, the room charges
for the event, or any combination of these. For example, for Group X’s staff meeting, the resources could
include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a
projector, a speaker’s podium, and so on).
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Event Timeline
The following time designators are used for an event in EMS Desktop Client:

l Event Time: The time period during which the event actually takes place.
l Setup/Teardown Hours: The hours, or fractions of hours, that you add to the event time to allow

staff to prepare a room for the event or to clean up after the event.
l Reserved Time: The total time for which the space (the where) is reserved. This time is the event

time plus the setup/teardown time.

VARIABLE  Time

Reserved Start Time 8:00 A.M.

Setup Hours 1 hour

Event Start Time 9:00 A.M. 

Event End Time 4:00 P.M.

Teardown Hours 1.5 hours

Reserved End Time 5:30 P.M.

Reserved Time 9.5 hours
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CHAPTER 131: Other Reservation Functions
EMS Desktop Client contains several miscellaneous standalone functions to assist you in managing and
maintaining reservations and bookings in your system as well as managing your general work
requirements.

l Record Actual Attendance Numbers for Bookings
l Manage Attendees and Visitors
l View Visitors
l Check In Visitors
l Import a List of Visitors to a Meeting
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CHAPTER 132: Recording Actual Attendance Numbers for Book-
ings
You use the Attendance Entry tool to view and record the actual attendance for bookings. (The tool does
not address reservation-level attendance.) The actual attendance numbers that you enter do not replace
the setup count (i.e., the estimated attendance) that you entered prior to an event. Reports that provide
attendance information typically provide both the estimated attendance and the actual attendance.

1. On the EMS main menu, click Reservations > Other > Attendance Entry. The Attendance Entry win-
dow opens.

2. In the Date field, select a date for which you are recording the booking attendance, on or before the
current day’s date. You can filter the results by building and/or a booking status.

3. For each booking as needed, scroll right to the Actual Attendance column, double-click in the field to
select the currently displayed value, and then enter the actual attendance number in the column.
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4. Click Close.
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CHAPTER 133: Manage Attendees and Visitors
Visitor management is an optional feature that your administrator can enable on booking templates so
that visitors can be added to your meetings in EMS Desktop Client and EMS Web App (or VEMS if on V44).
If the feature is enabled, you can:

l View Visitors
l Check in Visitors
l Import a List of Visitors to a Meeting
l Generate Attendee Visitor Reports
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CHAPTER 134: View Visitors
If visitors have been entered in your system, you can look them up in EMS Desktop Client.

1. On the EMS menu bar, click Reservations > Other > Visitors. The Visitors window opens on the Vis-
itors tab.

2. Specify search criteria:
l Start Date/End Date—The default value is the current day’s date.
l Building—Select (all) buildings, a specific building, an area, or a view to search.
l Show Cancelled—Select this option to search for registered attendees or visitors for canceled

events.
l Group—To search for registered attendees or visitors regardless of group, leave this field blank;

otherwise, to search based on a specific group, enter a search string in the field.
l Visitor—To search for a specific attendee or visitor, enter a search string in the field.
l Include Checked In—Selected by default. Clear this option to search only for registered

attendees and/or visitors who have not yet been checked in to their events.
3. Click Display. The list refreshes to match your search criteria.

4. Optionally, do one or more of the following:
l To see the booking linked to the person, select an attendee or visitor from the search results,

and then click Open to open the reservation in the Navigator that contains the booking that
the attendee/visitor is attending.

l To check a person in, select an attendee or visitor from the search results, or CTRL-click to
select multiple attendees/visitors, and then click Check In to “check in” the attendees/visitors to
the event. A date and timestamp is added to each attendee’s/visitor’s record. (you can do the
same to Check Out once people have checked in).
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l To export a list of people to a spreadsheet, on the Tools menu, click Export to export the list of
attendees/visitors to a spreadsheet.

l To print a list of people, on the Tools menu, or from the Visitors window, click Print to generate
an onscreen preview of the list of attendees/visitors. A variety of options are available from this
preview, including the options to email the list, to export the list to a .pdf, and so on.
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CHAPTER 135: Check in Visitors
This topic will provide information on:

l Check a new visitor into a meeting
l Check Visitors Into a Meeting

o Check In From the Booking Check-In Dashboard
l Checking in From the Reservation Book

Check a new visitor into a meeting:

1. On the EMS menu bar, click Reservations > Other > Visitors. The Visitors window opens.

2. Open the Groups tab (sometimes re-labeled "Employees" or "Customers").

TIP: Once you have added the new visitor, the Print Badge button becomes enabled on the screen above
so you can print badges.

3. Find the group or individual hosting the new visitor; specify search criteria:

l Start Date/End Date—The default value is the current day’s date.
l Building—Select (all) buildings, a specific building, an area, or a view to search.
l Group—Enter some or all of the hosting group’s name.
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4. Click Display. The groups and people that meet your search criteria are displayed in the middle pane
of the Visitors window.

TIP: You can see the booking a person is attending by clicking Open; this opens the reservation in the
Navigator that contains the booking that the unregistered visitor is attending.

5. Select the hosting group from the search results, and then click New Visitor. The New Visitor dialog
box opens. When you create this visitor account, they will be associated with the group or individual
you selected in the window above.
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6. Enter the information for the unregistered visitor, and then click OK. The Visitor dialog box closes.
You return to the Visitors window with the group and newly configured visitor automatically selec-
ted.

NOTE: Building and Name are required fields. Depending on how your EMS administrator configured your
system, Company Name, Email Address and/or Phone might be required. Notes are always optional. If you
selected a specific building in Step 3, then the Building field is automatically populated with the name of the
building in which the event is scheduled and you cannot edit this value; however, if you have set your
preferences for buildings such that this building is not available to you, then the Building field cannot be
populated with the correct value, and you cannot add the new visitor. See Setting User Preferences and
Default Values.

7. Repeat above steps as needed to add all new visitors to the event. The information in the Event
column for each new visitor is determined by your Administrator's settings (specified when con-
figuring the event building). For example, “Unregistered Visitor” might be displayed. The date and
time when you add an unregistered visitor to an event is used as the Check-In date and time for the
visitor.

Check Visitors Into a Meeting
If authorized, you can check unregistered visitors into a meeting from the Main Menu or the Reservation
Book.

Check In From the Booking Check-In Dashboard

1. Select Booking Check In from the menu bar in EMS Desktop Client.
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2. Set filters to search for bookings you want to check into.

3. Select an event from the list of results that displays and click the Check In button.

TIP: This feature replaces the Building and Booking Check In tools in previous releases.

Checking in From the Reservation Book
Bookings in the Reservation Book can be checked into by right-clicking on the booking and selecting
Check In.
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CHAPTER 136: Import a List of Visitors to a Meeting
To import a list of visitors to a meeting, you will

l Ensure your list of visitors is ready for import.
l Navigate to the meeting you want to work with.
l Import your list of visitors.
l Select the meetings within the reservation to which to add your list of visitors.
l Confirm and finalize.

1. Your list of visitors must be a tab-delimited spreadsheet that contains the information (in the order
listed) for the visitors you want to import. Each visitor must be a separate line entry.

FIELD DESCRIPTION REQUIRED/OPTIONAL

Visitor True/False

Company Name Text. 50 characters maximum. Optional

Email Address Text. 255 characters maximum. Optional

Phone Text. 50 characters maximum. Optional

Notes Text. No maximum. Optional

Name Text. 50 characters maximum. Required

TIP: You can click Print Format on the second page of the Add Booking Details Wizard (described below)
to see the required format for the tab-delimited file.

2. Open the reservation from the Reservation Book.
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3. In the left pane of the Navigator window that opens, select the meeting for which you are importing
the list of attendees/visitors, and in the Bookings pane on the right, click Tools, and then select Add
Booking Details Wizard. 
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4. The Add Booking Details wizard opens.
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5. Select Visitors or Attendees, and then clickNext. 
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6. The second page of the Add Booking Details Wizard opens with a blank row for adding an
attendee/visitor to the event.

7. Click Import. The Open File dialog box opens. Browse to and select your visitor list spreadsheet, and

then click Import to import the file. The Add Booking Details Wizard is updated with the imported
attendee/visitor information. Each imported visitor is a separate line entry in the Wizard.

8. ClickNext. The Select Bookings window opens, listing all the bookings within the selected reser-

vation with a date on or after the current day's date, and that do not already have the visitor list
added.
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TIP: To show canceled bookings, clear the Hide Canceled Bookings checkbox. To hide them, select the
option. To show all bookings regardless of date, clear the Hide Old Bookings option.

9. Select the meetings to which to add your visitor list (use CTRL+click or Select All to select multiple
meetings), and then click Finish. 

10. A message opens asking you if you want to add more booking details. ClickNo. 
11. A message opens indicating that the changes were made successfully. ClickOK to close the message

and return to the Navigator. The booking detail (Visitors) and its items (visitors) are displayed as
folders under the appropriate booking folders in the Navigator.
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CHAPTER 137: The EMS Main Window
The EMS main window is your starting point for the EMS application. The window provides quick access to
all the EMS functions (Reservations, Reports, Configuration, and so on) and system tools. The EMS Main
window has four major components:

l Title Bar
l Menu Bar
l Toolbar
l Main Menu

Title Bar 
The name of the software, EMS Software, and the version number of the application appear in the title bar
across the top of the main window.

Menu Bar 
The menu bar is set up in a standard Windows menu format with menu commands grouped into menus
(File, Settings, Reservations, and so on) across the menu bar. Some of these menu commands are also
available in the main menu.

Toolbar 
The toolbar provides quick access to the most commonly used functions. The toolbar buttons that are
always displayed by default are the buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User
Reservations, Clients, Email, Dashboard, and Manage Services. Other buttons for other functions are also
displayed by default depending on the version of EMS that you are running, for example, EMS Academic
Planning or EMS Workplace. Some of the functions that are available on the toolbar are also available from
the main menu. You can customize the appearance of this toolbar to best suit your business needs. See
Also: Toolbar Buttons.

Main Menu
The main menu gives you access to the main EMS functions: Reservations, Reports, Billing, Configuration,
and System Administration.
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The main menu is arranged in a hierarchical folder structure. The top-level folders are the system functions
of Reservations, Reports, Billing, Billing, Configuration, and System Administration. The available tasks for
each top-level folder are further organized into subfolders. For example, to perform a system
administration task, you must first open the top-level System Administration folder, and then open the
correct subfolder to view the list of available tasks.

You can always close the main menu by clicking the Close button in the upper right corner. To open the
main menu again, on the menu bar, click File > Show Main Menu.
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CHAPTER 138: Work with EMS Windows
This topic guides you in modifying the size and manner of viewing information in most pages or "browser
windows" in EMS Desktop Client.

Click-and-Drag
Column headers and borders enable you to change column location, order, or width. When a window
offers the option shown below, you can click and drag a column header to group data by that column.

Right-Click Column Menu
These menus let you sort, hide, and group lists and resize.
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Column Sort Arrows
Use the up/down arrows in each header to quickly sort a column in ascending or descending order.

Column Filters
Filtering options help narrow down lists.
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CHAPTER 139: Toolbar Buttons
The toolbar always displays buttons for Book, Calendar, Wizard, Navigator, Browser, Everyday User
Reservations, Groups, Email, Dashboard, and Manage Services. Other buttons for other functions might
also display, depending on the version of EMS that you are running (such as EMS Campus or EMS
Workplace) and additional components your organization might have installed, such as EMS Glance or the
EMS Polycom Interface. Some of the functions that are available on the toolbar are also available from the
main menu. You can customize the appearance of this toolbar to best suit your business needs; keep in
mind that your System Administrator might have re-labeled these options with different names than the
examples shown in this topic.

TIP: If you are new to EMS Desktop Client, we recommend that you print out this Toolbar Cheat Sheet.

Book
Often called the "Reservation Book," this window shows all confirmed reservations (time and room) for
your organization. Canceled bookings are not shown. You can use the Book to view and edit existing
reservation, and to make new reservations. For detailed instructions, See Also: Using the Reservation
Book.

Calendar 
You use the Calendar to quickly find for reservations, bookings, and service orders using basic or advanced
criteria; results are displayed in a calendar view. See Also: Using the Calendar.

Wizard 
You use the Reservation Wizard to make reservations using a streamlined booking template. See
Also: Using the Reservation Wizard.

Navigator 
The Navigator enables you to to view and manage all aspects of a reservation including bookings and
booking details. This window also presents whenever you open a reservation for editing from other pages
in EMS Desktop Client. See Also: The Navigator Overview.
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Browser and Everyday User Reservations 
Authorized users can use the Browser or Everyday User Reservations Browser to search at a very detailed
level for reservations, web reservations, bookings, service orders, resources, and queries. See Also: Search
with the Browser.

Groups 
Your organization might have re-labeled this button, "Customers" or "Employees." You can use this
browser to search for groups or individuals and reservations and bookings made on their behalf. See
Also: Groups and Contacts.

Email  
If your system is configured to use SMTP email, clicking this button launches a generic email window. For
detailed instructions, See Also: Sending Email from EMS.

Dashboard 
Authorized users can access this window for centralized information about reservations in a single location.
They typically use this feature to plan day-to-day tasks, such as set and check reminders, send or read
notifications, approve or check the status of meeting and service order requests, and review the latest
changes to events. See Also: Overview of the EMS Dashboard.

Manage Services  
You use Manage Services to search for and view the resources with and without service orders for all
bookings on a particular day as well as the current state of the resources and their Reviewed status. After
viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you
can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if
necessary. See Also: Manage Services.

Group Reservations 
If your organization has licensed EMS Workplace, you might see Group Reservation icon in your toolbar.
This feature enables you to manage and make reservations for Groups in a centralized location. See
Also: Work with Information for a Group.
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CHAPTER 140: Customizing Your Toolbar

1. Right-click the toolbar and click Customize. 

2. The Customize Toolbar dialog box opens.

3. To display the toolbar icons as large icons, select Large Icons; otherwise, click Small Icons. To add or
remove icons from the toolbar display, select them (CTRL+click to pick more than one at a time) and
then use the arrow buttons in the middle or double-click on them to move them between the Hide
or Show panels.
To change the order (from left to right) in which the icons are displayed on the toolbar, click Move
Up or Move Down.

4. Click OK to save your changes and update the toolbar, or click Cancel to exit without saving your
changes).
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CHAPTER 141: Using the Reservation Book
The Reservation Book provides a view of all the confirmed reservations (the reserved time as well as the
room for which the reservation is scheduled) for your organization. (Canceled bookings are not shown.)
You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to
make a new reservation. In addition, before you edit or make a reservation, you can change the
Reservation Book display so it better suits your working needs.

Concept: Space is Hierarchical in EMS
In EMS, your organization's office is made up of locations, spaces, and users. 

Locations
A physical area representing multiple spaces. Depending on how large your company is, it could be
anything from "West Coast HQ" to a campus-level "Mail Room 6". and can contain multiple rooms,
buildings, and other spaces.

Areas
Similar to locations, and area can also include multiple locations, and helps you group locations, buildings,
and rooms by your own organization's 

Buildings
A physical building containing rooms, with pre-defined equipment and service options. Buildings belong to
Locations. 

Rooms
Rooms with pre-defined equipment and service options. Rooms belong to a Building. You can think of the
hierarchy like this: Your Company > New York HQ > Client Consultation Area > Central Park Building >
Nicest Conference Room

Users
When you add users in EMS, how you define their user profiles and booking templates control whether
they will be able to schedule events in the rooms you've configured. 

To open the Reservation Book, on the EMS toolbar, click the Book icon; a window opens where you can see
all confirmed reservations for today. You can set Filters along the top, such as Building, View, and Date to
change the events listed, and you can change the time zone displayed. All today's reservations that meet
the filtering criteria are displayed in the book in the Daily view. You might have to scroll up and down to
see all reservations. 
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TIP: You can only make a new reservation from here in the Daily View. You might also be able to Check In
to events from here. You can customize the information that shows when you mouse over an event.

Filtering Rooms 
You can filter the Reservation Book to only show certain Rooms.

Accruent Confidential and Proprietary © 2019 Page | 522

CHAPTER 141: Using the Reservation Book



1. Click Filter. The Filter Rooms dialog box opens. 

l If you click Room Properties, you can filter by Building, Floor, Room Type, Capacity, and Room
Availability.

l If you click Specific Room, you can filter the list to only show events in specific rooms.
2. Click OK to close the popup and update in the Reservation Book.

TIP: Click Reset at the top of the Rooms list to reset filters back to defaults.

Customizing Your Reservation Book Display 
Click Options (upper right) to open the Book Options dialog box where you can customize the display of
the book and reservations in it.

NOTE: As of Update 22, you can simultaneously view event type color and status color from the
Reservation Book. See Also: Book Option Fields below.

Book Option Fields
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OPTION DESCRIPTION

Start Hour The daily start time for the Reservation Book display.

Automatically
Refresh

The time interval at which the Reservation Book display is automatically
refreshed.

Display The information that is displayed in the middle bar for a reservation.

Time Display
Interval

Changes the granularity of the time display interval.

Maximum
No. of Rooms

The maximum number of rooms to display in the Reservation Book.

Booking
Colors Based
On

The color of the bookings in the reservation. Select one: Status, Event Type,
or Check-in Status (for EMS Workplace only.)

Show Event Type Color As Outline on Bookings: Check this box to
simultaneously view Status and Event Type on the Reservation Book.

For example, in the image below, the event type is yellow and the status is
blue.

Rooms
Without
Bookings

Whether to highlight rooms without bookings and if so, the highlight color.
If both Highlight Rooms and Booked Space Status Only are selected, then
only those rooms that do not have a Booked Space status are highlighted.

Room
Display

Display the room code or the room name for a reservation.

Building
Display

Display the building code or the building name for a reservation.

Go To Today
on Startup

If selected, the Reservation Book opens to the current day’s date; otherwise,
it opens to the last date viewed.

Always
Prompt for

If Show ‘(all)’ in Building List is also selected, then when you open the
Reservation Book, the Room Filter dialog box opens on top of the
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OPTION DESCRIPTION

Room Filter
on Startup

Reservation Book. You can select different options on this dialog box to
display only specific reservations in the book, for example, bookings only
for selected rooms. If you do not select any options on this dialog box, but
instead simply close it, then all reservations for all rooms in all buildings are
displayed in the book.

Hide Current
Time
Indicator

Show or hide the vertical bar that indicates the current time for current day.

Note: The Current Time indicator is displayed only if the view is the Daily or
Weekly view and the view includes the current day’s date.

Show ‘(all)’ in
Building List

Show the “all” option on the Building drop-down list; otherwise, a user must
select a specific building. If this option is selected in conjunction
with Always Prompt for Room Filter on Startup, then when you open the
Reservation Book, then the Room Filter dialog box always opens on top of
the Reservation Book. If you are setting your Reservation Book options, and
you do not want to the Room Filter dialog box to open on top of the
Reservation Book when you open the book, then do the following:

l Clear Always Prompt for Room Filter on Startup.
l Clear Show (‘all’) in Building List.
l On the Building drop-down list in the Reservation Book, select any

building, area, or view.

Note: The building, area, or view that you select is not important. This last
step just clears the “all” building option from the Reservation Book cache
and ensures that the Room Filter dialog box does not open on top of the
Reservation Book. Going forward, you can always select all buildings, or any
specific building, area, or view as needed when you are working in the
Reservation Book.

Show
Capacity

Show the minimum and maximum capacities next to the room description.

Hide Booking
Shadow

Hide the vertical shadow bar that highlights the reserved and/or event start
times and end times when a user moves a booking in the Reservation Book.
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Customize Event Information on Mouseover 
In the Book Options dialog box, click the Tooltip Display tab to select which items to include in the tooltip
that opens when you mouseover an event in the Reservation Book.

Accruent Confidential and Proprietary © 2019 Page | 526

CHAPTER 141: Using the Reservation Book



CHAPTER 142: Create a Booking in the Reservation Book
To begin, locate and select the room you want to book in the Reservation Book (Daily display). To the
right of the room in the time grid, click and drag your mouse to select a start time and end time. The
Reservation Wizard launches.

You use the Reservation Wizard to check for available space for an event and to make a reservation for the
event.

Concept: Reservations are containers for multiple bookings; bookings are individual meetings .
When you "make a reservation" in EMS, you are creating the broader rules for events that take place with a
similar purpose and involving most of the same people, services, resources, and spaces. When you "book" a
meeting, you are creating a meeting within a reservation. See Also: Reservation Structure.

The Reservation Wizard helps you search for rooms that are available for a particular time on one day (a
simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You
can also create a series reservation by selecting one date and time, but multiple rooms.

To make a reservation using the wizard, you will:

l Set the event date, time, and status
l Set the event location
l Specify the event information

The following procedure describes how to make a reservation by selecting values for the required and
optional fields.

l If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard
Template drop-down list is displayed at the top of the Reservation Wizard. You can streamline the
booking process by choosing from these templates, which automatically sets the default values for
many of the fields in the Reservation Wizard.

l If your job entails making multiple reservations that require the same information, and you are not
using reservation wizard templates, then you can set your own default values for many of the fields in
the Reservation Wizard. See Also: Setting User Preferences and Default Values.

Setting the Event Date and Time

1. On the toolbar, click the Wizard icon. The Reservation Wizard opens. All required fields in the wizard
are marked with a red dot. Your EMS administrator configures the required fields.
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2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different
month (< or >) or for a different year (<< or >>). You can also click a month at the top of the cal-
endar to open a drop-down list from which you can select a different month and you can also click a
year at the top of the calendar to open a drop-down list from which you can select a different year.

l If the event dates do not follow a pattern, use one or more of the following options for entering
a date; otherwise, go to the next step. Click to pick dates on the calendar. To select all five days
in a work week, click in the blank space to the left of the week. To select all seven days in a week,
double-click in the blank space to the left of the week.
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To select every occurrence of a specific day of the week for the displayed month (for example, all
Tuesdays in November, 2012), click the heading (S, M, T, and so on) for the day. To select every
occurrence of a specific day of the week shown (regardless if the day falls within the same
month), double-click the heading (S, M, T, and so on) for the day. If you need to clear a single
selected date, click the date again. To clear multiple selected dates in a single step, click Clear
Month to clear all currently selected dates for the currently displayed month or click Clear All to
clear all currently selected dates regardless of month or year.

l If the event dates do follow a recurrent pattern, (for example, the third Friday of every month),
click Date Pattern to open the Date Pattern dialog box and enter your event date information.
The steps that you use to create a date pattern in EMS are very similar to the steps that you use
to create a date pattern in Microsoft Outlook or in any other calendaring product.

As you specify the event dates, the Selected Dates tab is automatically updated with the
selected dates. Dates that are closed are displayed in red on the Calendar tab, holidays are
green. These are linked to information about the closure (in the Selected Dates tab,
click Holidays). To remove the date your selection, open the Selected Dates tab, select the date,
or CTRL-click to select multiple dates, and then click Remove. When you make a reservation for
multiple dates, the process is easier if you first remove all holidays or closed dates from the list
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of selected dates; however, be very careful when selecting dates for removal as you are not
prompted to confirm your selection before you click Remove.

Viewing information about a holiday or closed date from the Calendar tab

3. Specify the start time and end time for the event:
l Select a time from the drop-down list for each field.
l Manually enter the time in each field. When you manually enter the time, you can use a short-

cut. For example, for 9:00 am, you need to enter only "9a" and for 2:00 pm, you need to enter
only "2p" and so on. If you enter an end time that is earlier than the start time, then the system
assumes that the end time is the next day and the phrase "Next Day" is displayed to the right of
the End time field.

4. Specify Setup and Teardown times. To use the default setup and teardown times that your EMS
administrator has assigned to the rooms in your system, leave Use Default selected. To override the
default setup/teardown times, clear Use Default, select Minutes or Hours, and then enter your own
setup and teardown times. Remember, setup and teardown times are the hours, or fractions of
hours, that you add to the event time to allow staff to prepare a room for the event or to clean up
after the event. For example, for a 30 minute setup time, you can enter 30 minutes or 0.5 hours.

5. Select the status for the event. Depending on the status that you select, for example, Tentative or
Hold, you might be required to enter a reconfirm date. You can monitor reservations that must be
reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See Also: EMS Dashboard.

Setting the Event Location
You have three options for selecting the event location on the first window of the Reservation Wizard:

SEARCH

METHOD

DESCRIPTION

Standard Use this option to display a list of all the available rooms that meet all the
requested dates. 

Note: Standard search is required for Video Conference room assignments.
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SEARCH

METHOD

DESCRIPTION

Best Fit Use this option if no one room can meet all the requested dates. The system lists
the available rooms along with the number of bookings for which you can
reserve each room. You can piece together the entire reservation using Best Fit,
or just part of it. 

Specific
Room

Use this option to confirm the availability and reserve of one specific room for
the scheduled event. 

Note: By default, EMS looks for an available room or rooms in only the first 50 rooms that it finds in the
pre-configured Rooms list. To search more than 50 rooms, before you begin any search, click Options >
Max. Number of Rooms to Search, and then select a different number of rooms to search.

Finding a Standard Room
By default, when you search for a standard room, rooms that are available all day are marked with an
asterisk (*). To set or clear this option, click Options > Standard Search > Show Available All Day Indicator.

1. Select Standard.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to
search for a standard room. Your selection on the Building drop-down list determines the options
that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a
time zone. If you select a specific building, then by default, a time zone is selected for the building,
and you cannot select a different value.

3. If applicable, select the appropriate time zone for the event.

4. Specify one or more room settings:
l Type is the class or category of the room, for example a meeting room, a workspace, and so on.

Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type drop-down list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type drop-down list.

l Setup count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count. The selected setup type and setup count are applied to
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all the bookings that you add to this reservation. If any of the bookings require a different
setup type or count, you can change this information after you complete the reservation. 

5. You can add optional Features on the Features tab.

6. Click Next. Up to two tabs are displayed:
l The Available tab, which is the active tab and is always displayed, lists all the rooms that

meet all your event criteria. If you have elected to show the Available All Day Indicator, the
rooms that are available all day are marked with an asterisk (*). By default, the available rooms
are sorted alphabetically by room code. If your EMS administrator has configured the rooms
for your EMS implementation with a book sequence, then under Options, select Sort Rooms by
Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have
the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not
available for scheduling as well as list of the events that are scheduled for each room.

Example of standard room search results

7. Select the room, or CTRL-click to select the multiple rooms you are scheduling for the event. If the
reservation is for a video conferencing meeting, then you must select a minimum of two rooms. You
must designate one of these rooms as the Host Location on the Video Conference tab on the last
page of the Reservation Wizard.

8. Optionally, do one or both of the following; otherwise, go to Step 9.
l Click Room Info to open the Room Info dialog box and view information about any bookings

for the room, the room properties, its pricing, and/or to view an image of the room.
l Click Building Hours to open the Building Hours dialog box which displays the hours that the

selected room/building is open on the reserved date.
9. Click the Move button (>) to move the rooms to the Selected list.

Tip: If you select more than one room, all the selected rooms are booked for all the event dates.
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10. Click Next.

Finding a Best Fit Room

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to
search for a standard room.

3. If applicable, select the appropriate time zone for the event.

Note: Your selection on the Building drop-down list determines the options that are available on the Time
Zone drop-down list. If you select (all) buildings, then you can select a time zone. If you select a specific
building, then by default, a time zone is selected for the building, and you cannot select a different value.

4. Do one or more or all of the following for room specifications:
l Type is the class or category of the room, for example a meeting room, a workspace, and so on.

Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type drop-down list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type drop-down list.

l Setup count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count. The selected setup type and setup count are applied to
all the bookings that you add to this reservation. If any of the bookings require a different
setup type or count, you can edit the reservation later.

5. You can add optional Features for the room on the Features tab.

6. Click Next. Up to two tabs are displayed:
l The Available tab, which is the active tab and is always displayed, has two lists. The list in the left

pane is a list of all the rooms that meet some or all of your event criteria. The list in the right
pane is a list of all the event dates that must be fulfilled. By default, the available rooms are sor-
ted alphabetically by room code. If your EMS administrator has configured the rooms for your
EMS implementation with a book sequence, then under Options, select Sort Rooms by Book
Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the
same sequence, then the rooms are sorted alphabetically by name within the sequence.)

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not avail-
able for scheduling for the event as well as list of the events that are scheduled for each room.

Accruent Confidential and Proprietary © 2019 Page | 533

CHAPTER 142: Create a Booking in the Reservation Book



Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to the next step.
l To see detailed room information, click Room Info  (such as the room properties, pricing, and/or

to view an image of the room).
l To see building hours, click Building Hours (which shows hours when the selected room/build-

ing is open on the reserved date).
8. If a room is available, select the single room that is available for all the requested dates, and then click

the Move button (>) to move the room to the Event Dates list. If a room is not available, select a
room that is available for some of your requested dates, and then click the Move button (>) to move
the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue.

Finding a Specific Room
You can use the specific room search to book a standard EMS room or a room or area that is not managed
in EMS. An override room, or "override description," is used to book an event in a space that has not been
configured in your EMS system. For example, your EMS administrator might have configured an override
room named "Other Area" in the Engineering building. To book an event in Dr. Wilson's office, which is a
room that is not defined in EMS, in the Engineering building, you can select the "Other Area" room and
specify "Dr. Wilson's Office" for the location. EMS does not track availability for events booked in override
rooms; however, EMS reports on events that are scheduled in an override room just like any other event
scheduled for any other room.
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1. Select Specific Room. The Room Selector dialog box opens.

2. To choose a room from list of all rooms in all available buildings, select (all) on the Building drop-
down list; then select a room, and then click OK. To select a room in a specific building, area, or view,
select it on the Building drop-down list, select the room, and then click OK. If the room is configured
as an override room, go to the next step, otherwise, go skip to Step 4.

3. In the Location field, enter the location of the override room, and then click Next skip the remaining
steps in this subsection.

4. Click Next. If the event is scheduled for a single date and the room is available, then continue. In all
other cases, (for example, the event is scheduled for a single date but the room is not available or it is
a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific
room is available. You can open the Conflicts tab to view the list of dates for which the specific room
is not available as well as list of the events that are scheduled for the room.

5. Optionally, do one or both of the following; otherwise, go to the next step.
l To see detailed room information, click Room Info  (such as the room properties, pricing, and/or

to view an image of the room).
l To see building hours, click Building Hours (which shows hours when the selected room/build-

ing is open on the reserved date).
6. If the specific room is available for all the event dates, then click the Move All button (>>) to schedule

the room for all the event dates. If the specific room is not available, try another approach such as
reserving a different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue. 

Specify Event Information
After you select an event location or locations, you must specify other information for the event. You must
enter information in the required fields.
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1. Enter event information using the elements in this window (see also: Reservation Wizard Fields). 
2. Click Finish. The Navigator window opens. The reservation information appears in the window. You

use this window to add booking details and to make any needed modifications to the reservation
and its bookings.

Note: A reservation is not complete and rooms are not removed from the Available list until you
click Finish. Although unlikely, it is possible for another user to select and reserve a room during the time
period after you have selected the room but before you have finalized the reservation. If this occurs, after
you click Finish, a message opens stating that your reservation conflicts with an existing reservation.
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CHAPTER 143: View and Edit Reservations in the Reservation
Book
The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well
as the room for which the reservation is scheduled) for your organization. (Canceled bookings are not
shown.) You use the Reservation Book to the view information for a reservation, to edit an existing
reservation, and to make a new reservation. In addition, when the Reservation Book first opens, before you
edit or make a reservation, you can change the Reservation Book view so that it better suits your working
needs.

This section will provide information on the following topics:

l To open the Reservation Book
l To change the Reservation Book display
l To view reservation information
l To make a new reservation
l To edit an existing reservation

To open the Reservation Book

1. From the toolbar, click theBook icon. The first time that you open the Reservation Book for your
EMS implementation, by default, the Filter dialog box opens on top of a blank Reservation Book. You
can leave the room filtering criteria set to their default values, or you can select different values as
needed, and then click OK. All reservations that meet the filtering criteria and that are scheduled for
the current day’s date are displayed in the book in theDaily view.

TIP: You might need to use the book’s scroll features to scroll through all the reservations that are
scheduled for the current day’s date.

l If an event is scheduled for a room that is a component of a combination room, then the reservation
text is displayed in black. A duplicate reservation is also shown for the combination room; however,
the reservation text is displayed in gray to indicate that a component of the combination room is cur-
rently booked for the indicated time and therefore, the combination room is not available

l Conversely, if an event is scheduled for a combination room, then the reservation text for the com-
bination room is displayed in black and the reservation text for each component is displayed in gray.
This reversed color coding indicates that the component room is currently booked for the selected
time and that none of the components is available.

The Reservation Book has the following appearance:
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l Minimum and maximum capacities are displayed next to room descriptions
l The current time is shown by a vertical line in the grid, called the Current Time Indicator
l If building hours have been configured for a building, then this information is displayed for the build-

ing

The reservations are displayed with three components:

1. A left bar that indicates the setup time

2. A middle bar that indicates, by default, the event name

3. A right bar that indicates the teardown time

To change the Reservation Book display

1. On the EMS Web Client toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. You can change the Reservation Book display in the following ways:
l Change the list of rooms that are displayed in the Reservation Book based on room properties.
l Change the list of rooms that are displayed in the Reservation Book based on a specific room

(s).
l Change the Reservation Book view.
l Change multiple display options for a reservation.
l Select which items to include in the tooltip that opens when you place the cursor over an event

in the Reservation Book.
l Change the display date using the calendar.
l Change the display date using the Reservation Book scroll features.

3. To change the list of rooms based on room properties:
a. Click Filter if the Filter dialog box is not already open.

b. Select Room Properties and customize one or more of the following:
l Leave the Building drop-down list set to the default value of (all) buildings, or select a spe-

cific building, area, or view.
l Select a specific floor.
l Select a specific room type.
l Select Capacity and then enter a capacity.
l Select Academic to limit the search to academic rooms.
l Select a Room Availability option.

4. Click OK. The Filter Rooms dialog box closes. The room display in the Reservation Book is changed
accordingly.

5. To change the list of rooms that are displayed in the Reservation Book based on a specific room or
rooms:

a. If the Filter Rooms dialog box is not already open, then above the Rooms list, click Filter to open
the dialog box and select Specific Room.
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b. Select the room, or CTRL-click to select multiple rooms on the Available list.

c. Click the Move (>) button to move the selected rooms to the Selected list. The Reservation
Book is updated to show bookings only for the selected rooms

6. To change the Reservation Book view:
a. From the View drop-down list, select Daily, Weekly, or Monthly. 

7. To change multiple display options for a reservation:
a. Click Options (upper right hand corner of Reservation Book) to open the Book Options dialog

box (the General tab is the active tab).
b. Change multiple display options not only for the Reservation Book, but also a reservation in

the book.

OPTION DESCRIPTION

Start Hour The daily start time for the Reservation Book display.

Display The information that is displayed in the middle bar for a reservation.

Time
Display
Interval

Changes the granularity of the time display interval.

Maximum
Number
of Rooms

The maximum number of rooms to display in the Reservation Book.

Booking
Colors
Based On

The color of the bookings in the reservation. Select one: Status, Event Type, or
Check-in Status (for EMS Workplace only.)

Rooms
Without
Bookings

Whether to highlight rooms without bookings and if so, the highlight color. If
both Highlight Rooms and Booked Space Status Only are selected, then only
those rooms that do not have a Booked Space status are highlighted.

Room
Display

Display the room code or the room name for a reservation.

Building
Display

Display the building code or the building name for a reservation.

Go To If selected, the Reservation Book opens to the current day’s date; otherwise, it
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OPTION DESCRIPTION

Today on
Startup

opens to the last date viewed.

Always
Prompt
for Room
Filter on
Startup

If Show ‘(all)’ in Building List is also selected, then when you open the
Reservation Book, the Filter dialog box opens on top of the Reservation Book.
You can select different options on this dialog box to display only specific
reservations in the book, for example, bookings only for selected rooms. If you
do not select any options on this dialog box, but instead simply close it, then
all reservations for all rooms in all buildings are displayed in the book.

Hide
Current
Time
Indicator

Show or hide the vertical bar that indicates the current time for current day.

Note: The Current Time indicator is displayed only if the view is the Daily or
Weekly view and the view includes the current day’s date.

Show
‘(all)’ in
Building
List

Show the “all” option on the Building drop-down list; otherwise, a user must
select a specific building. If this option is selected in conjunction with Always
Prompt for Room Filter on Startup, then when you open the Reservation Book,
then the Filter dialog box always opens on top of the Reservation Book. If you
are setting your Reservation Book options, and you do not want to the Filter
dialog box to open on top of the Reservation Book when you open the book,
then do the following:

l Clear Always Prompt for Room Filter on Startup.
l Clear Show (‘all’) in Building List.
l On the Building drop-down list in the Reservation Book, select any build-

ing, area, or view.

Note: The building, area, or view that you select is not important. This last step
just clears the “all” building option from the Reservation Book cache and
ensures that the Filter dialog box does not open on top of the Reservation
Book. Going forward, you can always select all buildings, or any specific
building, area, or view as needed when you are working in the Reservation
Book.
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OPTION DESCRIPTION

Show
Capacity

Show the minimum and maximum capacities next to the room description.

Hide
Booking
Shadow

Hide the vertical shadow bar that highlights the reserved and/or event start
times and end times when a user moves a booking in the Reservation Book.

8. To select which items to include in the tooltip that opens when you place the cursor over an event in
the Reservation Book:

a. ClickOptions (upper right hand corner of Reservation Book) to open the Book Options dialog
box. 

b. Open the Tooltip Display tab and select which items to include in the tooltip that opens
when you rest the mouse pointer on an event in the Reservation Book.

9. To change the display date using the calendar: 
a. From theDate field, click the drop-down arrow to open the Calendar.
b. Use the (< and >) scroll features at the top of the calendar to change the month or use the (>)

scroll features at the top of the calendar to change the year.
c. To select a different date for a month, click the date.

10. To change the display date using the Reservation Book scroll features:
a. Use the scroll features at the top of the reservation book display to scroll to a different day,

week, month, or any different combination of these.
b. To reset the display immediately to the current day’s date, click Today.

To view reservation information

1. On the EMS toolbar, click theBook icon. The Reservation Book opens in the Daily view.
2. To view the reservation in the Navigator, double-click the middle bar for the reservation entry or

right-click the reservation entry and on the context menu that opens, clickOpen.
3. You can view the reservation information in the following ways:

l View thebookings for a room
l View theproperties for a room
l View thepricing for a booked room
l View the setup information, event information, or teardown information for a reservation.

4. To view the bookings for a room:
a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dia-

log box. The tab on this dialog box lists all the bookings for the selected room based on the
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current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field.
b. To view a booking in the Navigator, select the booking, and then click Open.

5. To view room properties:
a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info

dialog box.
b. Open theRoom tab. The tab on this dialog box lists all the properties for the room, such as the

room code, the room name, the room classification, etc. It also lists the setup type and capa-
city for the room, and any notes that have been entered for the room.

6. To view the pricing for a booked room:
a. Click the room name or code in the Rooms list to open the Bookings tab for the Room Info

dialog box.
b. Open thePricing tab. This tab displays any pricing information that was defined for the room.

7. To view the room setup information, event information, or teardown information for a reservation:
a. Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tool-

tip showing the respective setup, event, or teardown information opens.
b. If buildings that are located in multiple time zones are currently displayed, you can specify the

time zone in which to view all of your bookings.

To make a new reservation

1. On the EMS toolbar, click theBook icon. The Reservation Book opens in the Daily view.
2. Change the display to show the room for which you are making the reservation.

3. Select the date for which you are making the reservation.

4. In the Time Grid for the room, click and hold the left mouse button, drag the mouse to schedule the
room and time, and then release the mouse button to open the Reservation Wizard. See Create a
Reservation in the Reservation Wizard. 

To edit an existing reservation

1. On the EMS toolbar, click the Book icon. The Reservation Book opens in the Daily view.

2. Optionally, you can do one or more of the following to edit an existing reservation:

STEP ACTION

Change the setup time
for a reservation

l Drag the left bar horizontally to a new time.
l Click Yes in the Confirm Change dialog box.

Change the event time l Drag the middle bar horizontally to a new time.
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STEP ACTION

l Click Yes in the Confirm Change dialog box.

Change the teardown
time for a reservation

l Drag the right bar horizontally to a new time.
l Click Yes in the Confirm Change dialog box.

Edit the reservation
building, room, time, or
both

l Drag and drop the reservation to a new room that is the
same building or in a different building, and/or to a new
time.

l Click Yes in the Confirm Change dialog box.

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu
that opens, select one of the following:

OPTION DESCRIPTION

Open Opens a reservation in the EMS Navigator.

Move Forward Move the reservation date forward by one day or one week.

Move Backward Move the reservation date backward by one day or one week.

Move to a
Specific Date

Move the reservation to a specific date.

Change Status Change the status of the reservation.

Copy Bookings N/A

Note: Although this option is available on the context menu for a
reservation, its associated functionality is currently under development.

Swap Rooms
With Another
Booking

Swap the room assignments of two events. The swap option is
applicable only for two events that have identical meeting patterns.

Highlight Related
Reservations

Highlights the bookings that belong to the same reservation.
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CHAPTER 144: Edit Reservations in the Reservations Book

1. Begin by locating a booking in the Reservation Book.

2. You can do one or more of the following to edit an existing reservation:

STEP Action

Change the setup
time

Drag the left bar horizontally to a new time, then click Yes.

Change the event
time

Drag the middle bar horizontally to a new time, then click Yes.

Change the tear-
down time

Drag the right bar horizontally to a new time, then click Yes.

Change the build-
ing, room, time, or
both

Drag and drop the reservation to a new room that is the same build-
ing or in a different building, and/or to a new time, the click Yes.

3. Right-click on a reservation in the Reservation Book to access a menu of editing options (defined
below).
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OPTION Description

Open Opens a reservation in the EMS Navigator.

Add to Personal Calendar Adds the reservation to your personal cal-
endar.

Move Forward Move the reservation date forward by one
day or one week.

Move Backward Move the reservation date back by one day
or one week.

Move to Specific Date Move the reservation to a specific date.

Change Status Change the status of the reservation.

Copy Bookings Opens the Copy Bookings wizard.

Swap Rooms With Another Booking (EMS) Swap the room assignments of two events
(only applicable for two events that have
identical meeting patterns). Right-click on
one of the two reservations that you are
swapping, and on the context menu that
opens, click Swap Rooms, click on the other
reservation, then click Yes. Note: If the rooms
that you are swapping have been configured
with a default setup type, and the setup
count is not within the capacity of one or
both rooms, a message opens indicating
this, but you are not prevented from swap-
ping rooms.

Swap Rooms With Another Booking (EMS
Academic Planning)

Swaps only the two bookings selected for
the indicated day. (Just like Swap Rooms
With Another Booking in EMS.)

Swap Rooms With Another Course (EMS Aca-
demic Planning)

If the meeting patterns of two courses are
identical, then the swap is allowed and all
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OPTION Description

bookings between the two courses for the
entire term are swapped.

Highlight Related Bookings Highlights the bookings that belong to the
same reservation.

Check In Check into the booking.
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CHAPTER 145: Import a List of Visitors to a Meeting
To import a list of visitors to a meeting, you will

l Ensure your list of visitors is ready for import.
l Navigate to the meeting you want to work with.
l Import your list of visitors.
l Select the meetings within the reservation to which to add your list of visitors.
l Confirm and finalize.

1. Your list of visitors must be a tab-delimited spreadsheet that contains the information (in the order
listed) for the visitors you want to import. Each visitor must be a separate line entry.

FIELD DESCRIPTION REQUIRED/OPTIONAL

Visitor True/False

Company Name Text. 50 characters maximum. Optional

Email Address Text. 255 characters maximum. Optional

Phone Text. 50 characters maximum. Optional

Notes Text. No maximum. Optional

Name Text. 50 characters maximum. Required

TIP: You can click Print Format on the second page of the Add Booking Details Wizard (described below)
to see the required format for the tab-delimited file.

2. Open the reservation from the Reservation Book.
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3. In the left pane of the Navigator window that opens, select the meeting for which you are importing
the list of attendees/visitors, and in the Bookings pane on the right, click Tools, and then select Add
Booking Details Wizard. 
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4. The Add Booking Details wizard opens.
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5. Select Visitors or Attendees, and then clickNext. 
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6. The second page of the Add Booking Details Wizard opens with a blank row for adding an
attendee/visitor to the event.

7. Click Import. The Open File dialog box opens. Browse to and select your visitor list spreadsheet, and

then click Import to import the file. The Add Booking Details Wizard is updated with the imported
attendee/visitor information. Each imported visitor is a separate line entry in the Wizard.

8. ClickNext. The Select Bookings window opens, listing all the bookings within the selected reser-

vation with a date on or after the current day's date, and that do not already have the visitor list
added.
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TIP: To show canceled bookings, clear the Hide Canceled Bookings checkbox. To hide them, select the
option. To show all bookings regardless of date, clear the Hide Old Bookings option.

9. Select the meetings to which to add your visitor list (use CTRL+click or Select All to select multiple
meetings), and then click Finish. 

10. A message opens asking you if you want to add more booking details. ClickNo. 
11. A message opens indicating that the changes were made successfully. ClickOK to close the message

and return to the Navigator. The booking detail (Visitors) and its items (visitors) are displayed as
folders under the appropriate booking folders in the Navigator.
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CHAPTER 146: The Navigator
The Navigator is the window in EMS that you use to view and manage all aspects of a reservation including
bookings and booking details.

This section includes the following: 

l Overview of the Navigator
l Edit a Reservation in the Navigator
l Add Bookings to a Reservation in the Navigator
l Copy a Reservation in the Navigator
l Change the Status of a Reservation in the Navigator
l Reprice Categories and Room Charges for a Reservation in the Navigator
l Apply a Reservation Discount
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l Edit a Booking in the Navigator
l Edit Multiple Bookings in the Navigator
l Move Bookings to a Different Reservation in the Navigator
l Copy Multiple Bookings in the Navigator
l Booking Details and Items Overview

o Add Booking Details and Items to Individual Bookings
o Add Booking Details and Items to Multiple Bookings
o Edit Booking Detail Items for Individual Bookings
o Copy Booking Details Between Bookings
o Delete Booking Detail Items from Multiple Bookings
o Edit Charges for Multiple Billable Item
o Edit Count Information for a Booking in the Navigator
o Add Booking Details Wizard
o Copy Booking Details Wizard
o Delete Booking Details Wizard
o Delete Item Wizard
o Add Item Wizard

l Comments and Reminders in the Navigator
o Add Multiple Comments and Reminders to a Reservation

l User-Defined Fields in the Navigator
l Attachments in the Navigator
l Drawings in the Navigator
l Resource Utility Conflicts Tool
l Approve or Deny Reservation Requests
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CHAPTER 147: Navigator Overview
This section provides an overview of opening a reservation in the Navigator, the Navigator's layout and
folder structure, and the commands that are available in the Navigator.

This topic provides information on the following:

l Open a Reservation in the Navigator
l Open a Reservation through the Reservation Book
l Open a Reservation through a Group
l Open a Reservation through a Search
l Layout and Folder Structure

o Reservation Folder
n Allocate Charges to Multiple Billing Reference Numbers and/or PO Numbers

o Booking Folder
o Booking Detail Folder

l Navigator Commands
o Navigator Options Dialog Box

n General Tab
n At a Glance Tab
n Highlight Categories Tab

o Other Navigator Commands

Open a Reservation in the Navigator
After you create a new reservation using the Reservation Wizard, the reservation opens automatically in
the Navigator. You can also manually open the Navigator by:

l Selecting a reservation, booking, or service order to open directly in the Navigator. See steps below.
l Opening a reservation through the Reservation Book. See Also: Open a reservation through the

Reservation Book.
l Opening a reservation through a group. See Also: Open a reservation through a group.
l Opening a reservation through a search. See Also: Open a reservation through a search.

1. On the toolbar, click the Navigator icon to open the Open Navigator dialog box.
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2. On the Open drop-down list, select the item that you are opening: reservation, booking, or service
order.

3. Do one of the following:
l In the No. field, enter the number for the reservation, service order, or booking, and then click

OK.
l To enter the last reservation, booking, or service order that you made during your current or

last EMS session, double-click in the field, and then click OK.

NOTE: If you do not know the reservation number, you can search for the reservation. On the Open
Navigator dialog box, click Browse to open the Browser.

Open a Reservation through the Reservation Book
On the toolbar, click the Book icon to open the Reservation Book, and then in the Reservation Book,
double-click a booking for the reservation to open the reservation in the Navigator. See Also: View and
Edit Reservations in the Reservation Book.

Open a Reservation through a Group
You can search for a reservation for a group and open the reservation in the Navigator from the group-
specific window. See Also: Reservations for a Group.
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Open a reservation through a Search
You can search for a reservation using the Browser, the Web Reservation Tool, and/or the Calendar, and
then double-clicking the search result entry to open the reservation in the Navigator.

TIP: You can also click Browse on the Open Navigator dialog box to open the Browser search tool.

Layout and Folder Structure
The Navigator has three panes:  left pane, a top right pane, and a bottom left pane. The left pane displays a
selected reservation, all the bookings for the reservation, and the details for each booking in a Windows
Explorer-style folder structure. The top-level folder is the reservation folder. The folders that are located
beneath a reservation folder are the booking folders. The folders that are located beneath a booking folder
are the booking detail folders. The top right pane of the Navigator displays different tabs and options
depending on the folder or item that is selected in the left pane of the Navigator. The bottom right pane of
the Navigator functions just like a browser window (See Also: Getting Started with EMS), and it also
displays different information and options depending on the folder or item that is selected in the left pane.

Reservation Folder
A reservation folder contains thewho and thewhat information for the reservation. When you select a
reservation folder in the left pane of the Navigator, the reservation number is displayed in the title bar of
the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

l Reservation Summary tab—The Reservation Summary displays information about the selected
reservation, including the event name, the group for which the reservation was made, the group
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contact name, the group contact phone number, and the reservation number.
l Properties tab—The Properties tab displays not only the same information as the Reservation Sum-

mary tab, but also information such as the event type, the second group contact, the date that the
reservation was added, the date that the reservation was changed, and so on.

l Billing Reference Allocation tab—By default, the charge for a reservation is allocated to a single
billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a
reservation to multiple billing reference numbers by percentage. See Also: Allocating charges to
multiple billing reference numbers and/or PO numbers.
TIP: Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab
to be displayed. See Also: EMS System Parameters.

l PO Number Allocation tab—By default, the charge for a reservation is allocated to a single pur-
chase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reser-
vation to multiple billing PO numbers by percentage. See Also: Allocating Charges to Multiple
Billing Reference Numbers and/or PO Numbers.
TIP: Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be
displayed. See Also: EMS System Parameters.

l Reminders tab—The Reminders tab displays any reminders that were created for the selected reser-

vation. See Also: Comments and Reminders in the Navigator.
l Comments—The Comments tab displays any text entries that were made for the selected reser-

vation. See Also: Comments and Reminders in the Navigator.
l Attachments tab—The Attachments tab displays any attachments (files) that have been saved

with the reservation. See Also: Attachments in the Navigator.
l User Defined Fields—The User Defined Fields tab displays the additional fields that store custom

data for a reservation. Your EMS administrator configures the types of fields that are available as well
as the allowed values for these fields. See Also: User Defined Fields in the Navigator.

l Transactions—The Transactions tab displays any invoices that were generated for the selected

reservation or any payments that were applied to the selected reservation. See Billing, for detailed
information about invoices and other financial transactions in EMS.

l History tab—The History tab displays the history for the reservation: the date that a change was
made to the reservation, the ID of the user who made the change, the field that was changed, the old
field value, and the new field value.

l Emails tab—The Emails tab displays any summarizing information for any emails that were sent via

SMTP to the group for whom the reservation was made. See Also: Sending Email from EMS.

Also, when you select a reservation folder:
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l All the tabs in the upper pane of the window have some of the basic features of an EMS browser win-
dow. You can change the width of the data columns, you can sort the data columns on a tab in either
ascending or descending sort order, and you can rearrange the column order by dragging a column
to a new location using the column heading. See Also: EMS Browser Window.

l The bookings for the selected reservation are displayed in the Bookings pane (the lower right pane)
of the Navigator. The colored rectangle to the left of a booking indicates the booking's status. If a
booking has been canceled, a Canceled icon is displayed on the booking folder in both the Reser-
vation (left) pane and the Bookings pane.

l You can right-click in the upper pane and open a context menu with options for emailing the group
for which the reservation was made, or the first contact for the group.

allocate charges to multiple billing reference numbers and/or PO numbers
TIP: The following procedure details how to allocate a reservation charge to multiple billing reference
numbers; however, by analogy, you can follow this procedure to allocate booking charges or booking
detail charges to multiple billing reference numbers and/or PO numbers.

1. For a selected reservation, open the Billing Reference Allocation tab, and then click Edit. The Billing
Reference Allocation dialog box opens. By default, when this dialog box first opens, it displays the
charge for the reservation allocated 100% to a single billing reference number placeholder.
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2. Select the billing reference number placeholder, and then click Edit. The Split Billing Add dialog box
opens.

3. Do one of the following:
l Enter the billing reference number to which you are allocating the reservation charges, and

then click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Alloc-
ation dialog box with the newly added billing reference number allocated at 100%. Continue to
Step 5.

l Click the Search icon to open a Billing References dialog box, and then do one of the following:
l Select a billing reference number from the list, click Select, and then click OK.
l In the Find field, enter a search string, and then click Display to display a list of all billing ref-

erence numbers that meet your search criteria. Select the appropriate billing reference number
from the search results, click Select, and then click OK.

l The Billing References dialog box closes. You return to the Split Billing Add dialog box with the
selected billing reference number displayed in the dialog box.

TIP: Your search is limited to the exact order of the characters in the string, but the string is not case-
sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both
123.445.678 and 445.678.123.

4. Click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog
box with the selected billing reference number allocated at 100%.

5. Do one of the following:
l To allocate the reservation charges to only this single billing reference number, click OK. The

Billing Reference Allocation dialog box closes and you return to the Navigator. The newly added
billing reference number, allocated at 100%, is displayed on the Billing Reference Allocation tab.

l To allocate the reservation charges to multiple billing reference numbers.
6. Click New. The Split Billing Add dialog box opens.
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7. Do one of the following:
l In the Billing Reference field, enter a billing reference number and then click OK.
l Click the Search icon to open a Billing References dialog box, and then do one of the following:
l Select a billing reference number from the list, click Select, and then click OK.
l In the Find field, enter a search string, and then click Display to display a list of all billing ref-

erence numbers that meet your search criteria. Select the appropriate billing reference number
from the search results, click Select, and then click OK.

TIP: Your search is limited to the exact order of the characters in the string, but the string is not case-
sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both
123.445.678 and 445.678.123.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with each of
the newly added billing reference numbers displayed with a 0% allocation.

8. Repeat Step 6 and Step 7 until you have added all the needed billing reference numbers.

9. For each new billing reference number, double-click in the Percent field to select the percent, and
then change the percent to the appropriate value.

NOTE: The percentages must add up to 100%.

10. Click OK to close the Billing Reference Allocation dialog box and return to the Billing Reference Alloc-
ation tab. All the billing reference numbers and their percent allocations are displayed on the tab.

Booking Folder
Booking folders contain thewhere andwhen information for the reservation. If you can expand a booking
folder, this indicates that details have been added to the booking. The booking details for the selected
booking are displayed in the Booking Details pane (the lower right pane) of the Navigator. A green
background for a booking detail folder indicates that one or more booking detail items have been invoiced
for the booking. 
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When you select a booking folder in the left pane of the Navigator, the booking number is displayed in the
title bar of the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

l Booking Summary tab—The Booking Summary displays information about the selected booking,
including the event date, the reserved time, the event time, and so on. If you use Outlook as your
email program, you can do the following from this tab:

o To add the selected booking to your personal calendar, click Outlook > Add to Personal Cal-
endar.

o To send invitations for the meeting to one or more contacts in your Outlook Address Book,
click Outlook > Send Invitation.

l Properties tab—The Properties tab displays not only the same information as the Booking Sum-
mary tab, but also information such as the event type, the setup count, the date that the booking
was added, the date that the booking was changed, and so on.

l Billing Reference Allocation tab—By default, the charge for a booking is allocated to a single
billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a
booking to multiple billing reference numbers by percentage. See Also: Allocating charges to mul-
tiple billing reference numbers and/or PO numbers.
TIP: Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab
to be displayed. See Also: EMS System Parameters.

l PO Number Allocation tab—By default, the charge for a booking is located to a single purchase
order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation
to multiple billing PO numbers by percentage. See Also: Allocating Charges to Multiple Billing
Reference Numbers and/or PO numbers.
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TIP: Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to
be displayed. See Also: EMS System Parameters.

l Reminders tab—The Reminders tab displays any reminders that were created for the selected book-

ing. See Also: Comments and Reminders in the Navigator.
l Attachments—The Attachments tab displays any attachments that were saved with the booking.

See Also: Attachments in the Navigator.
l Comments—The Comments tab displays any comments that were made for the selected booking.

See Also: Comments and Reminders in the Navigator.
l Drawings—The Drawings tab displays a list of files that were attached to the selected booking. See

Also: Drawings in the Navigator.
l History—The History tab displays a list of changes made for the selected booking: the date the

change was made to the booking, the user who made the change to the booking, and information
(field) that was changed for the booking.

Also, when you select a booking folder, all the tabs in the upper pane of the window have some of the same
basic features of an EMS browser window. You can change the width of the data columns, you can sort the
data columns on a tab in either ascending or descending sort order, and you can rearrange the column
order by dragging a column to a new location using the column heading.

Booking Detail Folder
If you can expand a booking folder, this indicates that details have been added to the booking. Booking
details, which are also called categories, are the services (catering, A/V equipment, and so on), notes,
attendees, activities, and room charges that you can add to a booking.
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TIP: Booking detail folders and booking detail items are discussed in Booking Details and Items
Overview.

Navigator Commands
The Navigator has two constant commands in the upper left hand corner: Open Reservation and View
Alerts and three constant commands in the upper right hand corner: Print, Refresh, and Settings.

COMMAND DESCRIPTION

Open
Reservation

Allows you to open and work with multiple reservations in the same Navigator
session. See Opening a reservation directly in the Navigator.

View Alerts Open and view any alerts that have been generated for the selected
reservation, booking, or a booking detail that is a service order or catering
category.

Print l Printing an invoice or a confirmation at the reservation level. See Con-
firmations.

l Printing the Setup Worksheet for Reservation report, the Service Orders
report, and the Banquet Event Order report. See Reports and Queries.

l Printing the Transaction report. See Generating an EMS Billing Report.
l Printing the history of a reservation, all its bookings, and all its booking
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COMMAND DESCRIPTION

detail items.

Refresh For refreshing the Navigator display based on the settings that you have
specified in the Navigator Options dialog box.

Settings l Options—Opens the Navigator Options dialog box in which you can spe-
cify such things as what is to be displayed in the Navigator, mouse
actions in the Navigator, and so on.

l Confirmation Settings—Opens the Confirmation Settings dialog box
which provides a variety of options that you can specify for manual and
automatic generation of a confirmation for a reservation or a booking.
See Also:  Confirmations.

All other navigator commands are available as buttons in the upper right pane and lower right pane of the
Navigator.

Navigator options Dialog box
The Navigator Options dialog box has three tabs: General, At a Glance, and Highlight Categories.

General tab
General tab—On the General tab, you select the options for such things as which types of bookings to
show in the Navigator (old bookings and/or canceled bookings), the result of double-clicking a listed folder
(opens the item or expands the folder), the booking time that is displayed (reserved time or event time),
and the highlight color for invoiced items.

 Navigator Options dialog box, General tab
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FIELD DESCRIPTION

General

Show Old
Bookings

Show bookings in the Navigator that occurred before the current day's
date.

Show Canceled
Bookings

Selected, show bookings in the Navigator with a canceled status.
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FIELD DESCRIPTION

Show Wizards in
Tools menu

Show all on the Tools menu in the Bookings pane. If cleared, show
only the "Wizards" option, which you must click to open a form from
which you can select a tool.

Show Deleted Item Show all deleted items (bookings, deleted resource items, and so on)
for a reservation in the Navigator.

Hide Empty Tabs Hide the tabs that do not have any data displayed on them for a
selected reservation, booking, or booking detail.

Double-Clicking a Listed Folder

Opens the item Opens the item for editing.

Expands folder Opens the next level of folders.

Wizard Results

Always Show Show a confirmation of all changes, regardless if they were successful,
on a Wizard Results page.

Show Unchanged
Only

Show only those changes that were not successful on a Wizard Results
page.

Confirmation

Always prompt When you click Confirmation, opens a Confirmation filter which you
can use to change the default filter options for a confirmation before
generating it.

Print Preview When you click Confirmation, opens an onscreen preview of the
confirmation.

Email When you click Confirmation, opens an email of the confirmation.

Print When you click Confirmation, prints an immediate confirmation.

Booking Display Time
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FIELD DESCRIPTION

Reserved Time Show the total time for which the space is reserved. This time is the
event time plus the setup/teardown times.

Event Time Show only the event time for which the space is reserved.

Invoiced Items

Highlight Color The color with which invoiced items are highlighted in the Navigator
window.

Service Orders

Show Pricing Show pricing on a service order.

Show Item Notes Show item notes on a service order.

Show Item Special
Instructions

Show special instructions for items on a service order.

Highlight Changes
Made Within
(days)

Highlight any changes that have been made to a service order within
the specified number of days.

Footer Message Show reconfigured blocks of text that appear in footer of a service
order (for example, a Cancellation policy).

Booking Edit

Auto Adjust
Reserved Time
When Event Time
is Changed

If the reservation includes setup and/or teardown times, then
automatically adjust the total time for the reservation (the event time
plus the setup/teardown time) when the event time is changed.

At A Glance tab
On the At A Glance tab, you specify whether reminders, comments, attachments, and so on are to be
displayed in the left pane of the Navigator when a reservation folder, booking folder, booking detail folder,
and/or booking detail item is opened.

Navigator Options dialog box, At a Glance tab
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Highlight Categories Tab
On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all booking detail
item folders for the selected booking detail. The default is to Highlight All, which means every booking
detail item folder for every booking detail is denoted with a checkmark.

Navigator Options dialog box, Highlight Categories tab
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Other Navigator commands
All other Navigator commands are available as buttons in the upper right pane and lower right pane of the
Navigator. The buttons that are available are dynamically updated based not only on the folder or item
that is currently selected in the left pane of the Navigator, but also on the tab that is open in the upper
right pane of the Navigator.

Buttons available in the Navigator window with a reservation folder selected
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Buttons available in the Navigator window with a booking folder selected

Buttons available in the Navigator window with a booking detail folder selected
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Many of these same commands are also available on a context menu, which is a menu that opens when
you right-click on a folder or item in the Navigator. All the context menus that are available in the
Navigator offer a limited set of choices based on the folder or item that is selected in the Navigator.  

Comparing context menus
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CHAPTER 148: Get Familiar with the Navigator
The Navigator is the master page you use to view a reservation and all its details. It launches from many
areas of EMS Desktop Client.

To familiarize with the Navigator, this topic provides information on how to do the following:

l Open a reservation in the Navigator
l Review the Navigator's layout and folder structure
l Learn the commands available on the Navigator
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Navigator in EMS Desktop Client

Opening a Reservation in the Navigator 
After you create a new reservation using the Reservation Wizard, the reservation opens automatically in
the Navigator. To open an existing reservation, follow the steps below.

1. On the toolbar, click the Navigator icon. The Open Navigator dialog box.
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Open Navigator Dialog Box

2. On the Open drop-down, select the item that you are opening—reservation, booking, or service
order.

3. Do one of the following:
l In the Reservation No. field, enter the reservation ID, service order number, or booking ID, and

then click OK.
l To see the last reservation, booking, or service order that you made during

your current or last EMS session, double-click in the field, and then click OK.

TIP: If you do not know the reservation number, you can search for the reservation. On the Open
Navigator dialog box, click Browse to open the Browser, and then find your reservation.

Opening a Reservation from The Reservation Book 
On the toolbar, click the Book icon to open the Reservation Book, and then in the Reservation Book,
double-click a reservation; this opens the reservation in the Navigator. 

Opening a Reservation Through a Group 
You can search for a reservation made for a group or individual user from the Groups icon; this opens the
reservation in the Navigator. 
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Opening a Reservation Using a Search 
You can search for a reservation using the Browser, the Web Reservation Tool, and/or the Calendar.
Double-clicking the search result entry will open the reservation in the Navigator. You can also
click Browse on the Open Navigator dialog box to open the Browser search tool.

Layout and Folder Structure 
The Navigator has three panes:

1. The left pane displays a selected reservation, all the bookings for the reservation, and the details for
each booking in a hierarchical folder structure. The top-level folder is the reservation folder. The
folders that are located beneath a reservation folder are the booking folders. The folders that are loc-
ated beneath a booking folder are the booking detail folders.

2. The top right pane of the Navigator displays different tabs and options depending on the folder or
item that you click on in the left pane.

3. The bottom right pane of the Navigator functions just like a browser window, and shows different
information and options depending on the folder or item you click on in the left pane.

Navigator Panes (Reservation Folder Selected)

Reservation Folder 
A reservation folder contains the who and the what information for the reservation. When you select a
reservation folder in the left pane of the Navigator, the reservation number is displayed in the title bar of
the Navigator. You can change the width of the data columns, you can sort the data columns on a tab in
either ascending or descending sort order, and you can rearrange the column order by dragging a column
to a new location using the column heading. When you select a reservation folder, the bookings for the
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selected reservation show in the Bookings pane (the lower right pane) of the Navigator. The colored
rectangle to the left of a booking indicates the booking's status. If a booking has been canceled, a Canceled
icon is displayed on the booking folder in both the Reservation (left) pane and the Bookings pane. You can
right-click in the upper pane and open a context menu with options for emailing the group for which the
reservation was made, or the first contact for the group.

When you select a Reservation folder, the following tabs are displayed in the upper right pane of the
Navigator:

l Reservation Summary Tab
l Properties Tab
l Billing Reference/PO Allocation Tab
l Reminders Tab
l Attachments Tab
l Comments Tab
l User Defined Fields Tab
l Transactions Tab
l Emails Tab

Reservation Summary Tab
The Reservation Summary displays information about the selected reservation, including the event name,
the group for which the reservation was made, the group contact name, the group contact phone number,
and the reservation number.

Properties Tab
The Properties tab displays not only the same information as the Reservation Summary tab, but also
information such as the event type, the second group contact, the date that the reservation was added,
the date that the reservation was changed, and so on.

Billing Reference/PO Allocation Tab
By default, the charge for a booking is allocated to a single billing reference number and/or a single
purchase order (PO) number. This tab enables you to allocate booking charges or booking detail charges
to multiple billing reference numbers and/or PO numbers. Your EMS administrator must enable the "Use
Billing Reference Allocation" and "Use PO Number Allocation" parameters for this tab to be
displayed. 

See Also: Allocating Multiple Billing and PO Numbers For a Reservation.
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Reminders Tab
The Reminders tab displays any reminders that were created for the selected reservation. 

Attachments Tab
The Attachments tab displays any attachments that were saved with the reservation. 

Comments Tab
The Comments tab displays any comments that were made for the selected reservation. 

History Tab
The History tab displays a list of changes made for the selected booking: the date the change was made to
the booking, the user who made the change to the booking, and information (field) that was changed for
the booking.

User Defined Fields Tab
The User Defined Fields tab displays the additional fields that store custom data for a reservation. Your
EMS administrator configures the types of fields that are available as well as the allowed values for these
fields. See Also: Working with User Defined Fields.

Transactions Tab
The Transactions tab displays any invoices that were generated for the selected reservation or any
payments that were applied to the selected reservation. 

Emails Tab
The Emails tab summarizes any emails that were sent via SMTP to the group for whom the reservation was
made. This does not include notifications and other communications done using EMS for Outlook or by
other means.

Booking Folder 
Booking folders contain the where and when information for the reservation. If you can expand a booking
folder, this indicates that details have been added to the booking. The booking details for the selected
booking are displayed in the Booking Details pane (the lower right pane) of the Navigator. A green
background for a booking detail folder indicates that one or more booking detail items have been invoiced
for the booking. 
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Navigator with Booking Folder Selected

When you select a booking folder in the left pane of the Navigator, the booking number is displayed in the
title bar of the Navigator. You can change the width of the data columns, you can sort the data columns on
a tab in either ascending or descending sort order, and you can rearrange the column order by dragging a
column to a new location using the column heading.  

When you select a Booking folder, the following tabs are displayed in the upper right pane of the
Navigator:

l Booking Summary Tab
l Properties Tab
l Billing Reference/PO Allocation Tab
l Reminders Tab
l Attachments Tab
l Comments Tab
l Drawings Tab
l History Tab

Booking Summary Tab
The Booking Summary displays information about the selected booking, including the event date, the
reserved time, the event time, and so on. If you use Outlook as your email program, you can use this tab to
add the selected booking to your personal calendar (click Outlook > Add to Personal Calendar) or send
invitations for the meeting to one or more contacts in your Outlook Address Book (click Outlook > Send
Invitation).
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Properties Tab
The Properties tab displays not only the same information as the Booking Summary tab, but also
information such as the event type, the setup count, the date that the booking was added, the date that
the booking was changed, and so on.

Billing Reference/PO Allocation Tab
By default, the charge for a booking is allocated to a single billing reference number and/or a single
purchase order (PO) number. This tab enables you to allocate booking charges or booking detail charges
to multiple billing reference numbers and/or PO numbers. Your EMS administrator must enable the "Use
Billing Reference Allocation" and "Use PO Number Allocation" parameters for this tab to be
displayed. 

See Also: Allocating Multiple Billing and PO Numbers For a Reservation.

Reminders Tab 
The Reminders tab displays any reminders that were created for the selected booking. 

Attachments Tab
The Attachments tab displays any attachments that were saved with the booking. 

Comments Tab
The Comments tab displays any comments that were made for the selected booking. 

Drawings Tab
The Drawings tab displays a list of files that were attached to the selected booking. 

History Tab
The History tab displays a list of changes made for the selected booking—the date the change was made
to the booking, the user who made the change to the booking, and information (field) that was changed
for the booking.

Booking Detail Folder 
If you can expand a booking folder, this indicates that details have been added to the booking. Booking
details, which are also called categories, are the services (catering, A/V equipment, and so on), notes,
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attendees, activities, and room charges that you can add to a booking.

Navigator with Booking Detail Folder Selected

See Also: Adding Services to a Meeting.

Navigator Commands 
The Navigator has two constant commands in the upper left corner: Open Reservation and View Alerts.
The Navigator also has three constant commands in the upper right corner: Print, Refresh, and Settings.

COMMAND DESCRIPTION

Open
Reservation

Allows you to open and work with multiple reservations in the same Navigator
session. 

View Alerts Open and view any alerts that have been generated for the selected
reservation, booking, or a booking detail that is a service order or catering
category.

Print l Printing an invoice or a confirmation at the reservation level. 
l Printing the Setup Worksheet for Reservation report, the Service Orders

report, and the Banquet Event Order report. 
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COMMAND DESCRIPTION

l Printing the Transaction report. 
l Printing the history of a reservation, all its bookings, and all its booking

detail items.

Refresh For refreshing the Navigator display based on the settings that you have
specified in the Navigator Options dialog box. 

Settings l Options—Opens the Navigator Options dialog box in which you can spe-
cify such things as what is to be displayed in the Navigator, mouse
actions in the Navigator, and so on. 

l Confirmation Settings—Opens the Confirmation Settings dialog box
which provides a variety of options that you can specify for manual and
automatic generation of a confirmation for a reservation or a booking. 

All other navigator commands are available as buttons in the upper right pane and lower right pane of the
Navigator.

Navigator Options 
The Navigator Options (click in the upper right corner) has three tabs:

1. General
2. At A Glance
3. Highlight Categories

General Tab 
On the General tab, you select the options for such things as which types of bookings to show in the
Navigator (old bookings and/or canceled bookings), the result of double-clicking a listed folder (opens the
item or expands the folder), the booking time that is displayed (reserved time or event time), and the
highlight color for invoiced items.
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Navigator Options Dialog Box, General Tab

FIELD DESCRIPTION

General

Show Old
Bookings

Show bookings in the Navigator that occurred before the current day's
date.

Show Canceled
Bookings

Selected, show bookings in the Navigator with a canceled status.

Show Wizards in
Tools menu

Show all on the Tools menu in the Bookings pane. If cleared, show
only the Wizards option, which you must click to open a form from
which you can select a tool.
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FIELD DESCRIPTION

Show Deleted
Items

Show all deleted items (bookings, deleted resource items, and so on)
for a reservation in the Navigator.

Hide Empty Tabs Hide the tabs that do not have any data displayed on them for a
selected reservation, booking, or booking detail.

Double-Clicking a Listed Folder

Opens the item Opens the item for editing.

Expands folder Opens the next level of folders.

Wizard Results

Always Show Show a confirmation of all changes, regardless if they were successful,
on a Wizard Results page.

Show Unchanged
Only

Show only those changes that were not successful on a Wizard Results
page.

Confirmation

Always prompt When you click Confirmation, opens a Confirmation filter which you
can use to change the default filter options for a confirmation before
generating it.

Print Preview When you click Confirmation, opens an onscreen preview of the
confirmation.

Email When you click Confirmation, opens an email of the confirmation.

Print When you click Confirmation, prints an immediate confirmation.

Booking Display Time

Reserved Time Show the total time for which the space is reserved. This time is the
event time plus the setup/teardown times.

Event Time Show only the event time for which the space is reserved.
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FIELD DESCRIPTION

Invoiced Items

Highlight Color The color with which invoiced items are highlighted in the Navigator
window.

Service Orders

Show Pricing Show pricing on a service order.

Show Item Notes Show item notes on a service order.

Show Item Special
Instructions

Show special instructions for items on a service order.

Highlight Changes
Made Within
(days)

Highlight any changes that have been made to a service order within
the specified number of days.

Footer Message Show reconfigured blocks of text that appear in footer of a service
order (for example, a Cancellation policy).

Booking Edit

Auto Adjust
Reserved Time
When Event Time
is Changed

If the reservation includes setup and/or teardown times, then
automatically adjust the total time for the reservation (the event time
plus the setup/teardown time) when the event time is changed.

At A Glance Tab 
On the At A Glance tab, you specify whether reminders, comments, attachments, and so on are to be
displayed in the left pane of the Navigator when a reservation folder, booking folder, booking detail folder,
and/or booking detail item is opened.
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Navigator Options Dialog Box, At A Glance Tab

Highlight Categories 
On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all booking detail
item folders for the selected booking detail. The default is to Highlight All, which means every booking
detail item folder for every booking detail is denoted with a checkmark.
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Navigator Options Dialog Box, Highlight Categories Tab

Other Navigator Commands 
All other Navigator commands are available as buttons in the upper right pane and lower right pane of the
Navigator. The buttons that are available are dynamically updated based not only on the folder or item
that is currently selected in the left pane of the Navigator, but also on the tab that is open in the upper
right pane of the Navigator.
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Buttons available in the Navigator window with a reservation folder selected

Buttons available in the Navigator window with a booking folder selected
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Buttons available in the Navigator window with a booking detail folder selected
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Many of these same commands are also available on a context menu, which is a menu that opens when
you right-click on a folder or item in the Navigator. All the context menus that are available in the
Navigator offer a limited set of choices based on the folder or item that is selected in the Navigator.  

Comparing context menus
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CHAPTER 149: Edit a Reservation in the Navigator
When you edit a reservation in the Navigator, you are working with the who and the what information for
the event: the event name, the group name, and so on. When you edit a reservation, you can edit
the reservation information (event name, event coordinator, and so on), and you can edit
the billing information (pricing plan, payment type, and so on).

Tip: When you edit a reservation, if you select a different pricing plan, that plan is applied at the reservation
level only; categories and room charges are not automatically repriced. To reprice your categories or room
charges based on a new pricing plan, you use the Update Pricing Plan wizard.
See Also: Repricing Categories and Room Charges for a Reservation.

1. Open the reservation in the Navigator. 

2. In left pane the Navigator, select the reservation that you are editing, and then on the Reservation
Summary tab or on the Properties tab, click Edit. The Reservation window opens. The Reservation tab
is the active tab.
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3. Edit information on the Reservation and Billing Information tabs as needed.
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TIP: If you select a different pricing plan, then the pricing plan is applied at the reservation level only.
Categories and room charges are not automatically repriced. To reprice your categories or room charges
based on a new pricing plan, you must use the Update Pricing Plan Wizard.

4. Click OK. The Reservation window closes and you return to the Navigator, which now shows the
updated information for the reservation.
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CHAPTER 150: Add Bookings to a Reservation in the Navigator
You can use the Navigator to add one or more bookings to an existing reservation.

1. Open the reservation in the Navigator. See Navigator Overview.
2. In the left pane of the Navigator, select the reservation to which you are adding the bookings, and

then in the Bookings pane, click New. The Reservation Wizard opens.

See Also: Create a Reservation in the Reservation Wizard.
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CHAPTER 151: Copy a Reservation in the Navigator
You can make a new reservation easily by copying an existing one and then make any necessary changes
to it. When you copy an existing reservation, you must provide a new start date and a new status, however,
you can copy existing reservation reminders, comments, user-defined fields, and drawings "as-is," and you
can copy one or more or all the existing booking details.

1. Open the reservation in the Navigator.

2. In the left pane of the Navigator, select the reservation you want to copy, and then in the right pane,
click Tools.

3. Click Copy Reservation Wizard. 

4. The Copy Reservation Wizard opens.
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5. Enter the information for the new reservation.

FIELD DESCRIPTION/COMMENTS

New Start Date The date of the first booking for the new reservation.

New Status The status for the new reservation.

Reconfirm Date Enter a date if it is required for the new status that you selected.

Conflict Status Enter a conflict status in the event that the new bookings are in conflict
with any existing bookings.

Reconfirm Date Enter a date if it is required for the new conflict status that you selected.

Copy Reminders

Copy Comments

Leave the appropriate options selected to copy the existing items "as-
is," or clear the option for each item that is not to be copied to the new
reservation.
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FIELD DESCRIPTION/COMMENTS

Copy User
Defined Fields

Copy
Attachments

Copy Drawings

Copy Booking
Details

Select the booking details that are being copied (CTRL-click to select
multiple details) or to select all the details for copying, click Select All.

NOTE: By default, only active booking details are displayed. To show
inactive booking details for copying, click Show Inactive.

Copy Inactive
Resources/Rooms

Selected by default. Copies the inactive resource and/or rooms from the
existing reservation to the new reservation. Clear this option if you do
not want to copy the inactive resources and rooms.

6. Click Next. The Select Bookings window opens. This window displays all the bookings for the reser-
vation that you are copying.

TIP: You can use the Hide Canceled Bookings option to show or hide canceled bookings. To show all
bookings regardless of date, clear Hide Old Bookings.
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TIP: The start date that you specified becomes the date of the first booking for the new reservation. Once
you copy bookings for this reservation, they are scheduled according to the same pattern as the existing
reservation. For example, if the existing reservation has three bookings and each booking was scheduled
every seven days (12/14, 12/21, and 12/28), and the start date for the new reservation is 12/15, then the
new reservation has three bookings with dates of 12/15, 12/22, and 12/29.

7. Select the booking(s) you want to recreating in the new reservation (or click Select All to select all the
displayed bookings in a single step), and then click Finish. A message opens indicating that the
changes were made successfully.

TIP: When you copy multiple bookings, the bookings are simply copied and pasted "as-is;" the bookings

are not moved to a different location. If you need to move a booking to a different location, see Changing
Rooms for Bookings.

7. Click OK to close the message and return to the Navigator. Both the existing reservation and the new
reservation are now listed in the left pane of the Navigator. The new reservation is assigned a number
based on the next available reservation number in the database. If any of the new bookings are in
conflict with existing bookings, this conflict is indicated in the Navigator.
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CHAPTER 152: Change the Status for a Reservation from the
Reservation Summary Tab
Even though the Change Booking Status Wizard is available for changing the status of multiple bookings in
a reservation, most reservationists who approve reservations that are submitted from Web App do so by
using the Change Status function that is available on the Reservation Summary tab in the Navigator. This is
because unlike the Change Booking Status Wizard, when you use the Change Status function in the
Navigator to change the status of a reservation, an option is available for automatically generating and
sending a confirmation to the group for whom the reservation was made.

Tip: Your EMS administrator must grant you the appropriate security access to change the status of a
booking, which includes canceling a booking. If you want to change the status of a booking using the
Change Booking Status Wizard, see Editing Multiple Bookings in the Navigator.

Tip: An email can be automatically generated and sent only if Email is selected for the Confirmation setting
on the General tab of the Navigator Options dialog box, and if the group for which the reservation was
made has an email address in its record. See Navigator Options dialog box and Search for and
Configure Groups.

To change the status for a reservation 

1. Open the reservation in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group
l Open a reservation through search

2. In left pane in the Navigator, select the reservation that you are editing, and then on the Reservation
Summary tab, click Change Status. The Change Booking Status window opens.
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Change Booking Status window

3. On the Status drop-down list, select the new status for the bookings.

Tip: If you select any type of Canceled status, then three additional fields—Reason, Who Canceled and
Notes—are displayed on the Change Booking Status window. You must enter data in all three of these
fields before you can continue in the Wizard.

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, do one or both of the following:
l Leave Update Reservation Status selected to have the reservation-level status changed as well.
l Select Send Confirmation If Successful to have an email automatically generated and sent to

the group for whom the reservation was made.

Tip: The confirmation is generated based on the system confirmation settings that you have specified.
See Specifying your Confirmation Settings.

6. Click Next. The Select Bookings window opens. This window displays all the bookings for the selected
reservation with a date greater than or equal to the current day's date and that do not have invoiced
items. By default, all the bookings are selected.
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Tip: To show canceled bookings, clear Hide Canceled Bookings. Conversely, to hide canceled bookings,
select Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

7. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the
status, and then click Finish. The Change Booking Status Results window opens. This window lists all
the bookings for the reservation, whether the status was successfully changed or not.

Tip: Optionally, to view only the bookings for the selected reservation that were NOT successfully changed,
select Show Unchanged Only. To view the details for a specific booking that was changed, select the
booking, and then click Go To.

8. Click Close to close the Change Status Results window and return to the Navigator.

Warning: If you reserve a resource and then edit the date, time, location, or status of a booking, and there
is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this
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report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator,
select Tools > Resource Inventory Conflict.
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CHAPTER 153: Reprice Categories and Room Charges for a Reser-
vation
When you edit a reservation, changes to the pricing plan are applied at the reservation-level only. Booking
level service categories and room charges are not automatically repriced. To reprice services or room
charges based on a new pricing plan, use the Update Pricing Plan Wizard shown here. 

Note: You can reprice a room charge for a booking only if the room charge has not been
invoiced. To reprice a room charge that has been invoiced, you must first void the invoice.

Additionally, you can also Edit Charges for Multiple Billable Items.

1. Open the parent reservation in the Navigator. 
2. In left pane the Navigator, select the reservation or booking with which you want to work, and then

on the Reservation Summary tab, click Update Pricing. 

3. The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is displayed in the
Pricing Plan field. The window displays all the service categories and room charges that can be
repriced in one or more of the reservation bookings.
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Note:  If the reservation has other optional Pricing Plans, you can change the list using the
drop-down field at the top.

4. Select a service category or room charge (CTRL-click to select multiple items) to reprice and click Next. 

5. The next window lists all bookings under the reservation that have one or more of the selected ser-
vice categories or room charges that you can reprice.

6. Select the booking(s) for which you want to apply the repricing (you can click Select All to select all the
displayed bookings in a single step), and then click Finish. A message confirms your changes.

7. Click OK to close the message and return to the Navigator.
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CHAPTER 154: Apply a Reservation Discount
You use the Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced details in a
booking. The discount is applied as a percentage of the total charge for an item and it is added to any
existing discounts that have already been applied to the item.

TIP: To apply a discount to invoiced items, you must first void the invoice. See Void an invoice.

1. Open the reservation in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group

2. In the left pane of the Navigator, select the reservation to which you are applying the discount.

3. In the Bookings pane, click Tools, and then click Apply Reservation Discount. The Apply Reservation
Discount window opens. All the bookings for the selected reservation with their categories that have
not been invoiced are displayed.

Accruent Confidential and Proprietary © 2019 Page | 607

CHAPTER 154: Apply a Reservation Discount



4. Leave the Category set to the default value of (all), or optionally, to apply a discount to all the items in
a specific category, on the Category drop-down list, select a category. The Apply Reservation Dis-
count window is updated with the bookings that have the selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are applying the dis-
count, or click Select All to select all the displayed bookings in a single step, and then click Finish. A
message appears indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are editing the reservation
on the Billing Information tab of the Reservation window in the Navigator. See Edit a Reservation in the
Navigator.
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CHAPTER 155: Edit a Booking in the Navigator
When you edit a booking in the Navigator, you are working with the when and where information for the
event: the event time, the event location, and so on. To edit a booking, you must have the appropriate
security access. For example, you cannot move a booking to a room if your EMS administrator has not
granted you access to the room. Likewise, you cannot change the status for a booking from Tentative to
Confirmed if your EMS administrator has not granted you access to the Confirmed status. If you cannot
change a booking and you have appropriate permissions, it might be locked. 

See Also: To edit billable information for a booking, see Edit Booking Detail Item Charges for Multiple
Items. 

TIP: Remember, you can also edit certain booking information in the Reservation Book.

1. Open the Navigator. 
2. In left pane of the Navigator, expand the folder structure for the reservation until the appropriate

booking folder is visible. Select the booking you want to change; the panes on the right refresh to
show information for the booking. On the Booking Summary tab or on the Properties tab, click Edit. 

3. The Booking window opens. A message is displayed at the top of the window that indicates the hours
for the building that contains the selected room. If the booking has any type of booking detail
assigned to it, then "This Booking has Service Orders" is displayed at the top of the window.
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TIP: If you have access, you can change the status of a booking, including canceling a booking.

l If you change the status for a booking, you can select Update Reservation Status to change the reser-
vation-level status to match.

l If you edit a video conference, any date and time changes you make to the booking automatically cas-
cade to all related bookings.

4. On the Booking tab, edit the information for the booking as needed, and then click OK. 
l If you edited anything other than the date, time, or location for a booking, the Booking window

closes and you return to the Navigator, which now shows the updated information for the
booking.

l If you cancel a booking, a Cancel Status dialog box opens in which you must identify the user
who canceled the booking and provide notes (for example, a cancellation reason) about the can-
cellation.

l If you edited the date, time, or location for a booking, a dialog box opens, warning you that crit-
ical booking information has changed and asking you if you want to continue. Click Yes. The
Booking window closes and you return to the Navigator, which now shows the updated inform-
ation for the booking. If you reserved a resource, a Resource Inventory Conflicts report then
opens. If you close this report, you can manually run a Resource Inventory Conflict check. In the
Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
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CHAPTER 156: Edit Multiple Bookings in the Navigator
This topic guides you in using the wizards available from the Navigator to make the same changes to
multiple bookings at once. To edit billable information for a booking, see Editing Charges for Multiple
Items.

This topic will also provide information on:

l Changing the Booking Date/Time
l Changing Booking Status
l Changing Rooms
l Changing Miscellaneous Information

Edit Multiple Bookings

1. Open the Navigator.

2. Select the booking(s) on the left pane that you want to apply the same change(s). The Tools menu
offers several wizards to help you batch-edit the bookings with the same changes.
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Changing the Booking Date/Time

1. In the Bookings pane, click Tools > Change Booking Date/Time Wizard. In the window that presents,
make changes using the field definitions below.

FIELD VALUE DESCRIPTION

Date

No changes The default value.

Reschedule Booking
Earlier

Reschedule the bookings to an earlier date
that is based on the number of days that
you specify.

Reschedule Booking
Later

Reschedule the bookings to a later date
based on the number of days that you spe-
cify.

Reschedule Booking
to Specific Date

Reschedule the bookings to a new date
that you specify.

Time

No changes The default value.
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FIELD VALUE DESCRIPTION

End Booking Earlier Resets the event end time and the reserved
end time to an earlier time, based on the
number of hours that you specify.

End Booking Later Resets the event end time and the reserved
end time to a later time, based on the num-
ber of hours that you specify.

Reschedule Booking
Earlier

Resets both the event start and end times
and the reserved start and end times to an
earlier time, based on the number of hours
that specify.

Reschedule Booking
Later

Resets both the event start and end times
and the reserved start and end times to a
later time, based on the number of hours
that you specify.

Reschedule Booking
to Specific Time

Resets the following values based on the
specific times that you select:
Reserved Start
Event Start
Event End
Reserved End

Set Setup/Teardown Resets the setup or teardown times based
on the hours or minutes that you specify.

Start Booking Earlier Resets the event start time and the
reserved start time to an earlier time,
based on the number of hours that you spe-
cify.

Start Booking Later Resets the event start time and the
reserved start time to a later time, based
on the number of hours that you specify.
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2. Click Next. The Select Bookings window opens, showing all current and future bookings for the selec-
ted reservation so you can select which ones to which to apply the date/time change.

TIP: To show canceled bookings, clear Hide Canceled Bookings. To show all bookings regardless of date,
clear Hide Old Bookings.

3. Select bookings to which to apply the date/time change and then click Finish. The Change Booking
Date/Time Results window opens to show the new changes.

4. Click Close to return to the Navigator.

Changing Booking Status
If authorized, you can change the status of multiple bookings using the Change Booking Status Wizard
(includes canceling a booking). If you change the status for a booking, you can quickly change the parent
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reservation status to match.

1. In the Bookings pane, click Tools > Change Booking Status Wizard. The Change Booking Status Wiz-
ard opens. Select the new Status for the request.

TIP: If you select any type of Canceled status, three additional required fields present: Reason, Who
Canceled and Notes. For status changes to bookings, you can leave Update Reservation Status selected to
change the parent reservation status to match. You can select Send Confirmation If Successful to trigger an
email to the group or individual for whom the reservation was made (depending on your Confirmation
Settings).

2. Enter a Reconfirm Date (if required) for the new status you selected.

3. Click Next. The Select Bookings window opens, listing all the current and upcoming bookings for the
reservation that do not have invoiced items. By default, all the bookings are selected. To show can-
celed bookings, clear Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old
Bookings.
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4. Select the booking(s) for which you want to change changing the status, and then click Finish. The
Change Booking Status Results window to show booking status changes for this reservation.

TIPS: To see only bookings that were not changed, select Show Unchanged Only. To view the details for a
specific booking that was changed, select the booking, and then click Go To. If you reserve a resource and
then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a
Resource Inventory Conflicts report opens when you Close this window. You can manually run a Resource
Inventory Conflict report: in the Bookings folder of the Navigator, select Tools > Resource Inventory
Conflict.

5. Click Close to close the Change Status Results wizard and return to the Navigator.
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Changing Rooms

1. In the Bookings pane, click Tools > Change Room Wizard. The Change Room Wizard opens, where
you can specify whether you want to search for rooms or only change to a specific room.

TIP: Clicking Search for Rooms changes this workflow to present you with a list of all available rooms that
match your search criteria later in these steps. Clicking Specific Room means you can search for a room
using the Search icon. In this case, you will not need to select from a list of rooms later.

2. Once you select the new room, the Change Rooms window refreshes so you apply detailed changes
to the bookings.

TIPS: In the left pane, select the bookings you want to move to a new room. In the right pane, change the
building, the room specifications, the status, the room features, or any combination of these as needed for
the selected bookings, and then click Next.

3. If prompted, enter a new setup count. Make sure that this count is the maximum that you expect the
new room to hold. You can apply the following options: Update Setup Type on Selected Bookings
and/or Update Setup Count On Selected Bookings (use Minimum).

4. To apply the same status change to the parent reservation, select Update Reservation Status.

5. Click Next. The Change Room Wizard is refreshed with an Available tab (if you selected Search for
Rooms initially, and if applicable, a Conflicts tab.

a. The Available tab shows available rooms that match your criteria, and contains two panes. The
left pane lists all the rooms that meet some or all of your event criteria. The right pane lists all
the event dates that must be fulfilled.

b. The Conflicts tab lists rooms (if any) that were not available due to booking conflicts.
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TIP: You can click Room Info to see room properties, setup type, features, and pricing, or Building Hours to
see when the selected room/building is open.

6. Select from the list of available rooms and use the arrow buttons to move them to the right pane.

7. When you have fulfilled all dates, click Finish

8. Once you confirm your changes, the Change Rooms Results window opens to show your changes.

9. Click Close to return to the Navigator.

Changing Miscellaneous Information
For multiple bookings, you can batch-change the event name, the event type, the setup type, the setup
count, and the attendance.

1. In the Bookings pane, click Tools > Change Miscellaneous Booking Information Wizard. The Change
Miscellaneous Booking Information Wizard opens.
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2. Select the information to change, enter new values, and then click Next. The Select Bookings window
shows the bookings to which you can apply these changes.

3. Select bookings to which to apply the changes then click Finish. A message opens, indicating that the
changes were made successfully.

4. Click OK to close the message and return to the Navigator.
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CHAPTER 157: Move Bookings to a Different Reservation in the
Navigator
You use the Move Bookings Wizard to move one or more bookings that do not have invoiced items from a
selected reservation to an existing reservation or to an entirely new reservation.

NOTE: When you move a booking, the booking and all its associated details are removed entirely from the
original reservation.

1. Open the reservation in the Navigator. 

2. In the left pane of the Navigator, select the reservation from which you are moving the bookings. In
the pane on the right, click Tools, and then click Move Bookings Wizard. 

3. The Move Bookings Wizard opens with the option to move the bookings to an Existing Reservation
pre-selected. You can enter the reservation number of an Existing Reservation or start a New Reser-
vation.

4. Click Next. The Select Bookings window displays, listing the bookings for the selected reservation that
do not have invoiced items.
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TIP: You can use the Hide Canceled Bookings and Hide Old Bookings options to adjust the list.

5. Select the booking(s) you want to move to the new or existing reservation (you can click Select All to
select all the displayed bookings in a single step), and then click Finish. A message opens indicating
that the changes were made successfully.

6. Click OK to close the message and return to the Navigator, which now shows both the old reser-
vation and the new or existing reservation in the left pane of the Navigator. Any conflicts that arise
are indicated in the Navigator.
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CHAPTER 158: Copy Multiple Bookings in the Navigator
You use the Copy Bookings Wizard to copy one or more bookings to a new date or to a set of dates, either
within the same reservation or to a new reservation.

1. Open the Navigator. 

2. In the left pane of the Navigator, select the reservation from which you are copying the bookings.

3. In the Bookings pane, click Tools, and then click Copy Bookings Wizard. The Copy Bookings Wizard
opens with Copy to Reservation No. automatically selected; the number for the reservation from
which you are copying the bookings is displayed in the field.

4. You can copy the bookings to an existing reservation (click the Search icon to search for the reser-
vation) or copy the bookings to a new reservation (click Copy to New Reservation).

5. Enter the information for the reservation to which you are copying the bookings.

INFORMATION DESCRIPTION/COMMENTS

New Start Date The date of the first booking for the new reservation.

New Status The status for the new reservation.

Reconfirm Date Enter if required for the new status that you selected.

Conflict Status You must enter a conflict status in the event that the new bookings are
in conflict with the existing bookings.
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INFORMATION DESCRIPTION/COMMENTS

Reconfirm Date Enter if required for the new conflict status that you selected.

l Copy
Reminders

l Copy Com-
ments

l Copy User
Defined
Fields

l Copy Attach-
ments

l Copy Draw-
ings

Leave the appropriate options selected to copy the existing items as is,
or clear the option for each item that is not to be copied to the new
reservation.

Copy Booking
Details

Select the booking details that are being copied (CTRL-click to select
multiple details) or to select all the details for copying, click Select All.

Note: By default, only active booking details are displayed. To show
inactive booking details for copying, click Show Inactive.

Copy Inactive
Resources/Rooms

Selected by default. Copies the inactive resource and/or rooms from
the existing bookings to the new bookings. Clear this option if you do
not want to copy the inactive resources and rooms.

6. Click Next. The Select Bookings window opens, listing all the bookings for the copied reservation,
regardless of the date or status. 
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TIPS: You can use the Hide Canceled Bookings and Hide Old Bookings options to adjust the data. The start
date you specify becomes the date of the first new booking. In addition, the copied bookings are scheduled
according to the same pattern as the existing reservation. For example, if the existing reservation has three
bookings and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and the new start
date for the first booking is 12/18, then the existing or new reservation has three bookings with dates of
12/15, 12/22, and 12/29.

7. Select the booking(s) that you want to copy to the existing or new reservation (you can click Select
All to select all the displayed bookings in a single step), and then click Finish. A message confirms that
the changes were made successfully.

TIP: When you copy multiple bookings, they are simply copied and pasted "as-is": bookings are not moved

to a different location. If you need to move a booking to a different location, see Changing Rooms for
Multiple Bookings.

8. Click OK to close the message and return to the Navigator. The reservation from which you copied
the bookings and the reservation to which you copied the bookings are displayed in the left pane of
the Navigator. If you moved the bookings to a new reservation, then the new reservation that is cre-
ated is assigned the next available reservation number in the database. If any of the new bookings
are in conflict with bookings in the existing reservation, this conflict is indicated in the Navigator.
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CHAPTER 159: Booking Details and Items Overview
Booking details, which are also called categories, are the services (catering, A/V equipment, and so on),
notes, attendees, activities, or room charges that you can add to a booking. Booking detail items, also
called resources, are the individual items (coffee, sandwich, projector, and so on) that you add to a booking
detail. When you add a resource to a booking, for example, coffee, various selections might be available or
required, for example, regular, decaf, Italian roast, breakfast blend, and so on. Depending on how your EMS
administrator has configured your categories, a resource might require service order times to be specified.

Tip: Your EMS administrator can configure buildings and categories so that a particular category can be
used only in a particular building or buildings. This means that when you are adding booking details to a
reservation, some booking details (categories) might not be displayed as an option.

The booking details for a selected booking are displayed in the Booking Details pane (the lower right pane)
of the Navigator.

Tip: Categories that contain resources, but do not require service times are referred to as "resource
categories." Categories that contain resources and that require service times are referred to as "service
order categories." Categories that are used to manage food service are referred to as "catering categories."
Categories that are used to manage miscellaneous notes (setup notes), agenda items, attendees/visitors,
or room charges are referred to as "non-resource categories."

The Navigator Window with a Booking Folder Selected

If you select a booking detail folder that is for a Resource with Service Order category or a Catering
category, then the service order number is displayed in the title bar of the Navigator.
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The Navigator Window With a Booking Detail Folder Selected

When you select a booking detail folder in the left pane of the Navigator, the tabs that are displayed in the
upper right pane of the Navigator depend on the type of booking detail that you selected.

l Summary tab—The Summary displays information about the selected booking detail, including the
event date, the event location, and the event status.

l Properties tab—The Properties tab also displays information about the booking detail, including the
date that it was added to the booking, who added the detail, and, if applicable, the date that the
detail was changed and who made the change.

If the booking detail has a price/charge associated with it, for example, a room charge, then the following
two tabs are also displayed:

l Billing Reference Allocation tab—By default, the charge for a booking detail can be allocated to a
single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge
for a reservation to multiple billing reference numbers by percentage. See Also: Allocating charges
to multiple billing reference numbers and/or PO numbers.

Tip: Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be
displayed. See Also: EMS Desktop Client Parameters.

l PO Number Allocation tab—By default, the charge for a booking detail can be allocated to a single
purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a
reservation to multiple billing PO numbers by percentage. See Also: Allocating charges to multiple
billing reference numbers and/or PO numbers.

Tip: Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be
displayed. See Also: EMS Desktop Client Parameters.
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Service order 
If the selected booking detail requires a service order or catering category, then the following four tabs are
also displayed:

l User Defined Fields tab—The User Defined Fields tab displays the additional fields that store custom
data for the booking detail. Your EMS administrator configures the types of fields that are available
as well as the allowed values for these fields. See Also: User Defined Fields in the Navigator.

l Reminders tab—The Reminders tab displays any reminders that were created for the selected book-
ing detail. See Also: Comments and Reminders in the Navigator.

l Comments tab—The Comments tab displays any comments that were made for the selected book-
ing detail. See Also: Comments and Reminders in the Navigator.

l History tab—The History tab displays the history for the booking detail (the date that a change was
made to the detail, the ID of the user who made the change, the field that was changed, the old field
value, and the new field value).

Also, when you select a booking detail folder:

l Most of the tabs in the upper pane of the window have some of the basic features of an EMS Browser
window. You can change the width of the data columns, you can rearrange the column order by drag-
ging a column to a new location using the column heading, and you can sort the data columns in
either ascending or descending sort order. See Also: EMS Browser Window.

l The booking detail items for the selected booking detail are displayed in the Items pane (the lower
right pane) of the Navigator. A green check mark appears in front of each individual item that has
been added to a booking. If the item is a package, then a green checkmark is displayed not only in
front of the package, but also, in front of each individual item in the package. A red "X" is displayed in
front of any booking detail and/or booking detail item that has been deleted from a booking. The
Items pane has all the features of an EMS Browser window. See Also: EMS Browser Window.

If you select a booking details item in the left pane of the Navigator, then the entire right pane of the
Navigator is refreshed with three tabs—Properties tab that displays for the selected item, a Selections tab
that displays the selections for the booking detail item (if applicable), and a History tab that details the
history of the item.
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The Navigator window with a booking detail item selected

A booking detail might include a service order. A service order is a request to use the resource for a
specified time period as opposed to using the resource for the entire event. For example, an event that
meets from 10:00 am to 2:00 pm, might have food service from 11:00 am to noon. A service order consists
of the service type, start and end times, and a unique, system-generated service order ID. For a catering
booking detail, you can also indicate estimated count, guaranteed count, and actual count. You can create
multiple service orders in the same booking. For example, you might have a number of catering services
(breakfast, lunch, and afternoon refreshments) in the course of a one day training event. In this case,
multiple folders are displayed under the booking folder on the left side of the Navigator window, with each
folder representing a unique service order.

The Navigator window showing multiple service orders in the same booking

If you reserve an item from a category that does not require a service order, your only choices are to
reserve the item for the event time or for the entire reserved time.

Tip: Your EMS administrator might have configured a default service type for some or all of your system's
categories, but you can always select a different value. In addition, your EMS administrator might have
configured states to manage your service order process. For detailed information about states, See
Also: Configure Categories.
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CHAPTER 160: Add Booking Details and Items to Individual Book-
ings
The steps that you follow to add booking details and items to individual bookings depend on the category
type. Also, you can add multiple occurrences of a booking detail to a booking only if the booking detail is a
Resource with Service Order category or a Catering category. If the booking detail is not a Resource with
Service Order category or a Catering category, and the detail is already added to a booking, you cannot
add the detail again to the booking. You can, however, add more items to the booking detail.

To add booking details and items to individual bookings

1. Open the reservation in the Navigator. Refer to the following for directions:
l Opening a reservation directly in the Navigator
l Opening a reservation through the Reservation Book
l Opening a reservation through a group
l Open a reservation through a search

2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate
booking folder is visible.

3. Select the booking folder, and then in the Booking Details pane, click New. The Booking Details list
opens.

4. Select the booking detail that you are adding to the booking. A dialog box opens.

5. Continue to one of the following:

Accruent Confidential and Proprietary © 2019 Page | 630

CHAPTER 160: Add Booking Details and Items to Individual Bookings



l Add a booking detail from a non-resource category
l Add a booking detail from a resource, service order, or catering category

To add a booking detail from a non-resource category 
A booking detail that is from a non-resource category can be setup notes, attendees, agenda (activities), or
a room charge.

To add setup notes 

1. Enter the sequence number for the setup notes.
TIP: The sequence number determines the order in which the notes are displayed in the Items pane in
the Navigator when the booking detail (Setup Notes) is selected for a booking.
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2. Enter the appropriate notes or comments.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded
from external reports like a confirmation), then select Internal.

4. Click OK. The Setup Notes dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator window.
TIP: After you add setup notes for the first time to a booking, Setup Notes is no longer an available
option on the Booking Details drop-down list. To add more setup notes to the booking, select the
Setup Notes folder for the booking or click a Setup Note in the Items pane, and then click New.

To add attendees 
Attendees dialog box

1. Enter the information for the attendee. At a minimum, you must enter the attendee name.

2. If the attendee is a visitor (that is, not registered for the event), then select Visitor.

3. Click OK. The Attendee dialog box remains open.
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4. Repeat Step 1 through Step 3 until you have added all the needed attendees/visitors to the booking.

5. Click Cancel. The Attendees dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator window.

TIP: If you close the Attendees dialog box before you have added all the needed attendees/visitors to the
booking, then Attendees is no longer an available option on the Booking Details drop-down list. To add
more attendees/visitors to the booking, select the Attendees folder for the booking or click an
attendee/visitor in the Items pane, and then click New.

To add an agenda (activities) 
Agenda dialog box

1. Enter the start time, the end time, and a description for the agenda.

2. Optionally, in the Description field, enter a name or description for the agenda.
TIP: The description can be a maximum of 50 characters, including spaces.
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3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded
from external reports like a confirmation), then select Internal.

4. Click OK. The Agenda dialog box remains open.

5. Repeat Step 1 through Step 4 until you have added all the needed agendas.

6. Click Cancel. The Agenda dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator window.

TIP: If you close the Agenda dialog box before you have added all the needed agendas/activities to the
booking, then Agenda is no longer an available option on the Booking Details drop-down list. To add more
agenda/activities to the booking, select the Agenda folder for the booking or click an agenda in the Items
pane, and then click New.

To add a room charge
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1. Enter the sequence number for the room charge.
TIP: The sequence number determines the order in which the charges are displayed in the Items pane
in the Navigator when the booking detail (Room Charge) is selected for a booking.

2. Optionally, enter notes or comments about the room charge.

3. If needed, edit the quantity.

4. Select the appropriate pricing method, and then enter any other additional information as needed
after you select a pricing method.

PRICINGMETHOD ADDITIONAL FIELDS

Unit Unit Price

Half Day/Full Day (Event Time) Half Day Price

Full Day Price

Hours

Half Day/Full Day (Reserved Time) Half Day Price

Full Day Price

Hours

Hourly (Event Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Reserved Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Specific) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge
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5. Optionally, enter a discount percent and/or a reservation discount.

6. Click OK. The Room Charge dialog box closes. The booking detail and its items are displayed as
folders under the Booking folder in the Navigator window.

TIP: If you must add multiple room charges to a booking, then after you add charges for the first time to a
booking, Room Charge is no longer an available option on the Booking Details drop-down list. To add
more charges to the booking, select the Room Charge folder for the booking or click a room charge in the
Items pane, and then click New.

To add a booking detail from a resource, service order, or catering
category 

l If you select a service order or catering category, a Service Order dialog box opens with, at a min-
imum, options for Service, Reviewed, Service Start Time, and End Time. If a catering category is selec-
ted, additional fields for Estimated, Guaranteed and Actual Counts are displayed. Go to Step 1 below.

Example of a Service Order dialog box for a catering category

l If you select a resource category, then a Resource Selection dialog box opens. The Resources tab is
the active tab. Go to Step 4.

Example of a Resource Selection dialog box, Resources tab
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1. Select the service type.

2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and if applic-
able, select Reviewed and/or a state.

TIP: For more information about reviewing service orders and selecting states, see also: Search for
Service Orders.

3. Click OK. A Resource Selection dialog box. The Resources tab is the active tab.

4. Do one of the following
l To select one or more resources from the pre-configured list of resources, leave the Resources

tab open, and then go to Step 5.
l To add multiple resources to the booking in a single step, open the Packages tab, and then go

to Step 7.
5. Do one of the following on the Grouping drop-down list:

l Leave the default value of (all) as is to search for all items in all groupings.
l Select a specific grouping to search for only those items in the grouping. For example, if the

selected resource category is A/V Equipment, then available groupings could include Com-
puter, Phone, Video, and so on. To search only for the available phones to add to a booking
detail, select the Phones grouping.
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6. Optionally, in the Filter field, enter a search string by which to filter your search.
TIP: Your search is limited to the exact order of the characters in the string, but the search string is
not case-sensitive and it can appear anywhere in the search results. For example, a search string
of co returns coffee service, conference phone, and mini-copier.

7. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.
TIP: If you change the quantity for a resource package, then the quantity for each individual resource
that makes up the package is also changed.

8. Do one of the following:
l For the Resources tab, on the Items list, select the resource item, or CTRL-click to select the mul-

tiple resource items that you are adding to the booking.
TIP: Your EMS administrator might have configured an override resource (also known as an
override description) so that you can book a resource that has not been configured in your
EMS database. For example, the administrator might have configured an override resource
named "Other." If you select the Other resource, then a Description field is displayed on the
Resource Selection dialog box. You must enter a description or name for the override resource
before you can continue. EMS does not track availability of override resource items; however,
EMS reports on override resource items just like any other resource item.

l For the Package tab, select the package that contains the multiple resources that you are
adding to the booking.

9. Click Select.
l For items on the Resources tab, if your EMS administrator configured selections for the

resource, then either you might be required to make selections for the resource, or you have
the option to make selections for the resource; otherwise, go to Step 10.
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Example of a Resource Selections dialog box

l For packages on the Packages tab, the package is added to the booking. An entry for the pack-
age as well as entry for each item in the package is displayed in the Booking Detail Items pane
of the Navigator.

10. Repeat Step 4 through Step 9 until you have added all the necessary booking detail items for the
selected booking.

11. Click Close. The Resource Selection dialog box closes. The resource and its items are displayed as
folders under the Booking folder in the Navigator.

TIP: If you close the Resource Selection dialog box before you have added all the needed resource items to
the booking, and the booking detail is not from a catering or service order category, then the booking
detail is no longer an available option on the Booking Details drop-down list. To add more resource items
to the booking, you can select the Booking Detail folder for the booking or you can click a booking detail
item in the Items pane, and then click New.
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CHAPTER 161: Add Booking Details and Items to Existing Book-
ings
The steps that you follow to add booking details and items to individual bookings depend on the category
of the item. You can only add an item more than once to a booking if it is a Resource with Service Order or
Catering item.

1. Open the Navigator. 
2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate

booking folder is visible, select the booking folder, and then in the Booking Details pane,
click New. The Booking Details list opens.

TIP: You can also add booking details and items after the first one has been added by clicking on the
booking and then clicking the Tools menu. This launches a menu with wizards to streamline the process of
working with many types of details for the booking.
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You can even use the Add Booking Details Wizard to add booking details and items to multiple bookings in
a single step, and you can add the same detail (for service order and catering categories) to multiple
bookings. The steps that you follow depend on the category type and how your Administrator has
configured your system. 

You can also copy booking details and items from one booking to another: right-click on the booking
detail and click Copy. Then right-click on the booking to which the booking detail is being copied
and click Paste.

3. Select the type of item you want to add to the booking.

4. Continue to the appropriate subtopic below:
l Adding a Non-Resource Item
l Adding a Resource, Service Order, or Catering Item

Adding A Non-Resource Item 
Non-resource items include:

1. Setup Notes
2. Attendees and Visitors
3. Agenda (Activities)
4. Room Charges

Adding Setup Notes 

1. Select Setup Notes from the New menu, so you can new setup notes for the booking.
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2. Enter the sequence number for the setup notes, which determines the order in which the notes are lis-
ted in the Items pane in the Navigator. 

3. Enter notes or comments. If you want these notes to be printed on internal reports only (the notes
would be excluded from external reports like a confirmation), select the Internal checkbox. 

4. Click OK. The Setup Notes dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator window.

Tip: After you add setup notes for the first time to a booking, Setup Notes is no longer an available option
on New menu. To add more setup notes to the booking, expand the folder hierarchy for the booking until
you see existing Setup Notes, click on one, and then click New.
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Adding Attendees and Visitors 
Visitors are non-registered attendees who are not already in your EMS database, such as temporary
building guests.

1. Select Visitor from the New menu so you can add attendees and visitors to the meeting. At a min-
imum, you must enter the visitor name.
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2. You can select the Visitor option to flag attendees who are not registered for the event.

3. Click OK. The dialog box remains open.

4. Repeat Steps 1 through 3 until you have added all the needed attendees/visitors to the booking.

5. Click Cancel to return to the Navigator window.

Tip: If you close the Attendees dialog box before you have added all the needed attendees/visitors to the
booking, Attendees is no longer an available option on New menu. To add more attendees/visitors to the
booking, expand the folder hierarchy for the booking until you see existing Attendees/Visitors, click on one,
and then click New.
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Adding An Agenda (Activities) 

1. Select Agenda from the New menu so you can add agendas to the meeting. Enter the information for
the agenda.
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2. Enter the start time, the end time for the agenda. You can enter a name or description for the agenda
(maximum of 50 characters, including spaces) in the Description field. If you want these notes to be
printed on internal reports only, select Internal.

3. Click OK. The Agenda dialog box remains open.

4. Repeat Steps 1 through 4 until you have added all the needed agendas.

5. Click Cancel. The Agenda dialog box closes. The booking detail and its items are displayed as folders
under the Booking folder in the Navigator window.

Tip: If you close the Agenda dialog box before you have added all the needed attendees/visitors to the
booking, Agenda is no longer an available option on New menu. To add more agendas to the booking,
expand the folder hierarchy for the booking until you see existing agendas, click on one, and then
click New.
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Adding A Room Charge 

1. Select Room Charge from the New menu so you can add room charges to the meeting. Enter the
information for the agenda. 
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2. Enter the Sequence Number for the room charge, which determines the order in which the charges
are listed in the Navigator. You can enter notes or comments about the room charge. If needed, edit
the quantity. 

3. Select the appropriate pricing method, and then enter any other additional information as needed
after you select a pricing method:

PRICINGMETHOD ADDITIONAL FIELDS

Unit Unit Price

Half Day/Full Day (Event Time) Half Day Price

Full Day Price

Hours
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PRICINGMETHOD ADDITIONAL FIELDS

Half Day/Full Day (Reserved Time) Half Day Price

Full Day Price

Hours

Hourly (Event Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Reserved Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Specific) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

4. You can enter a discount percent and/or a reservation discount.

5. Click OK to return to the Navigator window.

Tip: If you close the Room Charge dialog box before you have added all the needed attendees/visitors to
the booking, Room Charge is no longer an available option on New menu. To add more room charges to
the booking, expand the folder hierarchy for the booking until you see existing room charges, click on one,
and then click New.
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Adding a Resource, Service Order, or Catering Item 

1. From the New menu, select a resource, service order, or catering item, such as the examples shown
below.

l If you add a service order or catering item from the New menu, a Service Order dialog box
opens with, at a minimum, options for Service, Reviewed, Service Start Time, and End Time. For
catering items, additional fields display for you to enter Estimated, Guaranteed and Actual
Counts.
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Example of a Service Order dialog box for a catering category

Tip: Select the Service type and enter the Start Time. You can enter additional fields as needed.

l If you select a resource category item, then a Resource Selection dialog box opens, where you
select resources to add to the booking.
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Example of a Resource Selection dialog box, Resources tab

Tip: Your EMS administrator might have configured an override resource (also known as an
Override Description) so you can book a resource that has not been configured in your EMS
database. For example, the administrator might have configured an override resource named
"Other." If you select the "Other" resource, then a Description field is displayed on the Resource
Selection dialog box. You must enter a description or name for the override resource before
you can continue. EMS does not track availability of override resource items; however, EMS
reports on override resource items just like any other resource item. Furthermore, you might
be able to select variations for an item.
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Example of a Resource Selections Dialog Box

You can use the Grouping drop-down list to search for available items in a specific grouping,
such as A/V Equipment. In the Filter field, you can add a keyword for the search.

To add multiple resources as a "Package" to the booking in a single step, click the Packages tab,
choose a package, and specify how many packages to add Quantity field. If you change the
quantity for a resource package, the quantity for each individual resource that makes up the
package is also changed.

2. Once you have chosen items to add to the booking, click Select.

3. Repeat steps to add more items.

4. Once finished, click Close to return to the Navigator.

Tip: If you close the dialog box before you have added all the needed items to the booking, they no longer
an available option on New menu. To add more items to the booking, expand the folder hierarchy for the
booking until you see existing items, click on one, and then click New.
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Navigator Dialog
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CHAPTER 162: Add Booking Detail Items to Multiple Bookings
You use the Add Item Wizard to add booking detail items to multiple bookings for categories that are
already added to the bookings. For example, you can use this Wizard to add food service items only if any
of the bookings already has food service added as a booking detail.

To add booking detail items to multiple bookings 

1. Open the reservation in the Navigator. See Also:
l Opening a reservation directly in the Navigator
l Opening a reservation through the Reservation Book
l Opening a reservation through a group

2. In the left pane of the Navigator, select the reservation to which you are adding the booking detail
items.

3. In the Bookings pane, click Tools, and then click Add Item Wizard. The Add Item Wizard opens. The
first window in this Wizard, the Select Category window, displays only those categories that are
already in use for any of the bookings in the reservation. 

Add Item Wizard

4. Select the category to which you want to add items.

5. Click Next. 

The steps that you now must follow depend on the category type. See Also:
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l To add a booking detail from a non-resource category
l To add a booking detail from a resource, service order, or catering category
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CHAPTER 163: Edit Items for Individual Bookings

1. Open the Navigator. 
2. Select the booking detail folder that contains the items that you want to edit.

3. In the Items pane, select the item you want to change.

NOTE: The item cannot be invoiced. If the item is invoiced, the Edit button is not available. To edit an
invoiced item, you must first void the invoice.

4. Click Edit. 
l If editing a non-resource item, the Booking Detail dialog box opens. Edit the item as necessary,

and then click OK to return to the Navigator.
l If editing a resource item, the Resource dialog box opens on the Resource tab. You might also

see a Selections tab. Edit the information as necessary.

TIP: You can select a different item for the resource. Sequence determines the order in which the items (for
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example, juice, muffins, and so on) are displayed in the Items pane in the Navigator.

Time in Use indicates the time that the resource is to be available for the booking. You only can edit the
Time In Use if the item is not from a resource from a service order or catering category. (The Time in Use is
applied at the category level for these types of resources.) See Also: Event Timeline.

5. If you want for notes to be printed on internal reports only, select Internal. 

6. If you edit the pricing method, enter information as needed:

PRICINGMETHOD ADDITIONAL FIELDS

Unit Unit Price

Half Day/Full Day (Event Time) Half Day Price

Full Day Price

Hours

Half Day/Full Day (Reserved Time) Half Day Price

Full Day Price

Hours

Half Day/Full Day (Service Time)

Note: Available only for a resource with a service
order.

Half Day Price

Full Day Price

Hours

Hourly (Event Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Reserved Time) Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge
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PRICINGMETHOD ADDITIONAL FIELDS

Hourly (Service Time)

Note: Available only for a resource with a service
order.

Hourly Price

Minimum Charge

Maximum Charge

Initial Flat Charge

Hourly (Specific) Hourly Price

Minimum Charge

Maximum Charge

7. If applicable, open the Selection tab, and edit the resource selections as needed. 

8. Click OK. The dialog box closes, and you return to the Navigator with the edited item still selected in
the Items pane.

TIP: If you need to edit counts and/or times for individual items in a resource, service order, or catering,
category, see Edit Count Information for a Booking.
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CHAPTER 164: Copy Booking Details Between Bookings
You use the Copy Booking Details Wizard to copy the details from one booking in a reservation and paste
them into other bookings for the same reservation.

copy booking details between bookings 

1. Open the reservation to which you are copying the booking details in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group

2. In the left pane of the Navigator, select the reservation from which you are copying the details.

3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard. The Copy Booking
Details Wizard opens. The first window in this Wizard, the Select Booking Details to Copy window, dis-
plays all the bookings for the selected reservation, regardless of date. By default, the Copy From
Reservation No. field displays the reservation number for the selected reservation.

4. Optionally, in the Copy From Reservation No. field, click the Search icon to open the Open Navigator
dialog box and search for and select a different reservation from which to copy the booking
details. The Select Booking Details to Copy window is refreshed with all the bookings details for the
selected reservation.

5. Optionally, do one or both of the following:
l On the Category drop-down list, select a specific category of booking details to display on the

Select Booking Details to Copy window.
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l Leave Copy Inactive Resources/Rooms selected to copy this information for the bookings.
Clear this option if you do not want to copy this information.

6. Select the booking, or CTRL-click to select the multiple bookings from which you are copying the
booking details, and then click Next. The Select Bookings window opens. This window displays all the
bookings with a date greater than or equal to the current day's date to which you can copy the book-
ing details.

Tip: To show canceled bookings, clear Hide Canceled Bookings. Conversely, to hide canceled bookings,
select Hide Canceled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are copying the book-
ing details, or click Select All to select all the displayed bookings in a single step, and then click
Finish. A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.
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CHAPTER 165: Delete Booking Details from Multiple Bookings
You use the Delete Booking Details Wizard to delete one or more booking details that do not have
invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking,
any items that have been added for the detail are also deleted.

To delete booking details from multiple bookings 

1. Open the reservation from which you are deleting the booking details in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group

2. In the left pane of the Navigator, select the reservation from which you are deleting the booking
details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard. The Delete Booking
Details Wizard opens. The first window in this Wizard, the Select Categories window, displays all the
categories (booking details) that are already in use for any of the bookings in the selected reser-
vation.

4. Select the category, or CTRL-click to select the multiple categories that you are deleting from the
reservation, or click Select All to select all categories in a single step.

5. Click Next. The Select Booking Details window opens. This page lists all the bookings for the selected
reservation with a date greater than or equal to the current day's date that have the categories (book-
ing details) that were selected for deletion but do not have any invoiced items.
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6. Select the booking, or CTRL-click to select the multiple bookings from which you are deleting the cat-
egories, or click Select All to select all the displayed bookings in a single step, and then click Finish. A
message appears indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.
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CHAPTER 166: Delete Booking Details from Multiple Bookings
You use the Delete Booking Details Wizard to delete one or more booking details that do not have
invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking,
any items that have been added for the detail are also deleted.

To delete booking details from multiple bookings 

1. Open the reservation from which you are deleting the booking details in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group

2. In the left pane of the Navigator, select the reservation from which you are deleting the booking
details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard. The Delete Booking
Details Wizard opens. The first window in this Wizard, the Select Categories window, displays all the
categories (booking details) that are already in use for any of the bookings in the selected reser-
vation.

4. Select the category, or CTRL-click to select the multiple categories that you are deleting from the
reservation, or click Select All to select all categories in a single step.

5. Click Next. The Select Booking Details window opens. This page lists all the bookings for the selected
reservation with a date greater than or equal to the current day's date that have the categories (book-
ing details) that were selected for deletion but do not have any invoiced items.
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6. Select the booking, or CTRL-click to select the multiple bookings from which you are deleting the cat-
egories, or click Select All to select all the displayed bookings in a single step, and then click Finish. A
message appears indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.
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CHAPTER 167: Edit Charges for Multiple Billable Items
You can edit resource quantities and billing information (price, pricing method, and so on) for individual
items, or you can use the Edit Charges tool to edit this information for multiple non-invoiced items. To edit
the billing information for invoiced items, you must first void the invoice. See Also: Void an
Invoice and Reprice Service Categories and Room Charges for a Reservation.

1. Open the Navigator and select the reservation you want to work with. 
2. In the left pane of the Navigator, you can edit all billable items in all the bookings for a reservation,

only the billable items in a selected booking (expand the reservation folder, and under the expanded
reservation folder, select the booking that contains the items that you want to edit).

3. In the Bookings/Booking Details pane, click Tools > Edit Charges. The Edit Charges window opens. If
you selected a reservation, then all non-invoiced billable items in all the bookings for the selected
reservation are displayed in the window; otherwise, only the non-invoiced billable items for the selec-
ted booking are displayed.

Tip: You can select a category on the Category drop-down list to narrow the results.

4. To change the quantity, pricing method, price, or discount percentage for an item, click in the field
and make your changes.

5. When your changes are complete, click Close. Any resulting recalculations automatically execute. The
Edit Charges window closes and you return to the Navigator.
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CHAPTER 168: Edit Count Information for a Booking
You use this tool to change various "counts" for a booking, such as setup count, attendance count, the
estimated count, guaranteed count, and actual count for a booking detail (with a category type of
catering), as well as the counts for non-invoiced booking detail items. You can make similar changes in
other areas of the application. The Edit Counts simply collates all count information in a single location for
editing.

You can edit the counts for all bookings in a reservation or for just a selected booking.

1. Locate and select the parent reservation in the Navigator.
2. Click Tools.

3. Click Edit Counts.

4. The Edit Counts window shows a list of bookings under the reservation; select the booking for which
you want to edit counts. 
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Tip: You can focus the list of counts on a Category. The middle pane is refreshed with the information for
the selected category. If the category is a resource with a service order, then the pane displays the service
type and the start and end times for the category. If the category is catering, then the pane also displays
the estimated count, guaranteed count, and actual count for the booking detail.

5. In the middle pane, select the booking detail that contains the items for which you want to change
the count. The lower pane refreshes with a list of all the non-invoiced items for the selected detail. 

6. To edit the count information for any booking detail or detail item, click in the appropriate field and
make the necessary edits. Repeat needed for each booking. When finished, click Close to return to
the Navigator.
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CHAPTER 169: Add Booking Details Wizard
Concept: What are Services, Categories, and Resources?

l Booking details are also called categories.
l Booking detail items, also called resources, are the individual items (coffee, sandwich, projector, and

so on) that you add to a booking detail.
l A booking detail might include a service order.

If your booking template is designed so you can add details such as catering, audio/video equipment, or
housekeeping to a meeting, you will see fields for these options in the details screens for the booking. 

To add services, equipment, and other resources to an existing meeting, you will:

l Navigate to the event.
l Add services and so on to the event.
l Save your changes and send notifications.
l (If the request requires approval) Follow up on your service order request.

1. Open the reservation. 

TIP: For an in-depth overview of Booking Details you can see for existing events in the Navigator,
see Booking Details and Items Overview. This topic simply guides you in adding a service order to a
booking.

2. Focus the Navigator on the booking within that reservation for which you want to add services,
equipment, etc., and click the Tools button, then select Add Booking Details Wizard (your Admin-
istrator might have re-labeled this option; if it does appear, services are not allowed for this type of
booking). 
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3. Add a Service order: In the Add Booking Details popup window that presents, select a category of ser-
vice or equipment you want to add. The fields on the right panel change depending on the selection
you make. 
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4. When you have completed the fields in the right panel, click the Next button. EMS Desktop Client
advances you through the information you must enter to complete the service order. Tabs and fields
that display to you vary depending on how the type of service is configured for your organization.
The example below shows a catering service order that is defined to allow you to add menu items;
two have been added to the right panel which indicates menu items to be included with the order (in
this case, for 5 servings). The same type of window displays for other types of services such as equip-
ment; the only difference is that the items might be human activities such as setup, teardown, open-
ing windows, turning on lights, and so on.
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TIP: You can add notes and other details to each menu item by selecting it and clicking the Edit button.
Click OK to save such changes.
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NOTE: If a cost is associated with an item, cost related fields will appear similar to those shown above; if
you are authorized, you can change them (for example, to apply a discount). See
Also: Repricing Categories and Room Charges.

5. Once you have finished selecting items for the service order, click the Next button. A final screen
presents where you can select the bookings to which you want to apply the service order.

6. Select the booking(s) for which you want to add the service order and then click the Finish button.

7. On the confirmation popup that presents, click Yes to add more service orders, or No to finalize the
service order. You return to the Navigator and the new service order appears in the lower right panel.
If the service order requires an approval workflow, the state of the request shows in the State
column.
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TIP: You can see and work with the items (resources) requested for a service order by selecting it in the
lower right panel above and then clicking the Items button.
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You can click the buttons on the right to add or change items in the list. Clicking New will launch a popup
window where you can add more items within this category of service. This example shows catering fields.
When you have completed all required information, click OK to finalize the new item.
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Once a service order has been added to a booking and you click to expand the order in the left panel,
information in both the upper and lower right panel changes to show detail about that specific service
order. The following four tabs show in the Navigator in the upper right panel:

l User Defined Fields tab—The User Defined Fields tab displays the additional fields that store custom
data for the booking detail. Your EMS administrator configures the types of fields that are available
as well as the allowed values for these fields. See Working with User Defined Fields in the Nav-
igator.

l Reminders tab—The Reminders tab displays any reminders that were created for the selected book-
ing detail.

l Comments tab—The Comments tab displays any comments that were made for the selected book-
ing detail.

l See Working with Comments and Reminders in the Navigator.
l History tab—The History tab displays the history for the booking detail (the date that a change was

made to the detail, the ID of the user who made the change, the field that was changed, the old field
value, and the new field value).
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Also, service order items for the selected booking detail show in the Items pane in the lower right panel. A
green check mark appears in front of each individual item that has been added to a booking. If the item is a
package, then a green checkmark is displayed not only in front of the package, but also, in front of each
individual item in the package. A red "X" is displayed in front of any booking detail and/or booking detail
item that has been deleted from a booking. 

If you click on a booking details item in the left pane of the Navigator, then the entire right pane of the
Navigator is refreshed with three tabs: a Properties tab that displays for the selected item, a Selections tab
that displays the selections for the booking detail item (if applicable), and a History tab that details the
history of the item.

See Also:

l Adding Booking Details and Items to Multiple Bookings
l Editing Booking Detail Items for Individual Bookings
l Editing Booking Detail Item Charges for Multiple Items
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CHAPTER 170: Copy Booking Details Wizard
You use the Copy Booking Details Wizard to copy details from one booking to another booking under the
same reservation.

1. Open the parent reservation in the Navigator. 

2. In left pane the Navigator, select the reservation or booking with which you want to work. 

3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard. 

4. The Copy Booking Details Wizard pops up, listing all the bookings for the selected reservation.
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TIP: You can change the reservation from which to copy details by clicking the Search icon. You can narrow
the list by selecting a Category. You can clear the Copy Inactive Resources/Rooms if you want to carry over
these items.

5. Select the booking(s) for which you want to copy details and click Next. 

6. The next window lists the details you can copy.

TIP: Use the Hide Canceled Bookings and Hide Old Bookings options to manipulate the list.

7. Select the booking detail(s) (you can click Select All to select all the displayed bookings in a single
step), and then click Finish. A message confirms the copy.
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8. Click OK to close the message and return to the Navigator.
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CHAPTER 171: Delete Booking Details Wizard
You use the Delete Booking Details Wizard to delete one or more booking details that do not have
invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking,
any items that have been added for the detail are also deleted.

1. Find and select the parent reservation in the Navigator, click Tools, and then click Delete Booking
Details Wizard. 

2. The first window of the Delete Booking Details Wizard lists all the categories (booking details) that are
already in use for any of the bookings in the selected reservation.
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3. Select the category of details you want to delete (or click Select All to select all categories in a single
step), and click Next. 

4. The next window lists all the bookings for the selected reservation. Select the booking(s) for which
you want to delete details.

5. Once you have selected the bookings to which you want to apply the deleting, click Finish. A mes-
sage confirms your changes.

6. Click OK to close the message and return to the Navigator.
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CHAPTER 172: Delete Item Wizard
If you want to remove an item from a booking (and it has not already been invoiced), you can use the
Delete Item Wizard to delete it. You can delete one item at a time or you can all the items for a booking
detail. If you delete an item at the package level, this includes all the items in the package. You can also
delete individual items from a package.

1. Open the Navigator. 

2. Select the reservation that contains multiple bookings with items you want to delete, then click Tools,
and then click Delete Item Wizard. 

Access the Delete Item Wizard from the Navigator

3. In the first window of the wizard, select the category to which the items you want to delete belong,
and then click Next; the drop-down list only shows categories for items that exist within this reser-
vation.
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Category Drop-Down List of the Delete Items Wizard

4. The window refreshes to show items within this category that you can delete. The example below
shows furniture resources that were added to bookings under the chosen reservation.

Resource Drop-Down List of the Delete Items Wizard

Tip: You can narrow the list using the Grouping field and Delete Empty Categories option.

5. Select items in the list you want to delete, then click Next. 

6. The next screen lists all bookings under the reservation to which you can apply the deletion.
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List of Bookings on the Delete Items Wizard

7. Select the booking(s) for which you want to delete the resource items (you can click Select All to select
all the displayed bookings in a single step), and then click Finish. A message opens indicating that the
changes were made successfully.

8. Click OK to close the message and return to the Navigator.
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CHAPTER 173: Add Item Wizard

1. Open the Navigator and select the bookings to which you want to add the same items. 

2. In the Bookings pane, click Tools and then click Add Item Wizard. 

3. On the first window of the Add Item Wizard, the Select Category window displays categories that are
already in use for any of the bookings in the reservation. 
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4. Select the category to which you want to add items.

5. Click Next. 

6. Proceed to one of the following:
l Adding non-resource category items
l Adding resource, service order, or catering category items
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CHAPTER 174: Comments and Reminders in the Navigator
Concept: Comments Explain Details and Reminders Have Associated Due Dates 

l A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a service
order.

l A reminder is a comment that has a due date associated with it, and if it is attached to a reservation,
booking, group, or service order, then it is called an attached reminder.

In the Navigator, you can add comments/reminders directly to a reservation, booking, or service order, and
you can edit or delete them and view their history. When adding a comment or reminder, you can select
from a pre-configured list, or you can create your own.

1. Open the parent reservation in the Navigator. 

2. In left pane the Navigator, select the reservation or booking with which you want to work. 

3. Click the Comments or Reminders tab to work with either.

Tip: If you prefer to add more than one pre-configured comment or reminder at once to the reservation,
right-click on it in the left panel and choose Add Reminders and Comments. A popup window will guide
you through adding multiple reminders and comments at once.

4. To delete or change or view history for an existing one, select it in the list then click Delete or Edit.
(The Edit popup window provides a History tab).
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5. To add a new comment or reminder, click the New button. 

a. If you clicked the New button, a dialog box prompts you to enter details, like the example
below.
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b. On the Comment Type or Reminder Type drop-down list, select the type of comment or
reminder you want to add, or select "(user-specified comment)," and enter a Description.

c. If you are creating a new reminder, set a Due Date and specify the user who should be
reminded in the Responsible User field.

d. If you are creating a new comment, you can alert any EMS user when they open this reser-
vation, booking, or service order by selecting the Alert Users option.

e. In the Notes field, enter the comment or reminder.

f. Click OK. The Comment dialog box closes. The comment is added to the reservation, booking,
or service order. The Comments tab remains open.
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CHAPTER 175: Add Multiple Comments and Reminders to a
Reservation
When you add a comment or a reminder to a reservation from the Comments tab or Reminders tab,
respectively, then you can add only a single comment or reminder at a time. To add multiple comments or
reminders to a reservation in a single step, you must use an option on the context menu for reservations in
the Navigator.

Tip: When you add multiple reminders and comments to a reservation, your only option is to select from a
pre-configured list of comment types and reminder types. To add a user-specified comment type or
reminder type, you must add each comment or reminder individually. See Also: Comments and
Reminders in the Navigator.

1. Open the reservation to which you are adding multiple comments and/or reminders in the Nav-
igator. See Also:

l Opening a reservation directly in the Navigator
l Opening a reservation through the Reservation Book
l Opening a reservation through a group

2. In the left pane of the Navigator, right-click the reservation, and on the context menu that opens,
click Add Reminders and Comments. The Add Reminders and Comments window opens. This win-
dow lists all the available pre-configured reminder and comment types in the Available list.

Add Reminders and Comments window
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3. In the Available list, select the comment/reminder type, or CTRL-click to select the multiple com-
ment/reminder types that you are adding to the reservation, and then click the Move ( >) button to
move the selected comment/reminder types to the Selected list.

4. To enter the text for the selected comment/reminder types, select a comment/reminder type in the
Selected list, and then click Edit. A Notes dialog box opens in which you can enter the text for the
selected comment/reminder type.

5. After you have entered the text for a selected comment/reminder type, click OK to close the Notes
dialog box and return to the Add Reminders and Comments window.

6. Repeat Step 4 and Step 5 for each selected comment/reminder type.

7. Click Finish. A message appears indicating that the comment/reminder types were added suc-
cessfully.

8. Click OK to close the message and return to the Navigator.
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CHAPTER 176: User Defined Fields in the Navigator
The User Defined Fields tab displays additional fields for custom data for a reservation, booking, or a
booking detail that is a service order. Your Administrator configures these fields and their allowed values. If
you have permissions, you can add new User Defined Fields to a reservation or booking, edit the value for a
User Defined Field, and delete User Defined Fields. You can also view the history for a User Defined Field.

1. Open the parent reservation in the Navigator. 

2. In left pane the Navigator, select the reservation or booking detail with which you want to work
(remember, the booking detail must be a service order), and then in the top right pane of the Nav-
igator, click the User Defined Fields tab.

3. To change or delete an existing field, click the Edit or Delete buttons (field History is a tab under the
Edit option). Use the New button to add a new one. 

a. In the User Defined Field window that appears, define values for the field.
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b. Select the type of Field you are adding, an allowed Value for the field (such as a date, number, or
text field). If you selected a dependent or multi-select type of field, you might need to select
additional information to complete the form: 

l Multi-Select—You will see a list of values appear below.  Pick one or multiple of the
choices.

l Dependency—You will see another box appear below with another User Defined Field. 
Pick the answer to that User Defined Field.

4. Click OK to save your changes.
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CHAPTER 177: Attachments in the Navigator
Concept: An attachment is a file that you upload and store with a reservation or booking. 
A drawing is different in that it is a file referenced from your database. 

Note: To add an attachment to a group record, See Also: Configuring Additional Inform-
ation for a Group.

1. Open the parent reservation in the Navigator. 

2. In left pane the Navigator, select the reservation or booking with which you want to work. 

3. In the top right pane of the Navigator, click the Attachments tab.

4. To work with an existing attachment, select it and the use the Edit, Delete, and View buttons. To add
a new attachment, click the New button.
For new attachments, in the Attachment popup window that opens, enter a Description (or leave
blank to use the filename), choose a Type (if any), add your own Notes, and if you want for the attach-
ment to show for Everyday Users, click the Display on Web option. Attach a file by clicking the Search
icon. Click OK when finished.
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CHAPTER 178: Drawings in the Navigator
The term drawing is used to describe a file (text-based or image file) that you can add to a booking. The file
can stored on your organization's network, or you can create a drawing "on the fly" in the default drawing
program on your EMS client, and then add it to a booking. Typically, a drawing is a setup diagram of the
booking room. You can also detach a drawing from a booking, and view and edit a drawing.

Work with drawings in the Navigator 

1. Open the reservation in the Navigator.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate
booking folder is visible, and then select the booking.

3. In the right pane of the Navigator, open the Drawing tab.

4. Continue to one of the following:
l Attach a stored drawing to a booking
l Create a drawing "on the fly" and attach it to a booking
l Detach a drawing from a booking
l Edit a drawing for a booking
l View a drawing for a booking

Attach a stored drawing to a booking 

1. Click New > Attach. The Drawing dialog box opens.
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2. In the Description field, enter a name or description for the drawing (maximum of 50 characters,
including spaces). If you leave this field blank, then the Description field is populated with the name of
the file after you attach it to the booking.

3. Click the Search icon to open the Find Drawing dialog box, and then browse to and select the
drawing. The Find Drawing dialog box closes. The file name for the drawing is displayed in the Draw-
ing field.

4. Optionally, do one or both of the following:
l If you left the Description field blank, then the name of the attached file is used by default for

the file description, and you can edit this if needed.
l Click Spelling to spell check the description before you attach the drawing to the booking.

5. Click OK. The Drawing dialog box closes. The drawing is attached to the booking. The Drawing tab
remains open.

Create a drawing "on the fly" and attach it to a booking 

1. Click New > Create. The application you selected as your default drawing application for your EMS cli-
ent opens, for example, Microsoft Paint.

Tip: You specify your default drawing application in your user preferences. See Also: Set User
Preferences and Default Values.

2. Create and save the drawing.

Detach a drawing from a booking 

1. Select the drawing, or CTRL-click to select the multiple drawings that you are detaching from the
booking.

2. Click Detach. A message appears asking you if it is OK to detach the selected drawings.

3. Click Yes. The selected drawings are detached from the booking. The Drawing tab remains open.

Edit a drawing for a booking 

1. Select the drawing that you are editing, and then click Edit. The Drawing dialog box opens.

2. Do one or both of the following as needed:
l Edit the description (maximum of 50 characters, including spaces).
l Click the Search icon to open the Find Drawing dialog box and scroll to and select a different

drawing.
3. Optionally, click Spelling to spell check the description before you attach the drawing to the booking.

4. Click OK. The Drawing dialog box closes. The Drawing tab remains open.
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View a drawing for a booking 
Tip: Your computer must have the appropriate application installed to view drawings of a specific type. For
example, to open a .vsd file that is attached to a booking, Microsoft Visio must be installed on your
computer.

1. Select the drawing that you are opening, and then click Open. The file opens in the appropriate applic-
ation.

2. Close the application after viewing the drawing, or if the application allows it, edit the drawing as
needed, and then save the drawing. The next time you open the drawing in the Navigator, you can
see your changes.
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CHAPTER 179: Resource Utility Conflicts Tool
Resource conflicts can occur if bookings for the same date and time require the same resource, and there
are insufficient quantities of the resource to accommodate all the bookings. When you reserve any
resource for which the inventory is maintained (for example, equipment, personnel, and so on), EMS
Desktop Client checks the available quantity and automatically notifies you in an Inventory Conflict
message if there is an insufficient quantity of the selected resource to accommodate your event.

You can dismiss this message and over-commit the resource, however, although you are aware that the
resource has been over-committed, other users will not necessarily be aware of this. If you need to confirm
that an over-commitment of resources does not exist for a single reservation, then you can
manually run the Resource Inventory Conflicts tool from the Navigator to generate an onscreen report
that lists the resources that are in conflict by booking for the reservation.

Tip: You can check if resources are over-committed across multiple reservation by running usage
reports. See Also: Generate Reports and Statistics Reports.
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1. Open the Navigator and select the reservation for which you want to run the wizard. Click Tools and
then click Resource Inventory Conflicts. 

2. The next window to display shows the Resource Inventory Conflicts report, which lists the resources
that are in conflict by booking. The report provides options for printing a hard copy of the report, for
emailing the report, and so on.

3. You can use this report to edit the booking details for the involved bookings to resolve the conflict.
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CHAPTER 180: Approve or Deny Reservation Requests
To approve reservations submitted from EMS Web App, you typically use the Change Status option on the
Reservation Summary tab in the Navigator. Your EMS administrator must grant you the appropriate
security access to change the status of a booking, which includes canceling a booking.

TIP: To approve multiple requests using the Change Booking Status Wizard, See Also: Editing Multiple
Bookings in the Navigator.

1. Open the reservation in the Navigator. 

2. In left pane in the Navigator, select the request you are approving or denying, and then on the Reser-
vation Summary tab, click Change Status. 

3. The Change Booking Status or Change Reservation Status window opens. Select the new Status for
the request.
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TIP: If you select any type of Canceled status, three additional required fields display: Reason, Who
Canceled and Notes. For status changes to bookings, you can leave Update Reservation Status selected to
change the parent reservation status to match. You can select Send Confirmation If Successful to trigger an
email to the group or individual for whom the reservation was made (depending on your Confirmation
Settings).

4. Enter a Reconfirm Date (if required) for the new status you selected.

5. Click Next. The Select Bookings window opens, listing all the current and upcoming bookings for the
reservation that do not have invoiced items. All the bookings are automatically pre-selected. You can
use the Hide Canceled Bookings and Hide Old Bookings options to manipulate the list.
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6. Select the booking(s) for which you want to change changing the status, and then click Finish. The
Change Booking Status Results window displays to show booking status changes for this reser-
vation.

TIP: To see only bookings that were not changed, select Show Unchanged Only. To view the details for a
specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a
resource inventory conflict, a Resource Inventory Conflicts report opens when you Close this window. You
can manually run a Resource Inventory Conflict report: in the Bookings folder of the Navigator, select Tools
> Resource Inventory Conflict.

7. Click Close to close the Change Status Results window and return to the Navigator. 

Accruent Confidential and Proprietary © 2019 Page | 704

CHAPTER 180: Approve or Deny Reservation Requests



CHAPTER 181: The Calendar
You can use the calendar window to search for reservations, bookings, and service orders in your EMS
database. The results are listed in a calendar view.

The following topics provide more information about the calendar:

l Search with the Calendar
l Search with the Resource Calendar
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CHAPTER 182: Search with the Calendar
 You use this window to search for reservations, bookings, and service orders in your EMS database. The
results are listed in a calendar view. You can perform a basic search or an advanced search:

l In a basic search, you specify basic information for a reservation when you first create it, such as the
starting time, the end time, the group for which the event was scheduled, the group contact name,
and so on.

l An advanced search is a field-level search that is carried out at the reservation level, the booking
level, the booking detail level, the booking detail item level, or any combination of these. For example,
in an advanced search, you can specify criteria as granular as who added a specific booking detail
item.

Search in the Calendar 

1. On the EMS toolbar, click the Calendar icon. The Calendar window opens. When the Calendar win-
dow first opens, it defaults to the Results tab, set to the current month and year.

TIP: The Options menu lets you set the Calendar to always display results when it first opens. Click the Get
Data When Calendar Opens option.
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2. Click the Filter tab (if needed) to begin setting criteria for your search. You can toggle between a Basic
or Advanced using toggle button.
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Basic Search 

1. On the Browse For field, set the search to focus on Reservations, Bookings, or Service Orders.

2. Enter search criteria using the fields as defined below.

FIELD DESCRIPTION

Month

Year

The default value is the current month and year, but you can change one
or both of these values if needed.

Include
Canceled

By default, search results are not set to show canceled bookings. Select
this option if you want to search for canceled bookings as well.

Group If the pre-defined list of groups is too extensive to scroll, then click the
Search icon to open the Groups window and search for a specific group.
See .

1st Contact

Reservation
Event Name

Enter a search string by which to filter your search. The search is not case-
sensitive, but your search is limited to the exact order of characters in the
string and it must begin with the information for which you are searching.
For example, a search string of ed returns include Ed, Edward, Eddie, and
so on, but not Ted or Fred.

Building The default value is set to (all). You can leave this value as is, or you can
select a specific building, area, or view.

Building/Room l If you select a specific building, then (all) rooms in the building are
selected by default. You can select a specific room in the building.

l If you select an area, then you can select a specific building that is
contained in the area.

l If you select a view, then Room is left blank; however, you can select
a specific room to search.

Category The default value is set to (all). You can leave this value as is, or you can
select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order.
The default value is set to (all). You can leave this value as is, or you can
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FIELD DESCRIPTION

select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you can
select a specific booking status.

3. You can click Options and set additional search options: Date/Time Filter, Number of Records to
Return, Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day
Count Color.

4. Click Get Data or Refresh. The search results are listed on the Results tab in a calendar view. The num-
ber of bookings that meet the search criteria is indicated on the dates on which the events occur. The
current day’s date is outlined in black. By default, the number of events is indicated in red unless you
selected a different color for the Change Calendar Day Count Color. Any color that you pick here is
carried over to the same option for the Resource Calendar.

Calendar Window, Results Tab

5. Change the Browse For field at the top to see Reservations, Bookings, or Service Orders. Click on a
date in the upper pane to see items for the date in the lower pane of the tab.
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You can do the following from this page:

l Open a reservation. booking, or service order: double-click on the item in the lower pane to open it in
the Navigator.

l Click Print to print the search results.
l Email attendees: select an event and either click Email (if enabled) to start a pre-addressed

SMTP email to the group for that event (see Send Email from EMS), or click Outlook > Send Invit-
ation (if enabled) to message attendees via Outlook. Your Administrator must set a system para-
meter to enable these functions.

l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Work with Service orders: To mark Service Orders as Reviewed, select the service order, or CTRL-click

to select multiple service orders, and then click Review > Mark as Reviewed. To change the state
of Service Orders, click Change State. For detailed instructions in using the page that appears next,
see Search for Service Orders.

l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then
repeat the search.

l Click Refresh to re-query the database based on the current search criteria.

6. Click Close to save your changes and settings.

TIP: To reset the columns to their default values, click the Reset button.
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Advanced Search 

1. Toggle to the Advance search using the button.

2. Month and Year default to the current month and year. You can enter different values as needed.

3. Click Options if you want to add the search options: Date/Time Filter, Number of Records to Return,
Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count
Color.

4. Set search criteria in the remaining fields as needed.

5. Click Get Data or Refresh. Search results are listed on the Results tab just like they were for your Basic
Search, with the same options for working with the results.

6. Click Close to save your changes and settings.
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CHAPTER 183: Search with the Resource Calendar
You use the Resource Calendar to search for a particular resource and determine how much of the
resource (that is, how many individual items) is needed for a specific day or month in a specific year. For
example, how many slices of key lime pie were needed in March of 2018? You can use the results of the
search to assist you in managing the counts of the resources that your organization must ensure are
available for scheduled events. When you carry out a search in the Resource Calendar, you can carry out
a basic search or an advanced search. A basic search is based on the basic information that you specify for a
resource item when you first create it, such as its category and status. An advanced search is a field level
search that is carried out the booking level, the booking detail level, the booking detail item level, the
reservation level, the service order level, or any combination of these. For example, in an advanced search,
you can specify criteria as granular the date that the service order reminder was added. You can open a
resource item that has been returned in the search results in the Navigator, and edit the item if needed.

To search in the Resource Calendar 

1. On the EMS menu bar, click Reservations > Reservations > Resource Calendar. The first time that the
Resource Calendar opens, the Filter tab is set by default to a Basic search; otherwise, the Filter tab is
set to the search type (Basic or Advanced) that you last carried out.
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2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then con-
tinue to one of the following:

l Basic search in the Resource Calendar
l Advanced search in the Resource Calendar

Basic search in the Resource Calendar 

1. Leave the Month and Year set to the default values (current month and year), or optionally, enter dif-
ferent values as needed.

2. Enter the search criteria.

FIELD DESCRIPTION

Include
Canceled

By default, search results are not set to show resource items for canceled
reservations. Select this option to search for resource items in canceled
reservations as well.

Category Select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service order. Select a
specific resource item.

Status The default value is set to (all). You can leave this value as is, or you can select a
specific booking status.

3. Optionally, click Options and edit the default values for one or more additional search options—
Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar Day
Count Color.

4. Click Get Data or Refresh. The search results are displayed on the Results tab in a calendar view.
The total number of resources in all bookings that meet the search criteria is indicated on the dates
on which the events occur. The current day’s date is outlined in black. 

TIP: By default, the number of resources is indicated in red unless you selected a different color for the
Change Calendar Day Count Color. Any color that you pick here is carried over to the same option for the
Calendar.
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5. Optionally, do one or more of the following:
l  Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the

lower pane of the tab.
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l The lower pane on the Results tab is an EMS Browser window. See An EMS Browser
Window for all the features that are available for this pane.

l Double-click an event entry on the Results tab to open the event in the Navigator.
l Click Print to print the search results.
l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and

then repeat the search.
l Click Refresh to requery the database based on the current search criteria.

6. Click Close. Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their default val-
ues, see Resetting Column Settings.

Advanced search in the Resource Calendar 

1. Optionally, do one or both of the following:
l The default values for the month and year are the current month and year. You can enter dif-

ferent values as needed.
l Click Options and edit the default values for one or more additional search options—

Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar
Day Count Color.
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2. For each field level option by which to carry out the search:
l Select the field level option, and then click the Move button (>).

TIP: To filter the list of available fields, in the Field Search field, enter a search string. Your search is
limited to the exact order of the characters in the string, but the search string is not case-sensitive
and it can appear anywhere in the search results. For example, a search string of add returns Added
by, Date Added, and Group Address Line 1. The list of fields that meet your search criteria is
dynamically updated as you enter your search criteria.

l When prompted, enter a value or define the limits for the option, and then click OK.

The option is moved to the Filter Summary list.

TIP: If you have specific fields and/or values by which you always want to carry out a search, then you can
set up these fields to be your Favorite fields. See To set up favorite fields for a Resource Calendar search.

NOTE: To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on
the entry. A tooltip showing the complete field option information opens.

Viewing a selected field option in the Filter Summary list

3. Click Get Data or Refresh. The search results are displayed on the Results tab in a calendar view.
The total number of resources in all bookings that meet the search criteria is indicated on the dates
on which the events occur. The current day’s date is outlined in black.

TIP: By default, the number of resources is indicated in red unless you selected a different color for the
Change Calendar Day Count Color.
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4. Optionally, do one or more of the following:
l Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the

lower pane of the tab.

l The lower pane on the Results tab is an EMS Browser window. See An EMS Browser
Window for all the features that are available for this pane.

l Double-click an event entry on the Results tab to open the event in the Navigator.
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l Click Print to print the search results.
l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and

then repeat the search.
l Click Refresh to requery the database based on the current search criteria.

5. Click Close. Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. If you want to reset the columns to their default val-
ues, see Resetting Column Settings.

To set up favorite fields for a Resource Calendar search 
If you have specific fields and/or values by which you always want to carry out a Resource Calendar search,
you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each
of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Resource Calendar, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then
click Add to Favorites. The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog
box. The next time that you carry out a search, you can simply open the Favorite Fields tab or the
Saved Values tab to carry out a search based on your customized list of search fields.
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CHAPTER 184: The Reservation Wizard
You can use the Reservation Wizard to check for available space for an event and to make a reservation for
the event. The Reservation Wizard helps you search for rooms that are available for a particular time on
one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple
bookings). You can also create a series reservation by selecting one date and time, but multiple rooms.

The following topics provide more information about the Reservation Wizard:

l Reservation Wizard Fields
l The Everyday User Reservation Browser

o Search with the Everyday User Reservations Browser
l Create a Reservation in the Reservation Wizard
l Book a Video Conference
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CHAPTER 185: Reservation Wizard Fields
This section explains the fields on the reservation wizard.

 Event Section 

FIELD DESCRIPTION

Event Name A name or description for the event.

Event Type The classification for the event.

VIP Event Select this option to mark the event as a Very Important event.

Source The reservation source.

Video Conference Select this option for a video conference event.

Group/Contact Section 

FIELD DESCRIPTION

Group Drop-down list of all groups that are available in your system for
hosting/sponsoring an event.

Note: If the pre-configured list of groups is too extensive to scroll, then click the
Search icon to open the Groups window and search for a specific group. See
Also: Search for a group and/or contact. If the group that you want to select for
the reservation is not available on the pre-configured list, then you can add the
group.

Note: Optionally, after you select a group for the event, you can click Group Info
to open a dialog box that provides information (Properties, User Defined Fields,
and Comments) about the group.

1st
Contact

Temp
Contact

When you select a group, if a default contact has been defined for the group,
then this field is automatically populated with the name of the contact; otherwise,
the field is blank. You have several options for defining the 1st Contact for a
reservation:
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FIELD DESCRIPTION

l If the field is blank, but contacts have been configured for the group, you
can select a contact from the pre-configured list.

l If the field is populated with a default value, but other contacts have been
configured for the group, you can select a different contact from the pre-
configured list.

l If the field is blank, and no contacts have been configured for the group, or
the contact that you want to select for the group is not available on the pre-
configured list, you can click the Contact icon to open the Contact dialog
box and create a permanent contact for the group. See Configure Contacts.

l If you want to create a temporary contact just for this event, then select (tem-
porary contact), and in the Temp Contact field, enter the name for the tem-
porary contact.

Note: If a default contact has been configured for the group, then any
modifications that you make for the contact apply to this reservation only. The
next time you or anyone else creates a reservation for this group, the 1st Contact
field is again automatically populated with the name of the default contact.

Phone

Fax

Email
Address

One more of these fields might be automatically populated depending on how a
selected contact has been configured. You can manually edit these values if
needed.

Note: The Phone and Fax fields have a drop-down list available on which you can
select a different value (Fax, Mobile, Other, or Phone) for the field label, or you
can enter a user-defined value. To enter a user-defined value, double-click the
current field label to select it, and then enter the user-defined value over the
selected label.

Note: If default values have been configured for a selected contact, then any
modifications that you make apply to this reservation only. The next time you or
anyone else creates a reservation for the same contact, these fields are again
automatically populated with the default information.

2nd
Contact

Define if necessary for the event.
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FIELD DESCRIPTION

Temp
Contact

Room Setup tab 

FIELD DESCRIPTION

Setup
Type

If you selected a specific value for the setup type when searching for an event
location, this value is carried forward to this field; otherwise, the field is set to
(default). You can edit this value.

Setup
Count

If you selected a specific value for the setup type when searching for an event
location, this value is carried forward to this field; otherwise, the field is blank. You
can enter a value in this field.

Billing tab 
TIP: Depending on the group that you select, one or more of these fields might be automatically populated
with default values. You can edit these default values but any modifications that you make apply to this
reservation only. The next time you or anyone else creates a reservation for the same group, these fields
are again automatically populated with the default billing information.

FIELD DESCRIPTION

Pricing Plan Indicates what type of pricing is to be used for the event.

Billing
Reference
Number

The internal alphanumeric billing code that is associated with the group. You
can manually enter a value in this field, or if a master list of billing reference
numbers has been configured for the group, you can click the Search icon to
open a Billing Reference Numbers dialog box, and select the appropriate
value from this list.

Note: To search for a specific billing reference number, enter a search string in
the Find field, and then click Display. Your search is limited to the exact order
of the characters in the string, but the string is not case-sensitive and it can
appear anywhere in the search results. For example, if you enter co as the
search string, the search results can include CO-123, and 123-CO.
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FIELD DESCRIPTION

Sales
Category

How the group is sorted for purposes of tracking sales figures, for example,
local, regional, national, and so on.

Payment
Type

Indicates how the group paid for the event (cash, check, charged, and so on).

PO Number The internal alphanumeric purchase order number that is associated with the
group. You can manually enter a value in this field, or if a master list of PO
numbers has been configured for the group, you can click the Search icon to
open a PO Number dialog box, and select the appropriate value from this list.

Note: To search for a specific billing reference number, enter a search string in
the Find field, and then click Display. Your search is limited to the exact order
of the characters in the string, but the string is not case-sensitive and it can
appear anywhere in the search results. For example, if you enter co as the
search string, the search results can include CO-123, and 123-CO.

Salesperson The user who "sold" the event to the group.

Other tab 

FIELD DESCRIPTION

Event
Coordinator

The Event Coordinator who is assigned to the event.

Estimated Event
Attendance

The estimated number of people who are expected to attend the event.

Calendar Style Drop-down list of all the available formats for printing this event on the
Event Calendar and Event Schedule reports.

URL The event URL.
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Virtual tab 

FIELD DESCRIPTION

Web
User

To specify the web users who can view/manage this reservation in VEMS, click
the Search icon to open the Web Users dialog box and search from a list of
registered web users.

l You can search by User Name or Email Address.
l To search a list of all available web users, leave the Search field in the Web

Users dialog box blank, and then click Display.
l To search for a specific web user, enter a search string in the Search field,

and then click Display.

Note: The string is not case-sensitive, but your search is limited to the exact
order of characters in the string and it must begin with the information for which
you are searching. For example, if searching by Email Address, a search string of
bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

l To return this field to the (no change) value at any time, click Reset.

Web
Process
Template

The web process template that defines the functions that are available for the
selected web user.

Note: An Everyday User might be assigned to more than one process template,
so make sure to select the template that is applicable for this reservation.

User Defined Fields tab 

FIELD DESCRIPTION

User-defined fields are additional fields that store custom data for a reservation.
Your EMS administrator configures the types of fields that are available as well as
the allowed values for these fields.

l To enter or edit a value for a field, select the field, and then click Set Value.
l To clear a value for a field, select the field, and then click Clear Value.

Note: If a user-defined field is not required here, you can always supply a value for it
at a later date in the Navigator. See Also: User Defined Fields in the Navigator.
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Video Conference tab 

FIELD DESCRIPTION

Displayed only if you selected the Video Conference option on this window. N/A for
a Best Fit room or Specific Room meeting assignment. You identify the host
endpoint for the video conference on this tab.

Note: Not available in EMS Professional.
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CHAPTER 186: The Everyday User Reservation Browser
You can use the Everyday User Reservations Browser to search at a very detailed level for reservations,
bookings, service orders, resources, everyday user reservations, and pre-defined queries. The results are
listed in a calendar view. You can perform a basic search or an advanced search:

l In a basic search, you specify basic information for a reservation when you first create it, such as the
starting time, the end time, the group for which the event was scheduled, the group contact name,
and so on.

l An advanced search is a field-level search that is carried out at the reservation level, the booking
level, the booking detail level, the booking detail item level, or any combination of these. For example,
in an advanced search, you can specify criteria as granular as who added a specific booking detail
item.

To search using the Everyday User Reservation Browser, see Search with the Everyday User
Reservations Browser.

Concept: An everyday user reservation is any reservation that a user has submitted through EMS
Web App.
The Everyday User Reservations searching tool is identical to the Everyday User Reservations
Browser   searching tool with one exception: when the Everyday User Reservations Browser opens for the
first time, the Browse For function is set to all Reservations in your organization's database, whereas the
Everyday User Reservation tool is set to show only Everyday User Reservations. 
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CHAPTER 187: Search with the Everyday User Reservations
Browser
To search using the Everyday User Reservations Browser, do the following:

1. On the EMS toolbar, click the Everyday User Reservations Browser icon, the Everyday User Reser-
vations Browser window opens. When the Everyday User Reservations Browser window first opens, it
defaults to the Results tab, set to the current month and year.

2. Click the Filter tab (if needed) to begin setting criteria for your search. You can toggle between a Basic
or Advanced using toggle button.
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Basic Search

1. Toggle for a Basic search. On the Browse For field, set the search to focus on reservations, bookings,
service orders, resources, everyday user reservations, or a pre-defined query.

2. Enter search criteria using the fields as defined below.
FIELD DESCRIPTION

Starting
Date

Ending
Date

These fields set the date range for the search. The default value is the
current month and year, but you can change these values if needed.

Use
Specific
Times

Clicking this option adds specific Starting Time and Ending Time fields to
your search criteria.
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3. You can specify fields from the booking, reservation, service order, and so forth as part of your search
criteria by using the arrow buttons to move them from the left panel to the right panel. The level of
the field is noted in the list, for example, the "Booking... Room Design" field means your search will
pull all events that have the value you specify in the Room Design field at the booking level.

When you move a field to the right panel, you will be prompted to enter a field value for which to
search. 
TIP: Click Add to Favorites to save a field on the Favorite Fields tab for future searches. You can also
move items from the right panel into the Favorite Fields or Saved Values tabs in the left panel.
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4. Click Options to set additional search options.

5. Click Get Data or Refresh. The search results are listed on the Results tab in a calendar view.

You can do the following from this page:
l Change the Browse For field at the top to refresh the results to focus on reservations, book-

ings, service orders, resources, everyday user reservations, or pre-defined queries.
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l Open a reservation. booking, service order, etc.: double-click on the item in the results tab to
open it in the Navigator.

l Click Print to print the search results.
l Email attendees: select an event and either click Email (if enabled) to start a pre-addressed

SMTP email to the group for that event (see Send Email from EMS), or click Outlook > Send
Invitation (if enabled) to message attendees via Outlook. Your Administrator must set a system
parameter to enable these functions.

l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Work with Service orders: To mark Service Orders as Reviewed, select the service order, or

CTRL-click to select multiple service orders, and then click Review > Mark as
Reviewed. To change the state of Service Orders (when used), click Change State. For detailed
instructions in using the page that appears next, see Manage Service Orders.
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l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and
then repeat the search.

l Click Refresh to re-query the database based on the current search criteria.
6. Click Close to save your changes and settings.

TIP: To reset the columns to their default values, click the Reset button.

Advanced Search 

1. Toggle to the Advance search using the button.

2. Starting Date and Ending Date default to the current month and year. Enter your date range as
needed.

3. Click Options if you want to add the search options: Date/Time Filter, Number of Records to Return,
Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count
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Color.
4. Enter search criteria using the fields as defined below.

FIELD DESCRIPTION

Starting Date

Ending Date

The default value is the current month and year, but you can change
these values if needed.

Use Specific
Times

Clicking this option adds specific Starting Time and Ending Time
fields to your search criteria.

Include
Canceled

Deselected by default. Select this option to include canceled
bookings in the search.

Group Your Administrator might have re-labeled this field to Customer or
Employee. If the pre-defined list of groups is too extensive to scroll,
then click the Search icon to open the Groups window and search for
a specific group. See Also: Search for a group and/or contact.

1st Contact

Reservation
Event Name

Enter a search string by which to filter your search. The search is not
case-sensitive, but your search is limited to the exact order of
characters in the string and it must begin with the information for
which you are searching. For example, a search string of ed returns
include Ed, Edward, Eddie, and so on, but not Ted or Fred.

Building The default value is set to (all). You can leave this value as is, or you
can select a specific building, area, or view.

Room/Building l If you select a specific building, then (all) rooms in the building
are selected by default. You can select a specific room in the
building.

l If you select a area, then you can select a specific building that
is contained in the area.

l If you select a view, then Room is left blank; however, you can
select a specific room to search.

Category The default value is set to (all). You can leave this value as is, or you
can select a specific category (booking detail).
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FIELD DESCRIPTION

Resource Available only if you select a category that is a resource or service
order. The default value is set to (all). You can leave this value as is,
or you can select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you
can select a specific booking status.

5. Click Get Data or Refresh. Search results are listed on the Results tab just like they were for your Basic
Search, with the same options for working with the results.

6. Click Close to save your changes and settings.
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CHAPTER 188: Create a Reservation in the Reservation Wizard
You use the Reservation Wizard to check for available space for an event and to make a reservation for the
event.

Concept: Reservations are containers for multiple bookings; bookings are individual meetings
When you "make a reservation" in EMS, you are creating the broader rules for events that take place with a
similar purpose and involving most of the same people, services, resources, and spaces. When you "book" a
meeting, you are creating a meeting within a reservation. See Also: Reservation Structure.

The Reservation Wizard helps you search for rooms that are available for a particular time on one day (a
simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You
can also create a series reservation by selecting one date and time, but multiple rooms.

To make a reservation using the Reservation Wizard, you will:

l Set the event date, time, and status. 
l Set the event location. 
l Set the event information. 

Note: The following procedure describes how to make a reservation by selecting values for
the required and optional fields.

l If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard
Template drop-down list is displayed at the top of the Reservation Wizard. You can streamline the
booking process by choosing from these templates, which automatically sets the default values for
many of the fields in the Reservation Wizard.

l If your job entails making multiple reservations that require the same information, and you are not
using reservation wizard templates, then you can set your own default values for many of the fields in
the Reservation Wizard.

Setting the Event Date and Time

1. On the toolbar, click the Wizard icon. The Reservation Wizard opens. All required fields in the wizard
are marked with a red dot. Your EMS administrator configures the required fields.
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2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different
month (< or >) or for a different year (<< or >>). You can also click a month at the top of the cal-
endar to open a drop-down list from which you can select a different month and you can also click a
year at the top of the calendar to open a drop-down list from which you can select a different year.

3. If the event dates do not follow a pattern, use one or more of the following options for entering a
date; otherwise, go to the next step. Click to pick dates on the calendar. To select all five days in a
work week, click in the blank space to the left of the week. To select all seven days in a week, double-
click in the blank space to the left of the week.

To select every occurrence of a specific day of the week for the displayed month (for example, all Tuesdays
in November, 2012), click the heading (S, M, T, and so on) for the day. To select every occurrence of a
specific day of the week shown (regardless if the day falls within the same month), double-click the heading
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(S, M, T, and so on) for the day. If you need to clear a single selected date, click the date again. To clear
multiple selected dates in a single step, click Clear Month to clear all currently selected dates for the
currently displayed month or click Clear All to clear all currently selected dates regardless of month or year.

l If the event dates do follow a recurrent pattern, (for example, the third Friday of every month),
click Date Pattern to open the Date Pattern dialog box and enter your event date information. The
steps that you use to create a date pattern in EMS are very similar to the steps that you use to create
a date pattern in Microsoft Outlook or in any other calendaring product.

As you specify the event dates, the Selected Dates tab is automatically updated with the selected
dates. Dates that are closed are displayed in red on the Calendar tab, holidays are green. These are linked
to information about the closure (in the Selected Dates tab, click Holidays). To remove the date your
selection, open the Selected Dates tab, select the date, or CTRL-click to select multiple dates, and then
click Remove. When you make a reservation for multiple dates, the process is easier if you first remove all
holidays or closed dates from the list of selected dates; however, be very careful when selecting dates for
removal as you are not prompted to confirm your selection before you click Remove.

Viewing information about a holiday or closed date from the Calendar tab

4. Specify the start time and end time for the event:
l Select a time from the drop-down list for each field.
l Manually enter the time in each field. When you manually enter the time, you can use a short-

cut. For example, for 9:00 am, you need to enter only “9a” and for 2:00 pm, you need to enter
only “2p,” and so on. If you enter an end time that is earlier than the start time, then the system
assumes that the end time is the next day and the phrase “Next Day” is displayed to the right of
the End time field.
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5. Specify Setup and Teardown times. To use the default setup and teardown times that your EMS
administrator has assigned to the rooms in your system, leave Use Default selected. To override the
default setup/teardown times, clear Use Default, select Minutes or Hours, and then enter your own
setup and teardown times. Remember, setup and teardown times are the hours, or fractions of
hours, that you add to the event time to allow staff to prepare a room for the event or to clean up
after the event. For example, for a 30 minute setup time, you can enter 30 minutes or 0.5 hours.

6. Select the status for the event. Depending on the status that you select, for example, Tentative or
Hold, you might be required to enter a reconfirm date. You can monitor reservations that must be
reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See EMS Dashboard.

Setting the Event Location 
You have three options for selecting the event location on the first window of the Reservation Wizard:

SEARCH

METHOD

DESCRIPTION

Standard Use this option to display a list of all the available rooms that meet all the
requested dates. 

Note: Standard search is required for Video Conference room assignments.

Best Fit Use this option if no one room can meet all the requested dates. The system lists
the available rooms along with the number of bookings for which you can
reserve each room. You can piece together the entire reservation using Best Fit,
or just part of it. 

Specific
Room

Use this option to confirm the availability and reserve of one specific room for
the scheduled event. 

TIP: By default, EMS looks for an available room or rooms in only the first 50 rooms that it finds in the pre-
configured Rooms list. To search more than 50 rooms, before you begin any search, click Options > Max.
Number of Rooms to Search, and then select a different number of rooms to search.

Finding a Standard Room 
By default, when you search for a standard room, rooms that are available all day are marked with an
asterisk (*). To set or clear this option, click Options > Standard Search > Show Available All Day Indicator.
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1. Select Standard.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to
search for a standard room. Your selection on the Building drop-down list determines the options
that are available on the Time Zone drop-down list. If you select (all) buildings, then you can select a
time zone. If you select a specific building, then by default, a time zone is selected for the building,
and you cannot select a different value.

3. If applicable, select the appropriate time zone for the event.

4. Specify one or more room settings:
l Type is the class or category of the room, for example a meeting room, a workspace, and so on.

Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type drop-down list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type drop-down list.

l Setup count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count. The selected setup type and setup count are applied to
all the bookings that you add to this reservation. If any of the bookings require a different
setup type or count, you can change this information after you complete the reservation. 

5. You can add optional Features on the Features tab.

6. Click Next. Up to two tabs are displayed:
l The Available tab, which is the active tab and is always displayed, lists all the rooms that

meet all your event criteria. If you have elected to show the Available All Day Indicator, the
rooms that are available all day are marked with an asterisk (*). By default, the available rooms
are sorted alphabetically by room code. If your EMS administrator has configured the rooms
for your EMS implementation with a book sequence, then under Options, select Sort Rooms by
Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have
the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not
available for scheduling as well as list of the events that are scheduled for each room.

Accruent Confidential and Proprietary © 2019 Page | 739

CHAPTER 188: Create a Reservation in the Reservation Wizard



Example of standard room search results

7. Select the room, or CTRL-click to select the multiple rooms you are scheduling for the event. If the
reservation is for a video conferencing meeting, then you must select a minimum of two rooms. You
must designate one of these rooms as the Host Location on the Video Conference tab on the last
page of the Reservation Wizard.

8. Optionally, do one or both of the following; otherwise, go to Step 9.
l Click Room Info to open the Room Info dialog box and view information about any bookings

for the room, the room properties, its pricing, and/or to view an image of the room.
l Click Building Hours to open the Building Hours dialog box which displays the hours that the

selected room/building is open on the reserved date.
9. Click the Move button (>) to move the rooms to the Selected list.

Note: If you select more than one room, all the selected rooms are booked for all the event
dates.

10. Click Next.
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Finding a Best Fit Room 

1. Select Best Fit.

2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to
search for a standard room.

3. If applicable, select the appropriate time zone for the event.

Note: Your selection on the Building drop-down list determines the options that are avail-
able on the Time Zone drop-down list. If you select (all) buildings, then you can select a time
zone. If you select a specific building, then by default, a time zone is selected for the building,
and you cannot select a different value.

4. Do one or more or all of the following for room specifications:
l Type is the class or category of the room, for example a meeting room, a workspace, and so on.

Leave Type set to the default of (all) to search for all pre-configured room types or select a spe-
cific room type from the Type drop-down list.

l Floor is optional information when you are searching for a room. Leave Floor set to the default
value of (all) to search for all pre-configured floors or select the floor from the Floor drop-down
list.

l Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or
theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured
setup types or select the setup type from the Setup Type drop-down list.

l Setup count is the anticipated attendance for the event. If you selected a specific setup type,
then you must enter the setup count. The selected setup type and setup count are applied to
all the bookings that you add to this reservation. If any of the bookings require a different
setup type or count, you can edit the reservation later.

5. You can add optional Features for the room on the Features tab.

6. Click Next. Up to two tabs are displayed:
l The Available tab, which is the active tab and is always displayed, has two lists. The list in the left

pane is a list of all the rooms that meet some or all of your event criteria. The list in the right
pane is a list of all the event dates that must be fulfilled. By default, the available rooms are sor-
ted alphabetically by room code. If your EMS administrator has configured the rooms for your
EMS implementation with a book sequence, then under Options, select Sort Rooms by Book
Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the
same sequence, then the rooms are sorted alphabetically by name within the sequence.)

l The Conflicts tab is displayed only if there are rooms that are not available for the requested
dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not avail-
able for scheduling for the event as well as list of the events that are scheduled for each room.
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Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to the next step.
l To see detailed room information, click Room Info  (such as the room properties, pricing, and/or

to view an image of the room).
l To see building hours, click Building Hours (which shows hours when the selected room/build-

ing is open on the reserved date).
8. If a room is available, select the single room that is available for all the requested dates, and then click

the Move button (>) to move the room to the Event Dates list. If a room is not available, select a
room that is available for some of your requested dates, and then click the Move button (>) to move
the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue.

Finding a Specific Room
You can use the specific room search to book a standard EMS room or a room or area that is not managed
in EMS. An override room, or “override description,” is used to book an event in a space that has not been
configured in your EMS system. For example, your EMS administrator might have configured an override
room named “Other Area” in the Engineering building. To book an event in Dr. Wilson's office, which is a
room that is not defined in EMS, in the Engineering building, you can select the “Other Area” room and
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specify “Dr. Wilson's Office” for the location. EMS does not track availability for events booked in override
rooms; however, EMS reports on events that are scheduled in an override room just like any other event
scheduled for any other room.

1. Select Specific Room. The Room Selector dialog box opens.

2. To choose a room from list of all rooms in all available buildings, select (all) on the Building drop-
down list; then select a room, and then click OK. To select a room in a specific building, area, or view,
select it on the Building drop-down list, select the room, and then click OK. If the room is configured
as an override room, go to the next step, otherwise, go skip to Step 4.

3. In the Location field, enter the location of the override room, and then click Next skip the remaining
steps in this subsection.

4. Click Next. If the event is scheduled for a single date and the room is available, then continue. In all
other cases, (for example, the event is scheduled for a single date but the room is not available or it is
a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific
room is available. You can open the Conflicts tab to view the list of dates for which the specific room
is not available as well as list of the events that are scheduled for the room.

5. Optionally, do one or both of the following; otherwise, go to the next step.
l To see detailed room information, click Room Info  (such as the room properties, pricing, and/or

to view an image of the room).
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l To see building hours, click Building Hours (which shows hours when the selected room/build-
ing is open on the reserved date).

6. If the specific room is available for all the event dates, then click the Move All button (>>) to schedule
the room for all the event dates. If the specific room is not available, try another approach such as
reserving a different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue. 

Specifying Event Information 
After you select an event location or locations, you must specify other information for the event. You must
enter information in the required fields.
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1. Enter event information using the elements in this window (see Reservation Wizard Fields). 
2. Click Finish. The Navigator window opens. The reservation information appears in the window. You

use this window to add booking details and to make any needed modifications to the reservation
and its bookings.
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Note: A reservation is not complete and rooms are not removed from the Available list until
you click Finish. Although unlikely, it is possible for another user to select and reserve a room
during the time period after you have selected the room but before you have finalized the
reservation. If this occurs, after you click Finish, a message appears stating that your reser-
vation conflicts with an existing reservation.
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CHAPTER 189: Book a Video Conference
Booking a video conference is basically the same as making a standard reservation, except for a few
differences:

1. On the first screen of the Reservation Wizard, choose a video conference template option from
the Wizard Template drop-down, as shown in the example below. Your Administrator configures
these templates; if none are available, contact your Administrator. Additionally, set
the Search method to "Standard."

2. You select at least two rooms for video conferences; one is the "host" where the presenter drives the
video conference, and the other room(s) are "endpoints" where attendees participate in the video
conference. You can have multiple rooms and one host. On the second screen of the wizard where
you select rooms for the booking, select all rooms involved including your host room.
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3. An additional "Video Conference" tab is available for video conferencing on the third screen of the wiz-
ard where you designate one of the rooms as the host. 

4. Once you finalize your reservation the host room shows in the Navigator with "Yes" under the VC
Host column. Each room shows as a booking under the reservation, and if your Administrator has
configured it, resources needed for a video conference, such as a Video Conference cart, are auto-
matically included as details under the bookings.
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CHAPTER 190: The Browser
You can use the Browser to search at a very detailed level for reservations, bookings, service orders,
resources, everyday user reservations, and pre-defined queries. The results are listed in a calendar view.

Browser Tool

Using the Browser, you can perform a basic search or an advanced search:

l In a basic search, you specify basic information for a reservation when you first create it, such as the
starting time, the end time, the group for which the event was scheduled, the group contact name,
and so on.

l An advanced search is a field-level search that is carried out at the reservation level, the booking
level, the booking detail level, the booking detail item level, or any combination of these. For example,
in an advanced search, you can specify criteria as granular as who added a specific booking detail
item.

To search using the Browser, see Search with the Browser.

Concept: An everyday user reservation is any reservation that a user has submitted through EMS
Web App. 
The Everyday User Reservations searching tool is identical to the Browser searching tool with one
exception: when the Browser opens for the first time, the Browse For function is set to all Reservations in
your organization's database, whereas the Everyday User Reservation tool is set to show only Everyday
User Reservations. Basically, although this section is written from the perspective of using the Browser, all
the information can be applied when using the Everyday User Reservation searching tool.

Accruent Confidential and Proprietary © 2019 Page | 750

CHAPTER 190: The Browser



CHAPTER 191: Search with the Browser
To search using the browser, do the following: 

1. On the EMS toolbar, click the Browser icon. the Browser window opens. When the Browser window
first opens, it defaults to the Results tab, set to the current month and year.

2. Click the Filter tab (if needed) to begin setting criteria for your search. You can toggle between a Basic
or Advanced using toggle button.
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Basic Search 

1. Toggle for a Basic search. On the Browse For field, set the search to focus on reservations, bookings,
service orders, resources, everyday user reservations, or a pre-defined query.

2. Enter search criteria using the fields as defined below.
FIELD DESCRIPTION

Starting
Date

Ending
Date

These fields set the date range for the search. The default value is the
current month and year, but you can change these values if needed.

Use
Specific
Times

Clicking this option adds specific Starting Time and Ending Time fields to
your search criteria.

3. You can specify fields from the booking, reservation, service order, and so forth as part of your search
criteria by using the arrow buttons to move them from the left panel to the right panel. The level of
the field is noted in the list, for example, the "Booking... Room Design" field means your search will
pull all events that have the value you specify in the Room Design field at the booking level.
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When you move a field to the right panel, you will be prompted to enter a field value for which to
search. 

Note: Click Add to Favorites to save a field on the Favorite Fields tab for future
searches. You can also move items from the right panel into the Favorite
Fields or Saved Values tabs in the left panel.

4. You can click Options and set additional search options.
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5. Click Get Data or Refresh. The search results are listed on the Results tab in a calendar view.

You can do the following from this page:
l Change the Browse For field at the top to refresh the results to focus on reservations, book-

ings, service orders, resources, everyday user reservations, or pre-defined queries.
l Open a reservation, booking, service order, etc. by double-clicking on the item in the results

tab to open it in the Navigator.
l Click Print to print the search results.
l Email attendees by selecting an event and either click Email (if enabled) to start a pre-addressed

SMTP email to the group for that event (See Also: Send Email from EMS), or click Outlook >
Send Invitation (if enabled) to message attendees via Outlook. Your Administrator must set a
system parameter to enable these functions.

l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Work with Service orders: To mark Service Orders as Reviewed, select the service order, or

CTRL-click to select multiple service orders, and then click Review > Mark as
Reviewed. To change the state of Service Orders (when used), click Change State. For detailed
instructions in using the page that appears next, see Manage Service Orders.
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l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and
then repeat the search.

l Click Refresh to re-query the database based on the current search criteria.
6. Click Close to save your changes and settings.

TIP: To reset the columns to their default values, click the Reset button.
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Advanced Search 

1. Toggle to the Advance search using the button.

2. Starting Date and Ending Date default to the current month and year. Enter your date range as
needed.

3. Click Options if you want to add the search options Date/Time Filter, Number of Records to Return,
Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count
Color.

4. Enter search criteria using the fields as defined below.
FIELD DESCRIPTION

Starting Date

Ending Date

The default value is the current month and year, but you can change
these values if needed.

Use Specific
Times

Clicking this option adds specific Starting Time and Ending Time
fields to your search criteria.

Include
Canceled

Deselected by default. Select this option to include canceled
bookings in the search.
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FIELD DESCRIPTION

Group Your Administrator might have re-labeled this field to Customer or
Employee.
If the pre-defined list of groups is too extensive to scroll, then click
the Search icon to open the Groups window and search for a specific
group. See Also: Search for a group and/or contact.

1st Contact

Reservation
Event Name

Enter a search string by which to filter your search. The search is not
case-sensitive, but your search is limited to the exact order of
characters in the string and it must begin with the information for
which you are searching. For example, a search string of ed returns
include Ed, Edward, Eddie, and so on, but not Ted or Fred.

Building The default value is set to (all). You can leave this value as is, or you
can select a specific building, area, or view.

Room/Building l If you select a specific building, then (all) rooms in the building
are selected by default. You can select a specific room in the
building.

l If you select a area, then you can select a specific building that
is contained in the area.

l If you select a view, then Room is left blank; however, you can
select a specific room to search.

Category The default value is set to (all). You can leave this value as is, or you
can select a specific category (booking detail).

Resource Available only if you select a category that is a resource or service
order. The default value is set to (all). You can leave this value as is,
or you can select a specific resource item.

Booking Status The default value is set to (all). You can leave this value as is, or you
can select a specific booking status.

5. Click Get Data or Refresh. Search results are listed on the Results tab just like they were for your Basic
Search, with the same options for working with the results.
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6. Click Close to save your changes and settings.
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CHAPTER 192: People: Groups and Contacts
A group is an entity for which reservations are made at your facilities. A group is one of the four core data
items that your EMS administrator must configure so that you can make reservations. A group can be an
internal or external entity and it can be an organization or an individual. A contact is a person who serves as
the coordinator or focal point for a group.

Concept: Attendees= Invitees; Group = Meeting Organizers
Attendees get invited, and groups and/or first contacts get notices about changes to the meeting on the
Dashboard. Additionally, your Administrator sets the label for the Group field, so the name might vary; in
the example below, it is labeled "Customer." A Group is responsible for the meeting, and can designate a
First Contact to oversee questions, changes, and updates to the meeting. 
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CHAPTER 193: Search for People
Your organization might have re-labeled this button, "Customers" or "Employees." A group is an entity for
which reservations are made at your facilities. A group can be an internal or external entity and it can be an
organization or an individual. A group must be defined EMS Desktop Client before you can make
reservations for it. Optionally, if you want to first confirm that a group has not already been configured,
then you can search for the group.

TIP: Typically, your EMS administrator carries out basic configuration of the groups for which you need to
make reservations. You always have the option of modifying any group that your EMS administrator has
configured and you always have the option of configuring new groups when needed.

1. On the toolbar, click the Groups icon. The Groups window opens on the Results tab is the active tab,
which lists the first 1000 groups in your EMS database that are Active.

TIP: Optionally, to change the number of records that are displayed in the Groups window, click Options,
and then on the Group Options dialog box, select a different number of records to return.

2. Open the Filter tab and set your search criteria.

OPTION DESCRIPTION

Display l Groups—Display all groups that meet your search criteria on the Results tab.
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OPTION DESCRIPTION

l Contacts—Display all contacts that meet your search criteria on the Results
tab.

Note: When a list of contacts is displayed, the contact’s group is also displayed.

Search
Fields

l Starts with—The string is not case-sensitive, but your search is limited to the
exact order of the characters in the string, and the string must begin with the
information for which you are searching. For
example, Assoc returns Association of Broadcasters but not Biomedical Stu-
dent Association.

l Contains—Your search is limited to the exact order of the characters in the
string, but the string is not case-sensitive, and the string can be found any-
where in your search results. For example, Assoc returns both Association of
Broadcasters and Biomedical Student Association.

Group Fields are available if you select Groups for Display. Enter values as needed in any
or all fields.

Contact Fields are available only if you select Contacts for Display. Leave all fields set to
their default search values to search for all active contacts that are currently
configured in your EMS database, or enter values as needed in any or all fields.

Note: If you select Contact, then both the Group fields and the Contact fields are
available for searching. If you enter data in both sets of fields when you are
searching for a contact, then your search criteria must be met for both the
contact and the contact’s group to be displayed on the Results tab.

Note: To reset the Filter at any time to its default settings, click Reset Filter.

3. Click Get Data. The Results tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the Results tab, in the Search field, enter a search string. The list of
groups is dynamically updated as you enter your search string.

TIP: Your search is limited to the exact order of the characters in the string, but the search string is not
case-sensitive and it can appear anywhere in the search results. For example, a search string
of Assoc returns both Association of Broadcasters and Biomedical Student Association.
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CHAPTER 194: Add or Edit Profile Information for People and
Groups
If authorized, you might be able to add or change profile information about groups or individuals in EMS
Desktop Client. 

To work with group or individual user profile information, you will:

l Open the Groups window.
l Search for existing Groups or Individuals. 
l Add or Modify Basic Profile Information.
l Add or Modify Details for Groups/Individuals.

o Contacts
o Reminders
o Comments
o Reservations
o Calculations
o Everyday Users
o Assign a Group to an Everyday User

Concept: Information on a Group or Individual Profile Is Used For Reservations for That Group or
Individual 
The values you specify here are become available when a new reservation is made for the group or
individual. A user can change these values if needed during the booking process.

Open the Groups Window 

1. On the toolbar, click the Groups icon. The Groups window opens on the Results tab is the active tab,
which lists the first 1000 groups in your EMS database that are Active.
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TIP: For instructions in filtering and navigating the list of groups shown above, See Also: Search for
People. 

Search for Existing Groups or Individuals  
The profile page for the group or individual displays, dividing information into a left panel of
hierarchical details about the group or individual, and a right panel showing basic information divided into
four tabs: Summary, Billing Information, Other, and Audit. 

2. From the Groups window:  
l To create a new group or individual profile, click the New button.
l To edit an existing one, find and select the group or individual profile you want to Edit and then

click Open, and on the profile page, click Edit.

Accruent Confidential and Proprietary © 2019 Page | 763

CHAPTER 194: Add or Edit Profile Information for People and Groups



The following dialog appears, where you can begin working with the basic profile information for the group
or individual.

Add or Modify Basic Profile Information 

3. On each tab on the dialog shown above, and enter or change information as needed.

Group Tab

FIELD DESCRIPTION

Name Required field. The name of the group.

Note: The name can be a maximum of 50 characters, including spaces.

Address The street or mailing address for the group.
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FIELD DESCRIPTION

City
ST
Country
Zip

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a user-defined value, double-
click the current field label to select it, and then enter the user-defined value
over the selected label.

Email
Address

The email address for the group.

Note: If your computer is connected to a network, click Search to open a
Global Address Lookup dialog box and search for the email address.

URL The URL for the group’s website.

Note: Web users can link to this group's website on the EMS Web App.

Default
Contact

Populated with the name of the default contact for the group after you have
defined default contacts for the group.

Require
Contacts

Select this option if the group is to always require a contact when a
reservation is being made for the group.

VIP Select this option if the group is to be designated as a VIP group.

Inactive Leave this option blank to add the group as an active group. Select this
option to inactivate the group.

Billing Information Tab
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OPTION DESCRIPTION

Pricing Plan Pick a pricing plan.

Account Pick an account.

Payment
Type

Pick a payment type.

Salesperson Pick the salesperson for the event.

Event
Coordinator

Pick the event coordinator for the group.

Sales
Category

Pick a sales category.

Status The status is a way to indicate the standing or ranking of the group. The
default values are the following:

l OK—A reservation can be made for the group. (In your organization, this
status could indicate that the group is current in payments due.)

l Warning—If a group status is set to Warning, then a Warning message
opens when you make a reservation for the group. It does not, however,
prevent a reservation from being made for the group.

l Bad—If a group status is set to Bad, then reservations cannot be made
for the group.

Billing
Reference
Number

You can manually enter data into the field, or you can click the Search icon to
open a master list of billing reference numbers and select a reference.

PO Number You can manually enter data into the field, or you can click the Search icon to
open a master list of PO Numbers and select a PO number.

External
Reference

Links the group to an outside EMS Desktop Client, if needed.

Other Tab
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OPTION DESCRIPTION

Network ID The Windows login for the group.

Personnel Number Organization number for the group.

Badge Number Badge number for the group.

Other ID Any secondary ID for the group.

4. After you finalize the information, click OK. You return to the Group profile window with the group
still selected.

Add or Modify Details for Groups/Individuals 

5. To begin this process, navigate to the group or individual profile page you want to work with
(see Step 2 above).
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From the profile page for the group or individual, you can work with details about a group from the left
panel.

Note: Adding and modifying information for a group or individual becomes fairly self-explanatory after the
first few tries. This topic provides guidance and tips only where the workflow or field definitions might not
be obvious, on the following types of information:

1. Contacts
2. Reminders
3. Comments
4. Reservations
5. Calculations
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Add or Modify Contacts 

1. In the left pane, select Contacts. Contacts for the group show in the right pane of the window. When
a reservation is being made for this group or individual, the contacts defined here will be available for
selection.

l To add a new contact, click New. 
l To modify an existing contact, select the contact and click Edit.

2. Enter or edit information for the contact as needed using the field definitions below.
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Tip: You can set this contact as the default (First Contact) on new reservations for this group or individual
using the Set as Default checkbox here or the Set Default button on list of contacts (above).

FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot change
this value.

Address Populated with the address of the group that you selected. If the contact
address is not the same as the group address, then clear Use Group Address
and enter the appropriate values in the Address fields.
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FIELD DESCRIPTION

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a user-defined value, double-
click the current field label to select it, and then enter the user-defined value
over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, you can click Search to
open a Global Address lookup.

External
Reference

Links the contact to an outside program if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact. You can
always specify a contact as the default contact for a selected group at a later
date. To do so, select the contact in the right pane, click Set Default, and then
click Yes at the prompt to set the selected user as the default contact.

Inactive Leave this option blank to add the contact as an active contact. Select this
option to inactivate the contact.

3. When finished, click OK to return to the group profile page.

Add or Modify Reminders

1. In the left pane, select Reminders; all reminders for the group or individual show on the right pane.
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2. Edit an existing reminder or create a New one.
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Tip: Leave Date Completed blank so that the reminder shows on the Dashboard for the group or individual
you are editing. In the Notes field, enter any further explanation or information about the reminder.

3. When finished, click OK to return to the group profile page.

Add or Modify Comments 

1. In the left pane, select Comments; all reminders for the group or individual show on the right pane.

2. Edit an existing comment or create a New one.
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Tip: Choose a pre-configured Comment Type. If none of the pre-configured comment types meets your
working needs, select (user specified comment), and then in the Description field, enter a description for
the comment type. Select the Alert Users checkbox if you want the Alert to be highlighted on the
group/individual dashboard.

3. When finished, click OK to return to the group profile page.

Add or Modify Reservations 

1. In the left pane, select Reservations; all events for the group or individual show on the right pane.
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Tip: Clicking New launches the Reservation Wizard. Selecting a reservation and clicking Open launches the
Navigator. Clicking Reassign launches the dialog below, where you can assign the reservation to another
Group or Individual. 

2. When finished, click OK to return to the group profile page.
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Add or Modify Calculations
Calculations are additional charges that can be applied to billable items (a category, a group, a group type,
a resource, or a room) such as gratuity or sales tax. Both pricing methods and calculations determine the
final cost for a billable item; however, unlike pricing, which is applied when a billable item is reserved (and
retained, even if the price for the item later changes), calculations are figured each time a confirmation or
an invoice is generated. Assigning calculations to a Group or Individual profile means that they will be
included automatically in any invoicing for this group or individual. See Also: Configure Calculations.

1. In the left pane, select Calculations, and then click Edit. The Calculations dialog box opens. 

2. On the Available list, use the Move arrows to move the selected calculations to the Selected list or
visa versa.

3. When finished, click OK to return to the group profile page.
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Add or Modify Everyday Users 

Concept: Creating an Everyday User From a Group
An everyday user is a registered user who can submit requests for reservations or schedule reservations in
EMS Web App. When you add a new group or individual in your database, you decide the “level” of the
group that you are adding. For a group that is added at the individual (personnel/employee) level, you
might also need to create an everyday user from the group. This user can then create and view
reservations on behalf of a group or groups in EMS Web App. You can create only one everyday
user from a group. When you create an everyday user, you can also specify one or more delegates for the
everyday user. A delegate is an everyday user who can create and view reservations on behalf of another
everyday user.

1. On the toolbar, click the Groups icon. 

2. Select the group for which you are creating the everyday user, then click Tools > Create Everyday
User. A dialog box opens on the Everyday User tab.
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3. Enter the information for the Everyday User.

Tip: Ideally, you should enter all the necessary information before saving; however, if you need to access
your everyday user, on the EMS menu bar, click Configuration > Web > Everyday Users.

FIELD DESCRIPTION

Name Automatically populated after you select the group from the Groups window.

Password The password that an everyday user must enter to log in to EMS Web App.
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FIELD DESCRIPTION

Email
address

If this information has been entered in the Groups window for the group, then
this field is automatically populated after you select the group from the Groups
window. If the field is blank, you must enter the full email address for the user.
(The user must enter this address to log in to EMS Web App.)

Phone/Fax Optional fields. If this information has been entered for the group, then these
fields are automatically populated after you select the group from the Groups
window. If the fields are blank, you can enter values if needed.

Notes Optional field.

External
Reference

Optional field. Links the everyday user to a group and/or HR Toolkit.

Network
ID

Optional field. The everyday user’s network ID.

Email Opt
Out

Select this option if the everyday user is not to receive automatic emails (such
as reservation summary emails) from EMS Web App. The user will still receive
manually sent emails.

Status Required field. Select the status for the everyday user:

l Active—The everyday user can log in to EMS Web App.
l Inactive—The user cannot log in to EMS Web App and is instructed to con-

tact the EMS administrator.
l Pending—The everyday user cannot log in to EMS Web App and is

informed that he/she must check back at a later time.

Security
Template

Required field. This determines the everyday user's access to the system—the
menu items that the user can see and the information that the user can view in
a tooltip when 'rolling-over' an event in EMS Web App.

Time
Zone

Required field. Select the time zone for the user.

Tip: Ideally, you should enter all the necessary information before saving; however, if you need to access
your everyday user, on the EMS menu bar, click Configuration > Web > Everyday Users.
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4. Open the Process Templates tab and on the Available list, use the arrows to move button templates
to the Selected list. An everyday user process template defines the functions that are available to
each type of everyday user in EMS Web App when the user is submitting a request for a reservation

5. Open the Groups tab and do one of the following to specify the groups on whose behalf the every-
day user can view and make reservations in EMS Web App.

l The group (everyday user) is selected by default. You can leave this group in the Selected list, or
you can select the group and click the Remove button (<).

l Specify any combination of search criteria for the Find field and Group Type, and then click Dis-
play to produce a list of all groups that meet the criteria. In the Available list, select a group, or
CTRL-click to select multiple groups, and then click the Move button (>) to move the selected
groups to the Selected list.

Tip: If you leave the Find field blank, then a list of all currently active groups for the selected group type is
displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is
limited to the exact order of the characters in the string and it must begin with the information for which
you are searching. For example, And returns Anderson, Scott, but not Cooper, Anderson.

6. Open the Delegates tab, and on the Search by drop-down list, do one of the following to specify the
delegates for the everyday user:

l Leave the Find field blank, and then click Display to open a list of all currently available Everyday
Users. Select a user, or CTRL-click to select multiple Everyday Users, and then click the Move
button (>) to move the selected Everyday Users to the Selected list.

l On the Search By drop-down list, select the option by which to search (Email Address or User
Name), and in the Find field, enter the string by which to filter your search, and then click Dis-
play. Select an everyday user, or CTRL-click to select web multiple users, and then click the
Move button (>) to move the selected users to the Selected list.

Tip: The string is not case-sensitive, but your search is limited to the exact order of the characters in the
string and it must begin with the information for which you are searching. For example, if searching by
Email Address, a search string of bob returns bob.worth@emssoftware.com but
not dbobbett@emssoftware.com.

7. You can click Spelling to spell check any information that you manually entered for the everyday user.

8. Click OK. The dialog box for creating an everyday user closes and a message opens indicating that
the everyday user was created successfully.

9. Click OK to close the message and return to the Groups window.

Assign a Group to an Everyday User

When you add a new group in your EMS database, you should also assign the group to an everyday user.
This everyday user can then create and view reservations on behalf of the group in EMS Web App. You can
assign a group to one or more Everyday Users.
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1. On the toolbar, click the Groups icon.

2. Select the group you want to assign to Everyday Users, and then click Tools > Assign to Everyday
Users. The Assign Group dialog box opens. 
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3. To assign Everyday Users to the group, find the users. Click Display to open a list of all currently act-
ive Everyday Users or Search By Email Address or User Name.

4. Once you have found and selected the everyday user to assign, click the Move button (>) to move
the selected users to the Selected list.

5. Click Finish. A message opens indicating that the group was assigned successfully.

6. Click OK to close the message and return to the Groups window.
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CHAPTER 195: Create an Everyday User from a Group 
Concept: An everyday user is a registered user who can submit requests for reservations or sched-
ule reservations in EMS Web App.
When you add a new group or individual in your database, you decide the "level" of the group that
you are adding. For a group that is added at the individual (personnel/employee) level, you might also
need to create an everyday user from the group. This user can then create and view reservations on behalf
of a group or groups in EMS Web App. You can create only one everyday user from a group. When you
create an everyday user, you can also specify one or more delegates for the everyday user. A delegate is an
everyday user who can create and view reservations on behalf of another everyday user.

1. On the toolbar, click the Groups icon. 

2. Select the group for which you are creating the everyday user, then click Tools > Create Everyday
User. A dialog box opens on the Everyday User tab.
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3. Enter the information for the everyday user.

Tip: Ideally, you should enter all the necessary information before saving; however, if you need to access
your everyday user, on the EMS menu bar, click Configuration > Web > Everyday Users.

FIELD DESCRIPTION

Name Automatically populated after you select the group from the Groups window.

Password The password that an everyday user must enter to log in to EMS Web App.
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FIELD DESCRIPTION

Email
address

If this information has been entered in the Groups window for the group, then
this field is automatically populated after you select the group from the Groups
window. If the field is blank, you must enter the full email address for the user.
(The user must enter this address to log in to EMS Web App.)

Phone/Fax Optional fields. If this information has been entered for the group, then these
fields are automatically populated after you select the group from the Groups
window. If the fields are blank, you can enter values if needed.

Notes Optional field.

External
Reference

Optional field. Links the everyday user to a group and/or HR Toolkit.

Network
ID

Optional field. The everyday user's network ID.

Email Opt
Out

Select this option if the everyday user is not to receive automatic emails (such
as reservation summary emails) from EMS Web App. The user will still receive
manually sent emails.

Status Required field. Select the status for the everyday user:

l Active—The everyday user can log in to EMS Web App.
l Inactive—The user cannot log in to EMS Web App and is instructed to con-

tact the EMS administrator.
l Pending—The everyday user cannot log in to EMS Web App and is

informed that he/she must check back at a later time.

Security
Template

Required field. This determines the everyday user's access to the system—the
menu items that the user can see and the information that the user can view in
a tooltip when 'rolling-over' an event in EMS Web App.

Time
Zone

Required field. Select the time zone for the user.
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Tip: Ideally, you should enter all the necessary information for your everyday user before you save the
everyday user; however, at any time if you need to access your everyday user, on the EMS menu bar, click
Configuration > Web > Everyday Users.

4. Open the Process Templates tab and on the Available list, use the arrows to move button templates
to the Selected list. An everyday user process template defines the functions that are available to
each type of everyday user in EMS Web App when the user is submitting a request for a reservation

5. Open the Groups tab and do one of the following to specify the groups on whose behalf the every-
day user can view and make reservations in EMS Web App.

l The group (everyday user) is selected by default. You can leave this group in the Selected list, or
you can select the group and click the Remove button (<).

l Specify any combination of search criteria for the Find field and Group Type, and then click Dis-
play to produce a list of all groups that meet the criteria. In the Available list, select a group, or
CTRL-click to select multiple groups, and then click the Move button (>) to move the selected
groups to the Selected list.

Tip: If you leave the Find field blank, then a list of all currently active groups for the selected group type is
displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is
limited to the exact order of the characters in the string and it must begin with the information for which
you are searching. For example, And returns Anderson, Scott, but not Cooper, Anderson.

6. Open the Delegates tab, and on the Search by drop-down list, do one of the following to specify the
delegates for the everyday user:

l Leave the Find field blank, and then click Display to open a list of all currently available Everyday
Users. Select a user, or CTRL-click to select multiple Everyday Users, and then click the Move
button (>) to move the selected Everyday Users to the Selected list.

l On the Search By drop-down list, select the option by which to search (Email Address or User
Name), and in the Find field, enter the string by which to filter your search, and then click Dis-
play. Select an everyday user, or CTRL-click to select web multiple users, and then click the
Move button (>) to move the selected users to the Selected list.

Tip: The string is not case-sensitive, but your search is limited to the exact order of the characters in the
string and it must begin with the information for which you are searching. For example, if searching by
Email Address, a search string of bob returns bob.worth@emssoftware.com but
not dbobbett@emssoftware.com.

7. You can click Spelling to spell check any information that you manually entered for the everyday user.

8. Click OK. The dialog box for creating an everyday user closes and a message opens indicating that
the everyday user was created successfully.

9. Click OK to close the message and return to the Groups window.
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CHAPTER 196: Assign Everyday Users to a Group
When you add a new group in your EMS database, you should also assign an everyday user to the group.
This everyday user can then create and view reservations on behalf of the group in EMS Web App. You can
assign a group to one or more Everyday Users.

1. On the toolbar, click the Groups icon.

2. Select the group you want to assign to Everyday Users, and then click Tools > Assign to Everyday
Users. The Assign Group dialog box opens. 
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3. To assign Everyday Users to the group, find the users. Click Display to open a list of all currently act-
ive Everyday Users or Search By Email Address or User Name.

4. Once you have found and selected the everyday user to assign, click the Move button (>) to move
the selected users to the Selected list.

5. Click Finish. A message opens indicating that the group was assigned successfully.

6. Click OK to close the message and return to the Groups window.
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CHAPTER 197: Configure Contacts for a Group
A contact is a person who serves as the coordinator or focal point for a group. You have two options
for configuring a contact for a group. You can configure a "free form" contact, which requires you to
manually enter the contact information, or you can configure a contact from another group, which means
that you do not have to manually enter the contact information. Instead, the group information is
automatically used for the contact.

Note: You can also configure and edit a contact "on the fly" during the reservation process.
See Create a Reservation in the Reservation Wizard for details.

configure contacts 

1. Open the Groups window and search for the group for which you are configuring the contact. See To
search for a group and/or contact.

2. Select the group, and then click Open. A group-specific window opens. The group is automatically
selected in the window.
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3. In the left pane of the group-specific window, select Contacts. A list of all currently active contacts for
the group is displayed in the right pane of the group-specific window.

Note: Optionally, to display all group contacts regardless of status, click Show Inactive. Any
inactive contacts are displayed in red italics in the right pane.

4. Continue to one of the following:
l Configure a contact manually
l Configure a contact from a group

configure a contact manually 

1. Click New. The Contact dialog box opens.

2. Enter the information for the new contact.
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FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected. You cannot change
this value.

Address Populated with the address of the group that you selected. If the contact
address is not the same as the group address, then clear Use Group Address
and enter the appropriate values in the Address fields.

International Select this option to drop the State and Zip fields for an international group.

Phone

Fax

The phone number and fax number for the contact. By default, they are set to
the phone number and fax number for the group, but you can always edit
these values.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a user-defined value, double-
click the current field label to select it, and then enter the user-defined value
over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

External
Reference

Links the contact to an outside program, for example, HR Toolkit, if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
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FIELD DESCRIPTION

specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a selected
group at a later date. To do so, select the contact in the right pane of the
group-specific window, click Set Default, and then click Yes at the prompt to
set the selected user as the default contact.

Inactive Leave this option blank to add the contact as an active contact. Select this
option to inactivate the contact.

3. Optionally, do one or both of the following:
l Click Spelling to spell check the information for the contact before you save it.
l Make sure that the newly created contact is selected so that you can create a everyday user

from the contact.
4. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific win-

dow remains open.

configure a contact from a group

1. Click Tools > Click Create Contact from Another Group. A second Groups window opens.

2. Search for the group that is to be the source of the contact, and then click Select. The Contact dialog
box opens. The name of the group (contact source) is displayed in the Group field and you cannot
edit this value. The remainder of the fields (Contact Name, Address, Phone, and so on) display the
information for the group that you selected when you Configured Contacts.

Note: See Search for a group and/or contacts.
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3. If needed, edit the information for the contact.

FIELD DESCRIPTION

Contact The name of the contact.

Note: The name can be a maximum of 50 characters, including spaces.

Title The title (Mr., Ms., Dr., and so on) of the contact.

Group Populated with the name of the group that you selected first (the group for
which you are configuring the contact). You cannot change this value.

Address Populated with the address of the contact. If the contact address is the same
as the group address, then select Use Group Address to populated the
address fields with the group address; otherwise, you can edit these values.
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FIELD DESCRIPTION

International Not applicable if Use Group Address is selected. Select this option to drop
the State and Zip fields from the address for an international contact.

Phone

Fax

The phone number and fax number for the group.

Note: The Phone and Fax fields have a drop-down list available on which you
can select a different value (Fax, Mobile, Other, or Phone) for the field label,
or you can enter a user-defined value. To enter a user-defined value, double-
click the current field label to select it, and then enter the user-defined value
over the selected label.

Email
Address

The email address for the contact.

Note: If your computer is connected to a network, click the Search icon to
open a Global Address Lookup dialog box and search for the email address.

External
Reference

Links the contact to an outside program, for example, HR Toolkit, if needed.

Notes Any other information that is pertinent for the contact.

Set as
Default

Select this option if the contact is to be the default contact for the selected
group.

Note: If a default contact has been defined for a group, then when you
specify the group information for a reservation, the Contact field is
automatically populated with the name of the default contact.

Note: You can always specify a contact as the default contact for a selected
group at a later date.

Inactive Leave this option blank to add the contact as an active contact. Select this
option to inactivate the contact.

4. Optionally, do one or both of the following:
l Click Spelling to spell check the information for the contact before you save it.
l Make sure that the newly created contact is selected so that you can create a everyday user

from the contact. See To create a everyday user from a contact.
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5. Click OK. The Contact dialog box closes. The contact is added to the group. The group-specific win-
dow remains open.

create an everyday user from a contact
An everyday user is a registered user who can submit requests for reservations or schedule reservations in
EMS Web App. When you add a contact to a group in your EMS database, you might also need to create a
user from the contact. This user can then create and view reservations on behalf of the contact's group in
EMS Web App. You can create only one user from a contact. When you create a user, you can also specify
one or more delegates for the user. A delegate is a user who can create and view reservations on behalf of
another user.

1. If needed, open the group that contains the contact from which you are creating the everyday user in
the group-specific window. See Configure Contacts.

2. In the left pane of the group-specific window, make sure that Contacts is selected.

3. In the right pane of the window, select the contact from which you are creating the everyday user.

4. Click Tools > Create Everyday User from Contact. A contact-specific dialog box opens. The everyday
user tab is the active tab.

Note: The User Defined Fields tab displays the questions that a everyday user was required
to answer when the user requested to create an account through EMS Web App and it is not
relevant to the procedure that is described below.
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5. Enter the information for the everyday user.

FIELD DESCRIPTION

Name Automatically populated after you select the contact. You can edit this
information.

Password The password that a everyday user must enter to log in to EMS Web App.

Email
address

If this information has been entered for the contact, then this field is
automatically populated after you select the contact. If the field is blank, you
must enter the full email address for the user. (The user must enter this address
to log in to EMS Web App.)

Phone/Fax Optional fields. If this information has been entered for the contact, then these
fields are automatically populated after you select the contact. If the fields are
blank, you can enter values if needed.

Notes Optional field.

External
Reference

Optional field. Links the everyday user to an outside program if needed.

Network
ID

Optional field. The everyday user's network ID.

Email Opt
Out

Select this option if the everyday user is not to receive automatic emails (such
as reservation summary emails) from EMS Web App. The user will still receive
manually sent emails.

Status Required field. Select the status for the everyday user:

l Active—The everyday user can log in to EMS Web App.
l Inactive—The user cannot log in to EMS Web App and is instructed to con-

tact the EMS administrator.
l Pending—The everyday user cannot log in to EMS Web App and is

informed that he/she must check back at a later time.

Security
Template

Required field. This determines the everyday user's access to the system's the
menu items that the user can see and the information that the user can view in
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FIELD DESCRIPTION

a tooltip when 'rolling-over' an event in EMS Web App.

Time
Zone

Required field. Select the time zone for the user.

6. Open the Process Templates tab and on the Available list, select the everyday user process template
or CTRL-click to select the multiple templates to which this user is to be assigned, and then click the
Move button (>) to move the selected templates to the Selected list.

TIP: An everyday user process template defines the functions that are available to each type of everyday
user in EMS Web App when the user is submitting a request for a reservation.

7. Open the Groups tab and do one of the following to specify the groups on whose behalf the every-
day user can view and make reservations in EMS Web App.

l The contact's group is selected by default. You can leave this group in the Selected list, or you
can select the group and click the Remove button (<).

l Specify any combination of search criteria for the Find field and Group Type, and then click Dis-
play to produce a list of all groups that meets the criteria. In the Available list, select a group, or
CTRL-click to select multiple groups, and then click the Move button (>) to move the selected
groups to the Selected list.

Note: If you leave the Find field blank, then a list of all currently active groups for the selec-
ted group type is displayed. If you enter a search string in the Find field, the string is not
case-sensitive, but your search is limited to the exact order of the characters in the string and
the string must begin with the information for which you are searching. For
example, AAA returns AAA Colorado, but not Colorado AAA.

8. Open the Delegates tab, and on the Search by drop-down list, do one of the following to specify the
delegates for the everyday user:

l Leave the Find field blank, and then click Display to open a list of all currently available everyday
users. Select a everyday user, or CTRL-click to select multiple everyday users, and then click the
Move button (>) to move the selected everyday users to the Selected list.

l On the Search By drop-down list, select the option by which to search (Email Address or User
Name), and in the Find field, enter the string by which to filter your search, and then click Dis-
play. Select a everyday user, or CTRL-click to select multiple everyday users, and then click the
Move button (>) to move the selected everyday users to the Selected list.
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Note: The string is not case-sensitive, but your search is limited to the exact order of the
characters in the string and the string must begin with the information for which you are
searching. For example, if searching by Email Address, a search string
of bob returns bob.worth@emssoftware.com but not dbobbett@emssoftware.com.

9. Optionally, click Spelling to spell check any information that you manually entered for the user.

10. Click OK. The dialog box for creating a everyday user closes and a message opens indicating that the
everyday user was created successfully.

11. Click OK to close the message and return to the group-specific window.
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CHAPTER 198: Import Groups
You can import groups into your EMS database from a tab-delimited text file. (See Import File
Specification in the EMS Desktop Client Configuration Guide for the file specifications.)

1. On the EMS toolbar, click the Groups icon. The Groups window opens.

2. Click Import. The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that you are importing. A dialog box opens,
indicating the number of groups that you are about to import, and asking you if you want to con-
tinue.

4. Click Yes. A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.
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CHAPTER 199: Print and Export Everyday User Information
You can print a variety of information for selected everyday users and you can also export a list of selected
everyday users (name and email address) to an Excel spreadsheet.

Print or export everyday user information 

1. On the EMS menu bar, click Configuration > Everyday User Applications > Everyday Users. The Every-
day Users dialog box opens. In the upper left corner, the number of everyday users currently in use
for EMS Web App is displayed. In the example below, "Group" has been relabeled "Employee."

Everyday Users Dialog Box

2. Enter any combination of the following search criteria:
l On the Group Type drop-down list, leave the group type set to the default value of (all), or

select a specific group type.
l On the Search by drop-down list, select User Name or Email Address.
l On the Status drop-down list, select the user status by which to search.
l On the Process Template drop-down list, leave the default value of (all), or select a specific web

process template.
3. To further filter the displayed search results do one or both of the following:

l To filter the search results based on either the User Name or Email Address, in the Filter field,
enter a search string.

l To filter the search results based on city, in the City field, enter a search string.
4. Click Display. The everyday users who meet your search criteria are displayed in the lower pane of the

everyday users window.
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5. Continue to one of the following:
l Print everyday user information
l Export a list of everyday users to an Excel spreadsheet

Print everyday user information 

1. On the everyday users window, click Print. A list with a variety of options for printing information for
the everyday users that are currently displayed in the everyday users window opens.

2. Select the information that you want to print for the displayed everyday users.

OPTION DESCRIPTION

List Opens an onscreen preview of a list of all the everyday users (user name,
email address, status, security template, process template, and last login)
who are currently displayed in the everyday users window. The list is sorted
alphabetically by everyday user name.

Delegates Opens an onscreen preview of a list of all the delegates (delegate name,
delegate email address, delegate status, everyday user, everyday user
email address, and everyday user status) for all the active everyday users
who are currently configured in your EMS database. The list is sorted
alphabetically by web delegate name and then by everyday user name for
everyday users that have multiple delegates.

Delegates by
everyday user

Opens an onscreen preview of a list of all the delegates (user name,
everyday user email address, everyday user status, delegate name,
delegate email address, and delegate status) for all the active everyday
users who are currently configured in your EMS database. The list is sorted
alphabetically by everyday user name and if a everyday user has multiple
delegates, the delegate is then sorted alphabetically by delegate name.

Note: A variety of options is available from an onscreen preview, including the options to
print a hard copy of the information, to export the information to a .pdf, and to email the
printed information. 
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Export a list of everyday users to an Excel spreadsheet 
On the everyday users window, click Export. A Save As dialog box opens for naming the file and selecting
the location in which to save the file. (The file contains the name and address for each everyday user that is
currently displayed in the everyday users window.) By default, the file is named everyday user List.xls, and
the file location is your Document Library, but you can change the name if needed, and you can also select
a different location in which to save the file. After you name and save the file, you have the option of
previewing the exported file.

Note: To preview the file, Microsoft Excel must be installed on your EMS client.
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CHAPTER 200: Print and Export Group Information
You can print a variety of information for selected groups such as contact summary information, status
exceptions, group import format information, and billing information, and you can also export a list of
selected groups and the summary information for each group (type, name, address, and so on) to an Excel
spreadsheet.

Print group information

1. Search for the groups for which you are printing the information. See Search for a group and/or
contact.

2. On the Groups window, click Print. A list with a variety of options for printing information for the
groups that are currently displayed in the Groups window opens.

3. Select the information that you want to print for the displayed groups.

OPTION DESCRIPTION

List Opens an onscreen preview of all groups (group name,
address, phone number, email address, pricing plan, and
status) that are currently displayed in the Groups window. The
groups are sorted by group type.

Contact Summary Opens an onscreen preview of all the contacts (group name,
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OPTION DESCRIPTION

group phone number, contact name, and contact phone
number) that have been configured for all the groups that are
currently displayed in the Groups window.

Status Exceptions Opens an onscreen preview of a list of groups that is derived
from all the groups that are currently displayed in the Groups
window that have any status other than OK. The groups are
sorted by group type.

Import Format Opens an onscreen preview of the required format for the tab-
delimited file that is to be used when importing groups.

Note: A variety of options are available from an onscreen preview, including the options to
print a hard copy of the information, to export the information to a .pdf, and to email the
printed information. 

Transaction Report See Generate an EMS Billing Report.

Statements See Generate an EMS Billing Report.

Voided Transaction Report See Generate an EMS Billing Report.

Ageing Report See Generate an EMS Billing Report.

General Ledger
Distribution

See Generate an EMS Billing Report.
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 Example of an onscreen preview of printed group information

Export a list of groups to an Excel spreadsheet

1. Search for the groups that are you exporting to an Excel spreadsheet. See Search for a group
and/or contact.

2. On the Groups window, click Export. A Save As dialog box opens for naming the file and selecting the
location in which to save the file. (The file details the summary information—type, name, address, and
so on—for each group.) By default, the file is named Groups.xls, and the file location is your Docu-
ment Library, but you can change the name if needed, and you can also select a different location in
which to save the file. After you name and save the file, you have the option of previewing the expor-
ted file.

Note: To preview the file, Microsoft Excel must be installed on your EMS client.
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CHAPTER 201: Work with Reservations for a Group
You have a variety of options for working with the reservations for a group. You can:

l Search for and make a reservation for a group from the Groups window.
l Search for and make a reservation for a group from the group-specific window.
l Search for reservations by group, and then open and view any existing reservations in the Navigator

for a group from the group-specific window.
l Reassign the reservations for a group or contact from the group-specific window.

In EMS Workplace, you can also make a group reservation from the Group Reservation window.

Work with reservations for a group 

1. Open the Groups window and search for the appropriate group.

2. On the Groups window, select the group, and then do one of the following:
l Click New Reservation at the top of the window to open the Reservation Wizard, and then con-

tinue to Create a Reservation in the Reservation Wizard.
l Click Open to open the group-specific window (the group is automatically selected in the win-

dow), and then continue to one of the following:
o Search for and view reservations by group from the group-specific window
o Search for and make a reservation for a group from the group-specific window
o Reassign a reservation for a group from the group-specific window

Search for and view reservations by group from the 
group-specific window 

1. In the left pane of the group-specific window, select Reservations. All reservations that have been
made for the group in your EMS database and that have a date greater than or equal to the current
day’s date are displayed in the right pane of the group-specific window.
TIP: Optionally, to show all reservations that have been made for the group, click Show Old.

2. In the right pane of the group-specific window, select the appropriate reservation, and then click
Open. The reservation opens in the Navigator.

3. Continue to the Navigator.
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Search for and make a reservation for a group from the group-specific
window

1. In the left pane of the group-specific window, select Reservations. All reservations that have been
made for the group in your EMS database and that have a date greater than or equal to the current
day’s date are displayed in the right pane of the group-specific window.
Tip: Optionally, to show all reservations that have been made for the group, click Show Old.

2. Click New. The Reservation Wizard opens.

3. Continue to Create a Reservation in the Reservation Wizard.

Reassign a reservation for a group from the group-specific window

1. In the left pane of the group-specific window, select Reservations. All reservations that have been
made for the group in your EMS database and that have a date greater than or equal to the current
day’s date are displayed in the right pane of the group-specific window.
TIP: Optionally, to show all reservations that have been made for the group, click Show Old.

2. In the right-pane of the group-specific window, select the appropriate reservation, or CTRL-click to
select multiple reservations, and then click Reassign. The Reassign Group/Contact on Reservations
dialog box opens. 

3. On the Group drop-down list, select the group to which you are reassigning the reservation, or click
the Search icon to open the Groups window and search for the group.

4. Optionally, edit any and/or all of the group information as needed.

OPTION DESCRIPTION

1st
Contact

2nd

The contact for the group to which you are reassigning the reservation.

Note: If none of the pre-configured contacts is appropriate, then select
(temporary contact) and in the Temp Contact field, enter the name of the
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OPTION DESCRIPTION

Contact temporary contact.

Phone

Fax

Email
Address

The phone, fax, and email address for the contacts for the group to which the
reservation is being reassigned. If you selected from the list of the pre-configured
contacts, then some or all of this information might be automatically populated,
but you can still edit the values. If you selected a (temporary contact), then you
must enter this information for the contact.

Web
User

The web user for the group. Initially, this field is set to (no change) which means
that the web user for the group to which you are reassigning the reservation is to
remain as is; however, if needed, you can click the Search icon to open the Web
Users dialog box and select a different web user.

l You can search by User Name or Email Address.
l To search a list of all available web users, leave the Search field in the Web

Users dialog box blank, and then click Display.
l To search for a specific web user, enter a search string in the Search field,

and then click Display.

Note: The string is not case-sensitive, but your search is limited to the exact order
of characters in the string and the string must begin with the information for
which you are searching. For example, if searching by Email Address, a search
string of bob returns bobworth@emssoftware.com but
not dbobbett@emssoftware.com.

Note: To return this field to the (no change) value at any time, click Reset.

5. Click OK. A Reassign Reservations message opens, asking you if it is OK to reassign the selected reser-
vations to the group.

6. Click Yes. The Reassign Reservations message closes and a second Reassign Reservations message
opens, indicating the reservations were successfully reassigned.

7. Click OK. The message closes, and the reassigned reservations are no longer displayed in the group-
specific window.

Note: You might have to click Reservations in the left-pane of the group-specific window to
refresh the display.
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Make a group reservation from the Group Reservation window (EMS
Workplace only) 

1. On the EMS Workplace toolbar, click the Group Reservation icon. 

The Group Reservation window opens. The Results tab is the active tab.

2. Open the Filter tab, and search for the group for which you are making a reservation. See Search for
a group and/or contact.

3. Select the group for which you are making the reservation, and then click Reservation. A drop-down
list of the available Reservation Wizard templates opens.

4. Select the appropriate template. The Reservation Wizard opens. The name of the group for which you
are making the reservation is displayed in the title bar of the Reservation Wizard. The Reservation Wiz-
ard template that you selected is displayed on the Wizard Template drop-down list at the top of the
Reservation Wizard. (You can always select a different template if needed.)

Note: Depending on how your EMS administrator has configured the template that you
selected, you might be prompted to select a reservation start date before the Reservation
Wizard opens.
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5. Continue making the reservation as you normally would. See Create a Reservation in the Reser-
vation Wizard.
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CHAPTER 202: Email a Group
Whether your organization uses Microsoft Outlook or SMTP, you can always email an EMS group.

Note:  If your organization uses Microsoft Outlook, you can continue to use this email sys-
tem to send emails to EMS groups; otherwise, to email an EMS group using the SMTP option,
your user account must have an email address.

1. Search for the group that you are emailing.

2. Do one of the following:
l On the Groups window, select the group and then click Email. Depending on how your system

is configured, either a pre-addressed Outlook email form or a pre-addressed SMTP email form
opens. The To field is populated with the email address that is defined for the group, but you
can edit this value if needed.

l On the Groups window, select the group, and then click Open.
3. The group-specific window opens.

4. On the group-specific window, make sure that the group is selected in the left pane, and then click
Email. Depending on how your system is configured, either a pre-addressed Outlook email form or a
pre-addressed SMTP email form opens. The To field is populated with the email address that is
defined for the group, but you can edit this value if needed.

5. Complete and send the email as you normally would.
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CHAPTER 203: The Dashboard
The Dashboard is a window that centralizes critical information about reservations in a single location. The
information that is displayed on this window, including notifications, reminders, web reservations, and so
on, provides you with the necessary input to manage your work in EMS. 
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CHAPTER 204: Overview of the Dashboard
The Dashboard is often used by administrative users to supervise, review, process, and approve many
types of activities in the system. When the window first opens, it has the following tabs:

l Notifications Tab
l Reminders Tab
l Everyday User Reservations Tab
l Guest Requests Tab
l Wait List Tab
l Reconfirm Dates Tab
l Building Hours Exceptions Tab
l Analytics Tab
l At A Glance Tab

You can sort columns on a tab in ascending or descending order, and you can rearrange columns by
dragging the column heading, and you can change their widths.

Note: Click the Dashboard icon at any time to open the Dashboard window. See
Also: Managing Requests for Managed Space.
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Dashboard Window
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Customizing Your Dashboard Options  
You can customize the appearance and behavior of your Dashboard under Options in the upper-right
corner.

Dashboard Options Dialog
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Dashboard Options Dialog Fields

OPTION DESCRIPTION

Open Dashboard At
Startup If Items Exist

Selected by default. The Dashboard window opens automatically
after you log into EMS if any tab displays at least one item.

l Show Remind-
ers

l Show Everyday
User Reser-
vations

l Show Guest
Requests

l Show Analytics
l Show Wait List
l Show Recon-

firm Dates
l Show Building

Hours Excep-
tions

l Show At A
Glance

Selected by default. Indicates the tabs that are to be displayed on
the Dashboard window.

“Thru Today”
includes xx Days
Prior to Today

Indicates how far into the past that reminders are to be displayed in
the “Thru Today” view. The default value is seven.

Activate Flashing
Indicator For:

l Notifications
l Reminders
l Everyday User

Reservations
l Guest Requests

Set on a per tab basis. Indicates when the Dashboard icon on the
EMS toolbar is to flash if at least one item is displayed on any tab.
Values are:

l Automatically—Immediately when there is at least one record
that is displayed on the indicated tab, even when you are work-
ing in EMS.

l At Startup Only
l Never
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OPTION DESCRIPTION

Activate Flashing
Indicator For:

l Wait List
l Reconfirm

Date Remind-
ers

l Building Hours
Exceptions

Set on a per tab basis. Indicates when the Dashboard icon on the
EMS toolbar is to flash if tasks on the tab require your attention.
Values are:

l At Startup Only
l Never
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CHAPTER 205: Notifications Tab
Concept: Changing Events Can Automatically Notify Users 
Your Administrator can automate alerts to be sent to you (or groups of which you are a member) when
changes or additions have been made in EMS for bookings and reservations, service orders, room
types, setup types, user accounts, and so on. When you create a reservation or booking that has
these notifications turned on, users will receive these alerts without requiring additional effort from you. Be
sure to review these notification settings during the process of creating or modifying events. 

If your EMS Web App implementation uses the Integration to Microsoft Exchange, you can handle
notifications using Outlook.

Concept: Integration to Microsoft® Exchange Enables You to Use Outlook®

If your organization deploys our Integration to Microsoft® Exchange, you can view the availability of
meeting rooms and attendees, and send Microsoft® Outlook meeting invitations, all from within EMS Web
App.

You must be licensed for EMS Desktop Client, EMS Web App, and Integration to Microsoft® Exchange in
order to configure and use this capability. If you are unsure if your organization is licensed for Integration
to Microsoft® Exchange, or if you would like to learn more about it, please contact your EMS Account
Executive.

Notifications Tab Overview 
When the Notifications tab first opens, all the notification rules that include you are listed in the
Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new notifications
(notifications with the current day's date) is displayed.
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The Notifications tab is interactive. For Notification Rules, you can:

l Select a rule, and under Show, select Unreviewed to view all unreviewed notifications for future book-
ings.

l Select a rule, and under Show, select Reviewed to view all reviewed notifications for future bookings.
l Select a rule, and under Show, select Old to view all notifications for past bookings.

For Notifications, you can:

l Select a notification to view detailed information about the notification (such as new bookings, the
changes made to a booking, and the users who were notified of the changes) in a pane at the bottom
of the window.

l Select Show New Only to show only new notifications (notifications with the current day's date) for
the notification rules.

l Select a notification, and then click Reviewed to mark a notification as "Reviewed."
l Select a notification and then click Go To to open the item to which the notification refers.
l If the notification is attached to a reservation, booking, or booking detail, then the reservation opens

in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is auto-
matically selected.

l If the notification is attached to a group, then the Group window opens with the group information
displayed in the window.

l Click Refresh to check for notifications that have been issued since you opened the Dashboard.
l Select a notification, or CTRL-click to select multiple notifications, and then click Delete to delete the

notifications from the Notifications tab.
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CHAPTER 206: Confirmations vs. Notifications, What's the Dif-
ference?

Confirmations 

l These are either sent out automatically after a booking is made in EMS Web App, or manually from
the EMS desktop client.

l They contain the date/time/resources for the booking that was created.
l These usually go to end users so they know when their event is and if they owe any money.

Notifications 

l These are sent out automatically based on the filters on the notification rule:
l There are five types of notification rules:

l These are mostly sent out X days before a booking.  They are triggered when a change occurs on a
booking, service order, and so forth within that range of days.
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CHAPTER 207: Reminders Tab
A comment is a text entry that explains or clarifies a reservation, booking, group, or service order.
A reminder is a comment that has a due date associated with it. The Reminders tab displays all the
reminders for which you are the responsible user and that, by default, have a due date through the current
day’s date.

To work with reminders, you can:

l Change the Reminders View
l Create Unattached Reminders
l Change a Reminder
l Delete a Reminder
l Print a Reminder
l View an Item to Which a Reminder is Attached
l Mark a Reminder Complete
l Reassign Multiple Reminders Between EMS Users

Changing the Reminders View
By default, when the Dashboard window first opens, the Reminders tab displays all the reminders for which
you are the responsible user and that have a due date through the current day’s date. You can do one or
more of the following to change this view:
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l To view the reminders for which other users are responsible, simply select the user or users in the
Responsible User pane.

l To view only a specific group of reminders for which you or others are the responsible users, change
the viewing criteria.

OPTION DESCRIPTION

View View reminders that have the indicated due date. The default value is Thru
Today. If a value from the pre-configured list does not meet your needs, then
select (user specified) and in the Date Due fields, enter at least a Starting due
date. The Ending due date is optional.

Reminder
Type

The default value is (all).

Attached
To

The default value is (all). To view reminders that are not attached to any item
(reservation, booking, group, or service order), select (none). See To create an
unattached reminder.

Search in
Text

Enter the string by which to search for specific reminders. (The search is carried
out on the Notes field for the reminder.) Your search is limited to the exact
order of the characters in the string, but the search string is not-case sensitive
and it can appear anywhere in the search results. For example, a search string
of cat returns reminders that have “catering” or “Mary’s catering” in the Notes
field.

Date
Completed

Available only if Exclude Complete is not checked.

Exclude
Completed

Selected by default. Clear this option to display completed reminders in the
Reminders list. To display completed reminders that meet the other viewing
criteria, regardless of their completion dates, leave the Date Completed fields
blank; otherwise, to view completed reminders that were completed by a
specific date, you can enter a Starting date or a date range in the Date
Completed fields.

Hide
Canceled

Not selected by default. Select this option to display canceled reminders in the
Reminders list.
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Creating Unattached Reminders
When you create reminder on the Navigator, the reminder is attached to a specific reservation, booking, or
booking detail. Similarly, when you create a reminder on the Groups window, the reminder is attached to a
specific group. If needed, however, you can create a reminder that addresses just your general business
needs and is not attached to any specific item. For example, you can create a reminder about “preparing for
your organization’s yearly safety inspection.” Any reminder that you create from the Reminders tab on the
Dashboard window is an unattached reminder.

1. Click New. The Reminder dialog box opens.

2. Do one of the following:

l Select a Reminder Type.
l If none of the pre-configured Reminder Types meets your working needs, then select (user-spe-

cified), and in the Description field, enter a description for the reminder type.

The Responsible User field is populated with your User ID and the Date Due field is populated with the
current day’s date.

3. Optionally, change the Responsible User, Date Due, or both.

4. If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank.
(This field is populated automatically when you or another user completes the reminder.)

5. Optionally, in the Notes field, enter any further explanation or information about the
reminder. Click Spelling to spell-check the reminder before you save it.

6. Click OK. The Reminder dialog box closes. The newly created reminder is not attached to an item. It
might or might not be displayed in the Reminders list depending on the values that you have set for
filtering the display.
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Changing a Reminder

1. On the Reminders list, select the reminder that you are editing, and then click Edit. The Reminder dia-
log box opens. The dialog box is populated with the current information for the reminder.

2. Edit the reminder as needed. Optionally, click Spelling to spell-check the reminder before you save
the edited reminder.

3. Click OK. The Reminder dialog box closes. If the reminder is attached to an item such as a reservation,
then the reminder remains attached; otherwise, it is saved as an unattached reminder.

Deleting a Reminder
You can delete any reminder (attached or unattached) regardless of its due date and regardless if it is
completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete. A message
opens asking you if it is OK to delete the reminder.

2. Click Yes. The message closes and the reminder is deleted.

Printing a Reminder

1. On the Reminders list, select the reminder that you are printing, and then click Print. An onscreen pre-
view of the reminder opens. The preview window contains options for printing a hard copy of the
reminder, for emailing the reminder, and so on.

Onscreen preview for a printed reminder

2. Select the option or options that best fit your working needs.

Viewing an Item to Which a Reminder Is Attached
On the Reminders list, select a reminder, and then click Go To.The Attached To column for the reminder
must state anything other than “Unattached.”
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l If the reminder is attached to a reservation, booking, or booking detail, then the reservation opens in
the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically
selected.

l If the reminder is attached to a group, then the Group window opens, with the group information dis-
played in the window

Marking a Reminder Complete

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are
completing.

2. Click Completed. A message opens asking you if it is OK to set the selected reminders as completed.

3. Click Yes. The message closes. The reminders are completed with a date equal to the current day’s
date. The reminders might or might not be displayed in the Reminders list depending on the values
that you have set for filtering the display.

Reassigning Multiple Reminders Between EMS Users

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are
reassigning.

2. Click Reassign. The Select User dialog box opens. This dialog box lists all the users for your EMS
implementation. 

3. Select the user to whom you are reassigning the reminder.

Tip: To search for a user, enter a search string in the Search field. The search string is limited to the exact
order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere
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in the search results. For example, a search string of Admin returns both Admin users and SysAdmin. The
list of users that meet your search string is dynamically updated as you enter the string.

4. Click OK. A message opens, asking you if you are sure that you want to reassign the selected remind-
ers to the user.

5. Click Yes. The Select User dialog box and message close and the reminder is reassigned.
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CHAPTER 208: Everyday User Reservations Tab
The Everyday User Reservations tab displays any reservation that was submitted through EMS Web App
made in Self Serve mode.

You can select options to filter the reservations list. Status and Building/Area/View filters show on the left
pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can
select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single
step. Date filters show on the View list at the top of the right pane of the tab. You can view reservations for
the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not
meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date.
The Ending due date is optional. After you select or edit the filtering options, click Refresh.

Select the reservation in the Reservations list, and then click Go To to open the reservation in the
Navigator.
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CHAPTER 209: Guest Requests Tab
The Guest Requests tab displays requests for space that require supervisory approval. Such requests are
submitted through EMS Web App using process templates designated for "Unauthenticated Users." An
unprocessed request is in Pending status.

Once your system administrator has configured facilities (rooms, categories, services, resources, and so
on), he or she can configure special process templates for "managed space," which is meeting space
that might require additional oversight and an approval process to finalize a reservation. For example, your
organization might need specialized space like the President's Conference room, or a large banquet hall, to
be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically,
managed space involves services, expenses, and invoicing that affect multiple stakeholders and
departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web
App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook
does not show the request status of such a reservation. 

The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter
the list by Status or Building (on the left panel), click Refresh.
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CHAPTER 210: Manage Requests for Managed Space
This topic guides you in approving "pending requests," which are requests for space that require
supervisory approval and appear in your Dashboard. 

Once your system administrator has configured facilities (rooms, categories, services, resources, and so
on), he or she can configure special process templates for "managed space," which is meeting space that
might require additional oversight and an approval process to finalize a reservation. For example, your
organization might need specialized space like the President's Conference room, or a large banquet hall, to
be treated as managed space to ensure that any request to use it is approved by a supervisor. Typically,
managed space involves services, expenses, and invoicing that affect multiple stakeholders and
departments, and templates designed for this model are typically assigned to Everyday Users of EMS Web
App. By contrast, such templates are not available for EMS for Outlook users since Microsoft® Outlook
does not show the request status of such a reservation. 

See Also: How Does EMS Classify Different Types of Users?

1. Click the Dashboard icon in the EMS Desktop Client toolbar.

2. Click the Guest Requests tab, which displays requests for space that require supervisory approval.
Such requests are submitted through EMS Web App using process templates designated for "Unau-
thenticated Users." An unprocessed request is in Pending status.
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The tab enables you to filter the list by status, building, room, and to work with the requests. If you filter
the list, click Refresh.

Approving or Working with a Pending Request 

1. Select the request you want to work with, and click Edit to launch the launch the Guest Request dia-
log box, which shows all the information submitted for the request through EMS Web App. The dia-
log box always has a Description tab, a Web Questions tab, and an Audit tab. If the request included
resources or setup notes, it also has a Services tab.
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2. To ask the requester for further clarification before approving the request, edit the request without
processing it:

l You can ask questions and add comments about the request (for example, "Will alcohol be
served at the event?") in the Notes field on the Description tab. When the user checks the
request in EMS Web App, these notes will display. 

l To indicate to the guest user that you are reviewing the request, you can set the Request
Status to In Progress. 

l To see the guest's answers to any predefined questions in EMS Web App, open the Web Ques-
tions tab. 

l To see service requests, click the Services tab. Double-click a category to see details on the
right.

3. When you have finished interacting with the request, click OK to save your changes and notify the
requester.

4. To process the request and create a reservation, change the Request Status field to a new status 
(such as Approved) and click Process on the Description tab. The reservation opens in the Reser-
vation Wizard and you must finish making the reservation in the Reservation Wizard window
that appears.

l If the reservation includes services, the Process Guest Request Details window opens next.
To process the services immediately, use the options on this window, or to process the services
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later, click Cancel. (You can later open the reservation on the Dashboard > Guest Requests tab,
and on the Services tab, click Process).

Deleting a Request 

1. Select the guest request, or CTRL-click to select the multiple requests, and then click Delete.

2. Click Yes. The message closes. The selected guest requests are deleted.

Printing a Request 

1. Select the guest request, or CTRL-click to select the multiple requests, and then
click Print. An preview of the selected requests opens, with options to print a hard copy, export the
requests to a .pdf, and email the requests.

2. Select the option or options that best fit your working needs.
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CHAPTER 211: Wait List Tab
The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides an indicator
when the requested room becomes available.

The tab is interactive. You can:

l Select options to filter the reservations that are displayed on the tab. After you select or edit the fil-
tering options, click Refresh.

l Status and Building/Area/View options are displayed on the left pane of the tab. You can select one
or more statuses, or you can select all statuses in a single step. You can select a specific building, area,
and/or view, or you can select all buildings, areas, and views in a single step.

l Date options are displayed on the View list at the top of the right pane of the tab. You can view reser-
vations for the indicated due date. The default value is Thru Today. If a value from the pre-configured
list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a
Starting due date. The Ending due date is optional.

l Select the reservation in the Reservations list, and then click Go To to open the reservation in the Nav-
igator.
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CHAPTER 212: Reconfirm Dates Tab
The Reconfirm Dates tab displays reservations that have been booked in a status that requires the
Reconfirm Date option (for example, a Tentative or Hold status). The list of reservations is automatically
sorted in ascending order by Reconfirm Date. You use this tab as a reminder to reconfirm such
reservations.

The tab is interactive. You can:

l Select options to filter the reservations that are displayed on the tab. After you select or edit the fil-
tering options, click Refresh.

l Status and Building/Area/View options are displayed on the left pane of the tab. You can select one
or more statuses, or you can select all statuses in a single step. You can select a specific building, area,
and/or view, or you can select all buildings, areas, and views in a single step.

l Date options are displayed on the View list at the top of the right pane of the tab. You can view reser-
vations for the indicated due date. The default value is Thru Today. If a value from the pre-configured
list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a
Starting due date. The Ending due date is optional.

l Select the reservation in the Reservations list, and then click Go To to open the reservation in the Nav-
igator.
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CHAPTER 213: Building Hours Exceptions Tab
The Building Hours Exceptions tab displays reservations that occur outside of configured building hours.

The tab is interactive. You can:

l Select options to filter the reservations that are displayed on the tab. After you select or edit the fil-
tering options, click Refresh.

l Status and Building/Area/View options are displayed on the left pane of the tab. You can select one
or more statuses, or you can select all statuses in a single step. You can select a specific building, area,
and/or view, or you can select all buildings, areas, and views in a single step.

l Date options are displayed on the View list at the top of the right pane of the tab. You can view reser-
vations for the indicated due date. The default value is Thru Today. If a value from the pre-configured
list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a
Starting due date. The Ending due date is optional.

l Select the reservation in the Reservations list, and then click Go To to open the reservation in the Nav-
igator.
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CHAPTER 213: Analytics Tab
The Analytics tab provides quick access for queries that have been defined using the Query builder and to
which you have access as a user. You can run these queries from the Analytics tab.

To run a query from the Analytics tab 

1. In the upper left corner of the Analytics tab, click Select Queries. The Queries dialog box opens. This
dialog box lists the queries that have been defined using the Query builder and to which you have
access.

2. Select the queries that you want to run, and then click OK. The Queries dialog box closes. The selec-
ted queries are displayed in the Queries pane (upper left) on the Analytics tab.

3. In the Queries pane, select the query that you want to run, and then select the date for which the
data in your EMS database is to be queried.

OPTION DESCRIPTION

Custom The starting date is set to the first day of the month and
the ending date is set to the last day of the month but
you can edit one or both of these dates.

Note: For some queries, if you select Custom, a Use
Specific Times option becomes available. If you enter
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OPTION DESCRIPTION

the same date for the starting date and ending date, you
can select Use Specific Times, and then enter a starting
time and ending time to query the data for in specific
time range on the same day.

Last Month The starting date is set to the first day of the previous
month and the ending date is set to the last day of the
previous month.

Last Quarter

This Quarter

This Quarter To
Date

Quarters are based on a calendar year:

l First quarter is 1/1 through 3/31.
l Second quarter is 4/1 through 6/30.
l Third quarter is 7/1 through 9/30.
l Fourth quarter is 10/1 through 12/31.

For example, if the current day's date is 11/22/2010, and
you select Last Quarter, then the starting date is set to
7/1/2010 and the ending date is set to 9/30/2010.

Last Year The starting date is set to 1/1 of the previous year, and
the ending date is set to 12/31 of the previous year.

This month The starting date is set to the first day of the current
month and the ending date is set to the last day of the
current month.

This Year The starting date is set to 1/1 of the current year, and the
ending date is set to 12/31 of the current year.

This Year to
Date

The starting date is set to 1/1 of the current year, and the
ending date is set to the current day's date.

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data. If the query returns data, then the results are displayed in the Results pane on the
Analytics tab.

6. Optionally, do one or more of the following:
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l To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the
appropriate file type. A dialog box opens in which you can specify the file name (the default file name
is the name of the query, but you can always edit this), and the location to which to save the file.

Tip: The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML
file is .xml and you cannot change this.

l To generate an onscreen preview of the printed query results, click Print. The preview window con-
tains options for printing a hard copy of the query results, for emailing the results, and so on. Select
the option or options that best fit your working needs.

Onscreen preview of a query results

l If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an
onscreen preview of the charted data. The preview window contains options for printing a hard copy
of the chart, for emailing the chart, and so on. Select the option or options that best fit your working
needs.

Onscreen preview of query results that are charted/graphed
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CHAPTER 214: Analytics Tab
The Analytics tab provides quick access for queries that have been defined using the Query builder and to
which you have access as a user. You can run these queries from the Analytics tab.

To run a query from the Analytics tab

1. In the upper left corner of the Analytics tab, click Select Queries. The Queries dialog box opens. This
dialog box lists the queries that have been defined using the Query builder and to which you have
access.

2. Select the queries that you want to run, and then click OK. The Queries dialog box closes. The selec-
ted queries are displayed in the Queries pane (upper left) on the Analytics tab.

3. In the Queries pane, select the query that you want to run, and then select the date for which the
data in your EMS database is to be queried.

OPTION DESCRIPTION

Custom The starting date is set to the first day of the month and the ending date is set to
the last day of the month but you can edit one or both of these dates.

Note: For some queries, if you select Custom, a Use Specific Times option
becomes available. If you enter the same date for the starting date and ending
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OPTION DESCRIPTION

date, you can select Use Specific Times, and then enter a starting time and ending
time to query the data for in specific time range on the same day.

Last
Month

The starting date is set to the first day of the previous month and the ending date
is set to the last day of the previous month.

Last
Quarter

This
Quarter

This
Quarter
To
Date

Quarters are based on a calendar year:

l First quarter is 1/1 through 3/31.
l Second quarter is 4/1 through 6/30.
l Third quarter is 7/1 through 9/30.
l Fourth quarter is 10/1 through 12/31.

For example, if the current day's date is 11/22/2010, and you select Last Quarter,
then the starting date is set to 7/1/2010 and the ending date is set to 9/30/2010.

Last
Year

The starting date is set to 1/1 of the previous year, and the ending date is set to
12/31 of the previous year.

This
month

The starting date is set to the first day of the current month and the ending date is
set to the last day of the current month.

This
Year

The starting date is set to 1/1 of the current year, and the ending date is set to
12/31 of the current year.

This
Year to
Date

The starting date is set to 1/1 of the current year, and the ending date is set to the
current day's date.

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data. If the query returns data, then the results are displayed in the Results pane on the
Analytics tab.

6. Optionally, do one or more of the following:

l To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the
appropriate file type. A dialog box opens in which you can specify the file name (the default file name
is the name of the query, but you can always edit this), and the location to which to save the file.
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Tip: The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML
file is .xml and you cannot change this.

l To generate an onscreen preview of the printed query results, click Print. The preview window con-
tains options for printing a hard copy of the query results, for emailing the results, and so on. Select
the option or options that best fit your working needs.

Onscreen preview of a query results

l If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an
onscreen preview of the charted data. The preview window contains options for printing a hard copy
of the chart, for emailing the chart, and so on. Select the option or options that best fit your working
needs.

Onscreen preview of query results that are charted/graphed
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CHAPTER 215: At A Glance Tab
The At A Glance tab provides quick access to high-level booking statistics for events at your organization
or facility. You can select to show booking statistics by category, by event type, by group type, by
reservation source, by room type, or by status.

By default, when the tab first opens, the date is set to the current day’s date, and category is the selected
display type.

To view booking statistics for your facility on a given date:

1. Select options (Status and Building) on the left pane of the tab to filter the results that are displayed
on the tab.

2. Change the date and/or the display type as needed to view the bookings statistics for a selected
date.
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CHAPTER 216: Manage Services
You use Manage Services to search for and view the resources with and without service orders for all
bookings on a particular day as well as the current state of the resources and their Reviewed status. After
viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you
can mark a resource as un-reviewed. You can also open a resource in the Navigator, and edit it if necessary.

Concept: What is a Service Order, Category, and Resource?
In EMS, you might hear these terms used interchangeably at times; however, they are different concepts.

A Category in EMS is anything you might add to a Booking such as Catering, Audio Visual, Furniture,
Security, Notes, Attendee Names, Agendas etc. When you configure a Category, however, it must be of
six Category types: Activities, Attendees, Catering, Notes, Resources with Service Orders, or Resources
Without Service Orders. These types cause the service to behave slightly differently when added to a
booking. For example, a Notes/Activities/Attendees type service category does not require the EMS
Administrator to configure items under it and there is nothing for a person to select from these types of
services.

By contrast, a service category that has a type of Catering, Resource with Service Order, or a Resource
without a Service Order Category, will require the Administrator to create items under it. For example,
an "AV Equipment" service category (configured as a Resource without a Service Order Category type)
might have items under it such as a flip chart, whiteboard, (under AV Equipment). The person requesting
the service for this meeting would then select AV equipment; then flipchart and whiteboard would be
typical options to add to the event. 

TIP: The following Category Types allow Production Items: Catering, Resources with Service Orders, and
Resources Without Service Orders. 

Furthermore, a Category can be configured to "Use States" so that when a service is requested with a
meeting, it can be managed through a review and approval process in the Manage Services toolbar
option in the EMS Desktop Client. 
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To manage service orders, you will:

l Navigate to the Manage Services browser by clicking the Manage Services icon from the toolbar in
EMS Desktop Client.

l Search for Service Orders.
l Review, Edit, and/or Print Service Orders.
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Search for Service Orders

1. On the toolbar, click the Manage Services icon. The Service Order Management window opens.
Service Order Management window

l If states are assigned to any of the resources in a booking, the name of the state and if applic-
able, its color, is displayed in the State column for the booking. If a service order is part of a cat-
egory that has been configured to "Use States," but none has been assigned, then (none) is
displayed in the State column for the booking. If your Administrator has not configured cat-
egories in your system to use states, then the State column will be blank.

l If a resource has been reviewed for a booking, "Yes" appears in the Reviewed column for the
booking.

l If your Options are set to show deleted service orders/items, an "X" appears next to the book-
ing for which the orders/items were deleted and a single line through the booking is displayed.

TIP: You can change how data is listed: click Options in the upper right corner of the Service Order
Management window. The Options dialog box opens; make adjustments as needed and then
click OK to apply these changes.
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2. Use filters to search for service orders: 
l Leave the Date set to the default value (the current day's date), or select a different date.
l On the Building drop-down list, leave the value set to the default value (all buildings), or select

a specific building, area, or view.
l On the Category drop-down list, select the category by which to search.
l In the Status pane, select one or more specific booking statuses, or select (all) statuses.

Review and Edit Service Orders

1. You can see pending service orders and details about each order, review them, change their details,
change their states, and print a list of all the orders in the list:

l To view the individual service orders for a booking, click on the booking; detailed items show
below in the Items tab. You can view changes made to the service order, in the Changes tab in
the lower pane of the window. You can rearrange the column order by dragging a column to a
new location using the column heading, you can change the width of the data columns, and
you can sort the data columns on a tab in either ascending or descending sort order. See An
EMS Browser Window.

l To change the state of the service order, select it, or CTRL-click to select multiple
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l To change details for a service order, double-click on it or select it and click Open; this launches
the item in the Navigator. If you edit any information for a resource (quantity, notes, and so on)
or the service order (service order time, estimated count, or so on) for a booking, then a
Changed icon is displayed next to the booking.

l To Review a service order, select it, or CTRL-click to select multiple orders, and then
click Reviewed or Unreviewed. A message opens asking you if you are sure that you want to
mark the resource as reviewed. Click Yes to close the message. "Yes" is displayed in the
Reviewed column for the booking orders of the same category, and then click Change State. A
Change State window opens, which lists all available states for the service order. Select the new
state for the resource on the State drop-down list.

l To print the list of service orders that are displayed, click Print. An onscreen preview of the Ser-
vice Orders list opens. The preview window contains options for printing a hard copy of the list,
for emailing the list, and so on.

Onscreen preview for a printed reminder

2. When you are finished working with Service Orders, click Close. Any changes that you made to the
search results columns (position and width) remain in effect for any other searches that you do.
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CHAPTER 217: Search for Reservations, Bookings, Resources, and
Service Orders
EMS has a variety of options available to you for searching for reservations, bookings, service orders,
resources, and queries. These options include the Browser, the Everyday Reservation tool, the Calendar,
the Navigator, a Group, the Resource Calendar, and the Service Order Management browser.

Concept: What are Categories? Click for more...

l Booking details are also called categories.
l Booking detail items, also called resources, are the individual items (coffee, sandwich, projector, and

so on) that you add to a booking detail.
l A booking detail might include a service order.

In this section:

l Searching with the Browser
l Searching with the Calendar
l Searching with the Resource Calendar
l Search with the Everyday User Reservations Browser

Tip: A fast way to view and edit bookings is through the Reservation Book. See Viewing and Editing
Reservations in the Reservation Book.

For information about searching with the Navigator, see The Navigator.

Accruent Confidential and Proprietary © 2019 Page | 848

CHAPTER 217: Search for Reservations, Bookings, Resources, and Service Orders



CHAPTER 218: Booking Check-in
Organizations with a mobile workforce or flexible work arrangements often adopt a "workspace (hoteling
or hot-desking) strategy—allotting workspace on an as-needed basis to accommodate more people in less
space. EMS is a facility scheduling system for managing workspace requirements, as well as the booking of
meeting/event space and resources.

Sometimes meeting hosts don't use the space they reserved. In organizations where meeting space or
workspace is in high demand, or when the reservation is for a significant period of time, the lost utilization
of space adds up to a lot of waste. Using this feature, you can set up each room to require that the meeting
host check in to the space. When the time comes to check in, the host will receive an email with a link they
can click to check in. If you have EMS Kiosk, the host can check in via the touch-screen room sign (if
available), or if you have EMS Mobile App, by tapping "Check in" on the event on their mobile phone. You'll
also be able to set up what happens if the host fails to check in more than 10 minutes (or whatever time
you want) after the meeting starts. You might want to settle for a warning—at least for the first few
months—and then automatically free up the space so that someone else can use it. The result? Better use
of your space and happier users.

Booking level check in helps maintain room use levels and ensure accurate space usage reports. Check in at
the booking level allows users to check into a single space booking. Additionally, this feature triggers no-
show notifications in order to free up spaces that have no check ins. To enable users to check in this way,
you must first enable it for each user; see Enable Booking Check In.

NOTE: Older versions of EMS had "building-level check-in;" this has been replaced with booking-level
check-in.

See Also:

l Understanding Booking-Level Check In?
l Enabling Booking Check In
l Managing Check In
l Ways to Check In
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CHAPTER 219: Enable Booking Check In

Note: For an explanation of this feature, see Understand Booking Level Check In. To man-
age space that uses booking check in, see Manage Booking Level Check-In.

1. On the EMS menu bar, click Configuration > Facilities > Rooms.

2. On the filter drop-down fields along the top, select options by which to filter the list, such as a build-
ing, area, or view. 
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Note:  Make sure the Inactive checkbox in the lower right corner is cleared to further narrow
your list.

3. Select the room for which booking-level check in needs to be enabled and click the Edit button.

4. On the room configuration page that presents, check the box for Requires Check In. The Minutes
Prior to Booking Event Start is the amount of time before a booking in the specified room will be
open for check in.
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Note: This type of check-in can be done to multiple rooms at the same time using the Wiz-
ard on the Rooms screen.
Anyone with access to the EMS Desktop Client can check into a booking earlier than the time
assigned to the room.

Additionally, to allow Everyday Users (such as for EMS Web App, EMS for Outlook, EMS Kiosk, and EMS
Mobile App) to select this room during the booking process, select Available to Everyday Users in the
Everyday User Application Settings section.

5. Finish configuring the room using the tabs along the top. 

6. To enable Everyday Users to select the room when using an Everyday User Process Template, open
this tab and move the room to the Reserve and Request panels as needed.
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7. Click OK to save.
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CHAPTER 220: Ways to Check In

Checking In From the Booking Check In Dashboard 

1. Select Booking Check In from the menu bar in EMS Desktop Client.

2. Set filters to search for bookings you want to check into.

3. Select an event from the list of results that displays and click the Check In button.

Accruent Confidential and Proprietary © 2019 Page | 854

CHAPTER 220: Ways to Check In



Note: This feature replaces the Building and Booking Check In tools in previous releases. 

Checking In From the Reservation Book 
Bookings in the Reservation Book can be checked into by right-clicking on the booking and
selecting Check In.

Checking In From EMS Web App 

1. If authorized by your administrator, you can check into bookings in EMS Web App.
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Checking in with EMS Mobile App 

1. From the Calendar on the Home page, locate the event you want to check in to.

2. If it is with in the pre-determined check-in time period, a Check In option will appear when you swipe
right. The meeting organizer or booking template usually determines how soon before a meeting
you can check in. 

3. You can also Check In by opening and/or editing an event. 

4. Tap on the event and click Edit in the upper right-hand corner. 

5. Click Check In. 
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See Also: Inviting People

Checking in with EMS Room Sign 
Checking in on EMS Room Sign can be done at the Glance monitor by selecting the Check In button.
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Checking in with EMS Kiosk 
Checking in on EMS Kiosk can be done at the Kiosk by selecting the Check In icon on the My Reservations
screen.
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CHAPTER 221: Managing Check In
When check in is enabled for room bookings, there are multiple ways to check in to those bookings. Since
users can check into a booking from these various methods, this calls for oversight and management of
the booking. This topic guides you in managing check ins for your room bookings. 

Using the Booking Check In Dashboard 
This dashboard is where EMS administrators manage bookings and each booking's check in status.

Note: This dashboard is separate from the EMS Dashboard and replaces the
separate Building Check In and Group Check-In Status dashboards that were available in
older versions of EMS.

1. On the EMS menu bar, click Reservations > Other > Booking Check In to open the Booking Check In
dashboard, or click the Booking Check In icon on the Toolbar.

Note: You can add the Booking Check In icon to the Toolbar by right-clicking on the tool-
bar, then selecting Customize, and moving the Booking Check In to the Show Buttons side.

2. The Booking Check In window provides multiple options for EMS administrators to manage booking
check in. It displays bookings and shows whether they have check ins. Use the options to view,
modify, and control check ins for each booking.
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Options on the Booking Check In Dashboard 

OPTION DESCRIPTION

Building/Area/View The default value is (all), but you can select a specific Building, an
area,
or a view.

Room Type The default value is (all), but you can select a specific room type.

Event Type The default value is (all), but you can select a specific event type.

Room The default value is (all), but you can select a specific room.

Floor The default value is (all), but you can select a specific floor.

Start Date

End Date

The default value is the current day's date, but you can select a
different
value.

Group Type The default value is (all), but you can select a specific Group type.

Group Name Allows the user to search for a Group to check in to their booking.
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OPTION DESCRIPTION

Not Checked In
Only

Select this option to search only for bookings that have not been
checked
into.

Display Shows bookings in rooms that are set up for check in and match the
filters.

Check In This will check in a booking for a user that has not checked in using
another method.

End Now This will end a selected booking that is in progress, which will free the
room up for another booking.

Go To This will take the administrator to the navigator for the highlighted
booking to view further information.

Print This will print the information being displayed for the filters that are
set above.

Export This will export the information to a Microsoft Excel file.
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CHAPTER 222: Reports and Queries
EMS provides more than 110 reports and a custom query builder for use throughout the meeting and
event lifecycle—from setup and invoicing to billing and utilization analysis. These "one-way integration"
reports generate static reservation, service, billing, resource, and other information in .xml, .xls, comma-
delimited, and .txt formats. This data can be read and parsed by many other software applications. These
reports are categorized as follows:

l Daily: Summary, service, and other reports that describe activities over one or more days.
l Sales: Details of sales associated with reservations, resources, and more.
l Statistics: Insights you need to understand use and organizational activity.
l Exception: Clarifies the incorrectly run or allocated resources, templates, or systems.
l Billing: All reports for transactions, invoices, and other statements.
l Hoteling: Reports specific to office hoteling practices and QR codes for room cards.
l Other: Summary reports on cancelations and reservations.

The reports that you can send automatically include Reservation and Sales/Statistics Queries and all Saved
Daily and Statistics Reports. You can send reports according to whatever frequency, time, time zone, and
reporting period you choose, and you can customize the sender, subject, and message information. To set
up Automated Reports, your organization will need to install and configure the EMS Automated Report
service.

The application also contains a Query Builder function which you can use to define custom criteria for
searching for information in your organization’s EMS database.

Note: Reports that are specific for the Billing function in EMS are detailed in Billing.
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CHAPTER 223: Report Descriptions and Options
This section describes EMS reports by category, and defines especially important fields and settings for
each report. The following provide information about the various reports:

l Daily Reports
l Sales Reports
l Statistics Reports
l Other Reports
l Exceptions Reports
l Hoteling Reports
l Invoice Reports
l General Reports

Daily Reports 
Daily reports are able to be set to send as an email automatically. To learn more about Automated Reports,
see Create Automated Reports.

REPORT DESCRIPTION OPTIONS

Event
Schedule

A summary of the events that are
scheduled at your facility, sorted by
date and event start time. The report
shows event start and end time, group

l Use Page Breaks - If the report
is run across multiple days,
then each day starts on a new
page.
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REPORT DESCRIPTION OPTIONS

name, event name, and location. You
typically print and post the Event
Schedule in a lobby or entry way to
help visitors find their events.

l Show Bookings on Start Date
Only—If a booking is sched-
uled overnight, then only the
start date of the booking is dis-
played in the report. For
example, a booking exists for
3pm Thursday through 10am
Friday. If this option is selec-
ted, then the booking is dis-
played only for Thursday in the
report.

l Show Holidays—Displays any
holidays that are configured in
the EMS database on the
report.

l Show Building Hours—Dis-
plays building hours on the
report.

l VIP Events Only—Only the
events that are marked as a
“VIP” are displayed in the
report.

l Use Calendar Styles: Events are
displayed in the font/color of
the Calendar Style that is asso-
ciated with each event.

Event
Calendar

A chronological list of scheduled
events in a wall calendar format.

l Use Calendar Styles—Events
are displayed in the font/color
of the Calendar Style that is
associated with each event.

l Weekly Calendar—One week
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REPORT DESCRIPTION OPTIONS

per page is displayed in the
report.

l Show Adjacent Calendar
Days—Works in conjunction
with the Weekly Calendar
option to display events that
occur on Saturday and Sunday
in the report.

l Grey Out Adjacent Calendar
Days—Works in conjunction
with The “Show Adjacent Cal-
endar Days” option to display
events that occur on adjacent
days in gray instead of in
black.

l Hide Holidays—By default, hol-
idays are displayed on the
Daily Calendar Report. Select
this option to hide holidays in
the report.

l By Room—Displays events one
room at a time in a calendar
view.

Room
Cards

A list of events that is designed to be
posted outside a room or event space.
The report notes the date, event time,
and location for events, as well as the
group sponsoring each event. The
report can be a single list of all events
that are scheduled for the room on a
particular date, or it can be a single

l Show Bookings on Start Date
Only—If a booking is sched-
uled overnight, then only the
start date of the booking is dis-
played in the report. For
example, a booking exists for
3pm Thursday through 10am
Friday. If this option is selec-
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REPORT DESCRIPTION OPTIONS

page per event. ted, then the booking is dis-
played only for Thursday in the
report.

l Print Blank Room Cards—Prints
a room card for a space that
does not have any events
scheduled.

l Print Logo—Prints the facility
logo on each room card. You
can specify the logo location
on the right or left side of the
room card.

l Sort Room Cards By Book
Sequence—If Book Sequen-
cing is being used on Room
Configuration, then a facility
can print room cards in the
Book Sequence order.

l Print Combo Room Com-
ponents—Prints an individual
room card for each com-
ponent of a combo room.

l Suppress End Time—Do not
show the end times for book-
ings in the report.

Activity
Schedule

A list of bookings in all rooms in a
building, or just in a specific room in
the building. The report, which shows
event start and end times, event name,
group name and room, can be
generated for a range of dates. The

l Use Page Breaks—A new page
is generated for each date or
for each building.

l Show Bookings on Start Date
Only—If a booking is sched-
uled overnight, then only the
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REPORT DESCRIPTION OPTIONS

report can generated in one of two
formats—by Date or by Building.

start date of the booking is dis-
played in the report. For
example, a booking exists for
3pm Thursday through
10am Friday. If this option is
selected, then the booking is
displayed only for Thursday in
the report.

Setup
Worksheet

An internal report that setup crews,
custodial, or operations personnel use
to ensure that each room is arranged
properly for each event. The report
displays detailed information about
each booking, including setup type,
setup notes, required resources, user
defined fields, special instructions and
resource item notes.

l Use Page Breaks—If this report
is run across multiple days,
then each day starts on a new
page.

l Highlight Changes Made
Within:(days)—Changes that
have been made within the
specified number of days are
highlighted in the report.

l Limit Bookings To Those With
Details In Selected Cat-
egories—Only bookings with a
booking detail from the spe-
cified categories are displayed
in the report.

l Show Bookings on Start Date
Only—If a booking is sched-
uled overnight, then only the
start date of the booking is dis-
played in the report. For
example, a booking exists for
3pm Thursday through 10am
Friday. If this option is selec-
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REPORT DESCRIPTION OPTIONS

ted, then the booking is dis-
played only for Thursday in the
report.

l Keep Detail Together—If an
event has booking details, the
details are kept together on
one page instead of being
split across two pages.

l Show Holidays—Holidays are
displayed in the report.

l Show Building Hours—Build-
ing hours that are associated
with each building are dis-
played in the report.

l Show Item Notes—Any notes
that have been entered for a
booking detail item are dis-
played in the report.

l Show Item Special Instruc-
tions—Any special instructions
that have been entered in EMS
Web App for a booking detail
item are displayed in the
report.

l Show User Defined Fields—
Any user defined fields and
their answers for a reservation
are displayed in the report.

l Show Booking Changes Only—
Bookings that have been
edited within the specified
number of days are displayed
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REPORT DESCRIPTION OPTIONS

in the report.

Service
Order
Schedule

Lists the service orders that are
scheduled for a date or date range.
Produced by category.

l Use Page Breaks—If this report
is run across multiple days,
then each day starts on a new
page.

l Show Details—Booking item
details that associated with
each event are displayed in the
report.

l Highlight Changes Made
Within:(days)—Changes that
have been made within the
specified number of days are
highlighted in the report

l Show Pricing—Any pricing that
is associated with an item is
displayed in the report.

l Show Item Notes—Any notes
that have been entered for a
booking detail item are dis-
played in the report.

l Show Item Special Instruc-
tions—Any special instructions
that have been entered in EMS
Web App for a booking detail
item are displayed in the
report.

Service
Orders

Separate pages for each service order
in a date range. The report provides
information on the event and the items
or services needed. Produced by

l Highlight Changes Made
Within:(days)—Changes that
have been made within the
specified number of days are
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REPORT DESCRIPTION OPTIONS

category. highlighted in the report.
l Footer Message—Used to spe-

cify the Footer message that is
displayed on each page of the
report.

l Show Item Notes—Any notes
that have been entered for a
booking detail item are dis-
played in the report.

l Show Item Special Instruc-
tions—Any special instructions
that have been entered in EMS
Web App for a booking detail
item are displayed in the
report.

Banquet
Event
Order

Separate pages for each booking that
occurs on a date or within a date range
that has the “Primary Category”
specified. Service orders, resource
information, notes, and information for
resource with order type categories are
included in the report.

l Highlight Changes Made
Within:(days)—Changes that
have been made within the
specified number of days are
highlighted in the report.

l Show Pricing—Any pricing that
is associated with an item is
displayed in the report.

l Limit Bookings To Those With
Details In Selected Cat-
egories—Only bookings with a
booking detail from the spe-
cified categories are displayed
in the report.

l Show Item Notes—Any notes
that have been entered for a
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REPORT DESCRIPTION OPTIONS

booking detail item are dis-
played in the report.

l Show Item Special Instruc-
tions—Any special instructions
that have been entered in EMS
Web App for a booking detail
item are displayed in the
report.

l Show Item Selection Notes—
Any notes that have been
entered for a booking detail
item selection are displayed in
the report.

l Show Service User Defined
Fields—Any user defined ques-
tions and their answers for any
listed category are displayed
in the report.

l Set Page Numbers By Book-
ing—Resets page number for
every unique booking.

l Use Page Breaks—If this report
is run across multiple days,
then each day starts on a new
page.

Resource
Schedule

Lists by category and date, how many
of each resource item is needed, as
well as the event time, event name,
location, and group.

l Use Page Breaks—If this report
is run across multiple days,
then each day starts on a new
page.

l Highlight Changes Made
Within:(days)—Changes that
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REPORT DESCRIPTION OPTIONS

have been made within the
specified number of days are
highlighted in the report.

l Show Overbooked Resources
Only—Only those bookings
where the selected resource
exceeds the number available
in inventory at that time are
displayed in the report.

Service
Order
Change
Report

List the service orders to which a
change has been made by
Booking/Service Order ID. Includes the
service order category, a description of
the change, the old value for the
service order, the new value for the
service order, the date of the change,
and the ID for the user who made the
change.

Attendee
Visitor
Report

Lists the attendees for an event by date
or date range, and indicates whether
they are visitors and shows their group
name, phone number, event name, the
room they will be in, and the start and
end times for their event.

l Use Page Breaks—If this report
is run across multiple days,
then each day starts on a new
page.

Production
Report

Lists production items and their
quantities grouped by production area.

l Show Item Notes—Any notes
that have been entered for a
booking detail item are dis-
played in the report.

l Show Item Special Instruc-
tions—Any special instructions
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REPORT DESCRIPTION OPTIONS

that have been entered in EMS
Web App for a booking detail
item are displayed in the
report.

l Show Item Selections—Any
selections that have been
entered for a booking detail
item are displayed in the
report.

Sales Reports 

REPORT DESCRIPTION OPTIONS

Sales by
Group Type

Lists the sales for each group type
for a date or date range.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Sales by
Group

Lists the sales for each group,
divided by group type, for a date
or date range.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Sales by
Category

Lists the revenue generated by
each resource category for a date

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.
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REPORT DESCRIPTION OPTIONS

or date range. l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Sales by
Resources

Lists the sales for each resource
item for a date or date range.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Sales by
Reservation

Lists the reservations that have
bookings for a specified date or
date range and shows the charges,
by category, for the reservation.
Also gives a grand total for all
reservations. If a reservation also
has bookings that fall outside the
specified date or date range,
these figures are not included in
the report.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Sales by
Billing
Reference

Lists the total sales for a date or
date range, based on the billing
reference number on the
reservations that have bookings in
the specified range. Sales that are
associated with reservations that

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
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REPORT DESCRIPTION OPTIONS

have no billing reference number
are not included in the report.

with zero sales/discounts are dis-
played in the report.

Sales by
Booking

Lists the sales for a particular date
or for each date in a date range,
broken down by booking. This
report displays the following
information—Start/End Times,
Group, Event Name, Location,
Billing Reference#, PO Number,
Payment Type, Status, Reservation
ID, Booking ID, and Sales amount.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Status
Changes by
Reservation

Lists the sales that are associated
with a reservation where the
reservation or booking status was
changed.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Status
Changes by
Booking

Lists the sales that are associated
with bookings where the bookings
status was changed.

l Display Amount—Select from Net
Sales, Gross Sales, or Discounts.

l Include Report Criteria—The filter
settings for the report are dis-
played in the report.

l Show Zero Amounts—Group Types
with zero sales/discounts are dis-
played in the report.

Statistics Reports 
All Statistics reports, except Hourly Room Utilization and Hourly Resource Inventory Utilization, provide
data analysis functionality. To View and analyze data, click Analyze to open a Browser window that displays
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the queried data. You can group the information by column, you can export the raw data to an Excel file,
and you can click Details to provide more detailed information about the queried data.

Statistics reports are able to be set to send as an email automatically. To learn more about Automated
Reports, see Create Automated Reports.

Note: The Room Utilization report, the Hourly Room Utilization report, and the Hourly
Room Utilization report are available only in EMS Enterprise. They are not available in EMS
Professional.

REPORT DESCRIPTION OPTIONS

Room
Statistics

Lists all rooms by building and
for each room, indicates the
following information—the
number of bookings for the
date range selected, the
reserved hours, the event hours,
the estimated attendance (i.e.,
setup count), and the actual
attendance.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

Room
Utilization

Lists the number of bookings,
hours used, hours available,
percent utilization, and hours
vacant for rooms, by building,
for the date range specified.

l Day Selection—Specify which day(s)
of the week to include in the report.

l Group By Utilization Category—
Groups rooms by utilization (low,
high, unused).

l Include Cost—The cost for vacancies
is displayed in the report.

l Include Unused—Include rooms that
contain no bookings in the report.

l Cap Utilization at 100%?—Percent util-
ization cannot exceed 100%.

l Low Utilization—Specify what per-
centage equals “Low” utilization.

l High Utilization—Specify what per-
centage equals “High” utilization.
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l Availability Based On—Select to base
availability on one of the following -
Building Hours, Hours per Day, or Spe-
cific Hours.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

Hourly
Room
Utilization

Displays room utilization
broken down by hours in the
day, by percentage utilized.

l Day Selection—Specify which day(s)
of the week to include in the report.

l Display Chart—Includes a chart on the
final page of the report that sum-
marizes the reported data.

Hourly
Resource
Inventory
Utilization

Displays resources, and the
number of items used on an
hourly basis for a specified
date range.

l Day Selection—Specify which day(s)
of the week to include in the report.

l Display Chart—Includes a chart on the
final page of the report that sum-
marizes the reported data.

Group
Statistics

Displays Number of Bookings,
Reserved Hours, Event Hours,
Estimated Attendance, and
Actual Attendance by Group
Type for a given date or date
range. The format can be set to
“Detail” to provide statistics
for each specific group.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

Event Type
Analysis

Provides information by event
type on the following—the
number of reservations, the
number of bookings, the
percentage of total reserved

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

l Display Chart—Includes a chart on the
final page of the report that sum-
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hours, the percentage of total
event hours, the percentage of
total estimated attendance, the
percentage of total
attendance, the actual
attendance, and the
percentage of total.

marizes the reported data.

Reservation
Source
Analysis

Displays the number of
reservations, the number of
bookings with percentage,
reserved hours with
percentage, event hours with
percentage, estimated
attendance with percentage,
and actual attendance with
percentage by reservation
source.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

l Display Chart—Includes a chart on the
final page of the report that sum-
marizes the reported data.

Resource
Statistics

Lists the quantity and the hours
used by category and by
resource item.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

l Show Zero Quantities—Includes all
resources even if the resource is not
used during the date range specified.

l Show Inactive Resources—Includes all
inactive resources used during the
date range specified.

Room
Availability

Provides a count of room
availability by room type for a
given date range.

Setup Lists the total number of

Accruent Confidential and Proprietary © 2019 Page | 878

CHAPTER 223: Report Descriptions and Options



REPORT DESCRIPTION OPTIONS

Count
Analysis

bookings by setup count.

Seat
Occupancy

Displays the capacity for each
room, the number of bookings
for the date range, the seats
available for the bookings, the
total estimated attendance
based on setup count on each
booking, the average
estimated attendance, and the
estimated percentage of seats
filled for the specified date
range.Figures are also
provided for total actual
attendance, average actual
attendance, and actual
percentage of seats filled.

l Include Report Criteria—The filter set-
tings for the report are displayed in
the report.

Benchmark
Metrics
Report

Compiles metrics for a number
of different areas within EMS,
for example, Rooms By
Number of Bookings,
Reservations By Source, and so
on.

l Days Open Per Week—Indicates the
number of days per week your facility
is open per week. The default value is
7.

l Hours Open Per Day—Indicates the
number of hours per day that your
facility is open. The default value is
10.

Other Reports 

REPORT DESCRIPTION

Cancellation
Report

Lists the bookings that have a status that was changed to “Cancelled” on the
date or dates specified, or lists the bookings on the date or dates specified
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REPORT DESCRIPTION

that have a status type of “Cancelled.” The report also lists the date that the
booking status was changed, the date the bookings were to have taken place,
and the location of the event, the name of the person who canceled the
booking, the reason for the cancellation, and the booking ID. You can run the
report in one of two formats—by Booking Date (the date that the bookings
were to occur) or by Cancel Date (the date that the bookings were canceled).

Cancellation
Summary

Summarizes, by reservation, all charges for bookings on a date or in a date
range. The report shows the first and last bookings canceled within the
reservation, the Group, the reservation number, the group contact, the event
name, the event type, the total charges, and the reason for cancellation of the
most recently canceled booking. Reservations that do not have charges
associated with the bookings are not displayed on this report. You can select
Use Specific times and then enter a range of times to limit the report to
bookings that occurred within this specified time range.

Reservation
Summary

A summary of reservations that occurred within a specific date range. The
report also lists complete reservation information (reservation number, event
name, group, contact person, and so on) and booking dates. User defined
fields can also be printed in this report. You can select Use Specific times and
then enter a range of times to limit the report to reservations that occurred
within this specified time range.

Exceptions Reports 

REPORT DESCRIPTION OPTIONS

Undefined
Setups

Lists the bookings on the selected date or date
range for which no setup count has been entered.
The report lists the following information for the
bookings—the event name, time and location,
contact name and phone number, booking status,
and ID number. You can select Use Specific times
and then enter a range of times to limit the report

l Show Bookings
on Start Date
Only—If a book-
ing is scheduled
overnight, then
only the start
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REPORT DESCRIPTION OPTIONS

to bookings that occurred within this specified
time range. You can enter information about the
report, or a name or description for the report in
the Report Comment field.

date of the book-
ing is displayed in
the report. For
example, a book-
ing exists for 3pm
Thursday through
10am Friday. If
this option is
selected, then the
booking is dis-
played only for
Thursday in the
report.

Status
Reminder
Report

Lists the bookings that have a status with a
reconfirm date that falls within the selected date
range. You typically use the information in this
report to review tentative bookings. The report
can be run in one of two formats—by Status Date
(the date that the event was put in a “Tentative”
status) or by Booking Date (the actual date of the
event). You can select Use Specific times and then
enter a range of times to limit the report to
bookings that occurred within this specified time
range. You can enter a report name or description
or any pertinent information about the report in
the Comment field.

Wait List
Report

Lists all the bookings with a Wait status for the
time period that you have requested. Detects
situations where a booking has been canceled and
there are one or more bookings with a Wait status
that can now be changed to Confirmed, and
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REPORT DESCRIPTION OPTIONS

indicates if the room is available. You can select
Use Specific times and then enter a range of times
to limit the report to bookings that occurred
within this specified time range.

Booking
Conflict
Analysis

Reviews information on all bookings for a date or
date range and lists any conflicts

Note: EMS does not allow double-bookings, but
they might exist because conversion of data from
systems that do allow them, or the result of users
failing to restart EMS after encountering error
messages.

Building
Hours
Exceptions

Lists events for a date or date range that fall
outside of the configured building hours. Either
event time or reserved time is checked based on
the “Validate Building Hours on Event Time”
parameter. The report also shows the start and
end times, group, event name, location,
reservation number, and booking number. You can
select Use Specific times and then enter a range of
times to limit the report to bookings that occurred
within this specified time range. You can enter
information about the report, or a name or
description for the report in the Report Comment
field.

Inactive
Room With
Bookings

Lists the bookings for a specified date or date
range that are scheduled in inactive rooms. You
can select Use Specific times and then enter a
range of times to limit the report to bookings that
occurred within this specified time range. You can
enter information about the report, or a name or
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REPORT DESCRIPTION OPTIONS

description for the report in the Report Comment
field. You can click View to open the booking for
viewing and editing, changing the status of the
booking and/or emailing the group.

Inactive
Groups With
Reservations

Lists the reservations for a specified date or date
range that are scheduled for inactive groups. You
can click View to go to the reservation for viewing
and editing, including changing the status of the
reservation and/or its bookings.

Invalid
Service
Orders

Lists the service orders that have a start time
and/or end time that fall outside the reserved time
for the room. Lists the category, date, reserved and
event start and end times, location, group,
reservation number, booking number, service
order number and a description of the invalid
order. You can select Use Specific times and then
enter a range of times to limit the report to
bookings that occurred within this specified time
range. You can enter information about the report,
or a name or description for the report in the
Report Comment field.

Note: Service orders that fall outside the reserved
time are considered invalid even if the Validate
Service Order Times Against Booking parameter is
set to “No.”)

Invalid
Billing
References

Lists the bookings for a particular date or date
range that are in reservations that have invalid
billing reference numbers. You can select Use
Specific times and then enter a range of times to
limit the report to bookings that occurred within
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REPORT DESCRIPTION OPTIONS

this specified time range. You can enter
information about the report, or a name or
description for the report in the Report Comment
field.

Note: A billing reference number is considered
invalid if it has not been defined in the Billing
Reference Configuration area but the Validate
Billing Reference parameter is set to “Valid Only.”

Inactive
Web
Process
Templates

Displays the inactive web process templates that
are attached to reservations.

Hoteling Reports  

Note: In Version 44, the Early Checkout Report was removed. This category of reports is not
supported for EMS Professional.

REPORT DESCRIPTION OPTIONS

Room
Occupancy
Summary

Displays, by building and room type, the number and
percentage of rooms occupied.

No Show Lists the bookings for which the reservation holder did
not check in.

Note: A customer can be checked in via the EMS Kiosk,
the EMS desktop client, EMS Glance, or EMS Web App.

Visitor Lists events for groups that have cities on their group
record, other than what is specified in the Exclude
Locations field. If multiple locations are to be listed, they
should be entered with a comma between them (for
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REPORT DESCRIPTION OPTIONS

example, Denver, Houston, Tampa, and so on).

Booking
Notice
Statistics

Lists the total bookings for a date or date range, divided
into three “Amount of Notice” categories, where the
Amount of Notice is the time between when the booking
was scheduled and the date/time for which it was
scheduled. The report can be generated in one of two
formats— “standard” or by room type.

Transition Tracks the occupants of hoteling spaces during a
specified date range. Lists by floor and room where the
occupant was last, what room the occupant is moving to,
and who was in the space the previous day. Typically this
report is run for a two day range and the days of the
week must be checked. This report can be used by
personnel who are responsible for preparing hoteling
spaces for each occupant.

l Show
Details—
Prints the
categories
that are
associated
with the
bookings.

l Highlight
Changes
Made
Within:
(days)—
Changes
that have
been made
within the
specified
number of
days are
highlighted
in the
report.
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Arrivals
and
Departures

Lists the departures and arrivals for a particular room by
building and floor. The report shows the time of the
departure if the customer is a departure and the time of
the arrival if the customer is an arrival. Typically, this
report is run for a two day timespan listing the departure
date first and the arrival date second.

Groups
With
Multiple
Bookings

Lists groups that have multiple bookings for the date or
date range specified. The information is organized by
date, and lists the start and end times, the room, the
room type, and the booking status for each booking.

Room
Card - QR
Code

Allows you to print QR Codes that can be placed outside
rooms to be used within EMS Mobile App.

For complete instructions in configuring and generating
QR codes, See Also: Configure QR Codes.

Check In
Statistics

Lists the percentage of bookings that have been checked-
in to by building, building-room type, or room type.

Note: A customer can be checked in via the EMS Kiosk,
the EMS Desktop Client, or EMS Web App.

Invoice Reports 

REPORT DESCRIPTION

Billing
Worksheet

Provides information on how bookings are to be invoiced. The report can
include bookings within a date range, bookings within a reservation, or
bookings within a date range inside a reservation. The report breaks down the
charges in the same way as an invoice. The report also provides options for
printing heading/footer messages and the detail for zero-dollar items.

Accruent Confidential and Proprietary © 2019 Page | 886

CHAPTER 223: Report Descriptions and Options



General Reports 

REPORT DESCRIPTION OPTIONS

Ageing
Report

A list of outstanding invoices. Current
invoices are listed first, followed by past
due invoices organized by age. Ageing
Reports are based on department.

l Currency—Select the cur-
rency for the invoices.

l Show Unapplied Depos-
its—Deposits that are
applied to reservations
that have not been
invoiced are displayed
on the report.

Statements A list of outstanding invoices for a selected
group. Current invoices are listed first,
followed by past due invoices organized by
age.

l Currency—Select the cur-
rency for the invoices.

l Report Title—Can create
a title that is displayed at
the top of the statement.

l Header Message—Select
a message from the pre-
configured messages
that is displayed at the
top of every page of the
statement.

l Include Transactions On
Zero Balance Invoices
Within [ ]days—State-
ments that have a zero
balance within the spe-
cified number of days are
displayed.

l Show Billing Reference
Number—The billing ref-
erence number is dis-
played under the invoice
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information.
l Show Purchase Order

Number—The purchase
order number is dis-
played under the invoice
information.

l Show Transaction
Notes—Any notes
entered for the trans-
action are displayed
under the invoice inform-
ation.

l Use Current group
Address -
The current address of
the group is displayed on
the statement. (This
address might or might
not be the address for
the group when the reser-
vation was made.)

Transaction
Report

Shows all the billing transactions during a
specified period if you generate the report
in the By Transaction Type by Date format.
Simply enter the date or date range and
click Print. The report lists the group, event
name, reservation ID, transaction date,
transaction type, invoice number, check
number, and amount.

Note: If the report is generated in Standard
format, deposits are not shown as

l Currency—Select the cur-
rency for the billing trans-
actions.
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transactions if they have been absorbed by
the generation of an invoice.

Note: You can also generate the
Transaction Report from within a
reservation to see only transactions for the
selected event and you can generate the
Transaction Report from the Print option on
the Payment Entries window. Click Billing >
Payments > Payment Entry, and then on the
Payment Entries window, click Print.

Voided
Transaction
Report

Lists the payments, deposits, or adjustments
that were voided on a specific date or
within a date range. Lists the group, event
name, reservation ID, transaction date and
type, invoice number (if applicable), check
number, and amount.

l Currency—Select the cur-
rency for the voided trans-
actions.

Invoice
Detail
Report

Provides detail for all invoices that were
generated within a given date range.

Note: See To reprint an invoice  for detailed
instructions about the options that are
available for the Print Invoice Detail dialog
box.

N/A

General
Ledger
Distribution

Shows the totals for invoices that were
generated within a given date range.
Entries are broken down by account,
invoice, rate plan, or invoice. You can also
generate this report in a Summary format.

l Currency—Select the cur-
rency for the invoices.

l Invoices With Payments
Only—Only invoices
where payment has been
received are posted on
the report.
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l Show Applied Depos-
its/Prepayments—
Applied deposits and
prepayments are posted
on the report. (An
applied deposit is a
deposit on a reservation
that has been invoiced.)
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CHAPTER 224: Generate an EMS Report
All EMS reports are available under the Reports option on the menu bar. For any EMS report, you can
specify the parameters, options, and format for the report, or you can generate the report according
to saved settings. Not all reports require the same parameters, nor do they all have the same options
available. In addition, you can generate different reports in different formats.

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the
report that you are generating. For example, to generate the Event Schedule report, click Reports >
Daily > Setup Worksheet. A report setup window displays where you can set up your report. Shown
below is one for a Setup Worksheet.

2. On the Setup drop-down list, do one of the following:
l To generate the report according to your filter settings (parameters, options, and so on), leave

(user specified) selected on the Setup list, and then go to Step 3.
l To run the report with filter settings that have been saved, select the saved report on the Setup

list, and then go to Step 5.  
3. On the Options list, select the Date/Time Filter by which to generate the report.
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4. Specify the report parameters, options, and format. For brevity and ease, the parameters and options
that are available for each report are discussed in Report Descriptions and Options. Billing reports

are discussed in Billing. Academic reports are discussed in Academic Planning (EMS Campus). 
For descriptions of each type of report, refer to: 

l Daily Reports
l Sales Reports
l Statistics Reports
l Other Reports
l Exceptions Reports
l Hoteling Reports
l Invoice Reports
l General Reports

5. On the Report Setup window, you can:
l Add a comment to be printed in the report in the Report Comment field (only available on cer-

tain reports; maximum of 255 characters, including spaces).
l Click Print Preview. A preview of the report opens onscreen.
l Print a hard copy of the report; specify the number of copies that you are printing and then

click Print.
6. Click Close. Unless you change the filter settings, all subsequent reports are generated and printed

according to the parameters, options, and format you specified. If you want to save settings so you
do not have to adjust them every time you run the report, you can save the report. See Also: Work
with Saved Reports.

Accruent Confidential and Proprietary © 2019 Page | 892

CHAPTER 224: Generate an EMS Report



CHAPTER 225: Generate an EMS Billing Report
All EMS Billing reports are available under the Billing option on the menu bar. For any EMS report, you can
specify the parameters, options, and format for the report, or you can generate the report according
to saved settings. (For detailed information about a saved report, see Work with Saved Reports.) Not all
reports require the same parameters, nor do they all have the same options available. In addition, you
can generate different reports in different formats.

Note: For brevity and ease, the parameters and options that are available for each report
are not discussed here. Instead, the options are discussed in Report Descriptions and
Options. Contact your EMS administrator if you need assistance in generating any of these
report.

Generate a report

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the following:
l To generate the Billing Worksheet report, click Billing > Invoices > Billing Worksheet.
l To generate any other Billing report, click Billing > Reports, and then click the option for the

report that you are generating. For example, to generate the Ageing report, click Billing >
Reports > Ageing.

Note: All Billing reports other than the Billing Worksheet report are also available from
Reports > Billing.

2. On the Setup drop-down list, do one of the following:
l To generate the report according to the filter settings that you want (parameters, options, and

so on), leave user-specified selected, then go to Step 3.
l To run the report with filter settings that have been saved, select the saved report, and then go

to Step 4.

Note: For detailed information about saved reports, see Work with Saved Reports.

3. Specify the report parameters, options, and format. See:
l Invoice Reports
l General Reports

4. Optionally, do one or both of the following:
l Click Print Preview. A preview of the report opens onscreen.
l To print a hard copy of the confirmation, specify the number of copies that you are printing,

and then click Print.
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5. Click Close. Unless you change the setup, all subsequent reports will be generated and printed
according to the parameters and options that you have specified and in the format that you spe-
cified. If you want to save certain settings so that you do not have to adjust the filter settings every
time you run the report, you can save the report. See Work with Saved Reports.
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CHAPTER 226: Generate Attendee Visitor Reports
To generate a daily report of visitors, follow the steps below. 

1. On the main menu, click Reports > Daily > Attendee Visitor Report.

Access Attendee Visitor Report from the Reports Menu

2. On the Setup drop-down list, you can select from a list of saved visitor reports for your organization,
or you can set your own report parameters, options, and so on (leave "user specified" selected and
populate the fields on each tab as needed). If using a saved report Setup, simply specify a date range.
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Setup Drop-Down List of the Attendee Visitor Report Dialog Box

Tip: You can edit saved report setups from the Setups option in the upper right corner. Additionally,
you can quickly specify a date range based on when bookings start or when they occur using
the Options menu next to it. 

To save your (user specified) report for future use (so that it is listed in the Setup drop-down):
click Save next to the Setup field.
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3. To run the report once you have specified parameters, click Print. When finished, click OK on the Print
dialog and click Close on the Attendee Visitor Report dialog box.
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CHAPTER 227: Configure Automated Reports
EMS is able to send reports daily to selected email addresses. Reports that can currently be automated to
send are Reservation and Sales\Statistics Queries and all Saved Daily and Statistics Reports under the EMS
Reports menu. To learn more read about creating Queries or Saved Reports. Automated Reports can be
set up and emailed to selected individuals. Automated Reports use predefined Queries and Saved Reports.
An email will be sent to the users defined in the Automated Report Delivery with either the information
requested through the report, or with an email stating there was no data to display.

For Automated Reports to be sent, the EMS Automated Report service needs to be installed and
configured. For directions on installing and configuring the service see the Installing the EMS Automated
Report Service.

1. On the EMS menu bar, click Reports > Automated Report Delivery. The Automated Report
Delivery window opens. This window lists all Automated Reports that are currently configured in your
EMS database and that have a status of Active.

Note: To view any deactivated Automated Reports check the "Inactive" box inside the
"Show" section.

2. Click New. The Automated Report window opens.
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3. In the Description field, enter a name or description for the new Automated Report. The Automated
Report Delivery description should specify the type of delivery, such as"Daily Event Schedule Deliv-
ery."

4. Specify if this report is a Query or Saved report.

Concept: Queries and Saved Reports

Query

l Query Type: limits the displayed Queries to either Reservation or Sales\Statistics.
l Query: Shows the available Queries to Automate based on either Query Type, or if no Query Type is

selected it will display all Reservation and Sales\Statistics queries.

Saved Report

l Report Section: Set to (all) by default, but can be modified to either Daily or Statistics to limit the
Report Types that will be shown.
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l Report Type: Set to (all) by default, but can be modified to a specific Daily or Statistical report to filter
the saved reports.

l Saved Report: Displays the Saved Reports that are available to be automated.

5. Specify Frequency

l Daily/Weekly/Monthly: Determines the frequency that the report will send.
o Daily: will send every day at the specified time.
o Weekly: Can be set to a single day every week or multiple days every week.
o Monthly: Can specify a specific day each month (1-28) or the last day of the month.

l Send Report At: Determines the time each day that the Automated Report will send.
l Time Zone: Determines the time zone for the time selected for the report to send. Time and Time

Zone correlate to the database server and the server on which the Automated Report Service is
installed.

l Reporting Period: Determines the dates which the report will be automated for. Choose
from multiple options in the drop-down list to customize the reports.

6. Specify Email Settings/Recipients

l Email From: Enter the Email From address for the Automated Report.
o If you leave the Email From field blank, then the Email From address entered in the EMS Auto-

mated Report Service is used.
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l Email Subject: title for the email that will contain the Automated Report.
o If the Subject line is left blank the Automated Report description will be used as the email sub-

ject.
o A variable can be used to put information into the subject line as described in the Legend. %1%

is the code for the Reporting Period, so "Event Schedule for %1%" results in "Event Schedule for
Tomorrow" being displayed in the subject line.

o Email Address: You can look up Email Addresses by clicking the Add button, which selects from
the Global Address Book. In the Email Address field, for each user and/or group that is to
receive the Automated Report, enter the appropriate email address, and then click Add.
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CHAPTER 228: Work with Saved Reports
A saved report is a report for which the filter settings have been saved so that you do not have to adjust
the filter settings every time you run the report. You can create a saved report from a new saved report, or
you can copy an existing saved report, and edit the filter settings as needed to create a new saved report. If
you are the owner of a saved report, you can also edit the name of an existing saved report and you can
delete a saved report. To learn more about creating Automated Reports from Saved Reports with EMS,
see Create Automated Reports.

Note: Although this topic is written from the perspective of reports, it is also applicable for
working with saved confirmations and invoices.

1. Open a report you want to save. From the EMS menu bar, click Reports to open the Reports menu,
and then select the report type and the report name.

2. The Event Schedule window opens where you can set your report preferences.
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3. Click Options in the toolbar to set the Date/Time by which to generate the report.

4. Specify your report preferences: parameters, options, and format.

5. If you want to copy or edit a saved report, select it from the Setup field. The options at the top of the
window change so you can Automate, Edit, or Copy the saved report. 
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6. On the dialog box that presents, click Save or Copy. The Save Report Setup dialog box opens so you
can name the new saved report.

7. Enter a Description field (maximum of 50 characters). If you are an administrative user, and the report
is to be available to all users, then select Public (Available to All Users). If the report is to be available
only to you (the owner), then leave this option unchecked. If you are not an administrative user, only
your EMS administrator can make your saved reports available to all users. Contact your EMS admin-
istrator for assistance.

8. When you have set up your new or copied report, click OK. The Save Report Setup dialog box closes
and you return to the Report dialog box. The saved report is now an option on the Setup drop-down
list.

Renaming or Deleting a Saved Report

1. Open a report you want to edit or delete. From the EMS menu bar, click Reports to open the Reports
menu, and then select the report type and the report name.
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Example of an open report

2. On the report window, click Setups. The saved Report Setups dialog box opens. This dialog box lists
all the saved report setups for which you are the owner, and therefore can edit the name and/or
delete the report.
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Note: Administrative users can edit and delete all saved reports in the system, and can make
reports available to all users. See Also: Manage Saved Reports.

3. Select a saved report setup, and then do one of the following:
l To rename the report, click Edit to rename of the report in the Description field.
l To delete the report, click Delete, and then click Yes to confirm.
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CHAPTER 229: Work with a Query
A query is the primary mechanism for retrieving information from a database. A query consists of
questions that are presented to the database in a predefined format. A Query Builder function is available
from the Reports menu. You can use this function to create queries for retrieving information from your
EMS database. When you create a query, you can name and save the query so that you can run the query
at any time that you choose. You can create a query from a newly created query, or you can create a query
by copying an existing query and editing the copied query as needed. You can also edit a query, delete a
query, and view and print a query's filters.

This topic provides information about the following:

l Create a Query
l Edit a Query
l Delete a Query
l View and Print a Query's Filter
l Run a Query

Create a query

1. On the EMS menu bar, click Reports > Queries > Query Builder. The Query Definitions dialog box
opens. The dialog box displays all the queries that have been previously defined in your EMS data-
base and that have a status of Active.   

TIP: Optionally, to view all queries in your EMS database, regardless of status, under Show, click Inactive.
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2. Do one of the following:
l To create a query from scratch, click New.
l To create a query by editing an existing query, select the query that is to be edited, and then

click Copy.

The Query Builder Filter dialog box opens. The Query Builder Filter tab is the active tab. You use the options
on this dialog box to name and define the query.

3. Enter or edit the needed information for the query. See:
l Query Builder Filter tab
l Display Fields tab
l Filter tab
l Sort tab
l Chart tab
l Users tab

4. Do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.
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Query Builder Filter tab

1. On the Query Builder Filter tab, name and define the query.

OPTION  DESCRIPTION

Filter
Name

Name of the query filter.

Note: The name can be a maximum of 50 characters, including spaces.

Filter
Type

The type of information that the filter is to capture. The Filter Type affects the
items that are available on the Display Fields tab and the Filter tab. A Filter
Type of Group allows you to capture address information that can be exported
and subsequently used by other programs to create mailing labels.

Note: Only a single Filter Type, Reservation, is available in EMS Professional.

Display in
Browser

Available only for a Filter Type of Billing or Reservations. Select this option if
the query that you are creating is to be available in the Browser.

Open in
Navigator

Available only if the Filter Type is Reservations and Display in Browser is
selected. Indicate what the system should open in the Navigator when a user
double-clicks on an item that is retrieved by the query.

Owner Available only to administrative users.
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OPTION  DESCRIPTION

Return
First “xx”
Number
of
Records

To limit the number of records that the query returns, select this option, and
then enter the number of records in the field.

Inactive By default, a query is added as an active query. Select this option to inactivate
the query.

2. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.

Display Fields tab
Query Builder Filter dialog box, Display Fields tab
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1. Open the Display Fields tab, and then do one of the following:
l Select the field, or CTRL-click to select the multiple fields that are to be displayed in the query

results, and then click the Move button (>) to move the selected fields to the Selected list.
l In the Field Search field, enter the string by which to filter your search for available fields. Select

the field, or CTRL-click to select multiple fields, and then click the Move button (>) to move the
selected fields to the Selected list.

Note: The search is limited to the exact order of characters in the string, but the string is not
case-sensitive and it can be found anywhere in the search results. For example, a search
string of Add returns both Added By and Date Added. As you enter the search string, the
Available Fields list is dynamically updated with a list of fields that meet the search criteria.

Note: If you are copying an existing query, then when the Display Fields tab opens, the Selec-
ted list is already populated with a list of fields. You can select one or more of these fields, and
then click the Remove button (<) to move these fields back to the Available list.

2. The fields are displayed in the query results in the order in which they are listed in the Selected list.
Optionally, to change the order of the fields, select a field and then click Move Up/Move Down as
needed.

3. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.
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Filter tab

1. Open the Filter Fields tab, and then do one of the following:
l For each field that is to define the query, select the field, and then click the Move button (>) to

move the fields to the Filter Summary list.
l In the Field Search field, enter the string by which to filter your search for available fields. For

each field that is to define the query, select the field, and then click the Move button (>) to
move the fields to the Filter Summary list.

Note: The search is limited to the exact order of characters in the strings but the string is not
case-sensitive and it can be found anywhere in the search results. For example, a search
string of Contact returns both Contact Name and 1st Contact. As you enter the search
string, the Available Fields list is dynamically updated with a list of fields that meet the search
criteria.

For each field that you select, a dialog box opens in which you must specify the allowed values for the field.
After you specify the values and click OK, the dialog box closes, and the selected field is moved to the Filter
Summary list.

Note:  If you are copying an existing query, then when the Filter Summary tab opens, the
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Filter Summary list is already populated. You can select one or more of these fields and then
click the Remove button (<) to move these fields back to the Available list. If you want to use
the same Filter Summary fields in the “new” query, but with different values, you cannot
change the values directly. You must move the appropriate fields back to the Available list,
then select the fields again to change their values.

2. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.

Sort tab

1. Open the Sort tab, select the field or CTRL-click to select the multiple fields by which the query results
are to be sorted, and then click the Move button (>) to move the fields to the Selected list.

2. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.
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Chart tab

1. Open the Chart tab, and specify the type of chart that is to be used to graph the query results.

2. Manually enter any information for the chart (for example, Chart Title) as needed.

3. Optionally, do one or both of the following:
l To show a legend with the chart, select Show Legend, and then specify the legend information

(alignment, header, footer, and marker style and size).
l To spell check any charting information that you manually entered, click Spelling.

4. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.

Users tab
TIP: The ability to assign specific queries to specific users is available only in EMS Enterprise. It is not
available in EMS Professional.
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1. Open the Users tab, and in the Available list, select the user, or CTRL-click to select the multiple users
who can run this query, and then click the Move (>) button to move the selected users to the Selec-
ted list.

Note: By default, all administrative users can run any query that any user creates. These
users are listed in the Administrative list. You cannot remove any administrative users from
this list. Additionally, if a user is assigned to a User Template, this template controls which
queries they have access to here.

2. Continue with any other configuration for the query as needed, or do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the named query. The named

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
named query. The named query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.

Edit a Query

1. On the EMS menu bar, click Reports. The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder. The Query Definitions dialog box opens. The dia-
log box displays, by name, any queries that have been previously defined in your EMS application. 

3. Select the query that you are editing, and then click Edit. The Query Definitions dialog box opens. All
of the tabs are populated with the information for the selected query.
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4. Edit the query as necessary including one or more of the following:
l Renaming the query.
l Changing the fields that are to be displayed in the query results.
l Changing the fields that define the query.
l Changing the order of the fields by which the query results are to be sorted.
l Changing the charting options for the query results.
l Changing the users who can run the query.

5. Do one of the following:
l Click OK to close the Query Builder Filter dialog box and save the edited query. The edited

query is displayed on the Reports menu under the Queries option. You can run this query at
any later date when needed.

l Open the Results tab, and then click Preview to run the query immediately and view the results
on the tab. You can then click OK to close the Query Builder Filter dialog box and save the
edited query. The edited query is displayed on the Reports menu under the Queries option.
You can run this query at any later date when needed.

Delete a Query

1. On the EMS menu bar, click Reports. The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder. The Query Definitions dialog box opens. The dia-
log box displays any queries that have been previously defined in your EMS application. 

3. Select the query that is to be deleted, and then click Delete. A message opens, asking you if it is OK to
delete the selected query.

4. Click Yes. The message closes. The query is deleted.

View and print a query's filters

1. On the EMS menu bar, click Reports. The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder. The Query Definitions dialog box opens. The dia-
log box displays any queries that have been previously defined in your EMS application.

3. Select the query that is to be printed, and then click Print. An onscreen preview of the selected query
opens. A variety of options are available from this preview, including the options to print a hard copy
of the query, to email the query, and so on.
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Print Preview for a Query

4. Select the option or options that best fit your working needs.

Run a query
When you run a saved query, you can run the query from the Reports menu, or you can run the query
from the Query Definitions dialog box.

1. On the EMS menu bar, click Reports and on the Reports menu, click Queries, and then do one of the
following:

l Click the name of the query that you are running.
l Click Queries > Query Builder and on the Query Definitions dialog box, select the query that

you are running, and then click Run.
l The query is run and the results are displayed onscreen in the Query Results dialog box.

Note: The Results (lower) pane on the Query Results dialog box is an EMS browser window.
See EMS Browser Window for all the features that are available for this pane.
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Query Results dialog box example

2. Optionally, on the Query Results dialog box, do one or more of the following, and then click Get Data
to rerun the query according to the edited definition.

l Select the date for which the data in your EMS database is to be queried.

 OPTION DESCRIPTION

Custom The starting date is set to the first day of the month and the ending date is set to
the last day of the month but you can edit one or both of these dates.

Note: For some queries, if you select Custom, a Use Specific Times option
becomes available. If you enter the same date for the starting date and ending
date, you can select Use Specific Times, and then enter a starting time and ending
time to query the data in specific time range on the same day.

Last
Month

The starting date is set to the first day of the previous month and the ending date
is set to the last day of the previous month.

Last
Quarter

This

Quarters are based on a calendar year:

l First quarter is 1/1 through 3/31.
l Second quarter is 4/1 through 6/30.

Accruent Confidential and Proprietary © 2019 Page | 918

CHAPTER 229: Work with a Query



 OPTION DESCRIPTION

Quarter

This
Quarter
To
Date

l Third quarter is 7/1 through 9/30.
l Fourth quarter is 10/1 through 12/31.

For example, if the current day’s date is 5/22/2012, and you select Last Quarter,
then the starting date is set to 1/1/2012 and the ending date is set to 3/31/2012.

Last
Year

The starting date is set to 1/1 of the previous year, and the ending date is set to
12/31 of the previous year.

This
month

The starting date is set to the first day of the current month and the ending date is
set to the last day of the current month.

This
Year

The starting date is set to 1/1 of the current year, and the ending date is set to
12/31 of the current year.

This
Year to
Date

The starting date is set to 1/1 of the current year, and the ending date is set to the
current day’s date.

l Change the Starting Date, Ending Date, or both.
l In the Report Comment field, enter a comment that is to be printed on the query.

Note: The comment can be a maximum of 255 characters, including spaces.

l Click Options and change the settings for specific room filter and/or the number of records to return.

3. After you have run the query to your satisfaction, you can then do one or both of the following:
l To print the query results, click Print. An onscreen preview of the query results opens. A variety

of options are available from this preview, including the options to print a hard copy of the
query results, to export the query results to a .pdf, and to email the query results. Select the
option or options that best fit your working needs.

l To export the query results to an Excel spreadsheet, or to an XML file, click Export, and then
click Excel or XML as appropriate.
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CHAPTER 230: Billing
Accurate and timely billing is critical to ensuring a successful experience for organizations that schedule
events at your facilities. EMS provides a variety of functions for working with invoices and transactions for
reservations and bookings as well as reporting on this information.
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CHAPTER 231: Overview of Billing in EMS
Billing in EMS is a two-step process:

1. Generate Invoices
You can generate invoices based on reservation number, date range, or both. For example, you could
generate invoices for all bookings in Reservation 1829 that occurred last month. After you have gen-
erated the invoices, EMS tracks the amount due and the age of the invoices.

2. Process Received Payments
You can use the Payment Entry function to enter deposits made against a reservation before
invoicing or booking and to enter adjustments.

Tip: As part of this process, you can generate the Billing Worksheet report. (See Generating an EMS
Billing Report.) You use this report to review the dollar amounts for the bookings for which you intend to
create invoices. You can correct any discrepancies that you note in the report by editing the bookings or
booking items in question.

Financial transactions in EMS are batched by department. For example, if a user who is a member of the
Scheduling department applies a deposit to a reservation, then the deposit is shown on a confirmation
only if the user who applied the deposit or other users in the Scheduling department print the
confirmation. If a user in another department, for example, the Catering department, prints the
confirmation, then the deposit is not shown on the confirmation. Similarly, invoices that are generated by a
department are printed on the Ageing report only if the report is generated for the same department. If
you invoice a reservation or one of its bookings, any deposit that was previously made on the reservation
is then applied and is no longer shown on the confirmation. If you invoice an event, the event is locked and
cannot be edited. You can edit the event only after you void the invoice. You cannot void an invoice if
payments have been made against it. You must first void the payments. You can use an adjustment with a
negative dollar amount to clean up your financial records. For example, you generate an invoice for $102
for a group and the group returns a check for $100. If you do not want to ask the group for a $2.00 check,
an adjustment of $2.00 balances your books.
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CHAPTER 232: Search for Transactions
You can find all transactions for a reservation on the Transactions tab in the Navigator. The Browse
Transactions option, however, enables you to search for any transaction type with or without the
reservation number, using a basic or advanced search; search results show in a list view. A basic search calls
for basic information that you specify for a transaction when you first create it, such as the group to which
the transaction applies, the department that generated the transaction, and so on. An advanced search
goes through more specific field values in reservations, transactions, or both. For example, in an advanced
search, you search by the Bill-To Contact at the reservation level.

1. On the EMS menu bar, click Billing > Other > Browse Transactions. The Browse Transactions window
opens. The first time the Browse Transaction window opens, the Filter tab uses a basic search; oth-
erwise, it uses the search type (Basic or Advanced) that you last performed.

2. Click the Basic/Advanced toggle button to switch between the search types. 

Basic Search 
A basic search calls for basic information that you specify for a transaction when you first create it, such as
the group to which the transaction applies, the department that generated the transaction, and so on.

1. Enter your search criteria using the table below.
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FIELD DESCRIPTION

l Starting
Time

l Ending Time

The date range during which the transactions were
carried out. Both are optional.

Group (Often re-labeled "Employee" or "Customer").

Search  for a person or group for which the

transactions apply.

Department Leave the default value set to (all) or select a
specific department that generated/issued the
transaction.

Transaction Type Leave the default value set to (all), or select a
specific transaction type for which to search.

Invoice Number If you are searching for a specific invoice or
invoices, enter a search string.

Note: The search is not case-sensitive, but your
search is limited to the exact order of characters in
the string and it must begin with the information
for which you are searching. For example, a search
string of 10 returns 1000, 1017, but not 910.

Reservation ID Leave the default value set to 0 to search for a
transaction regardless of reservation ID; otherwise,
enter the exact value of the reservation ID.

Amount Leave the default value set to 0.00 to search for
transactions regardless of the transaction amount;
otherwise, enter the exact amount of the
transaction.

2. You can click Options and specify the Number of Records to Return.

3. Click Get Data or Refresh to see search results.

Browse Transactions window, Results tab
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4. To work with the results, you can do one or more of the following:

l Click Print to print the search results.
l Click Export to export the search results to a Microsoft Excel spreadsheet.
l Select an invoice, and then click Email to open a pre-addressed SMTP email to the group that is asso-

ciated with the invoiced reservation. Complete and send the email as you would normally. (The
invoice is sent as an attachment.) See Also: Sending Email.

l Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then
repeat the search.

l Click Refresh to re-query the database based on the current search criteria.

5. Click Close. Any changes that you made to the search results columns (position and width) remain in
effect for any other searches that you carry out. You can also Reset the columns to their default val-
ues.

Advanced Search 
An advanced search goes through more specific field values in reservations, transactions, or both. For
example, in an advanced search, you search by the Bill-To Contact at the reservation level. Toggling to
an Advanced search refreshes the Browse Transactions window with additional options.
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1. You can enter a Starting Date, an Ending Date, or both, to set a date range for the search. If these
dates are the same, you can select Use Specific Times and enter specific time periods to search. 

2. Select fields you want to specifically search and use the arrow button to move each to the right pane.

Tips: You can use the Field Search field to filter the list of available fields by keyword. 

If you want to use specific fields and/or values often in this kind of search, use Add To Favorites. After you
define a value or define the limits for a field, click Save Value on the Filter dialog box. The next time that you
perform a search, you can open the Favorite Fields tab or the Saved Values tab to re-use these favorite
fields and pre-set values.

To see details about a field, you can mouseover the field in the Filter Summary list.

3. When prompted, enter a value or define the limits for the field, and then click OK. 

4. You can, click Options and set values for additional search options: Date/Time Filter, Number of
Records to Return, and Specific Room Filters.

5. Click Get Data or Refresh to see search results.
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6. You can work with the search results just as you would for the Basic Search (above).

7. Click Close. 
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CHAPTER 233: Apply Calculations to Billing
Calculations are additional charges that can be applied to billable items based on an associated group or
individual, a category or service, or a room.

... such as gratuity or sales tax. Both pricing methods and calculations determine the final cost for a billable
item; however, unlike pricing, which is applied when a billable item is reserved (and retained, even if the
price for the item later changes), calculations are figured each time a confirmation or an invoice is
generated. If an event has associated calculations (which are assigned to groups or individuals, categories
and services, and rooms), you will see these in the invoicing process. 
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CHAPTER 234: Quick Reference Guide: Billing and Invoicing
This quick reference gets you going with billing and invoicing in EMS Desktop Client:

l Run the Billing Worksheet to Review Charges
l Edit Charges on Reservations
l Invoice Reservations in Batch
l Run the General Ledger Distribution Report by Invoice
l Apply Payments in Batch
l Void Payments and Invoices
l Additional Billing Reports

Run the Billing Worksheet to Review Charges 

l Once a billing cycle is complete, run the Billing Worksheet to review reservations with charges
assigned that have not been invoiced yet.

l Go to Billing > Invoices > Billing Worksheet > Select the Previous Billing Cycle > Print Preview

Edit Charges on Reservations 

l If a reservation on the billing worksheet needs to be modified, use the Reservation ID from the billing
worksheet to open the reservation.

l Add or edit billable items like resources as needed.
l In the navigator screen, you will see the prices in the booking details pane. Edit the booking detail to

manually change the price as needed.
l To change the prices to another pricing plan, go to the Reservation level > click Update Pricing

Then choose a New Pricing Plan, select the appropriate category, then click Next. Select all Applicable
Bookings, then click Finish.

Invoice Reservations in Batch 

l Once charges on reservations are corrected, invoice in batch.
l Go to Billing > Invoices > Invoicing
l Select the same Dates and other filter criteria used on the Billing Worksheet.
l Click Generate

l Highlight the transactions you want to invoice (all or some), click Preview to review, then click Final –
click Yes to warning about posting and printing x number of invoices
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l The invoices display. Close the preview.

Run the General Ledger Distribution Report by Invoice 

l Next run the general ledger distribution report by invoice to see all of the journal entries that need to
be made for the billing period. The report includes the Billing Reference Number to charge, the
accounts to credit, and the amount due.

l Go to Billing > Reports > General Ledger Distribution
l The first time you run this report, make the following selections and then click Memorize to save the

report for future use.
o Date Range Tab:

n Department - will default to the department you work in and are assigned to.
n First Transaction Date and Last Transaction Date – select the date the batch invoices were

created
n Group – (all)
n Format – By Invoice

o Group Types Tab:
n Move all group types that you invoice from the Available to the Selected column

o Options Tab:
n Currency: US Dollars
n Invoices with Payments Only: unchecked
n Show Applied Deposits/Pre-payments: unchecked

l After the report has been saved, click Print Preview.
l Optionally, use this report to make journal entries in your financial system. The Billing Reference Num-

bers represents the account to be debited, the Account represents the revenue account to be cred-
ited.
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Apply Payments in Batch 

l Optionally, apply payments in EMS to represent that the journal entry was made to pay for the
charges. Go to Billing > Payments > Payment Entry.

l The Payment Entries window will open. Click New.
l The Payment Entry window will open. Make the following selections:

o Transaction Type – Payment
o Payment Type – Internal Transfer
o Check No. – optionally enter the journal entry transaction number
o Amount – enter the total amount paid for the invoice
o Invoice No. – type the invoice number found on the General Ledger Report
o Notes – Optionally, enter other information you would like to track about this payment.

Click OK to save.

Void Payments and Invoices 

l If a correction to an invoice is needed, you must void the most recent transaction(s) on an invoice
before you can void the Invoice itself. For example, payments applied to an invoice must be voided
first.

l On the Transactions Tab, select payment > Void > enter Void Reason > OK (this action does not
delete the payment, it voids it and displays void date & comment)

l To void an Invoice, select invoice > Void> enter Void Reason > OK
l Transactions become locked after a certain number of days. The number of days are configured on

the Department are represent the number of days you are allowed to void an invoice.  If it is 365, for
example, you must void invoices within one year of creating that invoice.  After one year, you would
not be able to void the invoice.

Additional Billing Reports 

Statements 

l Allows you to create a customer facing statements (across all invoices) of the original amount due on
an invoice and remaining balance.

o Billing > Reports > Statements

Ageing Report 

l Used to show who owes a payment and if they are current, 30 days, 60 days, or 90 days late.
o Billing > Reports > Ageing Report
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Billing Queries 

l If you need a billing report that doesn’t already exist in EMS, build a query. Use billing as a filter type.
When billing is selected as the filter type, transaction fields become available as filters and display
fields.

o Reports > Queries > Query Builder
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CHAPTER 235: Work with Invoices
You can generate an invoice in EMS Desktop Client based on a specific booking date or date range, a
reservation number, or both. For example, you can generate invoices for all bookings from May 1 through
May 14, for all bookings in reservation number 22, or for all bookings in reservation number 22 that
occurred between May 1 and May 14. You can generate multiple invoices for the same booking, with each
invoice showing the charges for a different category (such as room charges on one invoice, catering
charges on another invoice, and so on). This might be necessary in situations in which you must produce
multiple invoices for the same booking if the departments within your organization bill separately for the
services they provide. You can also reprint an invoice and void an invoice.

You can work with invoices for a single reservation, or you can batch process multiple invoices. If you want
to work with invoices for a single reservation, you do so through the Transactions tab in the Navigator. If
you want to work with a batch of invoices, you do so through the EMS Desktop Client Billing menu: Billing
> Invoices > Invoicing.

Generate an Invoice 
TIP: Before you generate an invoice, you should generate the Billing Worksheet report. See Generate an
EMS Billing Report.

1. Do one of the following:
l Open the reservation in the Navigator and on the Transactions tab, click New > Invoice.
l On the EMS Desktop Client menu bar, click Billing > Invoices > Invoicing. The Invoicing window

opens.
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TIP: On the Setup drop-down list, you can select a saved, or memorized, invoice. If you select a memorized
confirmation, then the only changes that you can make are to the dates and/or times on the Date Range
tab.

2. Review and make changes as needed, using the table below.

FIELD DESCRIPTION

Date Range tab 

Department Select the department that is creating the invoices.
The department name and address is printed at the
top of the invoice.

Note: This field is automatically populated if you have
a default department assigned to your user account
but you can select a different value if needed.

Reservation Number Automatically populated if you are generating an
invoice from the Transaction tab; otherwise, enter a
reservation number.
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FIELD DESCRIPTION

Starting Date

Ending Date

Automatically populated with the first (starting)
booking date and the last (ending) booking date for
the selected reservation when you are generating an
invoice from the Transaction tab; otherwise, enter the
date range of the bookings for which you are
generating the invoice.

Use Specific Times If only a specific time for the bookings is to be
invoiced (for example, the bookings are from 8 am to
5 pm and you want to invoice the booking from only
8 am to noon), click Use Specific Times and then enter
a specific time period.

Invoice Date The default value is the current day’s date. You can
leave this value as is, or enter a different date.

Due Date The default value is 30 days from the current day’s
date. (Your Administrator might have configured a
different default value for this field.) You can leave in
the field as is, or you can enter a different date.

Buildings tab/Categories tab/Statuses tab/Group Types tab 

Open the appropriate tab on the window and select the buildings, resource categories,
booking statuses, and group types that are to be invoiced. This information is displayed on
the invoice. To select a building, category, and so on, select the item in the Available list
(CTRL-click to select multiple items), and then click the Move button (>) to move the items to
the Selected list.

NOTE: You can click the Show Inactive option for both categories and statuses, to show
inactive categories and statuses, so you can select these inactive items as part of your
filtering criteria.

Options tab—Format settings for a printed confirmation 

Header Message Select the header message and footer message that is
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FIELD DESCRIPTION

Footer Message to be printed on the invoice. By default, the header
and footer messages are printed on every page of the
invoice. To print the header only on the first page of
the invoice, clear the Print Header on Each
Page option.

Currency Select the currency that indicates how a room or
resources in a category should be charged.

Print Comments Include the comments for the reservation in the
printed invoice.

Print Reminders Include the reminders for the reservation in the
printed invoice.

Print User Defined Fields Include user-defined fields and their values in the
printed invoice.

Suppress Reserved Time Do not show the reserved time on the printed invoice.
(Instead, only the event time is included on the
printed invoice.)

Print Item Notes Include the notes for any booking items in the printed
invoice.

Print Zero Priced Items Include resources for which there was no charge in the
printed invoice.

Print Item Selections Include any resource item selections in the printed
invoice.

Print Header On Each Page Include the selected Header message on each page
of the printed invoice.

Suppress Logo Do not show your department’s/organization’s logo
on the printed invoice.

Print Billing Reference Allocation Include the billing reference numbers for the event as
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FIELD DESCRIPTION

well as the percentage of charges that is allocated to
each number in the printed invoice.

Print Category Subtotals Include the subtotal charges by category in the
printed invoice.

Display Messages as HTML If you have defined any HTML messages, then select
this option to display the HTML version of these
messages in the printed invoice; otherwise, the
message is displayed in plain text.

TIP: If needed, you can always save these settings. See Work with Saved Reports.

3. Click Generate. The generated invoices are displayed in the Invoicing dialog box. By default, invoices
with a zero balance are not shown.

4. Optionally, you can do one or more of the following to work with the invoices that are displayed; oth-
erwise, if you are satisfied with the invoices, you can go to the next step to post the invoice.

l To show zero balance invoices in the window, clear the Hide Zero Balances option.
l To preview an invoice, select the invoice (CTRL-click to select multiple invoices), and then click

Preview. An onscreen preview of the selected invoices opens, titled “Invoice Preview” (to dis-
tinguish the invoices from those that have been posted). The invoices also do not have invoice
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numbers, which are not issued until you post the invoices. The preview window contains
options for printing a hard copy of the invoices, for emailing the invoices (see Send Email from
EMS), and so on. Select the option or options that best fit your working needs.

l To change the criteria for the invoices, click Filter to return to the Invoicing window After chan-
ging the criteria, you can generate the invoices again.

Onscreen preview of an in-progress invoice

5. To post an invoice, select the invoice (CTRL-click to select multiple invoices), and then click Final. A
message opens warning you that you are about to post and print (#) invoices, and asking you if want
to continue.

6. Click Yes. The message closes and an onscreen preview of the final invoices opens. The preview is
titled “Invoices” and each invoice has been issued an invoice number. The preview window contains
options for printing a hard copy of the invoices, for emailing the invoices (see Send Email from
EMS), and so on. Select the option or options that best fit your working needs. 
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Onscreen preview of a posted invoice

After you generate and post an invoice, the message “Items have been invoiced” is displayed in red text on
the Reservation Summary tab, the Booking Summary tab, and the <Booking Detail> Summary tab in the
Navigator. The booking detail folder in which the invoiced items reside now has a green background in the
Booking Details pane and the icon for each invoiced item also has a green background in the Items pane.
Also, the invoice is permanently saved, and you cannot edit it. You can make changes to the balance due
for a reservation only by creating an adjustment or by voiding the invoice and regenerating it after you edit
the booking information. (Because invoiced bookings are locked and cannot be edited, you must void the
invoice before you can edit the bookings.)

Reprinting an Invoice 
You can reprint both non-voided and voided invoices. You can reprint invoices for only one department at
a time from the Billing area of EMS. Reprinting an invoice does not recalculate the invoice. The invoice is
simply printed as it appeared when it was first generated. You can specify the invoices that you are
reprinting, or you can search for invoices that meet specific criteria, and then select specific invoices to
reprint from the list of search results.

To reprint invoices for one or more departments, you must select the reservation in the Navigator, open
the Transactions tab and CTRL-click to select the multiple invoices that you are reprinting, and then use the
Reprint option on the Transactions tab.
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1. On the EMS Desktop Client menu bar, click Billing > Other > Reprint Invoices. The Reprint Invoices
dialog box opens.

Reprint Invoices dialog box

2. Select the Department that generated the invoices. This field is automatically populated if you have a
default department assigned to your user account, but you can select a different value if needed.

3. In the Invoice No. field, enter the number of the invoice that you want to reprint, and then
click Add. The invoice is displayed (by number) in the lower right Invoice pane.

4. Repeat Step 3 until you have added all the invoices that you want to reprint.

5. Leave the reprinting criteria set to their default values, or change them as needed using the table
below.

OPTION DESCRIPTION

Invoices The invoice type that you are reprinting—Non Voided (the default value) or
Voided.

Format Select the sort order for the reprinted invoices. The default value is By
Reservation.

First Leave these values blank to reprint the invoice for all bookings; otherwise,
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OPTION DESCRIPTION

Transaction
Date

Last
Transaction
Date

enter the date range of the bookings for which you are reprinting the invoice.

Print
Header on
Each Page

Leave this option selected to print the invoice header on every page of the
invoice.

Print
Transactions

Select this option to include any associated transactions (deposits, payments,
and so on) in the reprinted invoice.

6. Click OK. An onscreen preview of the invoices opens. The preview is titled “Invoices.” The preview win-
dow contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf,
emailing the invoice (see Send Email from EMS) and so on. Select the option or options that best
fits your working needs.
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Void an Invoice 
You can void an invoice only if the invoice has not been paid. If payments have been made against an
invoice, you must first void the payments. You can void invoices for only one department at a time. When
you void an invoice, the invoice is removed from the Ageing report and its associated bookings are
unlocked. You can specify invoices to void, or you can search for invoices that meet specific criteria, and
then select specific invoices to void from the list of search results.

TIP: You can also void an invoice from the Transactions tab when a reservation is selected in the Navigator.

1. On the EMS menu bar, click Billing > Other > Void Invoices. The Void Invoices dialog box opens. 
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2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are voiding, and then click Add.
Two results are possible:

l If payments have not been applied to the invoice, then a Void Reason dialog box opens.
Continue to Step 4.

l If payments have been applied to the invoice, then an error message opens indicating that pay-
ments have been applied to the invoice and it cannot be voided. You must void the payments
first before you can continue with voiding the invoice. See Void a transaction.

4. Enter a reason for voiding the invoice, and then click OK. The invoice is displayed (by number) in the
lower right Invoice pane.

5. Repeat Step 3 and Step 4 until you have selected all the invoices from the same department that you
are voiding.
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6. Do one of the following:
l To review an invoice before you void it, go Step 7.
l To void an invoice without reviewing it, go to Step 8.

7. Optionally, before you void a selected invoice, you can review it to ensure that it is indeed an invoice
that you want to void. In the lower right Invoice pane, select the invoice, or CTRL-click to select mul-
tiple invoices, and then click Preview. An onscreen preview of the selected invoices opens. The pre-
view is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices,
for exporting the invoices to a .pdf, and so on. Select the option or options that best fit your working
needs. For example, before you void an invoice, you might want to email a copy of the invoice to a col-
league to confirm that the invoice should be voided.

Onscreen preview of an invoice selected for voiding

8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple invoices that
you are voiding, and then click OK. A message opens asking you if you are sure that you want to void
the selected invoices.

9. Click Yes. A message opens indicating that the invoices have been voided.
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10. Click OK. The message and the Void Invoices dialog box close. The Void column is set to Yes on the
Transactions tab for each of the voided invoices in the Navigator.

Concept: Calculations are additional charges that can be applied to billable items based on an
associated group or individual, a category or service, or a room.
... such as gratuity or sales tax. Both pricing methods and calculations determine the final cost for a billable
item; however, unlike pricing, which is applied when a billable item is reserved (and retained, even if the
price for the item later changes), calculations are figured each time a confirmation or an invoice is
generated. If a event has associated calculations (which are assigned to groups or individuals, categories
and services, and rooms), you will see these in the invoicing process. 
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CHAPTER 236: Types of Transactions
A transaction in EMS can be any of the following types:

TRANSACTION TYPE DESCRIPTION

Deposit A deposit is the dollar amount paid in advance
of a meeting or event before invoicing occurs.

l A deposit is added to a reservation. After
you invoice the reservation, all out-
standing deposits are applied to the
invoice to reduce the balance due.

l A damage deposit is used to a collect a
deposit that is not applied to an invoice
and therefore, does not reduce the bal-
ance due. Instead, if the customer does
not damage the room, any reserved equip-
ment, and so on, then you must return the
damage deposit to the customer by void-
ing the damage deposit transaction.

Payment A payment is the dollar amount that is applied
to an invoice to reduce the balance due. A pre-
payment is similar to a deposit and is applied
to a reservation.

Adjustment An adjustment is a modification that is made
to the amount due on an existing invoice. For
example, if you send out an invoice to a group
for $202.00 and the group sends you a check
for $200.00, you can make an adjustment of
“$2.00-” to close out the invoice.

Refund A refund is the return of funds that have been
applied to an invoiced reservation.
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CHAPTER 237: Work with Transaction
Working with transactions includes entering and voiding:

l Adjustments.
l Deposits (Damage, Booking, Reservation).
l Payments
l Pre-Payments.
l Refunds.

Each type of transaction involves unique steps for entering them, but the task of voiding all these types of
transactions are the same.

Note:  You might need to first search for an existing transaction to determine if it has
already been entered or voided.

Enter a Transaction: Adjustments, Deposits, Payments, Pre-Payments,
Refunds

1. Do one of the following:
l Open the reservation in the Navigator and on the Transactions tab, click New > Payment. (This

method pre-populates many fields with information for the reservation).
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l On the EMS Desktop Client menu bar, click Billing > Payments > Payment Entry, and then on
the Payment Entries window, click New. (This method launches a blank Payment Entry form
you must complete "from scratch").
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Payment Entry Window
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2. Select a Transaction Type: Adjustment, Damage Deposit, Deposit (Bookings), Deposit (Reservation),
Payment, Pre-payment, Refund. Your selection in this field affects your entries in other fields in this
form.

Transaction Type Field, Payment Entry Window
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Types of Transactions (select type in Transaction Type field of Payment Entry Window)

TRANSACTION

TYPE

Description

Adjustment A price adjustment for the event, such as a discount or late charge.

Damage
Deposit

A refundable amount to cover possible damages during the event.

Deposit
(Reservation)

Deposit (Reservation) is best suited for reservations with one or more
bookings that are to be invoiced in their entirety upon completion of the
event.

Deposit
(Bookings)

Deposit (Bookings) is best suited for reservations with multiple bookings, for
example, an event with multiple occurrences spanning several months, that is
to be billed monthly. A Deposit (Bookings) allows you to spread the deposit
across multiple months so that only a portion of the deposit is consumed
and applied to the invoice that is generated monthly. In this scenario, a large
deposit that is entered as Deposit (Reservation) would be consumed in its
entirety by the first invoice that is generated.

Payment or
Pre-payment

Remember that pre-payments act just like deposits in that they are applied
to a reservation and are applied to an invoice reducing the balance due.
Payments are applied to an invoice.

Refund Funds reimbursed to the payee.

Note:  You can also void an existing transaction from this window by clicking
the Void option. For detailed instructions, see Void Transactions (below).
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3. Enter additional information using the table below.

Field Descriptions for Payment Entry Window

FIELD DESCRIPTION

Transaction
Date

The default value is the current day’s date. You can edit this value if needed.

Department Select the department.

Payment
Type

Select the payment type.

Check No. Enter a check number if you selected “Check” as the payment Type.

Amount Enter the amount of the transaction. To decrease the invoice by this amount,
enter a minus sign (-) before or after the amount.

Currency Select the currency for the transaction.

Reservation
No.

Automatically populated if you opened this window from the Transaction tab
in the Navigator; otherwise, enter a reservation number or Search for a
reservation.

Adjustments, Payments, Refunds: This field is not available for these
transaction types since they are applied to invoices, not reservations.

Invoice No. When required, Search for an invoice (with a specific date and Employee or
Customer name from the Department you specified) to associate with this
transaction .

Deposits, Pre-payments: This field is not required for deposits and pre-
payments since they are applied before an invoice is generated. The invoicing
process totals the charges for the specified date range, consumes any
applied reservation deposits, and results in a net balance due for the invoice.
The invoicing process does not consume any Damage deposits.

See Also: Work with Invoices.

Notes Optional. Enter any other comments or statements that explain or clarify the
transaction.
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4. Click OK. The Payment Entry dialog box closes. The transaction information is displayed on the Trans-
actions tab for the reservation.

Void a Transaction 

1. Open the reservation in the Navigator and on the Transactions tab, select the transaction you want
to void (CTRL-click to select multiple transactions), and then click Void. A Void Reason dialog box
opens.

Void Reason Dialog Box

Note: You can also void a transaction by opening it in Edit mode from the Transactions tab
or by locating the transaction by date under the Billing > Payments > Payment Entry option
in the EMS Desktop Client menu bar. On the Payment Entry window that displays,
select the Void option.

2. Enter the reason for voiding the transactions, and then click OK. 

3. The Void Reason dialog box closes and a message confirms that the transaction has been
voided. Click OK to return to the Navigator. The Void column is set to Yes for each of the voided trans-
actions in the Navigator.
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CHAPTER 238: Generate an EMS Billing Report
All EMS Billing reports are available under the Billing option on the menu bar. For any EMS report, you can
specify the parameters, options, and format for the report, or you can generate the report according
to saved settings. (For detailed information about a saved report, see Work with Saved Reports.) Not all
reports require the same parameters, nor do they all have the same options available. In addition, you
can generate different reports in different formats.

Note: For brevity and ease, the parameters and options that are available for each report
are not discussed here. Instead, the options are discussed in Report Descriptions and
Options. Contact your EMS administrator if you need assistance in generating any of these
report.

Generate a report

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the following:
l To generate the Billing Worksheet report, click Billing > Invoices > Billing Worksheet.
l To generate any other Billing report, click Billing > Reports, and then click the option for the

report that you are generating. For example, to generate the Ageing report, click Billing >
Reports > Ageing.

Note: All Billing reports other than the Billing Worksheet report are also available from
Reports > Billing.

2. On the Setup drop-down list, do one of the following:
l To generate the report according to the filter settings that you want (parameters, options, and

so on), leave user-specified selected, then go to Step 3.
l To run the report with filter settings that have been saved, select the saved report, and then go

to Step 4.

Note: For detailed information about saved reports, see Work with Saved Reports.

3. Specify the report parameters, options, and format. See:
l Invoice Reports
l General Reports

4. Optionally, do one or both of the following:
l Click Print Preview. A preview of the report opens onscreen.
l To print a hard copy of the confirmation, specify the number of copies that you are printing,

and then click Print.
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5. Click Close. Unless you change the setup, all subsequent reports will be generated and printed
according to the parameters and options that you have specified and in the format that you spe-
cified. If you want to save certain settings so that you do not have to adjust the filter settings every
time you run the report, you can save the report. See Work with Saved Reports.
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CHAPTER 239: Apply a Reservation Discount
You use the Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced details in a
booking. The discount is applied as a percentage of the total charge for an item and it is added to any
existing discounts that have already been applied to the item.

TIP: To apply a discount to invoiced items, you must first void the invoice. See Void an invoice.

1. Open the reservation in the Navigator. See:
l Open a reservation directly in the Navigator
l Open a reservation through the Reservation Book
l Open a reservation through a group

2. In the left pane of the Navigator, select the reservation to which you are applying the discount.

3. In the Bookings pane, click Tools, and then click Apply Reservation Discount. The Apply Reservation
Discount window opens. All the bookings for the selected reservation with their categories that have
not been invoiced are displayed.
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4. Leave the Category set to the default value of (all), or optionally, to apply a discount to all the items in
a specific category, on the Category drop-down list, select a category. The Apply Reservation Dis-
count window is updated with the bookings that have the selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are applying the dis-
count, or click Select All to select all the displayed bookings in a single step, and then click Finish. A
message appears indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

After you apply a reservation discount, you can view it and/or edit it when you are editing the reservation
on the Billing Information tab of the Reservation window in the Navigator. See Edit a Reservation in the
Navigator.
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CHAPTER 240: Bill Multiple Reference and PO Numbers for a
Reservation
The following procedure details how to allocate a reservation charge to multiple billing reference numbers;
however, by analogy, you can follow this procedure to allocate booking charges or booking detail charges
to multiple billing reference numbers and/or PO numbers. 

1. For a selected reservation, open the Billing Reference Allocation tab, and then click Edit. The Billing
Reference Allocation dialog box opens. By default, when this dialog box first opens, it displays the
charge for the reservation allocated 100% to a single billing reference number placeholder.

2. Select the billing reference number placeholder, and then click Edit. The Split Billing Add dialog box
opens.

3. Do one of the following:

l Enter the billing reference number to which you are allocating the reservation charges, and then
click OK. The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog
box with the newly added billing reference number allocated at 100%. 
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l Search for a billing reference: click the Search icon and select a billing reference number from the list,
or, enter a search string in the Find field to choose from a list of close matches. The Billing References
dialog box closes. You return to the Split Billing Add dialog box with the selected billing reference
number displayed in the dialog box. You return to the Billing Reference Allocation dialog box with the
selected billing reference number allocated at 100%.

4. Do one of the following

l To allocate the reservation charges to only this single billing reference number, click OK. The Billing
Reference Allocation dialog box closes and you return to the Navigator. The newly added billing ref-
erence number, allocated at 100%, is displayed on the Billing Reference Allocation tab.

l To allocate the reservation charges to multiple billing reference numbers, click New. The Split Billing
Add dialog box opens.

5. Do one of the following:

l Enter a Billing Reference number, and then click OK.
l Search for a number by selecting from the list or by keyword, and then click OK. 

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with
each of the newly added billing reference numbers displayed with a 0% allocation.

6. Repeat these steps until you have added all the needed billing reference numbers.

7. For each new billing reference number, double-click in the Percent field to select the percent, and
then change the percent to the appropriate value. The percentages must add up to 100%.

8. Click OK to close the Billing Reference Allocation dialog box and return to the Billing Reference Alloc-
ation tab on the Navigator. All the billing reference numbers and their percent allocations are dis-
played on the tab.
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CHAPTER 241: Reprice Categories and Room Charges for a Reser-
vation
When you edit a reservation, changes to the pricing plan are applied at the reservation-level only. Booking
level service categories and room charges are not automatically repriced. To reprice services or room
charges based on a new pricing plan, use the Update Pricing Plan Wizard shown here. 

Note: You can reprice a room charge for a booking only if the room charge has not been
invoiced. To reprice a room charge that has been invoiced, you must first void the invoice.

Additionally, you can also Edit Charges for Multiple Billable Items.

1. Open the parent reservation in the Navigator. 
2. In left pane the Navigator, select the reservation or booking with which you want to work, and then

on the Reservation Summary tab, click Update Pricing. 

3. The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is displayed in the
Pricing Plan field. The window displays all the service categories and room charges that can be
repriced in one or more of the reservation bookings.
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Note:  If the reservation has other optional Pricing Plans, you can change the list using the
drop-down field at the top.

4. Select a service category or room charge (CTRL-click to select multiple items) to reprice and click Next. 

5. The next window lists all bookings under the reservation that have one or more of the selected ser-
vice categories or room charges that you can reprice.

6. Select the booking(s) for which you want to apply the repricing (you can click Select All to select all the
displayed bookings in a single step), and then click Finish. A message confirms your changes.

7. Click OK to close the message and return to the Navigator.
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CHAPTER 242: Confirmations
In EMS, a confirmation is a way to communicate critical information for a reservation—the date, the time,
the location, the scheduled resources, and so on. You send a confirmation to the group who is sponsoring
or hosting the event to make sure the reservation has been correctly set up—the time and location are
correct, all the necessary resources have been scheduled, and so on. You can also use the confirmation to
inform the group of any outstanding issues related to the reservation (such as a balance due) and to
provide other information that is not necessarily reservation-specific such as your organization's
cancellation policies, your organization's alcohol policies, and so on. You can generate a confirmation for all
the bookings in a reservation, or just for a selected booking in a reservation.

Confirmations are sent automatically to essential stakeholders; notifications trigger based on more
granular "notification rules."

Confirmations

l These are either sent out automatically after a booking is made in EMS Web App, or manually from
the EMS desktop client.

l They contain the date/time/resources for the booking that was created.
l These usually go to end users so they know when their event is and if they owe any money.

Notifications

l These are sent out automatically based on the filters on the notification rule:
l There are five types of notification rules:

l These are mostly sent out X days before a booking.  They are triggered when a change occurs on a
booking, service order, and so forth within that range of days.

The following topics provide information about specifying and generating confirmations in EMS Desktop
Client:

l Specify Your Confirmation Settings
l Send Confirmations
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l Generate a Single Confirmation at a Time
l Generate Printed Confirmations
l Generate Work Merge Documents for Custom Documentation
l Send Emails from EMS
l View History of Sent Emails
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CHAPTER 243: Send Confirmations

1. Open a reservation in the Navigator.

2. In the upper right corner of the Navigator, click Settings > Confirmation Settings. The Confirmation
Settings dialog box opens.

See Also: Confirmations vs. Notifications: What's the Difference?

Confirmations

l These are either sent out automatically after a booking is made in EMS Web App, or manually from
the EMS desktop client.

l They contain the date/time/resources for the booking that was created.
l These usually go to end users so they know when their event is and if they owe any money.
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Notifications

l These are sent out automatically based on the filters on the notification rule:
l There are five types of notification rules:

l These are mostly sent out X days before a booking.  They are triggered when a change occurs on a
booking, service order, and so forth within that range of days.

Accruent Confidential and Proprietary, Copyright © 2018 Page | 965



CHAPTER 244: Generate a Single Confirmation at a Time
You can generate a confirmation for all the bookings in a reservation, or just for a selected booking in a
reservation. In the as-delivered implementation of EMS, when you generate a confirmation for a
reservation or a booking, the Confirmation dialog box opens. This dialog box has the same tabs as the
Confirmation Settings dialog box. It also contains options for generating a print preview of the
confirmation and for manually printing or emailing an EMS-generated confirmation.

See Also: 

l Your Confirmation Settings determine the information included in a confirmation. See Also: Specify
Confirmation Settings.

l To generate multiple confirmations in a single step, see also: Generating Multiple Confirmations.
l You can Memorize your confirmation settings for the next time you generate the confirmation. See

Also: Working with Saved Reports.

Manually generating one confirmation at a time 

1. Open a reservation.

2. In the left pane of the Navigator, select the reservation for which you are generating the con-
firmation.

l You can also associate the confirmation with a specific booking within the reservation by select-
ing it in the Bookings (lower right) pane.

3. Do one of the following:
l If you are generating a confirmation for a reservation, then open the Reservation Summary tab

or Properties tab in the upper right pane of the Navigator, and then click Confirmation.
l If you are generating a confirmation for a selected booking, then open the Booking Summary

tab in the upper right pane of the Navigator, and then click Confirmation.
l The Confirmation dialog box opens. The dialog box has the same tabs as the Confirmation Set-

tings dialog box with one exception, the Date Range tab. On the Date Range tab, you can limit
the confirmation to specific bookings and/or specific booking times. When the dialog box first
opens, the Confirmation Setup is set to (user-specified). 
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Confirmation Dialog Box, Date Range Tab

4. Review the selections on this dialog box, and optionally, make any needed modifications.
l If you Use Specific Times, then you must also click Options and indicate how the confirmation is

to be limited: to bookings that start within the range or to bookings that occur within the time
range.

l From the Setup drop-down list, you can select a memorized confirmation. If you select a mem-
orized confirmation, then the only changes that you can make are to the dates and/or times on
the Date Range tab.

5. Generate a printed confirmation or email one:
l For a printed confirmation, enter the number Copies to Print, and click Print. A Print dialog box

opens in which you can specify information, such as the printer to use and the page range. Click
Print in this dialog box to manually generate the printed confirmation.
Tip: Before you print the confirmation, you can view a Print Preview, from which you can email
the confirmation, export the confirmation to .pdf, and print the confirmation.

l For an emailed confirmation, click Email. See Sending Email from EMS. Below is an example of
the SMTP email window.
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SMTP Email Window for a Confirmation

Automatically generating a confirmation 
If you want to always automatically generate a printed or emailed confirmation based on your
confirmation settings, then you must edit the Confirmation setting on the General tab of the Navigator
Options dialog box.

1. Open a reservation.

2. In the upper corner of the Navigator window, click Settings > Options. The Navigator Options dialog
box opens. The General tab is the active tab.
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Navigator Options Dialog Box, General Tab

3. Under Confirmation, select one of the following:
l Email—Always automatically generate an emailed confirmation based on your confirmation set-

tings.
l Print—Always automatically generate a printed confirmation based on your confirmation set-

tings.
4. Click OK to close the dialog box and return to the Navigator. The next time you initiate a Con-

firmation in the Navigator, EMS will Email or Print your confirmation based on your settings above.
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CHAPTER 245: Generate Printed Confirmations
A confirmation is a document that details the critical information for a reservation—the date, the time, the
location, the scheduled resources, and so on. Through the Navigator, you have the option of generating a
single confirmation, either manually or automatically. (See Also: Confirmations.) A miscellaneous
reservation function is also available for manually generating multiple confirmations at the same time.
When you generate multiple confirmations, all the confirmations are contained in a single file, but each
confirmation begins at the top of a new page. All the confirmations are "sent" by the same office, all the
confirmations use the same format (By Booking Date, By Date Added, or By Date Changed) and all the
confirmations use the same print options (Confirmation Title, Header Message, and so on); however, each
confirmation can contain unique information for the buildings, statuses, and/or categories that are detailed
in the confirmation. Because multiple confirmations are for multiple recipients, you cannot mass email
these confirmations. Instead, you can only print them, and then manually mail them. You can specify the
settings for multiple confirmations "from scratch," or you can copy an existing confirmation format, and
edit it as needed.

1. On the EMS menu bar, click Reservations > Other > Confirmations. The window opens on the Date
Range tab.

2. You can either draft a confirmation by completing the fields shown on this page (defined below), or
on the Setup drop-down list at the, select a saved, or memorized, confirmation, which means that the
only changes that you can make are to the dates and/or times on the Date Range tab.
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FIELD DESCRIPTION

Date Range Tab

Department The department name that appears at the top the printed confirmation.

Starting
Date

Ending Date

The range of dates for which you are generating the confirmations.

Use Specific
Times

Available only if the Starting Date is the same as the Ending Date. If this
option is selected, then two fields are displayed on the Date Range tab in
which you must specify the time range. After you specify the time range,
click Options > Date/Time Filter, and then indicate how the confirmation is
to be limited by bookings that start within the time range, or by bookings
that occur within the time range.

Format The format/organization of the confirmation By Booking Date, By Date
Added, or By Date Changed.

Buildings Tab — Select the specific buildings that are to be included in the confirmation.

Categories Tab — Select the specific booking details that are to be included in the
confirmation.

Statuses Tab — Select the specific statuses that are to be included in the confirmation.

Options Tab — Format settings for a printed confirmation.

Confirmation
Title

Appears bold and centered at the top of the confirmation.

Header
Message

Footer
Message

Pre-configured blocks of text that appear in the header and footer of the
printed confirmation.

Note: Your EMS administrator configures these values. Contact your
administrator if you need assistance with adding or editing a value.

Paper Size The size of the paper on which the confirmation is printed. Values are Letter,
Legal, and A4.
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FIELD DESCRIPTION

Print
Comments

Include the comments for the reservation in the printed confirmation.

Print
Reminders

Include the reminders for the reservation in the printed confirmation.

Print Cancel
Reasons

Include the reasons for cancellation in the printed confirmation.

Print User
Defined
Fields

Include user-defined fields and their values in the printed confirmation.

Print Room
Phone

Include the phone number for the room in which the event is being held in
the printed confirmation.

Print Room
Notes

Include any notes for the room in which the event is being held in the
printed confirmation.

Print
Building
Notes

Include any notes about the building in the printed confirmation.

Print Billing
Reference
Allocation

Include the billing reference numbers for the event as well as the percentage
of charges that is allocated to each number in the printed confirmation.

Print PO
Number
Allocation

Include the PO numbers for the event as well as the percentage of charges
that is allocated to each number in the printed confirmation.

Print
Category
Subtotals

Include the subtotal charges by category in the printed confirmation.

Print Room
Type

Include the room type for the event in the printed confirmation.
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FIELD DESCRIPTION

Print Item
Selection
Notes

Include the notes for each resource selection item for the event in the
printed confirmation.

Suppress
Reserved
Time

Do not show the reserved time for the event in the printed confirmation.

Suppress
Location

Do not show the location for the reservation in the printed confirmation.

Suppress
Pricing

Do not show the reservation's room charges or resource charges in the
printed confirmation.

Suppress
Logo

Do no show your organization's logo in the printed confirmation.

Suppress
Item Notes

Do not show notes for any booking items in the printed confirmation.

Suppress
Item Special
Instructions

Do not show special instructions for any booking items in the printed
confirmation.

Suppress
Item
Selections

Do not show any resource item selections in the printed confirmation.

Always
Display Time
Zone

Always show the time zone for the event in the printed confirmation.

Display
Messages as
HTML

If you have defined any HTML messages, then select this option to display
the HTML version of these messages in the printed confirmation; otherwise,
the message is displayed in plain text.

Limit Show only those bookings in the printed confirmation that contain details
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FIELD DESCRIPTION

Bookings to
Those With
Details in
Selected
Categories

for the categories that are selected on the Categories tab.

Tip: If needed, you can always save or memorize, these settings. See Also: Work with Saved Reports.

3. To print the confirmation, do one or both of the following:
l Click Print Preview to open an onscreen preview of the printed confirmation. A variety of

options are available from this preview, including the options to export the confirmation to a
.pdf and to print the confirmation.

l To manually print the confirmations, edit the number of copies to print as needed in the Copies
to Print field (the default value is 1), and then click Print. A Print dialog box opens in which you
can specify information, such as the printer to use and the page range. Click Print in this dialog
box to manually print the confirmations.
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CHAPTER 246: Generate Word Merge Documents for Custom
Documentation
EMS provides options for producing pre-formatted documents that contain reservation information such
as confirmations. Your organization, however, might have organization-specific information that must be
included in these documents. If your organization has purchased and implemented the optional Word
Merge module, you can generate Word Merge documents to produce custom confirmations, contracts,
and so on that contain not only selected reservation information from EMS, but also, any information that
is required by your organization. Because these documents are generated in a Word format (.docx), you
cannot print them or email them from EMS.

Generate Word Merge Documents

1. Open the reservation in the Navigator. See:
l Opening a reservation directly in the Navigator
l Opening a reservation through the Reservation Book
l Opening a reservation through a group
l Search Tools

2. In the left pane of the Navigator, do one of the following:
l Select the reservation for which you are generating the confirmation.
l Select the reservation for which you are generating the confirmation, and then in the Bookings

(lower right) pane, select the booking for which you are generating the confirmation.
3. Do one of the following:

l If you are generating a confirmation for a reservation, then open the Reservation Summary tab
or Properties tab in the upper right pane of the Navigator, and then click Confirmation.

l If you are generating a confirmation for a selected booking, then open the Booking Summary
tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The Date Range tab is the active tab.
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Confirmation dialog box, Date Range tab

4. At the top of the Confirmation dialog box, click Word Merge. The Word Merge Documents dialog
box opens. This dialog box displays all the Word Merge documents that your EMS administrator has
configured for your organization-specific documents such as confirmations, contracts, and so on.

Word Merge Documents Dialog Box
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5. Select the appropriate Word Merge document, and then optionally, do one or both of the following:
l To attach the document at the reservation-level for the selected reservation, click Attach to

Reservation.
l Select the attachment type.

6. Click Generate. A message opens, indicating that the Word Merge was successful, and asking you if
you want to view the document.

7. Optionally, click Yes. The document opens in Microsoft Word. You can now use any of the standard
Word functions to save the document, to print the document, attach the document to email, and so
on.

Note: To save a copy of the document in your EMS database, you must either attach the
document to the reservation, or you must open and view the document and save it as a
Word document.
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CHAPTER 247: View a History of Sent Emails
You can use the Email History function to review a list of all emails that have been sent from within your
organization’s EMS system via SMTP (not via Microsoft Outlook), including confirmation emails, report
emails (which includes invoices, reminders, queries, guest requests, and group and contact information),
and generic emails. You can also view the contents of sent emails and print sent emails

1. On the EMS main menu, click Reservations > Other > Email History. The Emails window opens.
Regardless of your preferences, the From field is automatically populated with the email address for
your user account, but you can always change this value.

2. Enter the search criteria for the emails, and then click Display.

Note: Under Source, the Report option collectively refers to confirmations, invoices, remind-
ers, queries, group requests, and group and contact information.

All of the emails that meet the search criteria are displayed in the bottom pane of the Emails window.

3. Optionally, do one or more of the following:
l To view an email, select the mail in the search results list, and then click View.
l To print the complete results list, click Print > List.
l To print the contents of one or more emails in the results list, select the mail, or CTRL-click to

select multiple emails, and then click Print > Emails.
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